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About this document

The following topics are discussed in this section:

• “Who should read this document and why” (page 25)

• “What you need to know” (page 25)

• “What’s new in this document” (page 26)

• “Text conventions” (page 27)

• “Year representation” (page 28)

• “Related documents” (page 28)

Who should read this document and why
This document is for system administrators and network operators who are 
responsible for network management. This document describes how to use 
the Preside Multiservice Data Manager (MDM) Fault Management toolset.

What you need to know
This document assumes an understanding of network management. Also, you 
need to be familiar with 

• the Sun workstation

• the UNIX operating system 

• a UNIX text editor, for example, vi

• elements in your network, for example, DPN and Passport devices

To access the MDM Fault Management tools, you need to have a valid 
capability ID and a password.
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What’s new in this document
The following features were added to this document:

• “VPN Monitor” (page 26)

• “Fault Applications Java Desktop” (page 26)

• “Nortel Networks Multiservice Provider Edge 9500 (MPE 9500) 
support” (page 26)

VPN Monitor 
The VPN Monitor chapter has been revised to reflect the support for the 
following access types for RFC 2547 VPNs:

• Local ATM

For details, see “RFC 2547 basic service components” (page 288).

Fault Applications Java Desktop
This feature involves the implementation of the Operator Client application. 
The following sections are updated:

• Network Browser

• Alarm Display

• Component Information Viewer

• Network Status Bar

• Shelf View

Nortel Networks Multiservice Provider Edge 9500 (MPE 9500) 
support

MPE 9500 is supported in fault management tools. The following sections are 
updated:

• Network Browser

• Alarm Display

• Component Information Viewer

• Shelf View
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Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

In MDM, uppercase and lowercase letters that appear in UNIX 
commands and parameters must be matched exactly. The system matches 
upper and lowercase characters differently.

• ->

A right-pointing arrow in a procedure indicates that a menu item has 
submenus from which you must choose. The appropriate submenu 
selection is shown immediately after the arrow. 
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• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Year representation
There are occurrences in this document where years are expressed as two 
digits rather than four, for example, 97 rather than 1997. To avoid ambiguity 
with the use of two-digit years, the following convention is used in this 
document. Years 91 to 99 (inclusive) represent the twentieth century, for 
example, 97 represents 1997; years 00 to 90 (inclusive) represent the twenty-
first century, for example, 01 represents 2001.   

Related documents
See the following documents for related information:

• 241-1001-303 DPN-100 Operator Commands and Responses

• 241-2001-351 DPN-100 Network Control System Operations and 
Maintenance

• NN10600-060 Nortel Networks Multiservice Switch 7400/15000/20000 
Component Reference

• 241-6001-012 Preside MDM Configuration Management for DPN User 
Guide

• 241-6001-015 Preside MDM Network Model Administrator Guide

• 241-6001-023 Preside MDM Configuration Management for Passport 
User Guide
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• 241-6001-203 Preside MDM Alarm and Status API Reference Guide

• 241-6001-301 Preside MDM Customization Administrator Guide

• 241-6001-303 Preside MDM Administrator Guide

• 241-6001-804 Preside MDM Workstation Utilities User Guide

• NN10600-050 Nortel Networks Multiservice Switch 7400/15000/20000 
Command Reference

• NN10600-060 Nortel Networks Multiservice Switch 7400/15000/20000 
Component Reference
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Chapter 1
Fault Management Tools Overview

The Fault Management tool is available through both the MDM Toolset and 
Operator Client environments. For details about these MDM environments, 
see 241-6001-801 Preside MDM Overview.

Preside Multiservice Data Manager (MDM) supports both state-based and 
alarm-based surveillance. State-based surveillance is used by the Network 
Viewer and Component Status Display tools. Alarm-based surveillance is 
used by the Alarm Display tool. For an overview of MDM surveillance, see 
the figure “Fault management architecture” (page 33).

By using the monitoring tools that correspond with your preferred 
surveillance models, you can receive information about network element 
faults, their impact (through the Network Viewer and Component Status 
Display tools), and their cause (through the Alarm Display). High-level 
monitoring of the network is also available through the Network Status Bar. 
Diagnostic tools such as the Component Information Viewer, the DPN 
Performance Viewer, and the Data Viewer provide more information about 
the fault, its impact, its cause, and its history. After the fault is properly 
identified, you can perform the following actions:

• Mask the fault using the network model’s acknowledge and maintenance 
states.

• Clear the alarm through Alarm Display or Component Information 
Viewer. You can also issue commands to the element through the 
Command Console utility or one of the remote access tools. For details 
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about the Command Console and Remote Access utilities, see the 
Command Console section in 241-6001-804 Preside MDM Workstation 
Utilities User Guide

• Correct some configuration parameters using the configuration tools.

• Acknowledge the alarm through the Alarm Display or the Component 
Information Viewer to indicate to other network operators that the fault 
causing the alarm is currently being investigated.

Acknowledging all active alarms against a component causes the component 
state to become acknowledged. The component state is then masked as 
though it was directly acknowledged with a state-based surveillance 
application such as Network Viewer. 

Communication between these tools is simplified through cut and paste, and 
automatic context transfers.

Surveillance draws its information from the network model. For a description 
on how the network model works and the interactions among the surveillance 
tools, see 241-6001-015 Preside MDM Network Model Administrator Guide.

When used with the SNMP Surveillance Adapter, MDM can also manage 
other devices on the network. For information on how this works, see 
241-6001-118 Preside MDM SNMP Surveillance Adapter Guide.
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Figure 1
Fault management architecture 

Navigation
• “Network Viewer in the MDM Toolset” (page 37) describes the Network 

Viewer tool for monitoring a network. 
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• “Network Browser for Operator Client” (page 173) describes the 
Network Browser hierarchical representation of the network down to the 
node level.

• “Shelf View” (page 179) provides a graphical view of the Passport shelf 
that can be used to assist in troubleshooting network problems in real-
time.

• “VPN Monitor” (page 253) provides fault management capabilities for 
Passport Internet Protocol (IP) Virtual Private Network (VPN) services.

• “Alarm Display” (page 303) alerts to fault conditions in network 
components, indicating the severity of the fault, the type of fault, and 
additional information on the cause or current situation.

• “Alarm Help” (page 371) provides alarm code descriptions for DPN, 
Passport, MPE 9500, integrated SNMP device, and MDM proxy alarms.

• “Alarm acknowledgement and unacknowledgement” (page 381) 
describes the Acknowledge Alarm and Unacknowledge Alarms tools for 
informing other operators that you are currently investigating an active 
alarm problem.

• “Network Status Bar” (page 397) provides a high-level view of the state 
of the network. As well, it monitors network health by means of global 
statistics. 

• “Component Information Viewer” (page 415) performs diagnostic 
analysis of components identified by the first-alert surveillance tools. 

• “Query Historical Alarms” (page 505) describes the short-term historical 
alarm search tool for displaying short-term historical alarms and 
provides procedures for using this tool

• “Component Status Display” (page 519) performs first-alert surveillance 
of the network, indicating the current state or criticality of the network 
model components.

•  “IP Discovery” (page 553) enables you to discover Simple Network 
Management Protocol (SNMP) devices by hostname or IP address using 
direct discovery or route-based discovery.

• “Circuit Viewer” (page 599) provides the ability to view on-switch and 
off-switch circuit information stored in the Administration Database. 
Circuit Viewer also provides service diagnostic information.
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• “HP OpenView NNM desktop” (page 655) is an optional tool that 
provides access to the HP OpenView platform.

• “Common surveillance tasks” (page 671) provides information on 
monitoring the network for faults, diagnosing the cause of the faults and 
its impacts, and taking remedial actions.

• “LPDA-2 modem management” (page 681) describes how you can 
manage LPDA-2 modems

• “Common alarm format” (page 685) describes the common alarm format 
parameters.
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Network Viewer in the MDM Toolset

This section describes the Network Viewer and provides you with instructions 
on how to use this tool. The following information is included:

• “Network Viewer overview” (page 37)

• “Using the Network Viewer tool” (page 39)

• “Interacting with other tools” (page 42)

• “Understanding the network display” (page 47)

• “Navigating the network display” (page 67)

• “Controlling the network display” (page 79)

• “Customizing the Network Viewer display” (page 86)

• “Troubleshooting” (page 99)

• “Network Viewer interface” (page 101)

• “Network Viewer Editor interface” (page 157)

Network Viewer overview
The Network Viewer is a network component state surveillance tool used for 
the detection of faults for DPN, Passport, MPE 9500, and selected SNMP 
devices in the network. The Network Viewer displays state and topology 
information for the physical and organizational components that make up the 
network. 
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Network Viewer capabilities
The Network Viewer allows you to perform the following functions:

• use advanced navigational capabilities to locate components and alter the 
display of the network with great flexibility

• display module subcomponents down to the port level to trace a high-
level problem down to its source at the subcomponent level

• display different organizational levels of the network at the same time 
(for example, a mixed display of regions, sites, and modules)

• display a defined map in the background of the Network Viewer display

• put both modules and subcomponents into maintenance state or 
acknowledged state

• save a Network Viewer display configuration so that you can retrieve it 
and display it again later

• use filtering to make state surveillance more efficient

• customize such items as tools menus, alarms, and the use of color for 
states

• edit the contents and structure of the network model. For details, see 
241-6001-015 Preside MDM Network Model Administrator Guide.

• save a number of user-specific preference settings and re-apply them 
automatically when the Network Viewer is restarted.

Network Viewer modes
The Network Viewer operates in two modes:

• surveillance

• edit

Surveillance mode
In surveillance mode, the Network Viewer enables you to navigate the 
network and to monitor the states of network components. 
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Edit mode
In edit mode, the Network Viewer enables the administrator to monitor 
network element states and allows you to edit the network model. For more 
information on how to edit the model with Network Viewer, see 
241-6001-015 Preside MDM Network Model Administrator Guide.

Using the Network Viewer tool
This section provides basic procedures for using the Network Viewer.

Navigation
• “Starting Network Viewer” (page 39)

• “Using the Network Viewer Icon Bar” (page 41)

• “Interacting with other tools” (page 42)

• “Exiting the Network Viewer” (page 45)

Starting Network Viewer
The Network Viewer connects to the network model server referred to by 
current service selection. If the service selection changes, you are prompted 
for confirmation of the change. For additional information, see the section on 
using the Service Selection tool in 241-6001-303 Preside MDM 
Administrator Guide.

Note: Your workstation may be set up so that the Network Viewer 
window opens when you log on. Your system administrator can set this 
option.

Procedures
1  In the Preside MDM window, select Fault ->Network Viewer.

The Network Viewer window opens.

2 If more than one organization is defined, the organizational icons display. 
Go to step 3. If only one organization is defined, Network Viewer opens 
with the view of that organization. Go to step 3.

3 To open the display of an organization, double-click on the organization 
you want to view.

The first level components of the selected organization display in the 
Network Viewer window.
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General operations are available from these menus positioned in the 
Network Viewer menu bar: File, Edit, View, and Options. Another menu 
provides access to the network model edit mode and options. See the 
online help available from each menu for an explanation of the menu 
items.
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Using the Network Viewer Icon Bar
The Network Viewer supports an icon bar that consists of a selection of 
buttons. These buttons provide quick access to frequently used commands 
and tools. When you position the mouse pointer over a button, the Network 
Viewer displays a tooltip below that button. This tooltip contains the name of 
the command represented by the button. 

By clicking on a button in the icon bar, you can: 

• operate a range of expand and compress view options

• select components and organizations to view

• start other tools and utilities

• pass component IDs to invoked tools 

• view context-sensitive help information about individual items from the 
icon bar

The mode of operation of the Network Viewer determines which buttons 
appear in the icon bar. Some buttons appear only in edit mode or only in 
surveillance mode. Other buttons appear in both modes. 

You can show or hide the icon bar. If you hide the icon bar, the tool commands 
contained in it are still available. Access other tools using the Network Viewer 
pop-up menu and selecting the Start Tool command. By default, the tools 
available from the Network Viewer Start Tool menu are the same as those that 
appear in the icon bar. 

You can customize the Network Viewer icon bar (NDIconBar.menu) and the 
Network Model Edit icon bar (NDIconBarEdit.menu). For details, see 
241-6001-301 Preside MDM Customization Administrator Guide.

Showing the icon bar
1 From the Options menu, select Show Icon Bar.

The icon bar appears.

Hiding the icon bar
1 From the Options menu, select Hide Icon Bar.

The icon bar disappears.
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Note 1:  Alternatively, use the Preferences Dialog to control the visibility 
of the Icon Bar. See “Using the Preferences dialog” (page 83) for more 
information.

Note 2:  Icon bar contents can be customized. For details on customizing 
an icon bar, see the section on customizing toolsets and start tool menus 
in 241-6001-301 Preside MDM Customization Administrator Guide.

Interacting with other tools
There are two methods that you can use to access component information 
available in other tools but not stored in the Network Viewer:

• “Context” (page 42) 

• “Start Tool menus” (page 42)

Context
Context commands allow component identifiers to be passed quickly from 
one tool to another. For example, the identifier of any node, link, or 
subcomponent can be put into context by Network Viewer and picked up by 
the Component Information Viewer to display detailed information for the 
component. To put an identifier into context, press the Select mouse button to 
ensure that the node, link, or subcomponent is selected.

Start Tool menus
The Start Tool command supports a Start Tool menu that has a selection of 
tools and utilities that you can launch from the Network Viewer. Unlike other 
surveillance tools, the Network Viewer offers more than one type of Start Tool 
menu. You can access Start Tools from the following locations within the 
Network Viewer:

• surveillance mode icon bar

• model edit mode icon bar

• Start Tool menu

• Network Viewer pop-up menu

• Node pop-up menu

• Link pop-up menu

• Subcomponent pop-up menu
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Surveillance mode icon bar
The surveillance mode icon bar contains a series of icons that let you start 
other tools and utilities. In surveillance mode, the Start Tool submenu in the 
Network Viewer pop-up menu is a textual representation of the same tools 
shown graphically in the icon bar. You can customize the content of the 
surveillance icon bar. Any modifications that you make apply only to the 
surveillance icon bar and the Start Tool menu in the menu bar and in the 
Network Viewer pop-up menu. For details on customizing the surveillance 
icon bar, see the section on customizing toolsets and start tool menus in 
241-6001-301 Preside MDM Customization Administrator Guide.

Model edit mode icon bar
The model edit mode icon bar contains a series of icons that let you start other 
tools and utilities. In edit mode, the Start Tool submenu in the Network 
Viewer pop-up menu is a textual representation of the same tools shown 
graphically in the icon bar. You can customize the content of the edit mode 
icon bar. Any modifications that you make apply only to the edit mode icon 
bar and the Start Tool menu in the menu bar and in Network Viewer pop-up 
menu. For details on customizing the edit mode icon bar, see the section on 
customizing toolsets and start tool menus in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Start Tool menu
Use the Start Tool menu in the menu bar to launch other tools and utilities. 
The tools and utilities in the Start Tool menu are the same as those in the icon 
bar. Similar to the icon bar, the Start Tool menu in the menu bar changes 
content based on the mode of the Network Viewer. You can customize the 
content of the Start Tool menu. For details, the section on customizing 
toolsets and start tool menus in 241-6001-301 Preside MDM Customization 
Administrator Guide. The following list details the default Start Tool menu 
options and the mode in which they are available:

Expand in Place Edit & Surveillance

Expand in New Window Edit & Surveillance

Compress Edit & Surveillance

Open Shelf Dialog Edit & Surveillance
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If the corresponding software is installed, the Start Tool menu also displays 
the following tools:

Network Viewer pop-up menu
You can access the Network Viewer pop-up menu by positioning the mouse 
pointer on the Network Viewer background and pressing the mouse menu 
button.

Open (Troubled) Subcomponent Dialog Edit & Surveillance

Find Edit & Surveillance

Select New Organization Edit & Surveillance

Load/View Network Model File Edit

Save Network Model Edit

Collect Configuration Data Edit

Apply/View Collection Files Edit

Create/Edit Node Edit

Create/Edit Link Edit

Delete Selected Components Edit

CIV (Component Information Viewer) Surveillance 

OpCom (Operator Commands) Edit & Surveillance

Config Edit & Surveillance

PP4400 Edit & Surveillance

Ct Viewer (Circuit Viewer) Surveillance
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The Network Viewer pop-up menu contains a Start Tool command that opens 
a Start Tool submenu. The content of the Start tool submenu changes 
depending on whether the Network Viewer is in surveillance mode or model 
edit mode. If you customize a Network Viewer icon bar, the changes are 
reflected in the Start Tool submenu.

Node pop-up menu
You access the Node pop-up menu by positioning the mouse pointer on a 
single or multiple nodes and pressing the mouse menu button. The Node pop-
up menu contains a Start Tool command that opens a Start Tool menu. 

Link pop-up menu
You access the Link pop-up menu by positioning the mouse pointer on a link 
and pressing the mouse menu button. The Link pop-up menu contains a Start 
Tool command that opens a Start Tool menu. 

Subcomponent pop-up menu
Access the Subcomponent menu using the following procedure:

1 Position the mouse pointer on a node and press the mouse menu button. 

A Node pop-up menu opens. 

2 From the pop-up menu, select the Show Subcomponents command. 

The dialog opens displaying a list of subcomponents.

3 Position the mouse pointer on a specific subcomponent in the list and 
press the mouse menu button. 

The Subcomponent pop-up menu opens.

The Subcomponent pop-up menu contains the Start Tool command that opens 
a Start Tool menu. 

Exiting the Network Viewer
To exit the Network Viewer, select Exit from the File menu. 

If you have not modified any Filter or Preference Settings, an NV Exit 
Confirmation Dialog opens. Select Exit Application if you want to exit or 
Cancel Exit if you want to remain in Network Viewer.
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If you modify any Filter or Preference Settings and do not save them to your 
user-specific file, Network Viewer asks if you want to do so before exiting. 
The NV Exit Confirmation Dialog allows you to save the modified settings 
and exit Network Viewer, exit Network Viewer without saving, or cancel the 
exit and return to the Network Viewer main window.

The figure “NV Exit Confirmation Dialog” (page 46) shows a sample dialog 
that displays when you exit the Network Viewer.

Figure 2
NV Exit Confirmation Dialog

Note: This dialog appears only if the filter settings are changed or if the 
confirmExit resource is set to the default True. 

For the instructions to set this resource, see the section on customizing 
toolsets and start tool menus in 241-6001-301 Preside MDM Customization 
Administrator Guide.

Canceling exit
1 If you do not want to exit, select the Cancel Exit button from the dialog.

The exit dialog disappears and you are returned to the Network Viewer 
main window.

Exiting and saving settings
1 Select the Exit and Save button from the dialog.

The filter or Preference settings (or both) that you create are saved to your 
user-specific file, and you exit the Network Viewer.
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Exiting without saving settings
1 Select the Exit without Saving button from the dialog.

The modified filter or Preference settings (or both) are not saved and you 
exit the Network Viewer.

Understanding the network display
Two basic kinds of components are displayed by Network Viewer—nodes 
and links. Nodes include physical nodes and organizational nodes. Links 
include physical links and organizational links. Each component (node or 
link) has an object menu from which operations specific to the component are 
available.

The Network Viewer display can have background maps assigned to 
organizations, and nodes and link bendpoints can be assigned. Network 
Viewer display configuration is part of the overall task of network model 
configuration. This is handled by the Network Viewer in edit mode. See 
241-6001-015 Preside MDM Network Model Administrator Guide for details 
on network model configuration.

If node positions are not configured in the Network Viewer, the nodes are 
displayed with a grid cyclic policy; that is, they are placed side by side, a row 
at a time, along an imaginary grid. The grid starts at the upper left corner of 
the map and works its way from left to right, top to bottom, to the lower right 
corner of the map. When the grid is filled, the procedure starts over at the 
upper left corner, placing nodes one on top of the other.

This section describes how to

• display Network Viewer legend

• display Nodes

• display Node labels

• control Node positioning

• display Links

• display Nodes and Links owned by a site or region

• display subcomponents as shelf icons

• display subcomponents in a textual list
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• display component states

Displaying the Network Viewer legend
The Network Viewer legend shows the colors associated with state values and 
conditions. It also shows the meaning of icons and link styles. 

Displaying the Network Viewer legend
1 From the Options menu, select Legend. 

The Network Viewer legend opens.
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You can leave the legend open for reference or collapse it to an icon.

Displaying nodes
Nodes are represented by icons positioned on a background map of the 
organization displayed in the main Network Viewer window. The node type 
is indicated by the shape of the icon. Nodes can be these types of icons: 

• Polygon (or Type)
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• Shelf 

Note: You can display a label with the node name under the icon.

The Network Viewer Legend shows the meaning of these icons. See 
“Displaying the Network Viewer legend” (page 48).

Polygon icons
Polygon or Type icons identify the node type by their shape. Polygon icons are 
simple geometric shapes representing the component type. There are polygon 
icons for all the network model node types. In addition, a default polygon icon 
is available for any type not in this set. 

Note: Polygon icons are full color pixmaps of any size, shape, and detail.

Shelf icons
Shelf icons are displayed only for certain node types in a separate dialog. 
Shelf icons usually represent physical components housed in a shelf. The 
exception to this is the Passport icon, which displays the node’s logical 
processors.

Node types in the Network Viewer and the network model
The set of node types that are distinguished by different polygon icons in the 
Network Viewer differs slightly from the set of node types that are defined in 
the network model. For example, the Network Viewer has distinct icons for 
each of AM, RM, DPN-100/1, MAS, LDM, and DPN-100/5, which are all 
defined as type PM in the network model. Network Viewer distinguishes 
between these module types using attribute information stored in the network 
model. The set of node types distinguished by the Network Viewer and the 
corresponding network model node types are shown in the table “Node types 
and description” (page 51).

Note: By default the icon displayed for all MPE 9500 devices is the MPE 
9500 icon shape. To have differentiated MPE 9500 icons requires a 
manual editing.

Note: Many other nodes are distinguished by customer-specific icons.
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Table 1
Node types and description

Network Viewer 
node type

Network Model 
node type

Description Shelf dialog 
available

AM PM DPN Access Module (Default for PM 
components)

yes

RM PM DPN Resource Module yes

DPN-100/1 PM DPN-100/1 and Downloadable 
DPN-100/1

yes

MAS PM Magellan Access Switch (same icon 
as DPN-100/5)

yes

DPN-100/5 PM DPN-100/5 yes

PP4100 PM Passport 4100 yes

NM NM DPN Network Module no

OA OA NCS Operations Agent no

EM EM Enterprise Module (Passport 16-slot) yes

EM3 EM Passport 3-slot yes

EM5 EM Passport 5-slot yes

EM8 EM Meridian Passport yes

EMT EM Passport 15000 yes

EMN EM Passport 20000 yes

EMX EM Passport with unspecified shelf type yes

MPA MPA Passport 4400 Access Device yes

MPAX MPA Passport 4400 with unknown shelf 
type

no

LDM MPA Legacy Data Module no

PA PA Passport Access Module no

RBSE RBSE Radio Base Station Equipment (NNE) yes

RCPE RCPE Radio Customer Premise Equipment 
(NIU)

yes

 (Sheet 1 of 2)
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Displaying the node labels
You can show or hide node labels independently of one another.

Displaying node labels
1 To have all nodes show or hide their labels, choose Show all node labels 

or Hide all node labels from the options menu.

2 To have a single node show or hide its label, choose Show label or Hide 
label from its pop-up menu.

The nodes either show or hide their labels depending on which option you 
chose.

M1 M1 Meridian-1 Module no

M1_11 M1 Meridian-1 Option 11 Module no

SLAN SLAN Local area network (LAN) managed 
through SNMP

no

E_RTR E_RTR MAS embedded router no

RTR/HUB/BR RTR, HUB, BR Router, hub, bridge, managed 
through SNMP

no

HOST HOST Host no

FNMOD FNMOD Foreign Network Module (gateways) no

NMS NMS generic network management system no

BB BB Backbone Module no

SITE Organization 
node

Site node no

REGION Organization 
node

Region node no

Organization Organization 
node

Network model organizational 
hierarchy

no

Table 1 (Continued)
Node types and description

Network Viewer 
node type

Network Model 
node type

Description Shelf dialog 
available

 (Sheet 2 of 2)
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Note:  Use the Preferences Dialog to control the appearance of the 
nodes. See “Using the Preferences dialog” (page 83).

Positioning the nodes
You can use the mouse to position nodes in the Network Viewer display. If the 
Network Viewer is currently in Editing mode, these position changes are 
permanent in the network model and, therefore, available to all instances of 
Network Viewer monitoring this network. Otherwise, these changes are 
temporary and are known only to the current Network Viewer session.

Nodes are recorded in the network model exactly where you position them in 
the display. Cluster and pin options are available to help you position legibly 
and efficiently. 

The Network Viewer allows you to enable/disable an invisible grid to run in 
the background. If the grid is enabled, nodes and bendpoints snap to it as they 
are moved. This helps to position nodes and bendpoints accurately. 

Note: The various node positioning and clustering options described here 
are also controlled through the Preferences Dialog. See “Using the 
Preferences dialog” (page 83).

Enabling the grid 
1 On the View menu, choose Snap to Grid.

The invisible grid is enabled. Nodes and bendpoints snap to the grid as 
they are moved.

Disabling the grid 
1 On the View menu, choose Do Not Snap to Grid.

The invisible grid stops running in the background. Nodes and 
bendpoints, when moved, need to be aligned more carefully since they do 
not snap to a grid.

Positioning a single node
1 To move a single node, press and hold the left mouse button and move 

the node to the position in the display you want it to occupy.

An outline of the node follows the cursor.

2 Release the left mouse button to position the node in the display.
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The new node location appears in the Network Viewer display and is 
recorded in the network model.

Positioning multiple nodes
1 To select several nodes, draw a rubber band around them; or press and 

hold the Shift key, and use the left mouse button to select nodes and links.

Note:  To remove a node from the set of selected nodes, press and hold 
the Control key and click with the left mouse button.

2 Position the cursor on one of the selected nodes, and press the Shift key 
and the left mouse button.

When you start the move, a rectangle outlines the group.

3 Move the group to a chosen position and release the left mouse button. 

Nodes are repositioned in the Network Viewer display and are recorded 
in the network model. Selected links with end points are also moved.

Using the cluster and pin options
1 If you do not want to move certain nodes, invoke the Node pop-up menu, 

and select the Pin option from the Edit cascade menu.

Selected nodes are pinned to their positions in the display and are not 
affected by cluster commands.

2 Select a node with the left mouse button, and invoke the Node pop-up 
menu using the right mouse button.

3 On the Edit cascade menu, select Cluster Connected Nodes or Cluster 
Child Nodes.

Cluster Connected Nodes positions all nodes that connect to the selected 
node in a circle around the selected node; Cluster Child Nodes expands 
the selected node, and positions all subordinate nodes in a grid around 
the expanded node’s original position.

Note:  Nodes are never allowed to be positioned outside the map or 
viewspace boundaries, and will be automatically forced on if needed.

Positioning a node to its previous or original position
1 Select the node with the left mouse button, and invoke the Node pop-up 

menu using the right mouse button. 

2 To position the node to its previous position, select Move to Previous 
Position from the Node pop-up menu. 

The node is repositioned to its previous position.
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3 To position the node to its original position, select Move to Original 
Position from the Node pop-up menu.

The node is repositioned to its original position.

Reverting all nodes to their current network model location
1 To revert all nodes to their current network model location, on the View 

menu choose Set Shared Model Positions for all Nodes and Links. 

To revert selected nodes to their current network model location, on the 
View menu, choose Set Shared Model Positions for Selected Nodes and 
Links.

The nodes revert to their current network model location.

Aligning and distributing nodes
1 To align and distribute selected nodes, on the View menu, choose Align 

and Distribute Selected Nodes.

Displaying links
A link is displayed as a sequence of lines connecting the two link endpoints. 
Network links, trunks, gateways, and organizational links all appear as simple 
solid lines. Dial back-up network links (DBNL) are distinguished from other 
types of links through the use of a different line pattern. The line patterns are 
shown in the Network Viewer legend. For details, see “Displaying the 
Network Viewer legend” (page 48). 

The link type for any link can be determined from the link identifier that 
appears in the link’s object menu. A link identifier has this format:

<-link type-> end1ID <-> end2ID

For example, the link identifier for a DPN network link might look like this: 

<-NL-> PM/A15 PE/1 /PI/1 PO/4 <-> PM/R72 PE/3 PI/3 PO/5

A link identifier for a Passport to Passport trunk looks like this:

<-PTK-> EM/PASS1 TRK/20 <-> EM/PASS2 TRK/21

Accessing the link menu
1 Move the pointer over the link you want to work with, and press menu to 

display the link menu selections.

2 Choose an action from the menu.

See online help for a full explanation of the menu selections.
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Link bendpoints
You may add bendpoints to a link to separate it from other links that may be 
superimposed over one another. Bendpoints are the points where the lines 
meet. 

Link menus contain commands to show and hide bendpoint handles. 
Bendpoint handles must be visible to move or delete single bendpoints. You 
can access a bendpoint menu to perform bendpoint-related activities. 

Overlapping links between two nodes can also be spread out by the automatic 
insertion of bendpoints.

For an example of bendpoints, see the figure “Link with bendpoints” 
(page 56). For an example of bendpoint handles, see the figure “Link with 
bendpoints and handles” (page 56).

Figure 3
Link with bendpoints

Figure 4
Link with bendpoints and handles

Accessing the bendpoint menu
1 Move the pointer over the link whose bendpoints you want to work with, 

press menu, and choose Show Bendpoint Handles.

Note:  If the bendpoint handles are already showing, skip this step and 
proceed to step 2.

BendpointsBendpoints

Bendpoint HandlesBendpoint Handles
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2 Move the pointer over the bendpoint handle you want to work with, and 
press menu to display the bendpoint menu selections.

3 Choose an action from the bendpoint menu.

Automatically spreading the overlapping links
Note: This is available only if more than one link exists between two 
given nodes.

1 Spread the links using the Link pop-up menu. Use the Spread Links 
command, or double-click on the link.

All previous bendpoints are removed. New bendpoints are inserted at 
midsection to spread the links evenly.

Note:  Use the Preferences Dialog to control the Link Spreading distance. 
See “Using the Preferences dialog” (page 83) for more information.

Displaying nodes and links owned by a site or region
Nodes and links directly owned by a site or region can be displayed within a 
dialog. The dialog contains a list of components and an option button that 
enables you to toggle between the All Components and the Filtered 
Components Only view. In Filtered mode, only the nodes and links matching 
the current filter settings of the main window are displayed. 

The nodes in the list support the standard Node pop-up menu, where all 
graphical commands are disabled. Similarly, the links in the list support the 
standard Link pop-up menu. Nodes and links also support the same double-
click actions as in the main window. The components in the list can also be 
used as a drag source. 

The Components Dialog can be invoked from the Node pop-up menu. For 
Organizational Nodes, the Show Subcomponents… command is replaced by 
Show Children…. The Icon Bar command for Show Subcomponents can also 
be used if the selected node is an organizational node.

Displaying nodes and links owned by a site or region
1 Move the pointer over the site or region that contains the nodes and links 

you want to view.

2 Press menu to display the nodes and links.

3 Choose Show Subcomponents… from the cascade menu or, for 
Organizational nodes, choose Show Children.
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A dialog containing the nodes and links is displayed.

Displaying shelf views
You can display the logical shelf view for DPN devices or the logical and 
physical views for Passport multiservice devices and Nortel Networks 
Multiservice Provider Edge 9500 devices. 

If you select a DPN device and then select the Shelf View command, the DPN 
logical shelf view displays as a shelf icon within the Network Viewer tool. If 
you select a Passport device and then select the Shelf View command, the 
Passport Surveillance Shelf View tool opens and display the logical and 
physical views of the Passport device. For details about the Passport 
Surveillance Shelf View tool, see “Shelf View” (page 179). 

Each icon is configured according to the subcomponent information 
contained in the network model for the node. If the Network Viewer cannot 
determine the exact shelf type for a PM module, it uses an AM dual-shelf 
layout by default.
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Displaying the DPN shelf icon
1 Move the pointer over the node that contains the subcomponents you 

want to view.

2 Right-click on the node to display the Node pop-up menu. 

3 From the Node pop-up menu, select Show Menu. 

Note:  The default display for a dual AM or dual RM shelf dialog has Shelf 
0 on the top and Shelf 1 on the bottom. However, you can customize 
Network Viewer to display a dual AM or dual RM shelf dialog with Shelf 1 
on the top and Shelf 0 on the bottom by entering NV*reverseShelf:True in 
your.Xdefaults file.

A dialog containing the shelf icon for the node is displayed. The icon is 
colored according to its state. See “Displaying the Network Viewer 
legend” (page 48) in this guide and the section on network model states 
in 241-6001-015 Preside MDM Network Model Administrator Guide, for 
information on component states.
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You can view pop-up menus for the node and its subcomponents by right-
clicking a button in the shelf icon. See the menu’s online help for a description 
of its commands.

Displaying subcomponents in a textual list
Not all subcomponents of a node are displayed as part of a shelf icon. To see 
all subcomponents, use the Subcomponent dialog.

The Subcomponent dialog displays subcomponents in one of two modes: All 
Subcomponents or Troubled Subcomponents Only. The All Subcomponents 
mode displays all subcomponents. The Troubled Subcomponents Only mode 
displays only those subcomponents whose raw state is in-service—troubled 
(ISTB) or out of service (OOS). Components whose states are propagated as 
241-6001-011   15.1RSUP   



Chapter 2 Network Viewer in the MDM Toolset   61
ISTB or OOS are not included in the list. In Troubled Subcomponents Only 
mode, components are sorted so that troubled components appear first, 
components in Acknowledged state are shown second, and components in 
Maintenance state appear last. These categories are separated by labels. An 
option menu at the bottom of the dialog lets you change the display mode.

You can also reduce the number of subcomponents that are fetched and 
displayed by setting a criticality cutoff in the Preference Dialog (see “Using 
the Preferences dialog” (page 83)). Only subcomponents whose criticality is 
greater or equal to the specified criticality cutoff value are initially fetched 
(the default value is 1, indicating that all subcomponents should be 
displayed). Note that subcomponent notifications received for the node 
displayed in the dialog are added to the list regardless of their criticality value.

When the Subcomponent is displaying subcomponents with a criticality 
cutoff higher than 1, a label at the top of the dialog indicates this fact. An 
action button (Load All) is added to force all the remaining subcomponents to 
be loaded.

Displaying the subcomponent text dialog
1 Move the pointer over the node that contains the subcomponents you 

want to view.

2 To open the Subcomponent dialog in the troubled mode, double-click the 
Select mouse button on the node icon, or press menu to display the Node 
object menu

3 Choose Show Subcomponent Dialog… from the menu.

The text dialog opens and displays the subcomponents belonging to the 
node. States of the subcomponents are also listed in this dialog. See 
“Displaying the Network Viewer legend” (page 48) in this guide and the 
section on network model states in 241-6001-015 Preside MDM Network 
Model Administrator Guide, for information on component states. Multiple 
subcomponent dialogs for different components may be displayed at the 
same time.

Object menus for the node and its subcomponents are accessible by 
pressing the menu button on their state or name fields. See the menu’s 
online help for a description of its commands.

Changing the display mode of the subcomponent dialog
1 Press the menu option button in the Display area.
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2 Select the All Subcomponents or Troubled Subcomponents Only option.

Note:  You can use the accelerators CTRL-a and CTRL-t from the dialog 
to change to the All Subcomponents or Troubled Subcomponents Only 
option respectively.
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Displaying component states
Component states are shown by colors. The Network Viewer Legend shows 
the meaning of these icons. See “Displaying the Network Viewer legend” 
(page 48).

Component states are managed by the Surveillance Network Model Updater, 
which is responsible for computing states and storing them in the network 
model. For more details on how component states are computed, see 
241-6001-015 Preside MDM Network Model Administrator Guide. The 
Network Viewer is notified by the network model server whenever a 
component changes state. The Network Viewer responds to this notification 
by updating the network display.

The state displayed for a component is computed from the following factors:

• the network state of the component as determined from network data 
(alarms or status records, or both, depending on the type of component). 
The possible values for network state are described in the table 
“Component States” (page 64). The network states common to all 
component types.

Table 2
Component States

State Description

Unknown No alarms or status records have been received 
for the component.

In-service The component is functioning normally.

In-service-troubled The component is functioning, but is 
experiencing some problem.

Out-of-service The component or one of its parents is not 
functioning.
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• the criticality of the component: a number reflecting the importance of 
the component ranging from 1 (low importance) to 5 (high importance). 
Each component type has a default criticality that may be redefined 
during network model population. The criticality assigned to a 
component may be viewed in both the Component Information Viewer 
and the Network Viewer in edit mode.

• the states of related components. For more information on state and state 
propagation, see 241-6001-015 Preside MDM Network Model 
Administrator Guide.

A legend showing the state-color mapping is available from the Network 
Viewer Options menu. See “Displaying the Network Viewer legend” 
(page 48) to display the legend.

Node state display
An icon is colored according to its state. If the shelf dialog is being displayed, 
a stripe across its shelf icon is colored to display the overall node state. The 
individual shelf components are colored to display the subcomponent states. 

Link state display
The line representing the link is colored according to the state.

Maintenance state
Maintenance state hides a component’s current state and any subsequent state 
changes. If you perceive a problem on a component, you can put the 
component into Maintenance state when you do not want to be distracted by 
the state display.

Maintenance / Hierarchic 
Maintenance

The component’s real state and that of its 
subcomponents is masked pending corrective 
action. 

Acknowledged The component’s real state is temporarily 
masked. If the real state changes, the 
acknowledgment is automatically removed.

Table 2 (Continued)
Component States

State Description
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Putting components into the Maintenance state
1 Move the pointer over the component to be put into the Maintenance 

state.

2 Press menu and choose Set Maintenance On from the menu.

The request is sent to the network model and, if accepted, the state of the 
component is changed to Maintenance state. See 241-6001-015 Preside 
MDM Network Model Administrator Guide, for more information on the 
Maintenance state.

Taking components out of the Maintenance state
1 Move the pointer over the component to be taken out of the Maintenance 

state.

2 Press menu and choose Set Maintenance Off from the menu.

The component is taken out of the Maintenance state. The Network Model 
Updater recomputes the component’s state based on its state when 
received from the network and on the states of its related components.

Acknowledged state
Acknowledged state temporarily hides a component’s current Troubled state 
(indicated by the network). As soon as the component changes state, the 
acknowledgment is automatically removed and the component’s real state 
shows. When a component is acknowledged, it acts as though it is in an In 
Service state. That is, if a lower subcomponent is also troubled, it is reflected 
on the Acknowledged state through the usual propagation mechanisms—thus 
showing hidden faults. The only difference is that, if no other related 
components are troubled, the acknowledged component displays a state of 
Acked instead of In Service. Only troubled modules and subcomponents 
(from the network) can be acknowledged.

Putting components into the Acknowledged state
1 Move the pointer over the component to be put into the Acknowledged 

state.

2 Press menu and choose Set Acknowledged State On from the menu.

The request is sent to the network model and, if accepted, the state of the 
component is changed. 

Note:  You can also acknowledge all active alarms against the component 
by using the corresponding Start Tool menu option.
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Taking components out of the Acknowledged state
1 Move the pointer over the component to be taken out of the 

Acknowledged state.

2 Press menu and choose Set Acknowledged State Off from the menu.

The component is taken out of the Acknowledged state. The Network 
Model Updater recomputes the component’s state based on its state 
when received from the network and on the states of its related 
components.

Note:  You can also unacknowledge all active alarms against 
the component using the corresponding Start Tool menu option.

Navigating the network display
For large networks, it is generally neither feasible nor desirable to view the 
entire network at once in the Network Viewer display window. These kinds 
of navigation are provided by the Network Viewer:

• Component Finder

• Organization navigation

• Background navigation

• Double-click actions

Using the Component Finder
The Component Finder is the main navigational tool. It allows you to quickly 
locate components and to change the main window display to bring different 
components into view. The Component Finder Dialog contains a mini map 
representing the entire Network Viewer background. A rectangle, called the 
mini view window, indicates the part of the background that is currently 
displayed in the Network Viewer window (especially when zoom is used). 
This gives you a sense of where you are in the overall network display. The 
bitmap being displayed (if any) is not visible in the mini map. 

When the finder locates a specific node, it displays this found node as a mini 
node in the mini map. Like the real node, the mini node can be selected by 
dragging the mouse pointer over it while pressing the Select button, or by 
double-clicking the Select button while the mouse pointer is on it. After the 
mini node is selected, you can access a pop-up menu from which you can 
issue actions such as expanding and opening dialogs.
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The Component Finder provides an input field where you can enter the 
identifier of the component you want to find. The identifier may be selected 
from a list of components, typed in directly, or retrieved from context. The 
contents of the Component Selection List are determined by the selection in 
the Level Selection List, which lists the levels of the organization. For 
standard organizations, the levels are region, site, and module. Components 
below the module level are not listed since they do not have individual 
locations on a map. However, they are displayed as icons that are accessible 
from the module. 

Finding a component using the Component Finder
1 Press menu with the pointer over View in the Network Viewer menu bar.

2 Choose Find from the cascade menu.

The Component Finder Dialog opens.
241-6001-011   15.1RSUP   



Chapter 2 Network Viewer in the MDM Toolset   69
Note:  You can search for only one component at a time.

3 Type a component ID in the component ID field, retrieve it from context, or 
select an item in the Components List.

4 Select Find.

mini node

mini view

mini map
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The location of the module is shown in the mini map.

If the specified component is not found in the model, is an already un-
expanded node, is not part of the currently displayed organization, or is 
invisible due to some exclusive expansions, a message indicating this is 
displayed in the message area. If the node is not available for filtering, a 
message appears indicating this.

If the specified component is found in the current display, the finder 
indicates its location by displaying a circle in the mini map. The 
component is highlighted in the Network Viewer display window. The 
component remains highlighted until the next selection is made, or the 
component is deselected in the main navigation window (which also 
removes the tracking of the node in the finder dialog). If the component is 
found in compressed state, the mini node is displayed as a slightly larger 
square. The larger square represents the organizational node that needs 
to be expanded to display the component (which can be done by double-
clicking the mini node).

If the circle is outside the rectangle, you can move the current window 
view to include the component, or move the component into the current 
window view.

Note 1:  When a component is retrieved from context, this step is 
performed automatically.

Note 2:  If an item in the Components List is double-clicked instead of just 
single-clicked, this step is performed automatically.

Changing the window view to include the target component
1 Repeat steps 1 to 4 of “Finding a component using the Component 

Finder” (page 68).

2 Drag the mini view window over the indicated component, or select the 
Move View button located under the mini map. 

This automatically moves the window over to the indicated component so 
that it is just inside the view. The Network Viewer window view changes 
correspondingly.

Note:  Dragging the mini view window may be done only if the view area 
is not the entire map background (possible due to zooming in on a 
particular area of interest). If the view area is the entire map, then the mini 
view window fills the entire mini map space in the finder.

Moving a component into the current view
1 Repeat steps 1 to 4 of “Finding a component using the Component 

Finder” (page 68).
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2 Drag the mini view window over the indicated component, or select the 
Draw Node In button located under the mini map. 

The component moves to the interior of the window rectangle. The 
component icon is correspondingly moved into the Network Viewer 
window view.

Note:  To move the component back to its previous or original position, 
select Undo Last Move or Undo All Moves from its object menu. See 
“Positioning the nodes” (page 53).

Using organization navigation
Organization navigation allows you to navigate through the network 
organizational hierarchy, expand nodes to show their subcomponents or 
compress subcomponents into their higher level parents. 

Note: An organizational component and the components it contains are 
never displayed simultaneously.

You can expand a node by the following methods:

• in-place

• exclusive

• in a new window

Expanding in place 
Expanding in place replaces any selected organizational node with its 
children while leaving the display of unselected nodes unchanged. Links 
between the newly shown nodes and other organizations are visible. 

Expanding in place to the next lower level
1 Move the pointer over the component that you want to expand to the next 

lower level.

2 Double-click the Select mouse button. Alternatively, press the Menu 
mouse button and choose Expand In Place.

The selected component is replaced with the next level of 
subcomponents.

Note:  Only the selected component is expanded; all other components 
in the display remain unchanged.
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Expanding in place to the lowest level
1

2 Move the pointer over the component that you want to expand to the 
lowest level.

3 While holding down the Shift key, double-click the Select mouse button. 
Alternatively, press the mouse Menu button and choose Full Expand In 
Place.

The selected component is replaced with a view of all its subcomponents 
(if any) down to the module level.

The figure “Before in-place expansion to the lowest level” (page 73) 
illustrates the network view before in-place expansion for REGION 4.

The figure “After in-place expansion to the lowest level” (page 74) illustrates 
the view after REGION 4 is expanded down to its module level. The single 
link between REGION 3 and REGION 4 is expanded to two physical links—
one to PM A1 and the other to PM A2.
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Figure 5
Before in-place expansion to the lowest level
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Figure 6
After in-place expansion to the lowest level

Compressing a component back to the parent level
1 Move the pointer over the component whose parent you want to view.

2 While holding the Control key, double-click the Select mouse button. 
Alternatively, press the mouse Menu button and choose Compress In 
Place.

The selected component and all other components having the same 
immediate parent component are replaced by the parent component.

The figure “After in-place expansion to the lowest level” (page 74) illustrates 
the network view after SITE 5 is compressed in place. EM A3 and all other 
modules in SITE 5 are replaced by the SITE 5 icon.
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Figure 7
Compressing a component to its parent level

Expanding exclusively
Exclusive expansion replaces any selected organizational node with its 
children and hides the display of other unselected and unexpanded nodes. 
Links between the visible nodes and other organizations are not visible. When 
nodes are hidden due to exclusive expansions, the word Partial appears in the 
status label.

Expanding exclusively to the next lower level
1 Move the pointer over the component that you want to exclusively expand 

to the next lower level.

2 Press the Menu mouse button and choose Expand Exclusively.

The selected component is replaced with the next level of 
subcomponents. All other nodes are hidden.
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Expanding exclusively to the lowest level
1 Move the pointer over the component that you want to exclusively expand 

to the lowest level.

2 Press the Menu mouse button and choose Full Expand Exclusively.

The selected component is replaced with a view of all its subcomponents 
(if any) down to the module level. All other nodes are hidden.

In this example SITE 5, as shown in the figure “Exclusive expansion to the 
lowest level” (page 76), is exclusively expanded to the lowest level.

Figure 8
Exclusive expansion to the lowest level

Expanding in a new window
Expanding in a new window provides exclusive expansion of organizational 
nodes into new subwindows. These subwindows provide functionality similar 
to that of the main window. You can distinguish subwindows by their title bar.
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A node or link cannot appear in more than one window at any one time. As a 
result, non-organizational nodes cannot be included in subwindows during 
expansion as this would result in the same node being displayed in two 
windows. 

Expanding to the next lower level in a new window
1 Select one or more regions or sites, or both.

2 From the View menu or the Node pop-up menu, choose Expand in New 
Window. 

A new subwindow opens displaying the next lower level for each selected 
organizational node.

Expanding to the lowest level in a new window
1 Select one or more regions or sites, or both.

2 From the View menu or the Node pop-up menu, choose Full Expand in 
New Window. 

A new subwindow opens displaying the lowest level for each selected 
organizational node.

Closing a subwindow
1 From the File menu, select Compress parent node which closes this 

window and its subwindows. Alternatively, you can use the Network 
Viewer pop-up menu. From this pop-up menu, point to File and select 
Compress parent node which closes this window and its subwindows.

The subwindow closes.

Using background navigation
Background navigation allows you to change the visible part of the map. You 
can use the scroll bars across the bottom and along the right side of the 
Network Viewer display window to change the area displayed. You can also 
zoom the display.

Zooming in on the display
1 Move the pointer over the View button in the menu bar and press menu.

2 Choose Zoom.

A cascade menu appears listing the available magnification factors.

3 Choose a magnification factor.
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The display is zoomed around the current center point to the selected 
magnification factor.

Zooming out
1 Move the pointer over the View button in the menu bar and press menu.

2 Choose Zoom.

A cascade menu appears listing the available magnification factors.

3 Choose a lower magnification factor than the current setting.

Using double-clicking actions
You can double-click the Select mouse button and use it with the Shift, 
Control, or Meta keyboard keys to act on nodes, links, and subcomponents in 
the Network Viewer. The table “Default double-clicking actions” (page 78) 
lists the default actions for Network Viewer. These actions can be customized. 

Table 3
Default double-clicking actions

Node type Key held down Default action

Organizational root node none Opens the organization

Organizational node none Same as Expand In Place 
pop-up menu command

Organizational node Shift Same as Full Expand In 
Place pop-up menu 
command

Organizational node Ctrl Same as Compress pop-up 
menu command

Organizational node Meta Starts CIV tool

Module node none Same as Open 
Subcomponent Dialog pop-
up menu command, but in 
Troubled mode

Module node Shift Same as Open Shelf Dialog 
pop-up menu command
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Controlling the network display
You can control the network display by

• setting Component filtering using the Network Viewer Filter Settings 
Dialog. For more information, see “Using the NV Filter Settings Dialog” 
(page 79).

• setting node, cluster and positioning, and other preferences using the 
Preferences Dialog. For more information, see “Using the Preferences 
dialog” (page 83).

• setting various Views of the network. For more information, see “Using 
Views of the network” (page 85).

Using the NV Filter Settings Dialog
Network Viewer component filtering enhances state surveillance by 

• showing only the modules and links that require attention

• minimizing the display clutter by hiding irrelevant nodes and links

• speeding up display operations by reducing the number of displayed 
modules

Module node Ctrl Same as Compress pop-up 
menu command

Module node Shift + Meta Same as Expand in New 
Window

Module node Meta Starts CIV tool

Subcomponent Meta Starts CIV tool

Link Meta Starts CIV tool

Link none spreads overlapping links

Table 3 (Continued)
Default double-clicking actions

Node type Key held down Default action
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The NV Filter Settings Dialog allows you to tailor the NV Component Filter 
to your own preferences. With the NV Filter Settings Dialog, you can select 
active filtering options. You can also Save to file or Restore from file the 
settings and Apply the defined settings to the main Network Viewer display. 

Whether Component filtering is enabled or not when the Network Viewer 
starts is controlled by the Preference Dialog. See “Using the Preferences 
dialog” (page 83) for more information.

Note: Filtering is turned off by default; however, you can change this 
default by setting the ND* compFilteringOn resource to True in your user 
specific file: ${HOME}/MagellanNMS/.Xdefaults. If you set this 
resource, the saved preferences are automatically restored the next time 
the Network Viewer is started.

The Network Viewer supports filtering on component states and overriding 
conditions. After you select the node states and link states that you want 
filtered, you have the option of overriding these state filters by

• hiding DPN-100/1 nodes

• hiding Magellan Access switches (MAS)

• hiding cross-level links (links from a node to a site or from a site to a 
region in the context of Network Viewer’s in-place expansions)

• showing DNLs and DBNLs

Note: This override does not apply to BWODs. BWODs are not 
considered to be DBNLs or DNLs for filtering purposes; they are filtered 
like NLs.

• showing backbone components (RM, Passports, TKs, and PTKs by 
default)

• hiding Passport trunks

• hiding ATM links

Changing the filtering of the states of nodes and links
1 Ensure that the Set filtering option under the View menu in the Network 

Viewer main window is turned to On. 
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See “Activating and deactivating filter settings from the Network Viewer 
main window” (page 82) for more information.

2 Open the NV Filter Settings Dialog:

a. From the Network Viewer main window menu bar, select Options.

b. From the Options menu, select Change filter settings.

The NV Filter Setting Dialog opens.

1 Select the node states you want to filter from the Node States column.

2 Select the link states you want to filter from the Link States column.

3 Select the overriding conditions from the But ignore states to always list.

Note:  These overrides function only if the network model is properly 
populated with the information necessary to identify these components.

4 Save the settings:
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If you want to save the settings to the NDFilter.cfg file in your $HOME/
MagellanNMS directory, select Save to File.

If you want to save the settings to the Network Viewer main window, select 
Apply.

Note:  The settings are applied to the Network Viewer main window only 
if the Set filtering option under the View menu in the Network Viewer main 
window is set to On. See “Activating and deactivating filter settings from 
the Network Viewer main window” (page 82) for more information.

5 Close the NV Filter Settings DIalog by selecting Close.

The NV Filter Settings Dialog closes.

Activating and deactivating filter settings from the Network 
Viewer main window
The Set Filtering On option under the View menu in the Network Viewer main 
window enables the filter parameters set in the NV Filter Settings Dialog to 
be applied to the Network Viewer main window.

1 Press Select on the View menu in the Network Viewer main window.

2 Choose Set Filtering On to activate the filter parameters or Set Filtering 
Off to deactivate them.

The Preference Dialog enables and disables the Component filtering 
when Network Viewer starts. See “Using the Preferences dialog” 
(page 83) for more information.

Using previously saved filter settings
You can retrieve and apply previously filter settings saved to the NDFilter.cfg 
file in your $HOME/MagellanNMS directory.

Restoring previously saved filter settings
1 Open the NV Filter Settings Dialog:

a. From the Network Viewer main window menu bar, select Options.

b. From the Options menu, select Change filter settings.

The NV Filter Setting Dialog opens.

2 Select Restore from file. to apply the filter settings saved to the 
NDFilter.cfg file.

The restored filter settings are displayed in the dialog.

3 Select Apply to save the filter settings to the Network Viewer main window. 
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Using the Preferences dialog
The NV Preferences dialog allows you to modify a number of display and 
behavioral settings for the Network Viewer. You can save these settings so 
they can be automatically restored and applied whenever the Network Viewer 
is invoked. The Preference Settings come in the following categories: 

• Node Display

• Clustering and Positioning 

• Miscellaneous

Some of the settings, including Snap to Grid, are also available from other 
Network Viewer menus.

Changing the display options for Network Viewer
1 Press menu on Options in the Network Viewer main window menu bar.

2 Choose Change Preferences from the menu.

The NV Preferences dialog window opens.
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3 Select the option you wish to use from the Node Display Options button.

4 Select Save to File if you want to save these filter settings to the 
NVFilter.cfg file in your $HOME/MagellanNMS directory.

The settings made in the dialog are saved. The changes are not applied 
and the dialog remains open.

5 Select Apply to apply these settings to the Network Viewer main window.

Note:  These settings are applied only if the Set filtering option under the 
View menu in the Network Viewer main window is set to On. See 
“Activating and deactivating filter settings from the Network Viewer main 
window” (page 82) for more information.

6 Select Close to close the dialog window.

The NV Filter Settings Dialog closes.
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Using Views of the network
You can save a view that is used often under a view name to quickly retrieve 
and display it. By saving the view under a view name, you can store key 
portions of the network and switch very rapidly to different views. A named 
view stores the following information:

• organization that is displayed

• coordinates and zoom factor of the visible section of the organization’s 
map

• components that are expanded in the view

• visibility of node labels

• visibility of link bendpoint handles

• modified node and bendpoint positions (optional) 

• snap-to-grid state

• the network dimensions (without map if they are changed in the 
Preferences Dialog)

Saving a view
1 Have your network display in the format you want to save.

2 Press menu on File in the menu bar.

3 Choose Save View from the menu.

The current view is saved to its file.

You can also choose Save View As from the menu.

A dialog opens, enabling you to save the view under a specified name.

4 If you chose to save the view under a specified name, enter the filename, 
or select the name if it appears on the menu.

5 To save the positions of nodes and bendpoints that are changed in the 
view, ensure that Save Node Positions in View is enabled on the toggle 
button. 

If enabled, a checkmark appears on the left. Modified node positions are 
saved in the view.

If you do not want to save modified node positions in the view, deselect 
the toggle button. 
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The checkmark disappears and nodes are not saved in view. 

Restoring a view
1 Press menu on File in the menu bar.

2 Choose Restore View… from the menu.

A file selection dialog that contains a list of the names of all saved views 
is displayed.

3 Select the view you want to display in the window.

Note:  For instructions on setting a default view for Network Viewer, see 
“Selecting the default view” (page 88).

4 To restore modified node positions that are saved in the view, ensure that 
Restore Node Positions in View is enabled on the toggle button. 

If enabled, a checkmark appears on the left. Saved node positions are 
restored from the view.

If you do not want to restore saved node positions from the view, deselect 
the toggle button. 

The checkmark disappears and saved node positions are not restored 
from the view. 

Customizing the Network Viewer display
You can perform the following types of customization on the Network 
Viewer:

• select the background pixmap image

• select the default view

• select the color and display options

• modify the Start Tool menus and icon bars

Selecting the background pixmap image
The Network Viewer uses XPM3 format pixmaps for the background. This is 
a widely supported format. Various public- and commercial-domain tools 
allow you to create in, or convert other images to, this format. The Solaris 
Common Desktop Environment (CDE) software provides a pixmap editor that 
you can use for modifying pixmaps. This editor is located in the file
 /usr/dt/bin/dticon. For instructions on how to use this pixmap editor, see the 
Help menu in the tool itself. 
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Note: The dticon editor is limited to relatively small pixmaps (256x256). 
To edit larger pixmaps, use a commercial tool or, if preferred, a public 
domain tool (such as xpaint, which is available from the MIT ftp site 
ftp.x.org).

The pixmap files used by Network Viewer are stored in the directory
/opt/MagellanNMS/lib/nds/pixmaps.

You can use the pixmaps stored in this directory as a starting point, and edit 
them with a pixmap editor; or you can import your own pixmaps. Store any 
pixmaps that you edit or create in the directory 
/opt/MagellanNMS/cfg/nds/pixmaps. After your custom pixmaps are stored 
there, they are available to the Network Organization Populator through the 
Set organization map dialog. For more information, see 241-6001-015 
Preside MDM Network Model Administrator Guide.

Additional geographical area pixmaps are available from the Preside 
Multiservice Data Manager (MDM) CD ROM in the directory /cdrom/
cdrom0/NVMaps. Use the installmap tool on the CD ROM to install these 
pixmaps. 

Changing node icon pixmap images
Network Viewer uses XPM3 pixmaps to define the appearance of node icons. 
The pixmaps for all Network Viewer node icons can be found in the directory
/opt/MagellanNMS/lib/nds/pixmaps.

To change these pixmaps, use any available tool (commercial or otherwise) 
capable of editing XPM format images. The Icon Editor that comes with CDE 
is ideal for these pixmaps. When editing node icon pixmaps, keep the 
following points in mind:

• Define the bulk of the image using the symbolic colors Background, 
TopShadow, BottomShadow, and Select. The symbolic color 
Background is replaced by the appropriate color for the node’s current 
state. TopShadow and BottomShadow are dynamically calculated based 
on the current Background color. The Select color is defined as a 
Network Viewer (ND) resource. Set any area of the image that should 
never be filled with any color to the symbolic color Transparent.
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• Use TopShadow and BottomShadow symbolic colors to give your icon a 
3D effect.

• Use Static Colors and Static Grays only to add details and accents to the 
image. Use them sparingly to prevent confusion with state colors.

• Keep the node pixmaps small to conserve screen real estate (20X20 is a 
good average size).

• If you create new node pixmaps (as opposed to editing existing 
filenames), be sure to update the ND resource file appropriately.

Selecting the default view
You can set a default view that is restored automatically whenever Network 
Viewer is started. To do so, create the new default view in the standard 
directory (/opt/MagellanNMS/data/nvs/views) and name it 
DEFAULT_VIEW. Alternatively, you can set the defaultViewName resource 
for Network Viewer to the full path name of the view description file to use 
as default. For more details, see the section on customizing the toolsets and 
start tools menus in 241-6001-301 Preside MDM Customization 
Administrator Guide.

Modifying the Start Tool menus and icon bars
You can customize the Start Tool menus and icon bars. For details on the 
available Network Viewer Start Tool menus, see "Start Tool menus" on page 
42. 

For details on customizing the Start Tool menus and icon bars, see the section 
on customizing the toolsets and start tools menu in 241-6001-301 Preside 
MDM Customization Administrator Guide.

When you modify the Start Tools menu file, use one of the following 
substitution variables on the command line:

• $COMP: the selected component ID in API format (for example, 
EM TORONTO LP 1 PO 1)

• $COMP2: the second selected component ID in API format

• $DCOMP: the selected component ID in display format (for example, 
EM/TORONTO LP/1 PO/1)

• $DCOMP2: the second selected component ID in display format
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• $NMHOST: the current host from the Server Selection tool

• $DNAME: the module name only from the selected component ID in 
display format

• $DNAME2: the module name only from the second selected component 
ID in display format

• $SNAMES: the module names only from the selected component IDs in 
API format

• $SDNAMES: the module names only from the selected component IDs 
in display format

Customizing Network Viewer resources
The Network Viewer tool uses resources to describe certain functional and 
appearance aspects. You can customize some of these aspects. Others cannot 
be changed without affecting the functionality of Network Viewer.

The Network Viewer resource files are /opt/MagellanNMS/lib/app-defaults/
C/ND and /opt/MagellanNMS/lib/app-defaults/C/NDIcons.

The table “Resources that you can customize in the Network Viewer” 
(page 90) lists the Network Viewer resources that you can customize. Note 
that the application classname of the Network Viewer applications is actually 
ND.

CAUTION
Risk of altering the functionality of the Network Viewer
Do not modify resources that are not listed in the following 
table. Changing unlisted resources may negatively affect 
Network Viewer’s appearance and functionality
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Table 4
Resources that you can customize in the Network Viewer

Resource Description Legal values

ND*stateINVALID
ND*stateUNKNOWN
ND*stateINSV
ND*stateINSV
ND*stateISTB_1
ND*stateISTB_2
ND*stateISTB_3 
ND*stateISTB_4
ND*stateISTB_5
ND*stateOOS_1
ND*stateOOS_2
ND*stateOOS_3
ND*stateOOS_4
ND*stateOOS_5
ND*stateMTCE
ND*stateHIER_MTCE
ND*stateACKED
ND*stateModuleUNKNOWN

These resources specify the state-
to-color mapping used to indicate 
the current state of components in 
ND.

Any X windows color 
name specification, for 
example, gray98. 
See /usr/lib/X11/rgb.txt 
for a list of X11 color 
names.

ND*differentModuleUnknownColor If differentModuleUnknownColor is 
true, then the unknown color for the 
node at the module level is different 
from the default unknown color.

True or False

ND*nmsNodeStates*nvmColors
ND*nmsNodeStates*xpmBgColor
<n>

These resources specify the colors 
that represent the various node 
states. <n> ranges from zero to 
(numColors -1). Each unique color 
needs to be defined in this list only 
once (even if the same color is used 
for more than one state).
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ND*nmsNodeStates*nvmImages
ND*nmsNodeStates*xpm 
Image<n>

These resources specify all the 
unique XPM3 pixmaps that 
represent the various node types. 
<n> ranges from zero to 
(numImages -1). Each unique 
pixmap needs to be defined in this 
list only once (even if the same 
pixmap is used for more than one 
node type).

ND*nmsLinkStates*nvmLinkColor
s
ND*nmsLinkStates*linkColor<n>

These resources specify the colors 
that represent the various link 
states. <n> ranges from zero to 
(numLinkColors -1). Each unique 
color needs to be defined in this list 
only once (even if the same color is 
used for more than one state).

ND*nmsLinkStates*nvmLinkStyles
ND*nmsLinkStates*LinkStyleNam
e<n>
ND*nmsLinkStates*LinkStyleWidt
h<n>
ND*nmsLinkStates*LinkStyleStyle
<n>
ND*nmsLinkStates*LinkStyleDash
Offset<n>
ND*nmsLinkStates*LinkStyleDash
es<n>

These resources specify all the 
unique line styles that represent link 
types. <n> ranges from zero to 
(numLinkStyles -1). Each style 
needs to be defined only once. 
LinkStyleName is arbitrary. 
LinkStyleWidth can be any whole 
number. LinkStyleStyle must be 
zero for solid lines, and one or two 
for dashed lines. See X Window 
System graphics context 
documentation for explanations of 
LinkStyleDashOffset and 
LinkStyleDashes.

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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ND*numNodeTypes
ND*nodeTypeName<n>
ND*nodeTypeImageIndex<n>

These resources specify the 
mapping of node types to node 
images defined by the 
ND*nmsNodeStates*xpmImage 
resources. <n> ranges from zero to 
(numNodeTypes -1). The 
nodeTypeName must match the 
node type string defined by the 
network model. The 
nodeTypeImageIndex specifies (by 
index) which image to use for this 
node type.

ND*numStateNames
ND*stateName<n>
ND*stateColorIndex<n>

These resources specify the 
mapping of node state names to the 
colors defined by the 
ND*nmsNodeStates*xpmBgColor 
resources. <n> ranges from zero to 
(numStateNames -1). The 
stateName strings must match the 
state names defined by the network 
model. The stateColorIndex values 
specify (by index) which color to use 
for this node state.

ND*numLinkTypes
ND*linkTypeName<n>
ND*linkTypeStyleIndex<n>

These resources specify the 
mapping of link types to link styles 
defined by the 
ND*nmsLinkStates*linkStyle 
resources. <n> ranges from zero to 
(numLinkTypes -1). The 
linkTypeName must match the link 
type string defined by the network 
model. The linkTypeStyleIndex 
specifies (by index) which line style 
to use for this link type.

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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ND*numLinkStateName
ND*linkStateName<n>
ND*linkStateColorIndex<n>

These resources specify the 
mapping of link state names to the 
colors defined by the 
ND*nmsLinkStates*linkColor 
resources. <n> ranges from zero to 
(numLinkStateNames - 1). The 
linkStateName strings must match 
the state names defined by the 
network model. The 
linkStateColorIndex values specify 
(by index) which color to use for this 
link state.

ND*nmsLinkStates*linkSelectColo
r

This resource specifies the color of 
the lines that bound a selected link 
to show that it is selected.

ND*nmsLinkStates*linkSelectWidt
h

This resource specifies the width (in 
pixels) of the selection lines on 
either side of a selected link.

ND*nmsLinkStates*solidSelection
Lines

This boolean resource specifies 
whether or not the selection lines 
follow the style pattern of the link, or 
if they are always drawn as solid 
lines.

ND*nmsNodeStates*selectColor This resource specifies the color of 
the “halo” that surrounds selected 
nodes.

ND*labelOffset This integer resource specifies the 
distance (in pixels) from the bottom 
of a node icon to the top of its label.

ND*labelFontList This resource specifies the 
X Window System font to be used 
for node labels.

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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ND*restrictClusterToSite This resource indicates if Network 
Viewer needs to consider only 
connected nodes in the same parent 
Organizational Node when Cluster 
Connected Nodes is invoked on a 
node. This setting is now controlled 
by the Preferences Dialog. 

False

ND*clusterModuleSpacing
ND*clusterOrgNodeSpacing

These resources indicate the 
distance left between nodes when 
the Cluster Child Nodes or Cluster 
Connected Nodes commands are 
applied. 
For Cluster Connected Nodes, 
these values are implicitly majored 
by an increment based on the 
number of connected nodes. This 
setting is now controlled by the 
Preferences Dialog. 

If the target node is a 
module, the value is 
80.
If the target node is an 
Organizational Node, 
the value is 250.

ND*drawAreaBackgroundColor This resource specifies the color of 
the background when no map is 
assigned (for example, the 
background when the organization 
roots are being displayed)

Any X windows color 
name or numerical 
specification

ND*worldMinX
ND*worldMinY
ND*worldMaxX
ND*worldMaxY

These resources specify the 
dimension of the network when no 
map is assigned. Any node lying 
outside this area is forced within to 
ensure that it is visible. This setting 
is now controlled by the Preferences 
Dialog. 

X or Y coordinates in 
pixels

ND*rubberbandColor This resource specifies the color of 
the selection rectangle and the 
rubber band when positioning links. 
If you modify the background colors, 
you may also need to change these 
colors to get a better contrast.

Any X windows color 
name or numerical 
specification

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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ND*linkSelectionSensitivity These resources specify the number 
of pixels to either side of a link’s 
drawn line. If the mouse is clicked 
inside this margin, the link is 
selected. When set to zero, links can 
only be selected when the mouse is 
directly over the line (which can be 
tricky when trying to select a 
diagonal line).

ND*displacementInertia These resources pacify the number 
of pixels a node or bendpoint needs 
to be displaced before Network 
Viewer considers the object as 
moved. This helps to prevent 
accidental moves when selecting 
nodes.

ND*bendpointDimension This resource specifies the width 
and height of the bendpoint handles 
in pixels.

ND*labelForeground
ND*labelBackground

These resources specify the color of 
the node and link labels. If you 
changed the background color, you 
may also need to change these 
colors to get a better contrast.

Any X windows color 
name or numerical 
specification

ND*autoManageOrgs
ND*organizationName 

If autoManageOrgs is True (default), 
Network Viewer automatically tries 
to open an organization when it 
starts (no default view is specified). 
If organizationName is specified 
(commented out by default), it can 
hold the name of the organization 
that it is opening. If not specified, 
Network Viewer opens the 
DEFAULT ALL view if it is the only 
one or it opens the non DEFAULT 
one if only two organizations exist.

True or False
Organization name

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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ND*defaultViewName If it is specified (commented out by 
default), this resource indicates the 
full path name of the view 
description file to restore 
automatically when Network Viewer 
starts.

A view description file 
full path name

ND.geometry This resource specifies the default 
size of the Network Viewer window 
in terms of X geometry.

Standard X windows 
geometry specification

ND*mainWindow.width
ND*mainWindow.height

These resources specify the default 
size of the Network Viewer window 
in terms of width and height 
(defaults to 750x649)

Width and height in 
pixels

ND*showAllLabels If True, Network Viewer displays all 
node labels by default. Default is 
False. This setting is now controlled 
by the Preferences Dialog. 

True or False

ND*reverseShelf If True, displays DPN 100 shelf 0 at 
the bottom of the display. If False, 
displays DPN 100 shelf 0 at the top 
of the display.

True or False

ND*confirmExit If True (default), Network Viewer 
prompts with a confirmation dialog 
when Exit is selected. If False, 
Network Viewer directly exits.

True or False

*fontList If a fontList resource is added to 
Network Viewer’s resource file, or 
your.Xdefaults file (NV.*fontList) and 
the default font is set to “Default” in 
MSM’s font menu, the specified font 
is used by Network Viewer (usually 
not specified).

Available font name

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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*multiClickTime This resource specifies the 
maximum time (in milliseconds) 
between two consecutive mouse 
clicks to recognize a double click.

Time in milliseconds

ND*orgDblClickAction
ND*orgShiftDblClickAction
ND*orgMetaDblClickAction
.
.
.

These resources control what 
happens when you double-click on a 
node, a link, or a subcomponent in 
the Network Viewer tool while the 
Shift key is pressed, the Control key 
is pressed, the Meta key is pressed, 
or no key is pressed.

See the description in 
resource file Network 
Viewer.

ND*showIconBar If True, the command icon bar is 
displayed in the main Network 
Viewer window. If False, the 
command icon bar is not displayed. 
This setting is now controlled by the 
Preferences Dialog. 

True or False

ND*allowViewPositions This resource indicates if Network 
Viewer displays the toggle button in 
the Save and Restore view dialogs, 
allowing you to save/restore the 
modified node/bendpoint positions 
to/from the view.

True or False

ND*preferViewPositions This resource indicates if view 
positions are preferred. This results 
in the default value of the toggle 
button in the Save and Restore view 
dialogs. It also determines if 
positions should be restored when 
the default view is restored at 
startup and when a view is opened 
through the icon bar.

True or False

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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Customizing color and display attributes
Your Preside Multiservice Data Manager (MDM) system administrator can 
customize the following display attributes for you. See the section on 
customizing the toolsets and start tools menus in 241-6001-301 Preside MDM 
Customization Administrator Guide.

• color

— state color mappings for nodes and links

— background color when no maps are used

— rubber band and label colors

• double-clicking actions

• initial size of Network Viewer display window

• view space dimensions (when no background maps are used)

• initial organization or named view

• initial component label display state

• double-click speed

ND*gridOn This resource indicates if the 
Positioning Grid is enabled by 
default. This setting is now 
controlled by the Preferences 
Dialog. 

False

ND*gridWidth This resource indicates the width of 
the Positioning Grid cells. This 
setting is now controlled by the 
Preferences Dialog. 

80

ND*gridHeight This resource indicates the height of 
the Positioning Grid cells. This 
setting is now controlled by the 
Preferences Dialog.

50

Table 4 (Continued)
Resources that you can customize in the Network Viewer

Resource Description Legal values
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• backbone definition and custom override definition for component 
filtering

Troubleshooting
While Network Viewer is running, the network model may be edited either 
manually through the NetworkViewer in edit mode, or automatically. 
Network Viewer is informed of network model changes of the types listed in 
the table “Network model actions and results” (page 99) and updates its 
display.

Table 5 
Network model actions and results

Network model 
action

Network Viewer result

Link Deleted If the link is currently displayed, it is removed from the 
display.

Node Deleted If the node is currently displayed, it and any attached 
links are removed from the display. 

If a Subcomponent or Shelf dialog is currently up for this 
node, they are removed.

Subcomponent 
Deleted

If the subcomponent is currently displayed in a shelf 
dialog, its state is set to INVALID. If the subcomponent 
is currently displayed in its parent node’s 
subcomponent dialog, the component is removed from 
the dialog’s component list.

Link Created If both endpoints of the link are currently displayed, the 
link is added to the display. The link is drawn with any 
bendpoints that are defined for the link. (If either of the 
link’s endpoints are not defined in Network Viewer, the 
link is ignored.)

Node Created If the parent of the new node is currently expanded on 
the display, the node is added to the display. 

If coordinates are defined, the node appears in the 
defined position; otherwise, it appears in the top left-
hand corner of the Network Viewer display. If created 
manually, it appears with a grid cyclic policy.
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Subcomponent 
Created

If the subcomponent has a shelf location and the shelf 
is currently displayed, the state display of the 
subcomponent changes from INVALID to the 
subcomponent’s reported state. If the parent node’s 
subcomponent dialog is currently displayed, the 
subcomponent is added to the dialog’s component list.

Node Reassigned If the node is currently displayed and the new parent is 
not currently expanded, the node is removed from the 
display. If the node is not currently displayed and the 
new parent is currently expanded, the node is 
displayed.

Model Locked Network Viewer displays a lock icon indicating that no 
surveillance information is available until further notice.

Model Unlocked If no submessage indicates the change that was made 
to the model while it was locked, Network Viewer 
removes the lock icon, indicating that surveillance 
information is now available.

New Model
A new model is loaded into shared memory. 
Network Viewer displays a dialog indicating this, 
explaining that the Network Viewer display needs to be 
re-initialized from the network model. You may either 
confirm the reinitialization (Load new model) or 
terminate Network Viewer (Exit Application). If you 
confirm, Network Viewer clears the display and 
reinitializes its internal model. After initialization is 
complete, it displays the top level organization nodes of 
the new model.

Model in Editing 
mode

Either this Network Viewer or another Network Viewer is 
used to edit the model. A caution icon is displayed at the 
right of the status label.

Table 5 
Network model actions and results

Network model 
action

Network Viewer result
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If the connection to the network model is lost or the network model becomes 
inconsistent, a dialog is displayed to indicate this problem. It allows you to 
exit the Network Viewer application since the network model is crucial to its 
operation. Restarting the Network Viewer usually solves the problem; 
otherwise, contact your Preside Multiservice Data Manager (MDM) system 
administrator.

Network Viewer interface
Network Viewer is a network component state surveillance tool that displays 
the network topology in a graphical format. Network Viewer is used for the 
detection of faults in a DPN/Passport/MPE 9500 network. 

Node or bendpoint 
position changes

If a node or bendpoint position is changed by another 
Network Viewer in edit mode, the new positions are 
received, but are displayed only if the Set Shared Model 
Positions for All Nodes and Links, or the Set Shared 
Model Positions for Selected Nodes and Links 
command is invoked from the View menu.

CDF (Component 
Data File) loaded in 
the model

You can make these changes. Effects on the model are 
indicated in the changes described in this section.

PI or card type is 
changed

If the shelf dialog is up, the shelf is redisplayed to match 
the new information.

Module or shelf 
type changes

The node is destroyed and reconstructed to match the 
new type. If the shelf or subcomponent dialogs are up, 
they are brought down and need to be re-invoked 
manually.

Table 5 
Network model actions and results

Network model 
action

Network Viewer result
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Table 6
Network Viewer features

Feature Description

Graphical view View the network down to the port level.

View different organizational levels of the 
network at the same time. 

Display a defined map in the background 

Textual view Textually display all subcomponents.

Component state Indicated by the color of the component icon 
or link line. Color is also used in the textual 
view.

Put components into maintenance or 
acknowledged modes.

Look and feel Customize your view of the network.

Display subcomponents by a shelf icon or 
textual list.

Temporarily position nodes and links on the 
screen.

Zoom in and view different areas of the 
network.

Navigation Use the Component Finder.

Move through the levels of the organization 
using organization or background navigation.
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Network Viewer collects information about the network from the MDM 
Network Model Server (nmserver), to build a color graphics representation of 
the active network model. State changes are received asynchronously from 
the nmserver and are displayed in the Network Viewer. State changes are 
indicated by network component color changes. See “About component states 
and colors” (page 105) for more information about state representation. 

Users can interact with the network diagram using the various menus and 
dialogs built into the Network Viewer tool. 

 Network Viewer supports the following modes of operation:

• surveillance - to monitor network element states and navigate the node

• edit - to edit and organize the network node itself

Network models are organized such that nodes are collected into 
organizational groups called sites. Sites, in turn, are grouped into regions. 
Sites and regions are represented in the network model by logical (rather than 
physical) nodes. These organizational nodes allow a group of nodes to be 
monitored for a fault by monitoring just one organizational node rather than 
a multitude of physical nodes. When a fault is reported for an organizational 
node (for example, a region), the user can then navigate the network model 
organization to reach the actual component that is experiencing the fault. For 
more information on network models, see 241-6001-015 Preside MDM 
Network Model Administrator Guide. 

Access Directly access the Component Information 
Viewer.

Access your tools and macros.

Edit the network Edit and organize the network through the 
Network Viewer editor.

Table 6 (Continued)
Network Viewer features

Feature Description
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Note: This method of fault monitoring is not mandatory. If you prefer, 
and your network model is manageable in terms of the overall number of 
components, you can immediately expand the entire network so that all 
physical nodes are being directly monitored. 

For more information on the Network Viewer, see 241-6001-011 Preside 
MDM Fault Management User Guide. 

Navigating the network model 
Navigating the network model can be done by using the following:

• expansion and compression operations

• textual display of regions and sites

• NV Finder

• component filtering

Expansion and compression
The Network Viewer navigates the network model component hierarchy by 
expansion and compression. Expansion replaces the organizational node with 
the contents of that node one level down the model hierarchy. Compression is 
the reverse operation of expansion; the contents of the organizational node are 
replaced by the organizational node itself.

Using the expansion and compression operations, you can navigate the model 
by the following methods: 

• in-place

• exclusive

• in a new window

Regions and sites can be expanded and compressed without changing the 
background on which the diagram is drawn. Since the background map is not 
changed during these operations, expand and compress are referred to as 
being performed in-place. 

Exclusive expansion displays only those nodes and links contained in the 
expanded organizational node, hiding all other nodes. 
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Expanding in a new window provides an exclusive expansion in a new 
subwindow. 

Textual display of regions and sites
Regions and sites can be opened as a textual dialog, showing the name and 
state of its child nodes and links. Module nodes themselves can be opened to 
show their subcomponents (name and states) textually. Some module types 
also support a graphic shelf display of their subcomponents.

NV Finder
The Network Viewer provides a component finder that changes the network 
display area of the current window so that it immediately displays the desired. 
For more information on the Finder, from the View menu, select Find. A NV 
Finder dialogue is displayed. Click the Help button in this dialog. 

Component filtering
 Network Viewer supports component filtering in order to route the number 
of nodes and links being displayed at once to those matching a number of 
filtering options including state and various types of overrides. This filtering 
can also be applied to textual dialog of regions and site nodes.

About component states and colors
A component in the network model is assigned a raw state value that describes 
its current operating condition. Components can be in one of the following 
raw states: 

• in-service (INSV) which indicates the component is fully functional

• in-service—troubled (INST) which indicates the component is operating 
in a degraded or impaired manner

• out-of-service (OOS) which indicates the component is not operational

• unknown (UNK) which indicates the component is in-service but is not 
known to the MDM
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In addition to pure state information, network model components are assigned 
a value ranging from 1 to 5. These numeric values reflect the criticality of the 
component to the overall network. To make state information readily 
discernible, the Network Viewer also assigns a range of colors to the troubled 
and out-of-service states. 

The mapping of state and criticality to colors is shown in the NV Legend 
dialog. To open this dialog, from the Options menu, select Legend. When a 
node, link, or subcomponent is selected in Network Viewer, its corresponding 
state-color mapping is highlighted in the NV Legend dialog. 

 Network Viewer main window
The Network Viewer main window is composed of three areas:

Item Description

Menu bar Contains many commands for interacting with 
the Network Viewer. These commands are 
described in the Menu Bar Commands heading. 
Menu bars can be hidden or displayed using the 
corresponding command in the Options menu. 
When a menu bar is hidden, the Options menu 
can be accessed using the background Network 
Viewer popup menu.

Icon bar Contains a selection of push-buttons that start 
the most common Network Viewer commands 
and external tools. To start a tool or action item, 
select the target nodes or links and then select 
the appropriate push-button in the icon bar. 
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Menu Bar Commands
The menu bar organizes commands into the following groups:

There are in fact two icon bars, one for 
surveillance mode and another for edit mode. 
The default surveillance-mode icon bar offers 
internal actions like Expand, Compress, Open 
Shelf and Open Subcomponent. The edit-mode 
icon bar adds access to the most common model 
editing commands. The icon bar can be hidden 
or displayed using the corresponding command 
in the Options menu. When the icon bar is 
hidden, the non internal items it contains may be 
invoked through the Start Tool menu.

By default, the Start Tool menu and the icon bar 
contain the same list of tools

Note that the contents of the icon bar can be 
customized similar to the various tool menus 
available for nodes, links, and subcomponents.

Network display Provides a graphical representation of the 
network that consists of nodes and trunks. Nodes 
are represented by icons; trunks are represented 
by lines between nodes. The entire network 
diagram may, or may not, be visible in the display 
area. What appears in the display area depends 
on the dimensions of the current network 
diagram as defined in the network model, the 
amount of zooming that has already been 
performed, and the size of the Network Viewer 
window. If needed, you can scroll the image in 
the display area. 

Item Description
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Additional information for the File, Edit, View, and Options menus is 
available from the Help menu.

Network Viewer popup menu
If you hide the display of the menu bar, you can continue to access menu bar 
commands by using the background Network Viewer popup menu. This 
popup menu contains the same commands as those available from the Menu 
bar. To access the Network Viewer popup menu, move the pointer onto the 
background of any network display area and press the mouse Menu button.

 Network Viewer File Menu

The File menu contains commands that perform actions on files as well as 
actions on the application as a whole. The Network Viewer File contains the 
following commands:

File menu Provides commands related to files and a means 
to exit the Network Viewer tool. 

Edit menu Provides selection and de-selection commands.

View menu Provides a means to control which nodes are 
shown in the network display area. Network model 
navigation and background zooming can also be 
performed with these commands. 

Options menu Allows you to control the display of menu bars, 
icons bars, node labels, background maps, and 
legends. It also enables you to set preferences 
and filters. 

Network model editing 
menu

Allows you to enter the edit mode and access the 
various editing commands or exit edit mode.

Start tool menu Allows you to launch other selected tools from 
within Network Viewer. 

Help menu Displays online help about the Network Viewer. 
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Save View Stores a description of the current Network Viewer 
view in its file if a current view is known. 
Otherwise, it is equivalent to the Save View as… 
command.

Save View as… Opens a Save View dialog that allows you to 
specify a file to store the current Network Viewer 
view description. This view description contains 
information that includes the current map node, 
displayed map, current view and zoom on the 
map, current positioning grid parameters, visible 
nodes that show their labels, nodes that are 
expanded in place, and nodes that are expanded 
in subwindows. Views may optionally store 
positions for nodes that have been moved. Note 
that the current component filtering state (on or 
off) is not saved in the view description. 
Optionally, the current filter setting may be saved 
with the view. If allowed by customized resources, 
the node positions are also saved.

Restore View… Opens a Restore View dialog that allows you to 
specify a file from which a Network Viewer view 
description will be restored and made current. If 
allowed by customized resources, node positions 
are also restored. If you have subwindows open 
as a result of the Expand in New Window 
command and if customized resources permit, a 
dialog prompting for confirmation opens to 
prevent accidental closures.

Reload Model… Enables you to force reload the network model 
into the Viewer. This may be needed if you have 
chosen to ignore network increment notifications 
and you now want to synchronize the Viewer with 
the model. 
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 Network Viewer Edit Menu
The Edit menu contains commands for performing actions on the current data 
of the application. This includes selecting and deselecting all the visible 
nodes and trunks, as well as placing selected nodes and trunks into context. 
The Network Viewer Edit menu contains the following commands:

 Network Viewer View Menu
The View menu contains commands that change the view of the application 
data. In the Network Viewer, this includes commands for navigating the 
network model, zooming on the background, opening the Finder, and 
controlling the component filtering state. Also refer to the Save View… and 
Restore View… commands of the File menu. The Network Viewer View menu 
contains the following commands:

Compress parent node 
which closes this window 
and its subwindows

This command replaces Exit in subwindows 
created by the Expand in New Window command 
and closes the current subwindow. If the 
subwindow is a region containing sites that have 
also been expanded in new windows, those site 
windows are also closed. All other windows 
remain open.

Exit Causes the Network Viewer to exit. All windows 
associated with the Network Viewer tool are 
removed from the workstation screen. A dialog 
appears prompting you for confirmation and, if 
applicable, to save any modified component filter 
settings. 

Select all Nodes and 
Links

Selects all of the displayed nodes and trunks. 

Deselect all Nodes and Links Deselects all of the displayed nodes and 
trunks. 

Put Selected Nodes and 
Links in Context

Places the currently selected nodes and 
trunks into context. 
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Find… Opens the NV Finder dialog. The finder operates 
across all display windows. The window 
containing the found node is brought to the front.

Set Filtering on Enables component filtering. Filter settings apply 
across all display windows. The network is 
redisplayed with only the components (nodes and 
links) that pass the current active filter settings. To 
change filter settings, from the Options menu, 
select Change Filter Settings…. This setting is 
also controlled and saved along with the Network 
Viewer preferences through the Preferences 
dialog. Set Filtering on is available only when 
filtering is already off.

Set Filtering off Disables component filtering and reverts the 
display to show all visible nodes and links. Filter 
settings apply across all display windows. This 
setting is also controlled and saved along with the 
Network Viewer preferences through the 
Preferences dialog. Set Filtering off is available 
only when filtering is already on. 

Show Excluded 
Organizational Nodes

Displays the excluded organizational nodes for 
the current organization (EXCL_REGION and 
EXCL_SITE). By default, these nodes are hidden. 
This filter effect normally applies to just the main 
window. However, if EXCL_REGION and 
EXCL_SITE are shown and are expanded in one 
or more new windows, hiding the excluded nodes 
closes those windows. It is also controlled and 
saved along with the Network Viewer preferences 
through the Preferences dialog. Show Excluded 
Organizational Nodes is available only when 
excluded nodes are already hidden.

Hide Excluded 
Organizational Nodes

Hides the excluded organizational nodes for the 
current organization (EXCL_REGION, 
EXCL_SITE). It is also controlled and saved along 
with the Network Viewer preferences through the 
Preferences dialog. Hide Excluded Organizational 
Nodes is available only when excluded nodes are 
already shown.
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Open Selected 
Organization

Shows the first level organizational nodes of the 
selected network model organization. This 
command is available only when viewing the 
organizations of the network model. If no 
organizational nodes are selected, this command 
does nothing. If more than one organizational 
node is selected, this command operates on the 
first node in the select list. You can also open an 
organization from the Node popup menu by 
selecting Open Organization, or you can double-
click on the organizational icon.

Expand Selected Nodes in 
Place

Expands the selected nodes to show their child 
nodes. The background is not changed and the 
only nodes removed from the display are the 
nodes that were expanded. You can also expand 
organizational nodes from the Node popup menu 
by selecting Expand in Place, or you can double-
click on the organization icon. 

Full Expand Selected 
Nodes in Place

Works much like the Expand Selected Nodes in 
Place command except that if there is more than 
one organizational levels of nodes below the 
nodes that are to be expanded, they are also 
expanded. This command provides quick access 
to physical level nodes. You can also fully expand 
organizational nodes from the Node popup menu 
by selecting Full Expand in Place, or you can 
double-click organizational node icons while 
holding the Shift key. 

Expand Selected Nodes 
Exclusively

Expands selected nodes to the next lower level 
and removes all other nodes from the display. 
Unexpanded nodes remain hidden until all lower 
level nodes are compressed. 

Full Expand Selected 
Nodes Exclusively

Expands selected nodes to their lowest level and 
removes all other nodes from the display. 
Unexpanded nodes remain hidden until all lower 
level are compressed. 
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Expand Selected Nodes in 
New Window

Expands a selected organizational node to its next 
lower level in a new window (that is, a subwindow 
of the main Network Viewer window). 

Full Expand Selected 
Nodes in New Window

Expands a selected organizational node to its 
lowest level in a new window (that is, a subwindow 
of the main Network Viewer window).

Compress Selected Nodes 
in Place

Is the complement operation of Expand Selected 
Nodes in Place. This command replaces selected 
nodes and their sibling nodes with the parent or 
organizational node. If the compressed nodes are 
the last visible nodes of a given level (i.e. modules 
or sites), all hidden nodes of the next level up are 
made visible. You can also compress selected 
nodes from the Node popup menu by selecting 
Compress Node in Place, or you can double-click 
organizational icons while holding down the 
Control key. 

Select a New Organization 
to View

Causes the network model organizations to be 
displayed so that one can be selected for viewing. 
A confirmation dialog is displayed if one or more 
subwindows have been opened using Expand in 
New Window. If this operation is confirmed, all 
subwindows are closed.

Snap to Grid Causes the Network Viewer to position nodes and 
bendpoints to the nearest intersection of an 
invisible grid when the node or bendpoint is 
moved, therefore achieving a neat layout. This 
setting applies across all display windows. It is 
also controlled and saved along with the Network 
Viewer preferences through the Preferences 
dialog. Snap to Grid is available only when the 
grid is already disabled.
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Do not Snap to Grid Prevents the Network Viewer from calling nodes 
and bendpoints to the invisible grid when they are 
moved. This setting applies across all display 
windows. It is also controlled and saved along with 
the Network Viewer preferences through the 
Preferences dialog. Do not Snap to Grid is 
available only when the grid is already enabled.

Set Shared Model 
Positions for All Nodes and 
Links

Causes all node positions and link bendpoints to 
change back to their network model values (which 
may have changed). This operation applies 
across all windows.

Set Shared Model 
Positions for Selected 
Nodes and Links

Causes selected node positions and link 
bendpoints to change back to their network model 
values (which may have changed). This operation 
applies to the current window only.

Align and Distribute 
Selected Nodes

Aligns all selected nodes with the top left node 
and spaces them according to the Node Spread 
value in the NV Preferences dialog.

Zoom Allows the user to fit a view to a window or to 
change the magnification of the current network 
view. 

When you select the Zoom command, a submenu 
opens containing the Fit to Window command, the 
No Zoom command, and various magnification 
values. The Fit to Window command scales the 
Network Viewer display so that the entire network 
graph is visible in the current window size. The No 
Zoom command removes any existing 
magnification from the current window. When you 
select a magnification value, the center of the 
newly magnified display remains the same as that 
of the previous display
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 Network Viewer Options Menu
The Options menu contains commands that allow you to customize the 
application. In the Network Viewer, commands are provided to control the 
display of menu bars, icon bars, node labels, background maps and legends; 
to set preferences and filters. The Network Viewer Options menu contains the 
following commands:

Show Menu Bar Displays the menu bar, if already hidden. You can 
access this command from the background 
Network Viewer popup menu by selecting Options 
--> Show Menu Bar.

Hide Menu Bar Hides the display of the menu bar in the current 
window. To restore the display of the number, 
from the Network Viewer popup menu, select 
Options --> Show Menu Bar.

Show Icon Bar Displays the icon bar visible in the current window. 
This setting is also controlled and saved along 
with the Network Viewer preferences through the 
Preferences dialog. Show Icon Bar is available 
only when the icon bar is already hidden.

Hide Icon Bar Hides the display of the icon bar in the current 
window. This setting is also controlled and saved 
along with the Network Viewer preferences 
through the Preferences dialog. Hide Icon Bar is 
available only when the icon bar is already visible.

Show all Menu Bars Displays the menu bars in all windows, if already 
hidden. You can access this command from the 
background Network Viewer popup menu by 
selecting Options --> Show all Menu Bars.

Hide all Menu Bars Hides the display of menu bars in all windows. To 
restore the display of menu bars, from the 
Network Viewer popup menu, select Options --> 
Show all Menu Bars. This setting is available only 
when subwindows have been opened as a result 
of Expand in New Window.
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Show all Icon Bars Displays icon bars in all windows. This setting is 
available only when subwindows are open as a 
result of Expand in New Window and icon bars are 
already hidden.

Hide all Icon Bars Hides the display of icon bars in all windows. To 
restore the display of icon bars, from the 
background Network Viewer popup menu, select 
Options --> Show all Icon Bars. This setting is 
available only when subwindows are open as a 
result of Expand in New Window and icon bars are 
already shown.

Show all Node Labels Displays the node ID immediately below all nodes 
that are showing the polygon icon in the current 
window. This setting is also controlled and saved 
along with the Network Viewer preferences 
through the Preferences dialog. Show all Node 
Labels is available only when nodes already hide 
their labels. 

Hide all Node Labels Hides the display of node IDs. This setting is also 
controlled and saved along with the Network 
Viewer preferences through the Preferences 
dialog. Hide all Node Labels is available only 
when nodes already show their labels.

Show Map Displays the graphic details of the current 
background map in the window. This setting is 
also controlled and saved along with the NV 
preferences through the Preferences dialog. 
Show Map is available only when the background 
map is already hidden. 

Hide Map Hides the display of the current background map. 
It is also controlled and saved along with the NV 
preferences through the Preferences dialog. Hide 
Map is available only when background map is 
already displayed. 
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Network Model Edit Menu
The Editing menu provides commands that let you edit the network model. 
The Network Viewer has two modes of operation: surveillance mode and edit 
mode. Use the commands in the Network Model Edit menu to open and close 
an edit session and to make modifications to the network model. The Network 
Model Edit menu contains the following commands:

Show all Maps Displays maps in all windows. This setting is 
available only when subwindows are open as a 
result of Expand in New Window and maps are 
already hidden.

Hide all Maps Hides the display of all maps. This setting is 
available only when subwindows are open as a 
result of Expand in New Window and maps are 
currently displayed.

Change Preferences… Opens the NV Preferences dialog. Preferences 
apply across all windows.

Change Filter Settings… Opens the NV Filter Settings dialog. Filter settings 
apply across all windows.

Legend… Opens the NV Legend dialog. 

Enable Network Model 
Editing…

Opens a network model editing session. (This 
command is available only if Network Viewer is in 
surveillance mode.) If a password is specified to 
the targeted Network Model Editing Server, a 
dialog appears asking you to provide it. If another 
administrator is already editing the model or if an 
error occurs, an error dialog is displayed. If nodes 
were moved since the Network Viewer was 
started, a dialog appears asking if the Model 
should be synchronized to the Network Viewer 
positions or vice versa.

Leave Network Model 
Editing…

Allows you to return from editing mode into the 
surveillance mode. A dialog appears offering to 
save the model before leaving the editing mode.
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Create New Network 
Model…

Opens the Create New Model confirmation dialog. 
If confirmed, the current model is cleared out and 
an “empty” one is created.

Load/Change Network 
Model File…

Opens the Network Model File Manager dialog, 
which allows you to load, delete, or rename 
network model files. This command is available 
from the Icon Bar.

Apply/Change Network 
Model Collections…

Opens the Collection Manager dialog, which 
enables you to control the collection and 
application activities as well as remove or delete 
them. This command is available from the Icon 
Bar.

Save Network Model… Opens the Network Model File Save dialog, 
allowing you to save the current model to file and 
possibly commit it. This command is available 
from the Icon Bar.

Show Warnings… Opens the Warning Messages dialog to display 
warning messages from the model loading, if any.

Create Organizations… Opens the Create Organization dialog, which 
enables you to create a new organization 
structure. This command is available only when 
the Network Viewer’s main window is currently 
displaying the Organization Structure root nodes.

Delete Selected 
Organizations…

Opens the Component Delete dialog, which 
enables you to delete the selected organization 
structures if confirmed. This command is available 
only when the Network Viewer’s main window is 
currently displaying the Organization Structure 
root nodes.

Create/Edit Node… Opens the Create/Edit Component dialog, which 
enables you to create or edit a node or 
subcomponent. If a single node is currently 
selected, the dialog will already contain its 
description. This command is also available from 
the Icon Bar.
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Create/Edit Link… Opens the Create/Edit Link dialog, which enables 
you to create or edit a link. If a single link is 
currently selected, the dialog will already contain 
its description. This command is also available 
from the Icon Bar.

Delete Selected 
Components…

Opens the Component Delete dialog, which 
enables you to delete all selected components in 
the Network Viewer’s main window if confirmed.

Collect Data for Module 
Group…

Opens the Data Collection dialog, which enables 
you to collect configuration data on a node or 
group of nodes (OA, Passport Group, or Passport 
4400, MPE 9500 Group).

Save Components... Opens the Components Save dialog. This dialog 
lets you save any or all components from the 
model being edited to a collection data file (CDF). 
Optionally, you can save related links and 
organizations in the CDF.

Set Organization Map… Opens the Set Map dialog, which enables you to 
indicate the background pixmap file (XPM3 
format) to associate with the current 
organizational structure.

Detach Organization Map Detaches the current organization structure 
background map.

Select new Modules Automatically expands in place the 
NEW_REGION and NEW_SITE organization 
node and selects all the contained nodes. This is 
useful to organize new nodes.

Deselect New Modules Deselects all selected new modules (modules 
part of the NEW_SITE organizational node).
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Network Viewer Node
 Network Viewer nodes reflect the type and state of network model nodes, 
both organizational and physical, using graphical icons. DPN and Passport 
nodes also support another icon called “shelf” (note that the shelf icon is only 
available as a dialog; shelf icons are too large and detailed to be opened in the 
network display area of the Network Viewer). 

When they are selected, the nodes’ component IDs are put in Context. Nodes 
also support a drag operation to transfer their component IDs to other tools 
and dialogs.

Select the nodes you want to move, then drag them while holding the shift 
key. When you move nodes, they snap to a grid if the grid is enabled. If you 
select and move a group, then the whole group snaps to grid if the grid is 
enabled.

Node editing
For node editing, use the following commands:

Show New Modules… Opens the Component List dialog with the names 
of all the nodes part of the DEFAULT_SITE 
organizational node.

Show Excluded 
Modules…

Opens the Component List dialog with the names 
of all the nodes which are part of the EXCL_SITE 
organizational node and therefore not usually 
visible in the display.

Edit This submenu contains commands that are 
available only in Model Editing mode. 
These commands are:

Change…
Opens the Create/Edit Component dialog, which 
enables you to edit the node. The dialog is 
prefilled with the node’s description.
241-6001-011   15.1RSUP   



Chapter 2 Network Viewer in the MDM Toolset   121
Delete…
Opens the Delete Components dialog, which 
enables you to delete the node if confirmed.

Collect Data…
Opens the Data Collection dialog, which enables 
you to start a configuration data collection for the 
node.

Add Subcomponent…
Opens the Create/Edit Component dialog, which 
enables you to add subcomponents to the node.

Add Links…
Opens the Create/Edit Link dialog, which enables 
you to add links to the node.

Show Related Links…
Opens a Component List dialog containing the 
names of all links terminating on the node or its 
subcomponents.

Show Shelf… For DPN devices, opens a separate dialog 
containing the node’s shelf icon; for Passport 
multiservice devices, opens the Passport 
Surveillance Shelf View tool. 
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Show Subcomponents… Opens a dialog window containing a list of all the 
node’s subcomponents. When this command is 
selected, there may be a short delay while the 
subcomponent information is retrieved from the 
network model. If the node does not support 
subcomponents, this command is not available for 
that node. If the subcomponent dialog is already 
open, selecting this command a second time 
raises the subcomponent dialog window. If the 
subcomponent dialog is being invoked for the first 
time, then it is opened in All Subcomponents 
mode by default. Alternatively, the subcomponent 
dialog may be invoked by double-clicking the 
node icon. In this case, the dialog will be opened 
in Troubled Subcomponent mode. In all cases, 
only the components with criticality equal or 
greater to the Criticality Cutoff Preference value 
(see Set Preferences in the Options menu) are 
fetched and initially displayed.

Show Children Available in region and site nodes, this command 
opens a textual dialog similar to that of Show 
Subcomponents, but showing the nodes and links 
contained in the region or site. This command 
invokes the Components Dialog for the current 
node to show in a textual fashion all its children 
nodes and links. This command is available only if 
the current node is an Organizational Node.

Open Organization Clears the current network display area and 
displays the first level of organizational nodes in 
the network model organization represented by 
the node. This command is available only for 
organizations of network models. It is disabled for 
all other node types. Alternatively, an organization 
may be opened by double-clicking its icon. 

Expand in Place Replaces the node for which the menu was 
popped up with its subordinate nodes. The 
background is not changed. If the node does not 
have any subordinate nodes the command is not 
available. Alternatively, an organizational node 
may be expanded by double-clicking its icon. 
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Full Expand in Place Operates exactly like the previous “Expand in 
Place” command except that it ensures expansion 
continues to the lowest level (i.e., physical) of the 
network model. Alternatively, an organizational 
node may be full expanded by double-click its icon 
while holding the SHIFT key. 

Expand Exclusively Replaces the node for which the menu was 
popped up just like “Expand in Place” but only the 
expanded nodes will be left visible on screen. All 
unexpanded nodes are hidden until compressed. 

Full Expand Exclusively Acts just like “Full Expand in Place” except that 
only the expanded nodes are left visible on 
screen. All unexpanded nodes are hidden until 
compressed.

Expand in New Window Performs an exclusive expansion of an 
organizational node to the next lower level in a 
new window (that is, a subwindow of the Network 
Viewer main window).

Full Expand in New 
Window

Performs an exclusive expansion of an 
organizational node to the lowest level in a new 
window (that is, a subwindow of the Network 
Viewer main window).

Compress in Place This command is the complement operation of the 
Expand in Place command. It removes selected 
nodes and any organizational siblings from the 
display and replaces them with parent nodes. If 
the compressed node is the last visible node of a 
given level (i.e. modules or sites), all hidden 
nodes of the next up level (due to a previous 
Expand Exclusive) are made visible. Alternatively, 
you can compress a node by double clicking its 
icon while holding down the CONTROL key.

Show Label Display’s the node’s identifier below the icon. This 
command appears only if the node is not already 
showing its label. This command is available only 
when the node is showing its polygon icon.
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Hide Label Removes the node’s identifier from below the 
icon. This command appears only if the node is 
already showing its label. This command is 
available only when the node is showing its 
polygon icon.

Cluster Connected 
Nodes…

Repositions all (unpinned) nodes connected to 
this node so that they neatly surround it.

Cluster Child Nodes… Available only on organization nodes, this 
command expands the node and automatically 
repositions all its (unpinned) child nodes so they 
are neatly located around the position where the 
node was before it was expanded.

Pin Available only on unpinned nodes, this command 
pins the node in its current position. The cluster 
operations described above will not alter its 
current location. It is still possible to move the 
node with the Select mouse button.

Unpin Available only on pinned nodes, this command 
removes the relocation restriction so that further 
Cluster operations may affect its current position. 

Move to Previous Position Moves a node to the position it last occupied 
before it was moved. If the node has not been 
moved since Network Viewer was started, this 
command is not available. 

Move to Shared Model 
Position

Moves a node to the position it first occupied when 
the network model was initially loaded into the 
Network Viewer regardless of how many times the 
node has been moved since then. If the node has 
not been moved since Network Viewer was 
started, this command is not available. 
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 Network Viewer Node Subcomponent
Currently, all node subcomponents in Network Viewer support the same set 
of commands.

When a subcomponent is selected, its component ID is put in Context. 
Subcomponents all support a drag operation to transfer their component IDs 
onto other tools and dialogs. 

 Network Viewer Node Subcomponent supports the following commands: 

Set Acknowledged State 
on/off

Enables you to put a node into acknowledged 
state, temporarily masking its current state 
(contrary to “Set Maintenance State” describe 
below which masks it permanently, the 
acknowledgment is automatically removed when 
the state changes). Activating “Set Acknowledged 
State off” on the node which was target of the 
original acknowledge state, will re-instate the its 
current state. 

Set Maintenance State
on/off

Enables you to put a node into maintenance state, 
permanently masking its current state. Activating 
“Set Maintenance State off” on the node which 
was target of the original maintenance state, will 
re-instate the its current state.

Start Tool Allows you to access various tools that may be 
started for the node. 

You can customize the Start tool menu. For 
details, see 241-6001-301 Preside MDM 
Customization Administrator Guide.
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Edit Contains commands that are available only in 
Model Editing mode (NVEd). These commands 
are:

Change
Invokes the Create/Edit Component dialog, which 
enables you to edit the subcomponent. The dialog 
is prefilled with the subcomponent’s description.

Delete
Invokes NVEd’s Delete Components dialog, 
which enables you to delete the subcomponent if 
confirmed.

Add Subcomponent
Invokes the Create/Edit Component dialog, which 
enables you to add subcomponents to the 
subcomponent

Show Related Links
Invokes a Component List dialog containing the 
names of all links terminating on the 
subcomponent or its subcomponents.

Set Acknowledged 
State on/off

Enables you to put a subcomponent into 
acknowledged state, temporarily masking its 
current state (contrary to “Set Maintenance State” 
describe below which masks it permanently, the 
acknowledgment is automatically removed when 
the state changes). Activating “Set Acknowledged 
State off” on the subcomponent which was the 
target of the original acknowledged state, will re-
instate the subcomponent to its current state. 
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 Network Viewer Trunks/Links
 Network Viewer Trunks/Links reflect the state of network model links 
according to their color. DNL and DBNL links are also shown using a dashed 
line. All other link types are drawn with a solid line. 

When links are selected, their component ID is put in Context. Links support 
the drag operation to transfer their component IDs onto other tools and 
dialogs.

 Network Viewer Trunks/Links support the addition, deletion, and 
repositioning of bendpoints. 

Commands
 Network Viewer Trunks/Links supports the following commands: 

Set Maintenance 
State on/off

Enables you to put a subcomponent into 
maintenance state permanently masking its 
current state. Activating “Set Maintenance State 
off” on the subcomponent which was the target of 
the original maintenance state, will re-instate the 
its current state. 

Start Tool Allows you to access various tools that may be 
started for the subcomponent. 
You can customize the Start tool menu. For 
details, see 241-6001-301 Preside MDM 
Customization Administrator Guide.

Edit Contains commands that are available only in 
Model Editing mode (NVEd). These commands 
are:

Change 
Invokes the Create/Edit Link dialog, which 
enables you to edit the node. The dialog is 
prefilled with the link’s description.
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Delete 
Invokes NVEd’s Delete Components dialog, 
which enables you to delete the link if confirmed.

Spread Links Distributes all links evenly between this link’s 
endpoint nodes for better legibility. This is done by 
setting a bendpoint at the center of each link and 
spreading them on either side of the midline 
between the two nodes. The spread links’ existing 
endpoints, if any, are lost. This option is available 
only if there is more than one link between the 
two. This can also be done by double-clicking on 
the overlapping links.

Add a Bendpoint Adds a new bendpoint to the trunk for which the 
object menu was popped up. If the trunk already 
has one or more bendpoints, the new bendpoint 
divides the segment of the trunk for which the 
object menu was popped up. The user is required 
to position the bendpoint before the command 
completes. Bendpoints will be positions in 
accordance with the current grid settings.

Show Bendpoint Handles Places a small rectangle, called a “handle”, over 
each bendpoint in the trunk so that bendpoints 
can be moved or individually removed. This 
command is not shown if the bendpoint handles 
are already being shown. 

Hide Bendpoint Handles Removes the handles from each bendpoint in the 
trunk. This command is not shown if the bendpoint 
handles are not currently visible. 

Delete all Bendpoints Deletes all of the bendpoints from the current 
trunk. This command is not available if the trunk 
has no bendpoints. 
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 Network Viewer Bendpoint
Bendpoints allow multiple links between a pair of nodes to all be viewed 
simultaneously. When a pair of nodes has multiple links between them, each 
link is drawn on top of the other, so that only the topmost link is actually 
visible. By adding bendpoints to these links, they can all be monitored. 

Bendpoints can also be used to route a link through the network diagram 
rather than have it draw a straight line between its endpoint nodes. 

Bendpoints are displayed in one of two ways: 

• with handles—a small rectangle is drawn over top of the bendpoint so 
that users can interact with them. 

• without handles—the bendpoint only appears as a bend in the trunk 
providing a less cluttered display. 

You can move the handle around to move the bendpoint. It will snap to the 
grid if the grid is enabled. If the entire link is selected, its bendpoints will 
move along with other selected nodes during a group move.

Commands
The following commands are available to operate on bendpoints:

Set Shared Model 
Bendpoints

Available only if the bendpoints have changed, 
this command removes the current link 
bendpoints and replaces them by bendpoints 
positioned according to the shared model 
contents.

Start Tool Allows you to access various tools that may be 
started for the subcomponent. 
You can customize the Start tool menu. For 
details, see 241-6001-301 Preside MDM 
Customization Administrator Guide.
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 Network Viewer Legend
The NV Legend dialog provides an on-line reference for Network Viewer 
users to look up state-color mappings, node type icon shapes, and link line 
styles. 

It is a “passive” dialog in that there are no operations available in the dialog 
that can affect the operation of the Network Viewer tool. 

Dialog Layout
The NV Legend dialog is divided into four sections, as follows: 

State-Color Mappings
This table lists DPN-MDM Network Model states in the table rows and DPN-
MDM Network Model component criticality values in the table columns. 
Each entry in the table shows the color associated with a component of a given 
criticality when it is in any one of the valid states. When a node link or sub-
component is selected in Network Viewer, its corresponding state-color entry 
is highlighted in the Legend dialog 

This area of the dialog shows the icon for each type of node supported in 
MDM Network Models. Scroll bars are provided to enable viewing of all the 
nodes if there are more nodes than can fit in the scrolled window. 

Link Type Line Styles
This area of the dialog shows the line drawing style used for the various link 
types supported by the MDM Network Model. Scroll bars are provided to 
enable viewing of all the links if there are more links than can fit in the 
scrolled window. 

Hide all Bendpoint 
Handles

Removes all handles from all bendpoints in the 
link. 

Delete this Bendpoint Deletes the bendpoint from the trunk. The 
segments on either side of the bendpoint are 
merged into one. 
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Dialog Buttons
This area of the dialog provides a set of buttons which operate on the dialog. 
For details of these buttons, refer to the “Commands” section of this help 
panel. 

Commands
The NV Legend Dialog provides the following commands from the dialog 
buttons at the bottom of the dialog:

 Network Viewer Shelf Dialog
The NV Shelf Dialog provides an means of displaying a node’s shelf icon. 

Selecting a valid subcomponent with the Select mouse button, will put its 
name in the Context and highlight its state-color mapping in the Legend 
Dialog. The valid subcomponents of the shelf support the subcomponent 
menu.

The Shelf Dialog cannot be resized. 

Commands
The following commands are available for the NV Shelf Dialog:

 Network Viewer Component Dialog
The NV Component Dialog provides a display of a child’s nodes/links in a 
textual form. It will notably display all the node components known to the 
network model, not just those displayed by the Shelf Dialog. The Component 
Dialog supports two display modes: All Components, or Filtered 
Components only that can be changed using the option menu items of the 

Close Closes the NV Legend dialog. 

Help Displays online help. 

Close Closes the dialog. 

Help Displays online help. 
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same name in the dialog. In All Components mode, all the components are 
displayed. This is the default when invoking the dialog from the popup menu. 
In Filtered Components only mode, only the components that are accepted by 
the current filter settings of the main window. This is the default mode when 
the dialog is invoked from the icon bar. 

The name of the components and their current state are displayed in a 
scrollable list. The state itself is displayed both by name and by color. 
Selecting a component or its state will display a frame around the line, put 
its name in the Context, and highlight its state-color mapping in the Legend 
Dialog.

The components are displayed in alphanumerical order. Links and nodes in 
the list support the same popup menus as in the main window. The same 
double click actions are also supported.

Commands
The following commands are available for the NV Component Dialog:

NV Component List
The Excluded modules Dialog is a drop site for modules. The whole dialog 
acts as a drop site representing the excluded site node icon. Dropping modules 
on that dialog exclude them from the current organization.

The New module Dialog is a drop site for modules. The whole dialog acts as 
a drop site representing the new site node icon. Dropping modules on that 
dialog will make them new modules for the current organization.

Close Closes the dialog. 

Help Displays online help. 

All Components Puts the dialog in All Components mode. 

Filtered Components only Puts the dialog in Filtered Components only 
mode. 
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NV Subcomponent Dialog
The NV Subcomponent Dialog provides a display of a node’s subcomponents 
in a textual form. It will notably display all the node subcomponents known 
to the network model, not just those displayed by the Shelf Dialog. The 
Subcomponent Dialog supports two display modes: All Subcomponents, or 
Troubled Subcomponents that can be changed using the options menu items 
of the same name in the dialog. In All Subcomponents mode, all the 
subcomponents are displayed. This is the default when invoking the dialog 
from the popup menu. In Troubled Subcomponents mode, only the 
subcomponents that currently have a troubled raw state indicated by the 
network (through alarms, status, state change notifications) are displayed 
even if they currently are in maintenance or acknowledged state. This is the 
default mode when the dialog is invoked by double-clicking the node, or from 
the Icon Bar. 

When the dialog is initially invoked, only subcomponents with a criticality 
greater or equal to the Criticality Cutoff Preference value (see Set Preferences 
in the Options menu) are fetched from the model and displayed. If this value 
is set greater than 1 (the lowest possible value) a label is displayed at the top 
of the dialog indicating the cutoff. A command button, Load All, is also added 
to force load the missing components.

The name of the subcomponents and their current state are displayed in a 
scrollable list. The state itself is displayed both by name and by color. 
Selecting a subcomponent or its state will display a frame around the line, put 
its name in the Context, and highlight its state-color mapping in the Legend 
Dialog. 

In All Subcomponents mode, the subcomponents are displayed in 
alphanumerical order. In Troubled Subcomponent mode, they are also sorted 
by name but they are displayed so the component that are not in maintenance 
nor acknowledged state appear first, followed by the acknowledged 
subcomponents and finally the maintenance subcomponents. 

A menu is available from each subcomponent to invoke the applicable 
actions. 
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Commands
The following commands are available for the Network Viewer 
Subcomponent Dialog: 

NV Finder Dialog
This dialog provides a way for a user to locate a particular node in the 
network. The finder dialog displays a simple representation of the current 
navigator, with the entire map space visible. The visible view space within the 
navigator window, which may be the entire map space if no zooming actions 
have been performed, is represented as a smaller rectangle within the finder’s 
mini map of the network user space. Finally, when the user enters a node 
name which is to be searched for, a very small circle will appear in the finder’s 
mini map representing the node and its position in the main navigator 
window. 

The user may use the finder to move the node, or scroll the navigator view 
space in order to better see the desired node. Movement may be accomplished 
by clicking on the representation of the node (the little circle), holding the 
mouse button down, and dragging the cursor to the desired position. 
Releasing the mouse button completes the movement operation. Similarly, 
the navigator’s view space may be scrolled using the finder by clicking and 
dragging the rectangle within the finder’s map. Note that this last operation 
may only make sense if there has been some zoom operations in the navigator 
which create a view space smaller than the map itself. Otherwise, the user will 
not be able to see the small rectangle within the finder’s map, since it will fill 
the entire map itself. 

Load All Loads all components. This command is only 
available if the dialog was invoked with a Criticality 
Cutoff Preference greater than one.

Close Closes the dialog. 

Help Displays online help. 

All Subcomponents Puts the dialog in All Subcomponents mode. 

Troubled Subcomponents Puts the dialog in Troubled Subcomponents 
mode. 
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The Finder Dialog cannot be resized. 

Commands
Clicking on an entry in the “Level Selection List” will cause the “Component 
Selection List” to be updated. The list is updated with all nodes matching the 
organizational level which was clicked on. 

Clicking on an entry in the “Component Selection List” causes the text in the 
component ID field to be replaced with the text of the item which the user 
clicked on. Double clicking on an entry in the “Component Selection List” 
causes the component ID text to change and a “Find” operation to be done 
automatically. 

The following commands are available for the NV Finder Dialog: 

Find Performs a find using the node name specified in 
the component ID field (which the user may enter 
by hand, or automatically through lists or context). 
If the node is not in the navigator, then the node’s 
parent or grandparent will be searched for 
instead. Expanding the parent in the navigator, 
will then automatically cause the finder to indicate 
the position of the child node. If neither the node 
or any ancestor is displayed in the navigator, then 
a message saying “<node> <some error 
message>” will be displayed near the top of the 
finder dialog. (This may result from an incorrect 
name, the node not being part of the present 
organization, or an organizational node having 
been expanded on the map thus leaving only its 
children visible.) 

Get Context Takes the name of the node in context, and puts 
in the component ID field. A “find” command is 
automatically done to locate the node in context. 

Close Closes the finder dialog. 
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NV Filter Settings Dialog
The NV Filter Settings Dialog allows you to modify the parameters used by 
Network Viewer’s Component Filtering. The dialog determines the nodes and 
links settings to be displayed in the Network Viewer main window.

Note: The Component Filtering must be on before using filter settings. 
For information on setting the Component Filtering to on, see “Network 
Viewer View Menu” (page 110).

The NV Filter Settings Dialog consists of the following areas: 

• Node and Link States

• Special Overrides

At the top of the NV Filter Settings Dialog, there is a Node States area and a 
Link States area where you can select the Propagated States that a node or link 
must have to be displayed. For example, selecting node states of In-Service-
Troubled-3, 4, and 5 displays nodes having troubled components of at least 
criticality 3 (typically PEs).

At the middle of the NV Filter Settings Dialog, there is a But Ignore states to 
always area where you select filter settings to override the effect of the state 
filter.

The following overrides are available in the But ignore states to always area:

Move View Causes the view space to scroll so that the node 
comes within the visible display. This command is 
available if a node is presently being tracked. If 
the node is already well within the visible 
command, this command does nothing.

Move Node Causes the node to move its position 
automatically so that it comes within the present 
visible display. This command is available if a 
node is presently being tracked. If the node is 
already well within the visible display, this 
command does nothing. 

Help Invokes help for the NV Finder Dialog. 
241-6001-011   15.1RSUP   



Chapter 2 Network Viewer in the MDM Toolset   137
You can apply the filter settings to the main Network Viewer display or save 
the filter settings to a user specific file (${HOME}/MagellanNMS/
NVFilter.cfg) that can be used at a later time.

Commands & Controls
The NV Filter Settings Dialog provides the following controls, which take 
effect immediately:

Hide DPN-100/1s Hides all DPN-100/1 nodes whatever their state

Hide MASs Hides all MAS nodes whatever their state 

Hide cross-level links Hides all links crossing organizational levels (e.g. 
module-to-site, site-to-region, module-to-region) 
that are kept with In-Place Expansions whatever 
their state. 

NOTE: this filter has precedence over the other 
link type filters except for DNL/DBNLs. That is, if 
selected, cross-level links are always hidden even 
if they are backbone links or accepted by the 
Custom Filter but DNL/DBNLs are not affected 
and will be shown if the appropriate setting is 
selected). 

Show DNL and DBNLs Shows all DNL DBNL links whatever their state. 
Cross-level DNLs and DBNLs are always shown 
even if Hide cross-level links is selected.

This override does mot apply to BWODs. BWODS 
are filtered like NLs.

Show backbone 
components

Shows backbone components (RMs, Passports, 
TKs and PTKs) whatever their state (the 
backbone node and link types can be customized 
through resources). Cross-level backbone links 
will not be shown if Hide cross-level links is 
selected. 

Hide Passport trunks Hides Passport trunks, regardless of their states.

Hide ATM links Hides ATM links, regardless of their states.
Preside MDM Fault Management User Guide   15.1RSUP



138   Chapter 2 Network Viewer in the MDM Toolset
The NV Filter Settings Dialog provides the following commands:

Node States Provides a multi-select list (range selection 
discipline), which enables you to select the 
Propagated States a node must have to be 
displayed.

Link States Provides a multi-select list (range selection 
discipline), which enables you to select the 
Propagated States a link must have to be 
displayed. 

Hide DPN-100/1s Enables you to specify whether DPN-100/1 nodes 
should always be hidden regardless of their state. 

Hide MASs Enables you to specify whether MAS nodes 
should always be hidden regardless of their state. 

Hide cross-level links Enables you to specify whether cross-level links 
should always be hidden regardless of their state. 

Show DNL and DBNLs Enables you to specify whether DNL and DBNL 
links should always be shown regardless of their 
state.

Show backbone 
components

Enables you to specify whether backbone 
components should always be shown regardless 
of their state. By default, backbone components 
are RMs, Passports, TKs, and PTKs.

Hide Passport trunks Hides Passport trunks, regardless of their state.

Hide ATM links Hides ATM links, regardless of their state.
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NV Preferences Dialog
This dialog allows one to modify a number of display and behavioral settings 
for Network Viewer. These settings can be saved so they will be automatically 
restored and applied whenever Network Viewer is invoked. The Preference 
Settings come in three large categories: Node Display, Clustering and 
Positioning, and Miscellaneous. Some of the settings (e.g. Snap to Grid) are 
also available from other Network Viewer menus. 

The Node Display settings pertain to how nodes are represented in the main 
Network Viewer window (with or without label and with full or mnemonic 
label. The Clustering and Positioning settings provide control on various 
network display geometry parameters (network dimensions, snapping cell 
dimensions, clustering and spreading distances). Finally, the Miscellaneous 
parameters control other Network Viewer options (filtering state, Excluded 
Organizational node display, Icon Bar display and Background map display).

The controls for these options are grouped in three overlay panels whose 
visibility is controlled by a option menu,

Use Filters Applies the current filter settings to the main 
Network Viewer display and closes the dialog. 
You are prompted to save the modified settings 
when exiting Network Viewer. 

Save to File Saves the current filter settings to a user specific 
file (${HOME}/MagellanNMS/NVFilter.cfg). Save 
to File does not apply the current filter settings to 
the main Network Viewer display. 

Restore from File Restores the current filter settings from the user 
specific file (${HOME}/MagellanNMS/
NVFilter.cfg) to the dialog. Restore from File does 
not apply the restored filter settings to the main 
Network Viewer display.

Cancel Closes the dialog without applying the filter setting 
changes to the Network Viewer main display. 

Help Opens the help dialog on the Component Filter 
Settings dialog. 
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Commands & Controls
The following controls are provided by this dialog:

Node Display Options

Clustering and Positioning Options
Network Width (no map) … and HeightThese two entry fields let you control 
the dimensions of the network space (in pixels) for the main Network Viewer 
window. These are not the dimensions of the window but the dimensions of 
the network onto which the window is a viewport (i.e. the window may be 
smaller than the network in which case the scroll bars may be used to display 
the invisible sections, or larger in which case the network display is 
automatically zoomed). The network dimensions may not be set smaller than 
100 in either direction. These dimensions do not apply to when organizational 
structures that define a background map are being displayed (even if the map 
is hidden) as the maps provide their own dimensions

Options Menu button This Option Menu button controls which of the 
three controls panels is displayed. Its three 
possible values are; “Node Display Options”, 
“Clustering and positioning Options”, and 
“Miscellaneous Options”.

Show Node Labels This toggle controls whether nodes in the main NV 
window display their name label (on) or not (off). 
Individual nodes may override this setting through 
their popup menu. The Options pull-down menu 
also has a control for this option.

Show Mnemonic Labels 
Only

This toggle controls whether the name label 
displayed by the nodes in the main NV window 
(see Show Node Labels) contains both the node’s 
type and mnemonic (off) or the mnemonic only 
(on).
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Miscellaneous Options

Snap Nodes to Grid This toggle controls whether nodes (and 
bendpoints) are repositioned to the nearest grid 
corner when they are moved (on) or not (off). The 
View pull-down menu also contains a control for 
this option.

Cell Width… and Height These two entry fields let you control the 
dimensions of the Snap to Grid cells (in pixels).

Cluster Only Nodes in 
Same Site

This toggle controls whether, when Cluster 
Connected Nodes is invoked on a target node, all 
the connected nodes (off) or only those in the 
same parent organizational node (on) are re-
positioned.

Clustering Distance 
Between Modules

This entry field controls the distance in pixels left 
between clustered nodes (Cluster Connected 
Nodes or Cluster Child Nodes).

Clustering Distance 
between Orgs

This entry field controls the distance in pixels left 
between clustered organizational nodes (Cluster 
Connected Nodes and Cluster Child Nodes).

Link Spread Distance This entry field controls the distance left between 
the bendpoints of links spread with Spread Links.

Component Filtering On This toggle controls whether component filtering 
is activated (on) or not (off) in the main Network 
Viewer window. The View pull-down menu also 
contains a control for this option.

Hide Excluded 
Organizational Nodes

This toggle controls whether the Excluded Region 
and Site nodes are displayed (off) or not (on). The 
View pulldown menu also contains a control for 
this option.

Show Icon Bar This toggle controls whether the Icon Bar is visible 
(on) or not (off) in the main Network Viewer 
window. The Options pulldown menu also 
contains a control for this option.
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The following commands can be issued:

Hide Background Map This toggle controls whether the Background map 
is visible (off) or not (on) for organization structure 
that provide one.

Criticality Cutoff This Option Menu provides choices between 1 
and 5 for the current Criticality Cutoff. When 
opening a Subcomponent Dialog, only 
components with criticality greater of equal to the 
specified value are initial fetched. 1 is the lowest 
criticality and therefore calls for the display of all 
subcomponents.

Use Preferences Applies the current selections to the main Network 
Viewer display and pops down the dialog. The 
modified settings are not save to file and you will 
be prompted upon exiting Network Viewer to save 
them.

Save to File Saves the current selections to a user specific file 
(${HOME}/MagellanNMS/NVPrefs.cfg) so they 
can be re-activated in a subsequent Network 
Viewer session. Saved settings are not 
automatically applied to the main Network Viewer 
display, use Use Preferences to do so. 

Restore from File Restores the current settings from the user 
specific file (${HOME}/MagellanNMS/
NVPrefs.cfg) if any. Restored settings are not 
automatically applied to the main Network Viewer 
display, use Use Preferences to do so. 

Close Closes the dialog without applying the modified 
settings which are simply forgotten. 

Help Invokes help on the Preferences dialog. 
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Network Viewer Save View Dialog
This dialog is a File Selection Dialog to select the directory and file name onto 
which a description of the current view will be saved. The Directory list 
allows the selection of the destination directory simply by clicking. The File 
list does the same for the selection of existing file names. Alternatively, both 
the directory path of the file name may be entered or modified by typing in 
the Selection text. To save the view description to a new file in the default 
directory (shared by all Viewer users), just append the file name to the 
contents of the text entry item. If no view was already restored or saved by the 
Viewer, the default directory where view description files may be saved is /
opt/MagellanNMS/data/nvs/views. This directory is shared by all users of 
Network Viewer so a view description file saved there may be restored by 
other users. To save the view to a private directory, just select a new directory 
from the Directory list or type the full path name in the Selection text. To 
overwrite an existing view description file, just select its name from the File 
list. 

A toggle button is provided to indicate if the positions of nodes and 
bendpoints that were moved from their original location should be saved in 
the view.

Commands
Clicking on a name in the Directory list will selected the specified directory 
name. Selecting the “Change Directory” command then will update the File 
list to show the files contained in that directory and display the directory name 
in the Selection text. Clicking on a name in the File list will put the full path 
name of the specified file in the Selection text. Double-clicking on a list item 
(Directory or File) invokes the command of the current default button 
(“Change Directory” or “Save”). 

The following commands are available for the Save View Dialog:
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Network Viewer Restore View Dialog
This dialog is a File Selection Dialog to select the directory and name of a file 
containing an Network Viewer view description to be loaded and made 
current. The Directory list allows the selection of the destination directory 
simply by clicking. The File list does the same for the selection of file names. 
Alternatively, both the directory path of the file name may be entered or 
modified by typing in the Selection text. To restore a view description from 
the default directory (shared by all Viewer users), just select its name from the 
File list. If no view was already restored or saved by the Viewer, the default 
directory from where view description files may be restored is /opt/
MagellanNMS/data/nvs/views. This directory is shared by all users of 
Network Viewer so a view description file saved there may be restored by 
other users. To restore a view from a private directory, just select a new 
directory from the Directory list and file name from the File list or type the 
full path name in the Selection text. 

Save Node Positions If set, saves the changed node and bendpoint 
positions along with the rest of this View 
information.

Save Closes the dialog and selects the current contents 
of the Selection text as the name of the 
destination View description file. This command 
can also be invoked by double-clicking on a name 
in the File list. If the file already exists, you will be 
prompted to confirm the overwrite. 

Change Directory Displays the currently selected directory name in 
the Selection text and displays the files it contains 
in the File list. This command can also be invoked 
by double-clicking on a name in the Directory list. 

Cancel Closes the dialog without any file name selection 
and aborts the Save View operation. 

Help Displays online help. 
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A toggle button is provided to indicate whether the node and bendpoint 
positions saved in the view should be restored. Note that restoring view 
positions while in editing mode will make these new positions the default 
(actual) ones.

Commands
Clicking on a name in the Directory list will selected the specified directory 
name in the Selection text. Selecting the “Change Directory” command then 
will update the File list to show the files contained in that directory. Clicking 
on a name in the File list will put the full path name of the specified file in the 
Selection text. Double-clicking on a list item (Directory or File) invokes the 
command of the current default button (“Change Directory” or “Restore”). 

The following commands are available for the Restore View Dialog:

Network Viewer Confirm Dialog
This dialog appears when an attempt is made to save a view description on top 
of an existing file. Select the “Ok” command to save the view or “Cancel” to 
abort the operation. 

Restore Node Positions If set, restores the saved node and bendpoint 
positions along with the rest of this View 
information.

Restore Closes the dialog and selects the current contents 
of the Selection text as the name of the source 
View description file. This command can also be 
invoked by double-clicking on a name in the File 
list. 

Change Directory Displays the currently selected directory name in 
the Selection text and displays the files it contains 
in the File list. This command can also be invoked 
by double-clicking on a name in the Directory list. 

Cancel Closes the dialog without any file name selection 
and aborts the Restore View operation. 

Help Displays this help panel. 
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Commands

NV New Model Question Dialog
The NV New Model Question Dialog is popped up whenever someone loads 
a new network model as the active network model on the workstation from 
which Network Viewer is collecting its data. 

Given that this has already happened, there are only two alternatives that you 
can take at this point: 

• Wait while the new network model is loaded into Network Viewer. This 
takes approximately as long as the initial startup of the application 
(depending on the size of the new network model). 

• Exit Network Viewer. 

NV Reload Model Question Dialog
This dialog is raised to allow you to confirm the “Reload Model” command. 

Since this will cause the reconstruction of the whole model, this may be a 
lengthy operation. You can confirm the model load or cancel it and return to 
the Network Viewer. 

NV Model Increment Question Dialog
The NV Model Increment Question Dialog is popped up whenever someone 
increments the active network model with new data (such as merging a new 
CDF) on the workstation from which Network Viewer is collecting its data. 

Given that this has already happened, there are only two alternatives that you 
can take at this point: 

• Wait while the network model increment is loaded into Network Viewer. 

Ok Replaces the existing file with the view 
description. 

Cancel Stops the Save View operation. 

Help Displays online help. 
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• Ignore the network model increment and continue with the existing 
display. 

NV Exit Confirmation Dialog
This dialog allows you to confirm or abort an Exit operation. If there are any 
un-saved modified Component Filter or Preference Settings, this dialog also 
offers you to save them before exiting. 

Commands
The following commands are supported depending on the current context:

Exit and Save: Preference 
Settings Changes

Select this toggle to enable the saving of the 
modified Preference Settings. This control is only 
visible if the Preference settings were modified but 
not saved.

Exit and Save: Component 
Filter Changes

Select this toggle to enable the saving of the 
modified Component Filter Settings. This control 
is only visible if the Component Filter settings 
were modified but not saved.

Exit Application Closes all NV displays and dialogs and terminates 
the application. This command is not available if 
there were some un-saved modified Component 
Filter or Preference Settings. 

Cancel Exit Closes the Exit Confirmation Dialog and returns to 
the NV main display without terminating the 
application. 

Exit and Save Saves the modified Component Filter Settings to 
their user specific file (${HOME}/MagellanNMS/
NVFilter.cfg and ${HOME}/MagellanNMS/
NVPrefs.cfg) and terminates the application. This 
command is only available if there were un-saved 
modified Component Filter or Preference 
Settings. 
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NV Bad View Name Error
This error dialog indicates that an invalid file name was specified in the 
Network Viewer Save or Restore View dialogs when the action command was 
selected. Please re-issue the original view operation from the File menu to try 
again. 

Commands

NV Bad View File Error
This error dialog indicates that an invalid file was specified by the Network 
Viewer Save or Restore View dialogs. In the case of the Save View operations, 
this is due to the named file or its directory not being writable. For the Restore 
View operation, this is due to the named file not existing or being readable. 
Please change the protections of the specified file and re-issue the original 
view operation from the File menu or select another one. 

Commands

Exit without Saving Terminates Network Viewer but does not attempt 
to save the modified Component Filter or 
Preference Settings. This command is only 
available if there were un-saved modified 
Component Filter or Preference Settings. 

Help Displays online help. 

Ok Closes the dialog and returns you to the View 
dialog. 

Help Displays online help.

Ok Closes the dialog and returns you to the View 
dialog. 

Help Displays online help. 
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NV View Save Error
This error dialog indicates that a Save View operation has failed. This is 
currently impossible. 

Commands

NV View Restore Error
This error dialog indicates that a Restore View operation has failed. The 
possible reasons for this are: 

• the file to restore is not a valid NV View Description file, or 

• the organization to restore or the map node do not exist in the current 
model 

Please re-issue the original view operation from the File menu to try restoring 
another View Description file. 

Commands

NV Model Loading Error
This dialog indicates that an error occurred while loading topology or 
subcomponent information from the Network Model. This is probably caused 
by a locked, inactive, or invalid Network Model. If this error is the result of 
opening a Subcomponent or Shelf dialog, you may want to close it and try 
again. If this error occurs while loading the network model, you should exit 
Network Viewer, verify the Network Model’s integrity, and restart Network 
Viewer. 

Ok Closes the dialog and returns you to Network 
Viewer’s network display. 

Help Displays online help. 

Ok Closes the dialog and returns you to the network 
display. 

Help Displays online help. 
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Commands

NV Model Action Error
This dialog indicates that an error occurred while asking the Network Model 
to put a component in Maintenance State. This could be caused by the 
component not existing or already being in Maintenance or Hierarchical 
Maintenance state. Please verify the state of the component and re-issue the 
command if need be. 

Commands

NV Model Lock Error
This dialog indicates that the Network Model is locked and a query necessary 
to the completion of command could not be performed. Please try again when 
the model is unlocked. Look for the “padlock” icon on the status bar to go 
away indicating that the model was unlocked. 

Commands

NV Model Not Ready Question
This dialog is displayed when an attempt at loading the Network Model fails. 
This is probably caused by the fact that the model is currently locked by 
another application or is not available yet. It is possible to retry the model load 
or exit the application. 

Ok Closes the dialog and returns you to the network 
display.

Help Displays online help. 

Ok Closes the dialog and returns you to the network 
display. 

Help Displays online help. 

Ok Closes the dialog and returns you to the network 
display. 

Help Displays online help.
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Commands

NV Fatal Error
This dialog is displayed whenever a fatal error has occurred, for example 
when the connection to the Network Model Server is lost. When this occurs 
the Network Viewer Application cannot perform its task correctly and this 
dialog is brought up to indicate to the user that the application must be exited. 

Commands

NV Filter Save Error
This error dialog indicates that a Filter Settings Save operation has failed. The 
possible reasons for this are: 

• there is an NVFilter.cfg file in your ${Home}/MagellanNMS/ directory 
but it is write protected 

• there is no NVFilter.cfg in your ${Home}/MagellanNMS/ directory but 
the directory is write protected 

Please correct the file or directory access mode and retry the Save. 

Commands

Retry Model Load Re-attempts the model load into Network Viewer. 
If the model is still not available, the dialog will 
reappear.

Exit Application Causes Network Viewer to terminate. 

Exit Application This will cause Network Viewer to terminate. 

Ok Closes the dialog and return you to the Filter 
Settings dialog. 

Help Displays online help. 
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NV Filter Restore Error
This error dialog indicates that a Filter Settings Restore operation has failed. 
The possible reasons for this are: 

• the file to restore is not a valid NV Filter Settings file, or 

• there is no NVFilter.cfg file in your ${Home}/MagellanNMS/ directory or 
the file cannot be opened. 

Please correct the file or its access mode and retry the Restore or re-create and 
Save the Filter Settings. 

Commands

NV Network Model Edit Error
This dialog indicates that an internal error has occurred while editing the 
network model. The edit session has been terminated. 

Commands

NV Network Model Edit Startup Error
The Editing session could not be established as the Viewer was not able to 
connect to the Editing Dialog Manager process. 

Commands

Ok Closes the dialog and returns you to the Filter 
Settings dialog. 

Help Displays online help. 

Ok Closes the dialog. 

Help Displays online help. 

Ok Closes the dialog. 

Help Displays online help.
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NV Editing Unavailable
This indicates that the Network Viewer is connected to a Network Model 
Server that does not support Editing functions (probably on a previous 
release). The editing functions are not available but the Viewer can still be 
used for Network Surveillance. 

Commands

NV Preference Save Error
This dialog indicates that an internal error has occurred while saving the 
Network Viewer Preference settings to the $HOME/MagellanNMS/
NVPrefs.cfg file. Check the file protection and retry. 

Commands

NV Preference Restore Error
This dialog indicates that an internal error has occurred while restoring the 
Network Viewer Preference settings from the $HOME/MagellanNMS/
NVPrefs.cfg file. Check the file existence and protection and retry. 

Commands

NV Network Model Service Selection
Service Selection for the Network Model has just occurred. You can either 
accept the selection and the Viewer will reload the model from the new 
destination or ignore the selection. 

Ok Closes the dialog. 

Help Displays online help. 

Ok Closes the dialog. 

Help Displays online help. 

Ok Closes the dialog.

Help Displays online help.
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Commands

NV Network Model Service Selection Refused
Service Selection for the Network Model has occurred while the Network 
Viewer is in Editing mode. The Viewer cannot reload the model in this 
context. To follow the new Service Selection, you must first leave editing 
mode and then either reload the model manually or re-do the Service 
Selection. 

Commands

 Network Viewer Help
The Help menu contains the following commands: 

• Help on Window displays descriptive information about the Network 
Viewer window components. 

• What’s This? displays information about a selected area of the Network 
Viewer window.

 Network Viewer Keys
Network Viewer is built using the Motif user interface library.

Connect to new 
destination

Causes the Network Viewer to destroy the current 
View and attempt to load the model from the 
newly selected destination.

Ignore Service Selection Causes the selection to be ignored. The Viewer 
keeps the model from the current destination. To 
load the model from the new destination later you 
must either reload the model manually or re-do 
the Service Selection. 

Help Displays online help. 

Ok Closes the dialog.

Help Displays online help. 
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In a dialog, there may be a default action button. This button is visually 
distinguished by an extra box around it. If you press the Return key anywhere 
in the dialog, Motif will activate the default button. Not all dialogs have a 
default action button. 

Mnemonics
Mnemonics are available only from the menu bar menus. They are single 
characters. The characters are identified by an underscore. To use mnemonics, 
you must first press either F10 (from which menus can be opened using the 
mnemonics) or hold down the Meta key and press the mnemonic for the menu 
bar menu you wish to open. From there, the mnemonic of the specific 
command on the open menu can be pressed (once the Meta key has been 
released). For example, the following key sequence causes the Network 
Viewer tool to exit: “Meta-F E”. As does: “F10 F E”. 

Command Shortcuts 
Command shortcuts can be used by experienced users of Network Viewer to 
save them from using the mouse to select commands from menus. 

Command shortcuts use combinations of various modifier keys with regular 
character keys. Modifier keys are Shift, Control, and Meta. 

The shortcut for any particular command is shown on the menu itself. As 
users become familiar with the command they learn to remember the shortcut 
and can then invoke that command directly from the keyboard without having 
to pull down menus. 

Double Clicks 
Certain actions (mostly navigation) can be triggered by double clicking the 
Select mouse button on a node, link, or subcomponent with or without the 
Shift, Control, or Meta key being held down. These actions can be customized 
but they are by default
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Double click actions also apply to nodes and links in the textual components 
dialog.

Network Viewer Icon Bar Help
The Network Viewer supports two icon bars—one for surveillance mode and 
one for model edit mode. From an icon bar you can start other tools and 
utilities.

You can display the function of each icon. As you place the mouse pointer 
over an icon, the command represented by that icon is displayed. 

To execute the command represented by an icon, click on that icon.

On Organization Root 
Nodes

Opens the organization, as if Open Organization 
had been selected from its popup menu. 

On Organizational Nodes Without modifier keys, expands the node, as in 
“Expand in Place”. With the Shift key pressed, the 
node is expanded as in “Full Expand in Place”. 
With the Control key pressed, the node is 
compressed as in “Compress in Place”. With the 
Meta key pressed, the CIV tool is invoked for the 
node. 

On Module Level Nodes Without modifier keys, opens the Subcomponent 
Dialog in Troubled mode. With the Shift key 
pressed, the Shelf Dialog is opened. With the 
Control key pressed, the node is compressed as 
in “Compress in Place”. With the Meta key 
pressed, the CIV tool is invoked for the node.

On Links Without modifiers and if there is more than one 
link between the two nodes, removes all their 
bond points and inserts new ones, in order to 
spread the links evenly. With the Meta key 
pressed, the CIV tool is invoked for the link. 

On Subcomponents With the Meta key pressed, invokes the CIV tool 
for the subcomponent. (Subcomponents in either 
the Subcomponent Dialog or the Shelf Dialog.) 
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You can show or hide the icon bar. To show a hidden icon bar, from the 
Options menu, select Show Icon Bar. To hide an icon bar, from the Options 
menu, select Hide Icon Bar. Commands and tools in the hidden icon bar are 
also available from the menu bar. 

Network Viewer Editor interface
The Network Viewer Editor is a subset of Network Viewer which allows the 
user to create, supplement, and change a network model. 

All basic editing commands may be accessed through the main Network 
Viewer menu, "Network Model Edit", and through the "Edit" cascade options 
from component pull-down menus. In addition, many editing commands may 
be carried out through the use of the "drag and drop" interface using the 
middle mouse button. 

Add Node dialog
This dialog is used to create new nodes and subcomponents, including regions 
and sites. It is also used to edit existing nodes and subcomponents. In 
addition, nodes may be organized hierarchically using this dialog, by 
selecting their parent. 

Table 7
Add Node dialog commands

Add Adds the new node or subcomponent you 
described to the network model. It will contain the 
attribute information listed in the attribute area, 
and be assigned a parent node listed in the 
parent area. This button is only active if "Refresh" 
is pressed and the component name does not 
already currently exist in the network model. 

Change Causes the edited existing node or 
subcomponent you changed to be updated in the 
network model. It will contain the attribute 
information listed in the attribute area, and be 
assigned a parent node listed in the parent area. 
This button is only active if "Refresh" is pressed 
and the component name already exists in the 
network model. 

 (Sheet 1 of 3)
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Close Closes the dialog. 

Help Invokes online help. 

Use Defaults Places default values for attributes in the 
attribute area. The defaults are based on the 
component type. 

Node name Enables you to specify the component name to 
add or update. A selector field to the right of the 
name display the following choices: 

Show Legal Types - to list all valid child 
component types for this component. Selecting a 
type will add this type to the end of the 
component name. This may be used to build up 
a component name one step at a time. 

Get Context - to place a component name from 
context into the name field. If nothing is in 
context, the name field will be erased. 

Show Legal Names - to display a dialog 
describing the syntax of the current component 
type. 

Table 7 (Continued)
Add Node dialog commands
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NV Network Model Edit Node Position Dialog 
When you change the position of nodes in surveillance mode, these changes 
remain in effect until you reposition them or until you exit Network Viewer. 
Unlike surveillance mode, when you change the position of nodes in edit 
mode, these changes are saved in the network model and are available to all 
instances of Network Viewer monitoring this network. The NV Network 
Model Edit Node Position Dialog opens when you make changes to node 
positions in surveillance mode and then change to edit mode. The dialog 
confirms whether or not you want to save the node positions that you made in 
surveillance mode before edit mode opens. 

Add Link Dialog
This dialog is used to create new links, and to edit existing links.

Parent list Contains all the possible parents for the current 
node, and selecting a different parent (and 
pressing Add or Change) will cause the node to 
move to the new site or region. If a component is 
a module or site, it must be assigned to a parent 
node. 

Attributes Provides a list of all the attributes supported by 
this component type. Each attribute is a text field, 
which may be filled in manually. Another way of 
filling attributes which are small finite sets of 
strings is to use the attribute menu selector, to 
the right of the attribute field. Pulling down the 
attribute menu lists at least one entry, "Display 
Information".  Selecting this displays a brief 
description of the attribute. Another menu entry 
might be a range indicator. This is simply to let 
the user know the attribute must be within a 
numeric range. If the menu contains several 
values, these may be selected. The result is that 
the attribute is set to the selected string. The full 
range of possible strings is listed in the menu

Table 7 (Continued)
Add Node dialog commands
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Table 8
Add Link dialog commands

Add Adds the new link you described to the network 
model. It will contain the attribute information 
listed in the attribute area. (Usually just the 
criticality.) This button is only active if the link is 
"Refreshed" and the link name does not already 
currently exist in the network model. If you add a 
link to the model in which one link end is already 
involved in a connection, the previous link will be 
deleted. 

Change Causes the edited existing link you changed to 
be updated in the network model. It will contain 
the attribute information listed in the attribute 
area. (Usually just the criticality.) This button is 
only active if the link is "Refreshed" and the link 
name already exists in the network model. 

Close Closes the dialog. 

Help Invokes online help. 

Use Defaults Places default values for attributes in the 
attribute area. The defaults are based on the link 
type. 

Name Enables you to specify the link name to add or 
update. The link name is not normally entered 
directly into this field, but rather using the 
endpoint lists to build the name. 
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Enter Edit dialog
Use this dialog to enter the authentication password for network model 
editing. Once authentication is complete, editing mode will be enabled. 

Component Endpoint 
Lists

Provides three lists, which will automatically 
update the link name when items in the list are 
chosen. One of the lists is the link type, the other 
two are the endpoint lists. The endpoint lists 
contain a list of all connectable subcomponents 
which are children of the parent component 
identified in the "Component" field. A user may 
update this component name by typing, or by 
drag-and-drop of a node from Network Viewer's 
display or subcomponent list. Ports already 
involved in another link connection are shown 
with a connected 2-node bitmap to their left, 
unused ports are shown with a 1-node bitmap. 
By selecting two endpoints, plus a link type, the 
link name is built. 

Attributes Provides a list of all the attributes supported by 
this link type. Each attribute is a text field, which 
may be filled in manually. Another way of filling 
attributes which are small finite sets of strings is 
to use the attribute menu selector, to the right of 
the attribute field. Normally, the only link attribute 
the criticality, which is a numeric range from 1 to 
5. Pulling down the attribute menu lists at least 
one entry, "Display Information". Selecting this 
displays a brief description of the attribute. 
Another menu entry might be a range indicator. 
This is simply to let the user know the attribute 
must be within a numeric range. The link 
criticality is a range attribute. If the menu 
contains several values, these may be selected. 
The result is that the attribute is set to the 
selected string. The full range of possible strings 
is listed in the menu. 

Table 8 (Continued)
Add Link dialog commands
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Editing may be refused for several reasons: there may be no network model 
on the remote (or local) machine. You must LAN select to an appropriate 
workstation. If another user is already editing the network model, you will be 
denied access. Finally, if the remote model has stipulated local editing only, 
you will not be able to connect remotely. 

The password may or may not be required, depending if the network model 
enforces one. 

Leave Edit dialog
This dialog is displayed when the user requests to leave edit mode. This 
dialog permits a model save option before quitting editing mode. The user is 
given the option to save the model or to ignore it. 

Create Organization
This dialog allows the user to create a organization. The type of organization 
and a unique name must be specified. 

Table 9
Enter Edit dialog commands

OK Attempts to enter network model editing mode. 

Cancel Closes the dialog and returns you to Network 
Viewer's display. 

Help Invokes online help. 

Table 10
Leave Edit dialog commands 

Save Saves and exits edit mode. 

Exit without Saving Discards the outstanding unsaved network 
model changes, and leaves edit mode. You can 
always re-enter edit mode and save. 

Cancel Closes the dialog and returns you to the editor's 
display. 

Help Invokes online help. 
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Delete Components dialog
This dialog is a verification dialog, allowing the user to confirm the deletion 
of one or more components. Initially, all chosen components are selected in 
the dialog’s list, but the user may choose to unselect some of these so he may 
delete only some of the components. 

NMF Manager dialog
This dialog lists all the network model files stored on the machine running the 
network model editor server. You may load one of these files into the model, 
replacing the existing one. You may also rename and delete files. These 
commands are accessible via a pull down menu from the NMF list items, or 
from dialog buttons (delete and rename are available from the pull down 
menu only). 

A NMF file item must be selected before an operation can be done. 

After loading a model, the “Show all warnings” button may become enabled. 
In this case, pressing it will pop up a dialog listing warnings or errors detected 
during the load process. 

Table 11
Create Organization commands 

OK Creates the new organization that was specified. 

Close Closes the dialog and returns you to the editor's 
display. 

Help Invokes online help. 

Table 12
Delete Components dialog commands 

Delete Deletes all the selected components listed in the 
dialog from the network model. 

Cancel Closes the dialog and returns you to the editor's 
display. No components will be deleted. 

Help Invokes online help. 
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Rename NMF dialog
This dialog asks the user to specify a new name for the selected network 
model file. 

NMF Save dialog
This dialog allows the user to save the current network model to a file. A file 
name must be entered, or chosen from a list of existing files (in which case 
the model will overwrite the existing file). 

The model can be saved as a binary image (for quick loading), or an ASCII 
file (for portability between Preside Multiservice Data Manager releases). 

Table 13
NMF Manager dialog commands

Load Loads the new network model. The user is first 
prompted. 

Rename... Enables you to specify a new name for the 
network model file. A dialog pops up to specify 
the new name. 

Delete... Enables you to delete a network model file. A 
confirmation dialog pops up to verify this 
command. 

Close Closes the dialog and returns you to the editor's 
display. 

Help Invokes online help. 

Table 14
Rename NMF dialog commands

Accept New Name Changes the name of the network model file to 
the name which the user typed. 

Cancel Closes the dialog and returns you to the editor's 
display. The network model file is not renamed. 

Help Displays online help. 
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If you wish to have this model start up automatically after a reboot, then 
choose the option "Make this model the default on startup". 

Replace NMF dialog
This dialog is present if a network model save operation is about to overwrite 
an existing network model file. 

New Model
Erases the current network model, and creates a new model. The only 
organization present will be DEFAULT_ALL. All the modules will be stored 
in NEW_SITE/DEFAULT_ALL. 

Table 15
NMF Save dialog commands 

Save Saves the network model to a file on the network 
model editing server machine. The file name is 
specified in the "File name" field. If the file 
already exists, the user will be prompted to 
overwrite it. 

Close Closes the dialog and returns you to the editor's 
display. The dialog will close automatically after 
the save is completed. 

Help Displays online help. 

Table 16
Replace NMF dialog commands

Replace NM File Saves the network model to the file, overwriting 
the old file. 

Cancel Closes the dialog. The network model is not 
saved. 

Help Displays online help. 
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Detach Map
Removes the map file currently associated with the present organization. 

Set Map dialog 
This file selection dialog allows the user to specify a bitmap file to be 
displayed in the background of the current organization. Note that the file 
selection is done on files local to the user's machine, and not necessarily the 
machine running the network model server. No checking of a valid file format 
is done. 

Table 17
New Mode commands

Yes Creates the new model. 

No Closes the dialog and returns you to the editor's 
display. No new model is created. 

Help Displays online help. 

Table 18
Detach Map commands

Yes Detaches the map, and removes it from Network 
Viewer's display. 

No Closes the dialog and returns you to the editor's 
display. No changes are made. 

Help Displays online help. 

Table 19
Set Map dialog commands

Set Map Associates the file with a bitmap of the current 
organization's background. If the file is a valid 
bitmap, Network Viewer will display it. 
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Warning Messages
This dialog displays information messages to the user. It may be dismissed 
after viewing. 

EDM Exit Warning dialog
This dialog will terminate the editing session. 

Delete NMF Warning dialog
This dialog is a confirmation dialog for when the user requests deleting a 
network model file from the server machine. 

Cancel Closes the dialog and returns you to the editor's 
display. 

Help Displays online help. 

Table 20
Warning Messages commands

Close Closes the dialog and returns you to the editor's 
display. 

Help Displays online help. 

Table 21
EDM Exit Warning dialog commands

Yes, exit Network Viewer 
Editor

Exits editing mode. 

No, cancel exit Closes the dialog and returns you to the editor's 
display. 

Help Displays online help. 

Table 19 (Continued)
Set Map dialog commands

 (Sheet 2 of 2)
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Rename Collection dialog 
This dialog asks the user to specify a new name for the selected component 
data file. 

Data Collection dialog 
This dialog allows the user to collect data from the network, for use with the 
network model. 

A collection name must be specified; it may be any name the user wishes, so 
long as it is unique. The equipment type specifies whether you are collecting 
DPN components, Passport components, or Passport 4400 (PP4400) 
components. For DPN and Passport, a destination, capability, and password 
must be supplied. 

You can "Collect all Modules under <destination>", which will collect 
information for everything managed by that OA, group, or Passport 4400. Or 
you can "Collect only the following Modules", which will collect just the 
specified set of modules under that OA, group, or Passport 4400. The list is 

Table 22
Delete NMF Warning dialog commands

Yes, delete the remote file Deletes the network model file from disk. 

No Closes the dialog without deleting the file. 

Help Displays online help. 

Table 23
Rename Collection dialog commands

Accept New Name Changes the name of the component data file to 
the name specified by the user. 

Cancel Closes the dialog and returns you to the editor's 
display. The component data file is not renamed. 

Help Displays online help. 
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created by either a drag and drop of modules, or by typing names in the text 
field and pressing "Add". Modules are deleted by selecting them one at a time, 
and pressing "Delete", or by pressing “Delete All”. 

For DPN and Passport, you can specify a "Backbone Collection", which will 
collect only module and link information or a "Complete Collection", which 
will collect all subcomponent information as well. 

If "Notify Upon Completion" is selected, a notification dialog is displayed 
when the collection is finished. 

Collection Manager dialog 
Use the Collection Manager dialog to manage and apply collection files to the 
current network model. This dialog supports a pop-up menu of commands to 
manage and apply collection files, a series of check boxes to select various 
options, and command buttons for additional tasks.

Commands
To open the pop-up menu, right-click on an entry in the list of collections. The 
pop-up menu contains the following commands:

• Stop Data Collections stops the current data collection process. 

• Show Data Collection Errors and Warnings displays a log of problems 
that occur during data collection. 

• Show Data Collection Parameters… opens the Data Collection dialog 
containing the parameters used to create the collection. This command is 
available only if the collection was created during the current edit 
session.v 

Table 24
Data Collection dialog commands

Collect Data Starts the collection. If it is a large collection, it 
may take a while. 

Close Closes the dialog and returns you to the editor's 
display. No collection is started. 

Help Displays online help. 
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• Apply Collected Data to Network Model applies the selected 
collections to the network model. The files are applied sequentially and 
alphabetically. 

• Show Model Increment Errors and Warnings… displays a log of 
problems that occur during application to the network model. 

• Rename Collection… renames the selected collection. 

• Delete Collections deletes selected collections from the server.

Options 
The Collection Manager dialog contains a selection of options. Select or clear 
a checkbox to turn the option on or off. The dialog contains the following 
options: 

• Delete Collections Upon Successful Application deletes collection 
files if they have been successfully applied to the network model. 

• Destroy old sub-components Upon Application deletes old module 
subcomponents in the collection file before applying the collection to the 
network model. 

• Load Organizational Structure Upon Application restores the 
organizational structure (parentage and positions) of the components in 
the collection file when the collection is applied to the network model. 

Buttons 
The Collection Manager dialog contains the following buttons: 

• Apply Collected Data to Network Model applies the selected 
collections to the network model. The files are applied sequentially and 
alphabetically. 

• Close closes the Collection Manager dialog. 

• Help displays online help about the Collection Manager dialog.

Delete Collection 
This Delete Collection enables you to open a confirmation dialog to delete a 
selected CDF file from the list, using the CDF popup menu.
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CDF Notification dialog 
This dialog pops up automatically when a collection is complete. It is just to 
inform the user that he may now use it via the CDF manager. 

Warning dialog 
This dialog pops up with various warning messages for the user. 

Components Save dialog 
The Components Save Dialog lets you save a selected set of current network 
modules and their components to disk in portable collection information files. 

The Components Save Dialog lets you perform the following save operations: 

• You can choose which modules will be saved by specifying module 
naming patterns. 

• You can choose to save the current organizational context (parentage and 
positions) of the selected modules. 

Table 25
CDF Notification dialog commands

Acknowledge All Closes the dialog and will not display the current 
list of completed CDFs again. 

Close Closes the dialog but will display the current list 
of completed CDFs again the next time it pops 
up. 

Help Displays online help. 

Table 26
Warning dialog commands

OK Closes the dialog. 

Help Displays online help. 
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• You can choose to save all the links related to the selected modules. The 
standard load collection capability of Network Viewer may be used to 
increment a current model with the saved components, links and 
organizational structures. 

Items in the dialog are as follows: 

• Collection Name displays the name of the collection file. A default is 
provided and is used unless you enter an alternate name. 

• The Components List Area displays a list of all the modules in the 
collection. You can select modules in this area by clicking on the name 
of a module displayed in the area. 

• The Current Component Area displays the name of a module selected on 
the Components List Area, or the name of an existing module that you 
enter at the keyboard. You can enter wildcard (*) characters in this Area. 
For example, if you enter EM A* then click Save Components, you can 
save all modules to the collection whose names begin with EM A. 

• Add lets you add a module whose name you entered in the Current 
Component Area to the collection. 

• Delete removes the module whose name appears in the Current 
Component Area from the collection. 

• Delete All removes all modules from the collection. 

• Save Related Links saves all links related to the select modules. 

• Save Organizations saves all the organizational structures related to the 
selected modules.Saving the organizational structures also saves the 
positions of the modules and of their related links 

• Save Components saves changes you make to the collection.

• Close closes the dialog.
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Network Browser for Operator Client

The Network Browser provides a hierarchical representation of the network 
down to the node level. You can navigate through the levels to view the states 
of modeled objects.

Navigation
• “Network Browser procedures”

• “Network Browser fundamentals”

• “Network Browser interface”

Network Browser procedures
Starting and exiting

• “Starting Network Browser”

• “Exiting Network Browser”

Starting Network Browser
Start Network Browser to view state changes and updates in the network.

Procedure steps
1 From the Fault menu, select Network Browser.

The Network Browser window opens.

Exiting Network Browser
Exit Network Browser when you are finished viewing network state changes 
and updates.
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Procedure steps
1 From the Network Browser window, click File and then Exit.

Network Browser fundamentals
Network Browser detects state changes in the network model and updates the 
display with new state information on an on-going basis. Network Browser 
enables you to view network model objects down to the node level. To view 
objects below the node level, use the Component Information Viewer tool. 
See “Component Information Viewer” (page 415) for information about 
using Component Information Viewer tool.

Network Browser interface
The Network Browser window displays network model components down to 
the node level. The main window and the overall interface of the Network 
Browser is made up of the following parts:

• “Menu bar” (page 175)

• “Network model hierarchy” (page 176)

• “Network Browser pop-up menu” (page 176)

Figure “Network Browser interface” (page 175) displays the parts of the 
Network Browser interface.
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Figure 9
Network Browser interface

Menu bar
The Network Browser provides the following menus:

• “File”

• “Help”

File
The following commands are available from the File menu:

menu bar

network 
model 
hierarchy

pop model 
hierarchy
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Help
The following commands are available from the Help menu:

Network model hierarchy
The Network model hierarchy displays a hierarchical view of all the network 
components down to the node level.

Network Browser pop-up menu
The Network Browser pop-up menu which is accessed by right-clicking on 
the components in the Network model hierarchy contains the following 
commands:

Command Description

Reload Network Model Refreshes the network browser, capturing any 
additions or deletions to network model 
components.

Exit Closes the Network Browser window.

Command Description

Help on Window Provides help on the Network Browser window.

What’s This? Displays information about a selected area of the 
Network Browser window.
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Table 27
Network Browser pop-up menu commands

Command Description

Turn Maintenance State 
On

Puts a component in a maintenance state. The 
maintenance state is propagated down to all the 
component’s subcomponents. A component’s 
state is shown as MTCE. The default color for 
this state is light blue. The components remain in 
this state until you turn it off. You can also access 
this command from the pop-up menu in the 
Component Information Viewer.

Turn Maintenance State 
Off

Takes a component out of a maintenance state. 
You can also access this command from the pop-
up menu in the Component Information Viewer.

Start Tool Displays a list of other MDM tools that you can 
start from Network Browser. The content of the 
list varies depending on component context and 
access control. For a description of the pop-up 
menu commands, see the section about the Start 
Tool in 241-6001-122 Preside MDM Using MDM 
Toolset and Operator Client Interfaces.
Preside MDM Fault Management User Guide   15.1RSUP



178   Chapter 3 Network Browser for Operator Client
241-6001-011   15.1RSUP   



179
Chapter 4
Shelf View 

Shelf View is part of the Preside Multiservice Data Manager (MDM) set of 
fault management tools. This tool provides a graphical view of the device 
shelf that can be used to assist in troubleshooting network problems in real-
time:

Shelf View supports Passport and Nortel Networks Multiservice Provider 
Edge 9500 network elements. Shelf View is available through both the MDM 
Toolset and Operator Client environments. For details about these MDM 
environments, see 241-6001-801 Preside MDM Overview.

Navigation
• “Shelf View procedures” (page 180)

• “Tool fundamentals” (page 218)

• “Shelf View user interface” (page 219)

• “Menu bar” (page 221)

• “Components pop-up menu” (page 226)

• “Tool bar” (page 227)

• “Navigation area” (page 228)

• “Examination area” (page 232)

• “Details area” (page 244)

• “MDM state color conventions” (page 249)

• “Errors and warnings” (page 250)
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Shelf View procedures
The Shelf View tool lets you monitor, diagnose, and correct network faults. 
The tool monitors the device and returns component state values. Based on 
these state values, you can further diagnose problems and take corrective 
action. This section contains the following Shelf View procedures:

Starting and stopping the Shelf View tool

• “Starting Shelf View from the MDM toolset and Operator Client” 
(page 182)

• “Starting Shelf View from the UNIX command line” (page 183)

• “Starting Shelf View from other MDM tools” (page 184)

• “Quitting Shelf View” (page 185)

Displaying online help

• “Displaying Shelf View online help” (page 186)

Modifying the Shelf View window

• “Displaying tool tips” (page 187)

• “Opening pop-up menus” (page 188)

• “Adjusting the image size of the Passport Physical Shelf” (page 189)

• “Adjusting the image size of the MPE 9500 Physical Shelf” (page 190)

• “Adjusting panel sizes” (page 191)

• “Adjusting column widths” (page 192)

Working with components

• “Navigating the device component tree structure” (page 193)

• “Setting the maintenance state for a component” (page 196)

• “Locking a logical port on a Passport” (page 197)

• “Unlocking a logical port on a Passport” (page 198)
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Working with related components

• “Displaying related components” (page 199)

• “Sorting related components” (page 200)

• “Setting filters for related components” (page 201)

• “Setting an automatic refresh interval for related components” 
(page 202)

• “Displaying component attributes” (page 203)

Working with alarms

• “Displaying alarms” (page 204)

• “Sorting alarms” (page 205)

• “Setting an automatic refresh interval for alarms” (page 206)

• “Acknowledging an alarm” (page 207)

• “Acknowledging all active alarms on a component in MDM Toolset” 
(page 208)

• “Unacknowledging an alarm” (page 209)

• “Unacknowledging all active alarms on a component” (page 210)

• “Clearing local alarms on Passport” (page 211)

• “Clearing global alarms on Passport” (page 212)

Making provisioning changes

• “Making provisioning changes to components and services” (page 213)

Starting other MDM tools

• “Starting other MDM tools from Shelf View in MDM Toolset” 
(page 214)

• “Starting other MDM tools from Shelf View in Operator Client” 
(page 216)
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Starting Shelf View from the MDM toolset and Operator Client
Use Shelf View to display the device’s physical and logical views to perform 
a selection of surveillance and nodal provisioning tasks. 

Prerequisite
Before you can start the Shelf View tool, you need to authenticate to a device 
or device group. If you have not already authenticated during your current 
MDM session and try to start Shelf View, a Connection Management dialog 
automatically opens and prompts for authentication information. 

Procedure steps
1 Select one of the following actions, depending on the device you want to 

view. 

If you have already authenticated, the Shelf View window opens and you 
have completed the procedure. 

If you have not already authenticated, the Shelf View -Device Selection 
dialog box opens. All devices in the selected destination group display in 
the device list. You need to complete the remaining steps in this 
procedure to start the Shelf View.

2 Select a device from the Shelf View-Device Selection dialog and click 
OK.

3 In the Group Authentication dialog, complete the following fields and 
click OK:

• In the Group name field, select a group name.

• In the User Id field, type a valid user ID.

• In the device field, type the password associated with the specified 
user ID.

The Shelf View Authentication dialog box closes and the Shelf View 
window opens. 

For... On the MDM Toolset or Operator Client window...

Passport Click Fault menu, and then Passport Shelf View.

MPE 9500 Click Fault menu, and then MPE Shelf View.
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Starting Shelf View from the UNIX command line
Using Shelf View, you can display the device’s physical and logical views to 
perform a selection of surveillance and nodal provisioning tasks. 

Prerequisite
Before you can start the Shelf View tool, you need to authenticate to a device 
or device group. If you have not already authenticated during your current 
MDM session and try to start Shelf View, a Connection Management dialog 
automatically opens and prompts for authentication information.

Procedure steps
1 From the UNIX command line, type the following command:

If you have already authenticated, the Shelf View window opens and you 
have completed the procedure. 

If you have not already authenticated, the Shelf View -Device Selection 
dialog box opens. All devices in the selected destination group display in 
the device list. You need to complete the remaining steps in this 
procedure to start the Shelf View.

2 Select a device from the Shelf View-Device Selection dialog and click 
OK.

3 In the Group Authentication dialog, complete the following fields and 
click OK:

• In the Group name field, select a group name.

• In the User Id field, type a valid user ID.

• In the device field, type the password associated with the specified 
user ID.

The Shelf View Authentication dialog box closes and the Shelf View 
window opens. 

For... Use the command..

Passport /opt/Magellan/bin/shelfview -type EM

MPE 9500 /opt/Magellan/bin/shelfview -type SRS
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Starting Shelf View from other MDM tools 
Using Shelf View you can display device’s physical and logical views and 
perform a selection of surveillance and nodal provisioning tasks. You can start 
the Shelf View tool from other MDM tools by using component context or by 
using the MDM Start Tool menu. 

Procedure steps
1 If you are using component context, use the following steps:

a. From any Preside MDM tool that supports context, select a device to 
put it into context. Generally, selecting a component puts that 
component into context. Some MDM tools may support a component 
popup menu that contains a Put Context command.

b. In the Preside Multiservice Data Manager window, select Fault and 
then Shelf View.

2 If you are using the Start Tool menu, use the following steps:

a. From any MDM tool that supports a Start Tool menu, open the Start 
Tool menu. Generally, this step is done by right-clicking on a 
component to open a pop-up menu.

b. On the Start Tool pop-up menu, point to Fault and then select Shelf 
View.

If you have already authenticated, the Shelf View window opens and 
you have completed the procedure

If you have not already authenticated, the Shelf View -Device 
Selection dialog box opens. All devices in the selected destination 
group display in the device list. You need to complete the remaining 
steps in this procedure to start the Shelf View.

3 In the Group Authentication dialog, complete the following fields and 
click OK:

• In the Group name field, select a group name.

• In the User Id field, type a valid user ID.

• In the Password field, type the password associated with the 
specified user ID.

The Group Authentication dialog box closes and the Shelf View window 
opens. 
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Quitting Shelf View 
Use this procedure to quit the Shelf View tool. 

Procedure steps
1 From the File menu, select Exit

The Shelf View window closes.
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Displaying Shelf View online help
Use this procedure to view online help for the Shelf View tool. You can 
display various types of online help.

Procedure steps
Help on Window
Help on Window provides a description of the elements of the Shelf View 
window.

1 From the Help menu, select Help on Window. 

The online help window opens with a description of the Shelf View 
window.

What’s This?
What’s This displays online information about a specific area of the Shelf 
View window.

1 From the Help menu, select What’s This?

The mouse pointer changes to a question mark (?).

2 Move the mouse pointer onto an area of the window for which you want 
help and click the mouse button. 

The online help window opens with information specific to the area you 
selected. 
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Displaying tool tips
The Shelf View tool supports tool tips. Tool tips are pop-up text boxes that 
provide additional information. The contents of the tool tip depends on the 
mouse pointer location. Tool tips provide such information as full component 
ID and sparing scenarios for logical processors and cards. Use the following 
procedure to display tool tips.

Procedure steps
1 Move the mouse pointer over a provisioned component for a few seconds. 

The tool tip for that component opens. The following figure shows a 
sample card tool tip. 
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Opening pop-up menus
Pop-up menus are visible when you right-click on components in the Shelf 
View window. These pop-up menus provide additional commands that are 
specific to the selected area of the window. Use this procedure to open a pop-
up menu.

Procedure steps
1 Right-click on any provisioned (colored) component in any of the panels.

A pop-up menu opens.

2 Select a command from the pop-up menu.

The command executes and the pop-up menu closes.
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Adjusting the image size of the Passport Physical Shelf 
The Passport Physical Shelf supports three image sizes: small, medium, and 
large. When the Passport Shelf View tool opens, the Physical Shelf uses the 
medium image as its default. Use this procedure to change the physical shelf 
size image. 

Procedure steps
1 Click the Physical Shelf icon to select it.

2 Click one of the small, medium, or large image size icons.

The Physical Shelf increases or decreases in size, depending on your 
selection. 

small

medium

large
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Adjusting the image size of the MPE 9500 Physical Shelf
The MPE 9500 Physical Shelf supports zoom controls. Use this procedure to 
adjust the physical shelf size image. 

Procedure steps
1 Click the Front or Rear graphical view icon to select it.

2 Use one of the following icons to adjust the image size of the view. The 
icons are described in the order that they appear in the diagram below.:

• Selection - allows the user to select cards and ports

• Pan - allows the user to grab the image and move it around 
(alternative to scroll bars)

• Zoom In - zooms in x2 and maintains the center point

• Zoom Out - zooms out x 1/2 and maintains the center point

• Reset Zoom - returns to 1:1 zoom scale

• Fit to Window - makes entire image fit in the current window

• Zoom to Rectangle - user selects a rectangle and the selected image 
zooms to fill the viewing area (best fit).
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Adjusting panel sizes 
The Examination area contains various panes. You can adjust these panel 
sizes. Any adjustments that you make remain in effect until you readjust the 
settings or until you close the window. Use this procedure to adjust the sizes 
of these panes 

Procedure steps
1 To adjust the height of a panel, click on the bottom triangle to expand the 

window vertically.

2 To return to the normal view, click on the top triangle to decrease the 
height of the panel. 

Click on the bottom triangle to 
increase the size of the panel.
Preside MDM Fault Management User Guide   15.1RSUP



192   Chapter 4 Shelf View
Adjusting column widths 
You can change the default column width in tables located in the Examination 
Area and Details Area.

Procedure steps
1 In a panel, drag the boundary on the right side of the column heading until 

the column is the size you want. 

When you move the mouse pointer to the 
boundary of the column heading, the pointer 
changes to a double-pointing arrow and the 
header boundary displays.
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Navigating the device component tree structure 
The Navigation area represents the hierarchical component structure of the 
device. You can navigate down the component tree to explore the component 
architecture. You can also navigate across the logical Passport component 
branches through links to explore relationships between components. Use this 
procedure to navigate the component tree structure. 

Initially, all first level components in the Navigation area are displayed with 
a plus (+) sign in the folder icon, whether or not there are subcomponents. If 
you try to expand a first-level component that has no subcomponents, the 
component remains in the list but the folder and plus sign are removed.

Procedure steps
1 From the Navigation area, expand a component by clicking the plus sign 

(+) adjacent to the component you want to expand.

When the component expands, the plus sign changes to a minus sign (-). 
Expanding a component in the tree requires communication with the 
device. A short delay may be incurred during such expansion operations.

2 To compress subcomponents, click the minus sign (-) adjacent to the 
parent component.

3 To navigate across the component tree, you need to use links. In the 
Component Navigator, links are colored blue. Move the mouse pointer 
over the link until the pointer changes to the figure of a hand and then 
click. 

The Navigator panel refreshes with the linked component at the top level 
of the component hierarchy.

4 To return the node to the top level of the component hierarchy, click the 
Home button.
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5 To move forward or backward through the link history, click the back and 
forward buttons.

Back 
Forward 

Collapsed 
folder

Expanded 
folder
Preside MDM Fault Management User Guide   15.1RSUP



196   Chapter 4 Shelf View
Setting the maintenance state for a component
Use this procedure to set the maintenance state for a component on or off. 
Setting the maintenance state permanently hides the current troubled state of 
a component. Any children of the selected component are also put into 
maintenance state. For more information on maintenance state, see 
241-6001-015 Preside MDM Network Model Administrator Guide.

Procedure steps
1 To set the maintenance state, right-click on a provisioned component and 

then from the resulting pop-up menu, select either Set Maintenance 
State On or Set Maintenance State Off. 

When maintenance state is on, the selected component has a blue 
background. When maintenance state is off, the selected component 
displays a color that reflects its current MDM state.
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Locking a logical port on a Passport
Locking an LP prevents it from providing services. When an LP is in the 
process of locking, its OSI administration state (adminState) changes to 
shutting down. In this state, the component continues to provide services to 
existing clients but does not accept any new requests for services. When the 
lock process completes, the adminState changes to locked and the LP no 
longer provides any services. 

Prerequisite
When Shelf View opens, you need to authenticate to a device group. If you 
want to use the lock and unlock commands, you need to authenticate with a 
user ID that has the following administration capabilities:

• impact = service

• scope = network

• customer ID = 0

Procedure steps
1 Use one of the following steps on an unlocked LP:

• In the Logical Processor summary panel, right-click on an LP to 
open its pop-up menu.

• In the Physical View panel, right-click on a connector to list the 
associated LPs and then select an LP from the list to open the pop-
up menu.

2 On the pop-up menu, select Lock.

The Confirm Lock Request dialog opens and prompts for confirmation.

3 On the Confirm Lock Request dialog, select one of the following options:

• Lock to lock the LP

• Lock -force to immediately lock a component and skip the shutting 
down state

• Cancel closes the dialog

Passport Shelf View replaces the LP instance in the LP Summary with a 
padlock icon for locked ports and a downward arrow for LPs that are 
shutting down. These icons also display in the LP label, menu, and tooltip.
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Unlocking a logical port on a Passport
Unlocking a currently locked LP allows it to provide services. Unlocking an 
LP changes its administration state (adminState) to unlocked. 

Prerequisite
When Shelf View opens, you need to authenticate to a device group. If you 
want to use the lock and unlock commands, you need to authenticate with a 
user ID that has the following administration capabilities:

• impact = service

• scope = network

• customer ID = 0

Procedure steps
1 Use one of the following steps on an LP that is locked or shutting down:

• On the Logical Processor summary panel, right-click on an LP to 
open its pop-up menu.

• On the Physical View panel, right-click on a connector to list the 
associated LPs and then select an LP from the list to open the pop-
up menu.

2 On the pop-up menu, select Unlock.

The Confirm Unlock Request dialog opens and prompts for 
confirmation. 

3 On the Confirm Lock Request dialog, click OK. 

Passport Shelf View replaces the locked or shutting down icon with the LP 
instance in the LP Summary. These icons are also removed from the LP 
label, menu, and tooltip.
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Displaying related components 
Use this procedure to populate the related component list or to refresh the 
contents with related information for another component.

Procedure Steps
1 Select a component in any of the panels in the Shelf View window.

2 There are two ways to display related components:

• From the View menu, select Related Components.

• Click on the Related Components icon.

The Related Components panel opens.

3 To update the list with current information, click Retrieve.

The Related Components List refreshes with related component 
information. 
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Sorting related components
The related component panel displays related component information in 
tabular format. By default, the table sorts the related components by their 
component identifier. Use this procedure to change the sort order. 

Procedure steps
1 Click the Related components icon.

2 To sort the table on a specific column, click its column header. 

The header of the current sort column displays a border and an 
arrowhead. An upward pointing arrowhead indicates ascending order and 
a downward pointing arrowhead indicates descending order. 

3 To reverse the order of the current sort column, click the column header. 

The arrowhead in the column header reverses order. For example, when 
the column is in ascending order, clicking the column header reverses the 
order to descending.
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Setting filters for related components
The Related component panel in the Examination area supports filters. Filters 
reduce the amount of information to let you focus on what is relevant. Use this 
procedure to display a subset of related components based on their network 
model component state.

Procedure steps
1 Click the Related components icon.

2 In the Related component panel, select any of the filter check boxes, as 
required. The ISTB and OOS filters have criticality levels ranging from a 
low of 1 to a high of 5. By default, all levels display. If required, you can 
change the criticality levels. 

• UNKN displays related components whose state is unknown.

• INSV displays related components whose state is in-service.

• ISTB displays related components whose state is in-service—
troubled. If required, change the criticality levels by selecting from the 
associated drop-down list. 

• OOS displays related components whose state is out-of-service. If 
required, change the criticality levels by selecting from the associated 
drop-down list.

• MTCE displays related components whose state is maintenance.

• HIER MTCE displays related components whose state is hierarchical 
maintenance.

• ACKED displays related components whose state is acknowledged.

The related component list refreshes, based on the selected filters.
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Setting an automatic refresh interval for related components
You can control whether or not the related component list refreshes and the 
frequency of refreshes. Use this procedure to establish or change the 
automatic refresh settings.

Procedure steps
1 Click the Related components icon.

2 In the related component panel, type a value in the minute box or use the 
arrows to increase or decrease the current number of minutes. The 
minimum value is 2 minutes.

3 To set the automatic refresh value, select the Refresh the Related 
Components check box. 

The related component list automatically refreshes at the specified time 
interval.

4 To stop automatic refreshes, clear the Refresh the Related 
Components check box. 
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Displaying component attributes
You can display attributes and their associated values for device components. 
The Shelf View retrieves these attributes directly from the device. Use this 
procedure to display component attributes. 

Procedure steps
1 Click on a component.

2 In the Details area, select Details from the Details panel selector. 

Note:  Select an actual component instance from the component tree, not 
a entry that has a wildcard (*). For example, you can display component 
attributes for CARD/2, but you cannot display attributes for CARD/*. 
CARD/* represents a category of components, not an actual component 
instance.

3 To update the list with current information, click Refresh.
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Displaying alarms
Use this procedure to display detailed alarm information for a component.

Procedure Steps
1 In the Details area, select Fault from the Details panel selector.

2 To display alarms on a component, click on a component in the Related 
components area. 

Note:  Select an actual component instance from the component tree, not 
a entry that has a wildcard (*). For example, you can display component 
attributes for CARD/2, but you cannot display attributes for CARD/*. 
CARD/* represents a category of components, not an actual component 
instance.

The fault panel refreshes with the information for the selected component. 
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Sorting alarms
The Component Information tab displays alarm information in tabular 
format. By default, the alarm table sorts alarms by the order in which they are 
received by the General Management Data Router (GMDR). You can sort on 
multiple columns. You also can change the order from ascending to 
descending chronological order and you can change the column on which the 
table is sorted. The direction of the sorting arrows indicates whether the 
column is sorted in ascending or descending order. The arrows change 
direction each time they are selected.Use this procedure to sort alarms. 

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 To sort the alarm table on a specific column, click its column header. 

The header of the current sort column displays a border and an 
arrowhead. An upward pointing arrowhead indicates ascending order and 
a downward pointing arrowhead indicates descending order. This column 
becomes the first sort column and the arrowhead is labeled 1.

3 To reverse the order of the current sort column, click the column header. 

The arrowhead in the column header reverses order. For example, when 
the column is in ascending order, clicking the column header reverses the 
order to descending.

4 To sort the alarm table on multiple columns, click the first column header. 
Then press SHIFT and click a second column. Press SHIFT and click a 
third column. 

As columns are selected for sorting, a triangular marker is displayed in the 
header, and the columns are labeled 1, 2, and 3 respectively. For 
example, if severity, CompId, and time are selected, and labeled 1,2, and 
3 respectively, then the alarm list is sorted first by alarm severity, then 
within each severity part of the list, the alarms are sorted by CompId, and 
for each CompId of each severity grouping, the alarms are sorted by time.
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Setting an automatic refresh interval for alarms 
You can control whether or not the alarm list refreshes and the frequency of 
refreshes. Use this procedure to establish or change the automatic refresh 
settings.

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 In the Fault panel, type a value in the seconds box or use the arrows to 
increase or decrease the current number of seconds. The minimum value 
is 10 seconds.

3 To set the automatic refresh value, select the Refresh the alarm lists 
check box. 

The alarm list automatically refreshes at the specified time interval.

4 To stop automatic refreshes, clear the Refresh the alarm lists check box. 
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Acknowledging an alarm 
Acknowledging an alarm indicates that you are currently investigating the 
problem associated with the alarm. Use this procedure to acknowledge a 
selected alarm.

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 In the Active Alarms from GMDR list, right-click on an alarm.

A pop-up menu opens.

3 From the pop-up menu, select Acknowledge Alarm....

An Input dialog opens and prompts for the acknowledgement reason.

4 In the Input dialog, type the reason for alarm acknowledgement and click 
OK.

The Input dialog closes. 

5 To view the acknowledgement, the alarm list need refreshing. Use one of 
the following methods:

• Click Retrieve.

• If you have set an automatic refresh interval set up, wait for the list to 
update automatically.
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Acknowledging all active alarms on a component in MDM 
Toolset

You can acknowledge all active alarms on a component. Acknowledging the 
alarms indicates that you are currently investigating the problems associated 
with the component. Use this procedure to acknowledge all active alarms for 
a selected component.

Procedure steps
1 Position the mouse pointer on any provisioned (colored) component in the 

Shelf View window and right-click.

A pop-up menu opens.

2 From the pop-up menu, select Start Tool->Fault -> Acknowledge 
Alarms on Component....

The Acknowledge Alarm(s) Dialog opens.

3 In the Acknowledge Alarm(s) Dialog, type a reason for the alarm 
acknowledgement. 

4 Optionally, to acknowledge all alarms for related subcomponents, select 
the Also ack all alarms on related sub-components check box.

5 Click Ack Alarm(s). 

The dialog closes. 

6 Alarm acknowledgement displays in the alarm list after the specified 
refresh interval. To immediately view the acknowledgement, click 
Refresh. 
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Unacknowledging an alarm
If an alarm has been acknowledged, you can turn off the acknowledgement 
when required. Use this procedure to unacknowledge an alarm.

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 In the Active Alarms from GMDR list, right-click on an alarm that is 
currently acknowledged.

A pop-up menu opens.

3 From the pop-up menu, select Unacknowledge Alarm....

An Input dialog opens and prompts for the unacknowledgement reason.

4 In the Input dialog, type the reason for alarm unacknowledgement and 
click OK.

The Input dialog closes.

5 To view the unacknowledgement, the alarm list need refreshing. Use one 
of the following methods:

• Click Retrieve.

• If you have set an automatic refresh interval set up, wait for the list to 
update automatically.

6 Alarm unacknowledgement displays in the alarm list after the specified 
refresh interval. To immediately view the unacknowledgement, click 
Refresh. 
Preside MDM Fault Management User Guide   15.1RSUP



210   Chapter 4 Shelf View
Unacknowledging all active alarms on a component
If you have acknowledged all alarms for a component, you can turn off this 
acknowledgement when required. Use this procedure to unacknowledge all 
active alarms for a selected component.

Procedure steps
1 Position the mouse pointer on any provisioned (colored) component in the 

Shelf View window and right-click.

A pop-up menu opens.

2 From the pop-up menu, select Start Tool-> Fault -> Unacknowledge 
Alarms on Component....

The Unacknowledge Alarm(s) Dialog opens.

3 In the Unacknowledge Alarm(s) Dialog, type a reason for the alarm 
unacknowledgement. 

4 Optionally, to unacknowledge all alarms for related subcomponents, 
select the Also unack all alarms on related sub-components check 
box.

5 Click Unack Alarm(s). 

The dialog closes and the active alarms for the selected component are 
unacknowledged.

6 Alarm unacknowledgement displays in the alarm list after the specified 
refresh interval. To immediately view the unacknowledgement, click 
Refresh. 
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Clearing local alarms on Passport
You can clear active alarms from the workstation’s fault stack. This action 
clears the alarms from Preside Multiservice Data Manager only, not from the 
on-switch active alarm list. 

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 In the Active Alarms from GMDR list, right-click on an alarm.

A pop-up menu opens.

3 From the pop-up menu, select Local Clear.

4 In the Component details for field, click Retrieve to refresh the alarm 
list. 

The selected alarm is removed from the active alarm list.
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Clearing global alarms on Passport
You can clear active alarms from the workstation’s fault stack and the on-
switch active alarm list. Use this procedure to globally clear alarms.

Prerequisite
The ability to clear global alarms is available in Passport releases PCR 4.2 and 
above.

Procedure steps
1 In the Details area, select Fault from the Details panel selector.

2 In the Active Alarms from GMDR list, right-click on an alarm.

A pop-up menu opens.

3 From the pop-up menu, select Global Clear or Global Clear of Alarm.

4 In the Component details for field, click Retrieve to refresh the alarm 
list. 

The selected alarm is removed from the active alarm list.
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Making provisioning changes to components and services
You can perform component and service provisioning tasks from the Shelf 
View tool using the Embedded Nodal Provisioning tool. 

Limitations
The Embedded Nodal Provisioning tool lets you perform a selection of 
provisioning tasks to a small number of components in the current active 
view. To navigate and provision large numbers of device components in a 
variety of device views, use Nodal Provisioning rather than Embedded Nodal 
Provisioning.

References
For details about the Embedded Nodal Provisioning tool, see the embedded 
nodal provisioning section in 241-6001-610 Preside MDM Nodal 
Provisioning User Guide.

Procedure steps
1 To open the component pop-up menu, from any tabbed page right-click 

on the component you want to provision.

2 To enable Embedded Nodal Provisioning from the component pop-up 
menu, select one of the following provisioning tasks:

• Add Subcomponent…

• Change Component…

• Delete Component…

• Apply Service Template…

The Embedded Nodal Provisioning tool opens. 

3 To enable Nodal Provisioning from the component pop-up menu, select 
Start tool, Configuration, and then Nodal Provisioning.

The Nodal Provisioning tool opens. 
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Starting other MDM tools from Shelf View in MDM Toolset
The Shelf View tool provides a selection of fault and configuration 
capabilities. To perform additional fault, configuration, and performance 
tasks, you can start other tools from the Shelf View. Use this procedure to start 
other MDM tools with component context from device Shelf View.

Procedure steps
1 From any of the panes in the Shelf View window, right-click on the 

component that you want to put into context. 

A component pop-up menu opens.

2 From the component pop-up menu, select Start Tool, followed by one of 
Fault, Configuration, Performance or System from the resulting 
submenu select the tool you want to start. 

The table “Tools you can start from device Shelf View in MDM Toolset” 
(page 214) provides references to further information. 

Table 28
Tools you can start from device Shelf View in MDM Toolset

Start Tool Related Information

Fault:

Component Information
Viewer

“Component Information Viewer” 
(page 415)

Passport or MPE Shelf
View

Acknowledge Alarms on 
Component

“Alarm acknowledgement and 
unacknowledgement” (page 381)

Unacknowledge Alarms on 
Component

Circuit Viewer

“Alarm acknowledgement and 
unacknowledgement” (page 381)

“Circuit Viewer” (page 599)

Configuration:
Passport or MPE Nodal
Provisioning

Embedded Nodal Provisioning in 
241-6001-610 Preside MDM Nodal 
Provisioning User Guide
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Performance:
Datal
Viewer

Data Viewer in 241-6001-031 Preside 
MDM Performance Management User 
Guide

System:

Operational 
Commands

Table 28 (Continued)
Tools you can start from device Shelf View in MDM Toolset

Start Tool Related Information
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Starting other MDM tools from Shelf View in Operator Client
The Shelf View tool provides a selection of fault and configuration 
capabilities. To perform additional fault, configuration, and performance 
tasks, you can start other tools from the Shelf View. Use this procedure to start 
other MDM tools with component context from Shelf View.

Procedure steps
1 From any of the panes in the Shelf View window, right-click on the 

component that you want to put into context. 

A component pop-up menu opens.

2 From the component pop-up menu, select Start Tool, followed by one of 
Fault, Configuration, Performance or System and from the resulting 
submenu select the tool you want to start. 

The table “Tools you can start from the device Shelf View in Operator 
Client” (page 216) provides references to further information. 

Table 29
Tools you can start from the device Shelf View in Operator Client

Start Tool Related Information

Fault:

Component Information
Viewer

“Component Information Viewer” 
(page 415)

Passport or MPE Shelf
View

Configuration:
Passport or MPE Nodal
Provisioning

Embedded Nodal Provisioning in 
241-6001-610 Preside MDM Nodal 
Provisioning User Guide

Performance:
Datal
Viewer

Data Viewer in 241-6001-031 Preside 
MDM Performance Management User 
Guide

System Utilities:

Operational 
Commands
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Command 
Console

Telnet 
Access

Table 29 (Continued)
Tools you can start from the device Shelf View in Operator Client

Start Tool Related Information
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Tool fundamentals
Shelf View is a Preside Multiservice Data Manager (MDM) tool that 
communicates directly with a device to assist in troubleshooting network 
problems in real time. The Passport Shelf View window displays both 
physical and logical shelf views. The MPE 9500 Shelf View window displays 
two graphical views: the rear and the front of the MPE 9500. Both the 
Passport and MPE 9500 Shelf Views show related component information 
and associated alarms. The tool also supports a selection of nodal surveillance 
and provisioning activities. 

The Shelf View tool uses the psvagent server to collect its required data. For 
details about this server, see the section on psvagent in 241-6001-310 Preside 
MDM Server Reference Guide. 

For more details about Shelf View, see the following topics:

• “Shelf View user interface” (page 219)

• “Menu bar” (page 221)

• “Components pop-up menu” (page 226)

• “Tool bar” (page 227)

• “Navigation area” (page 228)

• “Examination area” (page 232)

• “Details area” (page 244)

• “MDM state color conventions” (page 249)

• “Errors and warnings” (page 250)
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Shelf View user interface
The Shelf View can be launched from the MDM toolset or Operator Client. 
See “Passport Shelf View” (page 220). The five major areas of the Shelf View 
graphical user interface are:

• “Menu bar” (page 221)

• “Tool bar” (page 227)

• “Navigation area” (page 228)

• “Examination area” (page 232)

• “Details area” (page 244)
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Figure 10
Passport Shelf View
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Shelf View Major Areas:

1 Menu Bar
2 Tool Bar
3 Navigation Area
4 Examination Area
5 Details Area
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Menu bar
The menu bar contains the following menus:

• “File” (page 221)

• “View menu” (page 222)

• “Actions” (page 224)

• “Help” (page 225)

File
The File menu contains the following command:

• Exit closes the window and exits the tool. See the procedure “Quitting 
Shelf View” (page 185).
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View menu 
The View menu for the Shelf View contains the following commands:

Table 30
View menu commands

Area Description

Back provides a drop-down list of context changes that 
have preceded the current context

Forward provides a drop-down list of context changes that 
have followed the current context.

Up one level changes context to the current context’s parent 
component regardless of whether or not that 
component appears in the Back or Forward lists. 
The button also provides a drop-down menu 
containing all parent components in the 
hierarchy, up to the root device component. This 
button is enabled only when the current context 
value is not the device name.

Logical processor 
(Passport only)

displays information about logical processors 
(LPs) and cards. It also provides sparing 
information for logical processors and cards.

Physical shelf (Passport 
only)

shows the device as it is currently equipped, 
including components that are present but not 
yet active. This view includes the shelf, card 
cages, card faceplates, frames and other 
hardware of the selected device.

Chassis Front (MPE 9500 
only)

displays the front of the MPE 9500 with the xSC 
cards. All provisioned ports are shown on each 
card according to the card type.

Chassis Rear (MPE 9500 
only)

displays the back of the MPE 9500 with the IOC 
cards (both half-height and full-height cards).

Related components displays parents, children, and related links of 
selected components.
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Details displays a tabular report of all available attributes 
of the components in the details context.

Fault provides alarm information for a specific 
component, both active and recent alarms.

Table 30
View menu commands (Continued)

Area Description
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Actions
The Actions menu contains the same menu items as the component pop-up 
menu. To open the component pop-up menu, right-click on any component in 
the Shelf View. See the “Components pop-up menu” (page 226) for more 
information.
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Help
The Help menu contains the following commands:

Table 31
Help menu commands

Area Description

Help on Window displays descriptive information about the device 
Shelf View window components.

What’s This? displays information about a selected area of the 
device Shelf View window.
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Components pop-up menu
The Shelf View provides a components pop-up menu. This menu is opened 
by right-clicking on any component ID shown in any area panel of the 
application (text or graphic). 

The components pop-up menu has two parts: an internal menu and an external 
menu. The external menu appears at the end of the internal pop-up menu. 

The components pop-up menu is a duplicate of the Actions menu. The 
external pop-up menu, defined under the Start Tools menu, launches other 
applications and is compliant with the Start Tool Filter that is defined in 
Operator Client.

When a user right clicks on a component ID, the components pop-up menu is 
displayed.
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Tool bar
The Context Browser Toolbar provides three buttons, similar to web-browser 
buttons.

Figure 11
Context tool bar

Table 32
Context tool bar commands

Area Description

Back provides a drop-down list of context changes that 
have preceded the current context

Forward provides a drop-down list of context changes that 
have followed the current context.

Up changes context to the current context’s parent 
component regardless of whether or not that 
component appears in the Back or Forward lists. 
The button also provides a drop-down menu 
containing all parent components in the 
hierarchy, up to the root device component. This 
button is enabled only when the current context 
value is not the device name.
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Navigation area
The Navigation area provides a set of panels that aid the user in locating 
specific components. The panels included in this area are

• A tree list of components from which the user can select a component as 
the target for examination in the Examination area.

• A Markers list of components to which the user may add and remove 
component ID markers. This list is similar to a web-browser Bookmarks 
or Favorites list.
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Navigation tree
The tree hierarchy is the left panel of the Shelf View main window. When the 
Shelf View is opened, the hierarchical component structure of the device is 
displayed.

The Navigation tree displays a tree list of component IDs showing the 
component structure of the network element. This panel is used to locate 
specific device components. 

When an item in the tree hierarchy has sub-items, a plus (+) sign displays to 
the left of the item name. You click the + sign to expand or collapse the sub-
items.

Selecting and right-clicking on items and sub-items in the tree hierarchy 
displays a popup menu with options to allow to perform configuration tasks 
and access help information.

A specific item is put into context when you select it. It is shown as selected 
in the tree list and notification of the context change is propagated throughout 
the application so that the panels in the Examination area and Details Area are 
automatically updated. 

When a selected component is the device itself, its chassis, or any of the 
physical components under the chassis, the Physical View is automatically 
selected in the Examination area. When the selected component is the LP 
component, the LP component is automatically selected in the Examination 
area. For any other selected component, the Related Components is 
automatically shown in the Examination area. 

Provisioning activities are made possible from the Shelf View by an 
embedded interface to the key elements of the Nodal Provisioning 
application. This embedded interface is called Embedded Nodal 
Provisioning. Embedded Nodal Provisioning lets you create, modify, and 
delete components and apply service templates to the current view. 
Embedded Nodal Provisioning only supports a subset of changes to a small 
number of components in the current active device view. To navigate and 
provision large numbers of device components in a variety of device views, 
you need to use the Nodal Provisioning tool. For a description of Embedded 
Nodal Provisioning and how to use it, see the Embedded Nodal Provisioning 
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section in 241-6001-023 Preside MDM Configuration Management for 
Passport User Guide. For details about the Nodal Provisioning, see 
241-6001-610 Preside MDM Nodal Provisioning User Guide.
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Markers list
The Markers list is a user-specific list of component IDs. This is similar to a 
web-browser Bookmarks or Favorites list. Only component IDs specific to 
the current device instance are shown. The Markers list is initially not shown 
by default.

The panel contains two controls for the maintenance of markers: Add and 
Remove. The Add + button adds the component ID currently in the 
application context to the list. The Remove button is enabled only when a 
marker is selected. It deletes the selected marker from the list.

Double-clicking on a marker re-establishes it as the current context value.

A duplicate Add control is available from the application tool bar to provide 
easy access to this function even when the Markers panel in the Navigation 
area is minimized or not visible.

Figure 12
Markers list
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Examination area
The Examination area shows the selected component IDs within the context 
of other nodal components, either graphically or textually. The View selectors 
allow the user to switch between the graphical and text view, and the Context 
history lets the user view previous context changes. 

When a component is selected, either in the Graphical or Related 
Components of the Examination area, the Navigator tree is automatically 
updated to reflect that component ID throughout the application.

The split panel containing the Examination and Details area is designed so 
that one-touch control can be used to minimized the top or bottom area. The 
header line always remains visible.

Context history
The context history provides a drop-down menu showing the last ten unique 
context changes performed in the Examination area.

Figure 13
Context history

Duplicate entries in this list are not permitted. If a user toggles back and forth 
between two context values, it does not fill the list each time a value is 
selected.
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When a component is selected form the drop down menu, if that component 
is the device itself, its chassis, or any of the physical components under the 
chassis, the Graphical view is automatically selected in the Examination area. 
For Passport, the LP Summary panel is displayed when you select an LP 
component.

For any other components, the Related Components is used. The user can 
always change to another view after the default is displayed using the icons 
buttons in the Examination Area header bar.
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View selector icons
In the right-hand corner of the Examination area, there are three icons that 
allow you to choose the view. For Passport, the left button activates the 
Logical Processor Summary, the middle button, the Physical View. For MPE 
9500, the left button displays the Front Chassis (Input/Output cards) and the 
middle button displays the Back Chassis (Service cards). For both devices, the 
right button activates the Related Components.

Figure 14
View selector icons

When the user selects components in the Navigator tree, the Examination area 
is automatically updated with the newly selected context.

If the selected component ID defines a component that appears in the physical 
graphics, for example, a card or port, then the Graphical view is automatically 
made visible and the graphical image of that component is shown as selected. 
If the component ID defines a logical component, for example, a controller or 
interface, the Related Components is automatically made visible and the 
specified component is shown as selected.

The user can toggle between the two views, but if the component in context 
does not appear in the Physical View, the selection is not indicated.
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Related Components
The Related Components List shows the MDM-related components list for 
the component ID in context. The list is retrieved from the MDM Network 
Model Server (nmserver) whenever the application context changes or every 
time an active refresh cycle is triggered.

The Related Components List displays parents, children, and related links of 
a selected component. Each entry in the list displays with a background color 
to indicate the state value. For details about colors and their associated states, 
see the table “MDM state color conventions” (page 249). 

The list also displays component states and full component IDs. Components 
with a state of in-service—troubled (ISTB) or out-of-service (OOS) display 
with an MDM network model component criticality factor, ranging from a 
low of 1 to a high of 5. You can control whether or not the related component 
list refreshes and the frequency of refreshes. You can also sort the list so that 
it is organized by severity of network model state or by component identifier. 

The Related component panel supports filtering so that you can limit the 
amount of information that displays in the list. A selection of check boxes in 
this panel lets you filter components based on the network model (NM) state. 

This panel also displays the total number of related components in the list. 
When you select any of the filter check boxes, the panel displays both the 
number of items in the filtered list and the total number of related 
components. 

To change the value in the Related component field, double-click on a 
component in the list. The list refreshes the display of related components for 
the selected component. As well, the Component details panel refreshes its 
display with information about the selected component.
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Physical Shelf for the Passport
The Passport Physical Shelf view represents the Passport device as it is 
currently equipped, including components that are present but not yet active. 
This view includes the shelf, card cages, card faceplates, frames and other 
hardware of the selected Passport device. Entire Passport 15000 and 20000 
series frames do not display because the Passport Shelf View tool cannot 
determine whether a shelf is mounted in the upper or lower half of the frame. 
For this reason, a small separation appears between the breaker interface 
panel (BIP) and the shelf in the Physical Shelf view. The figure “Passport 
Shelf View: Physical Shelf” (page 237) shows a sample Passport Shelf View 
window with the Physical Shelf tab selected. You can use the image size icons 
to increase or decrease the shelf view display. See “Adjusting the image size 
of the Passport Physical Shelf” (page 189).
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Figure 15
Passport Shelf View: Physical Shelf 

The Passport Shelf View window automatically refreshes to capture changes 
to components or states as they occur. The color of the card LED in the 
Passport Shelf View reflects the state of the card as assigned by MDM 
network model, not the actual physical LED. As a result, in some instances 
the derived Passport Shelf View LED color may differ from the actual LED. 

To assist in troubleshooting, when you select a port in the Logical Processor 
Summary panel, the physical connector associated with that port is 
highlighted in the Physical Shelf panel.

Supplementary 
component panel

Card faceplates

Image size icons
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When you select a card in the Physical Shelf, its associated LPs display with 
colored borders in the Logical Processor Summary panel. LPs associated with 
a main card have a thick magenta border; LP’s associated with the spare card 
have a thin grey border.

The Physical Shelf panel consists of the following components:

• “Card faceplates” (page 238)

• “Supplementary component bar” (page 238)

Card faceplates
In the physical view, only the cards represent modelled Passport components. 
Connectors may map to multiple connectors, each according to its card type. 
Cards, card LEDs, and port connectors are the only interactive portions of the 
physical view. The color of the LEDs on the faceplates indicate the state of 
the card. The color overlay on the physical connectors is in accordance with 
MDM state hierarchical propagation rules and represent a composite of the 
states of all the logical ports that map to the connector.

Supplementary component bar
The supplementary component bar provides MDM state information for some 
additional components. This bar includes states for the following Passport 
components:

• BUS/X and BUS/Y (for Passport 6000 and 7000 series) or 
FABRICCARD/X and FACRICCARD/Y (for Passport 15000 and 20000 
series)

• DISK/0

• DISK/1 if configured (for Passport 15000 and 20000 series)

• DISK/15 if configured (16-slot Passport 6000 and 7000 series)

• FAN

• PWR (power supply)

The FAN and PWR components are not MDM modelled component types. 
The states for these components are simulated by monitoring the Passport 
device for specific alarms and are presented in the Passport Shelf View 
window to further assist in fault detection.
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Application status bar
The application status bar is common to all application views and provides 
information about the status of the application as a whole. The following 
information is available from the application status bar:

• the name of the Passport node

• the type of Passport device including

— 6000/7000 (for all 6000 and 7000 series Passport devices)

— 15000 (for Passport 15000 only)

— 20000 (for Passport 20000 only)

Logical Processor Summary 
The Logical Processor Summary icon displays summary state information for 
logical processors (LP) and cards. It also provides sparing information for 
logical processors and cards. The figure “Passport Shelf View: Logical 
Processor Summary” (page 240) shows a sample Shelf View window with the 
Logical Processor Summary tab selected. 

The Logical Processor Summary panel contains the following items:

• “Logical Processor Summary panel” (page 241)
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Figure 16
Passport Shelf View: Logical Processor Summary 

1

2
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Logical Processor Summary panel
The Logical Processor Summary panel provides information about the 
architecture for logical processors (LP) and their associated ports. This panel 
also provides sparing relationships, port to physical connector mappings, and 
access to LP subcomponent information. 

LP physical representation
The Logical Processor Summary panel displays 16 LP slots (0 to 15) and their 
ports. For Passport Shelf View, an LP slot refers to the physical representation 
of the collection of logical ports associated with an LP, not the physical card 
cage slots in the Passport. Ports display in columns of eight. If an LP has more 
than eight ports, multiple columns display. The number of logical port buttons 
in a slot depends on the LP’s associated card type. 

LPs and ports that are not provisioned appear recessed; provisioned LPs and 
ports appear raised. If a port is predefined as not being able to be provisioned, 
then that port is labelled with a X rather than a port instance number. Ports for 
Passport 6000 and 7000 series display in ascending order; ports for Passport 
15000 and 20000 series display in descending order.

LP to connector mapping
To help map logical ports to the physical connectors of the card faceplate, 
when you select a port in the LP Summary panel, the physical connector 
associated with that port is highlighted in the physical view.

Subcomponent information
To view the subcomponents of any component on the Logical Processor 
Summary panel, click on that component. The Navigation tree is updated with 
selected component at the top level of the Navigator panel and, if applicable, 
all subcomponents underneath.

Sparing relationships
When you select a component in the Logical Processor Summary panel, any 
provisioned sparing relationship for that object automatically displays. For a 
list of sparing types, see the table “Shelf View supported sparing types” 
(page 242).
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Table 33
Shelf View supported sparing types

Sparing type View from  Indicators

LP/CARD 
(logical processor/card)

Logical Processor 
Summary and 
Physical Shelf. 

When you select an LP or port, the 
associated main and spare cards display 
with colored borders. A magenta border 
surrounds the main card; a grey border 
surrounds the spare card.

LAPS/APS
(line automatic protection 
switching/automatic 
protection switching)

Logical Processor 
Summary panel

A dashed line connects the spared ports. 
W indicates the working line end,
P indicates the protection line end, and 
A indicates the currently active end.

DLEP Logical Processor 
Summary panel

A dashed line connects the spared ports. 
M indicates the main LP end, 
S indicates the spare LP end, and 
A indicates the currently active end.

MLEP Logical Processor 
Summary panel

A dashed line connects the spared LPs. 
A indicates the currently active LP.

PBG
(port bridge group)

Logical Processor 
Summary panel

A dashed line connects the spared ports. 
W indicates the working line end, 
B indicates the bridge end.
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Physical shelf for Nortel Networks Multiservice Provider Edge 
9500

The MPE 9500 physical shelf view is comprised of two graphical views: the 
rear of the device (Rear Chassis) and the front of the device (Front Chassis). 

The rear graphical view displays the Service cards. Service cards fall into two 
categories: switched service cards (XSCs) and processing service cards 
(CSCs and DSCs). All service cards are installed in the rear of the shelf and 
have no external port interfaces. 

The front graphical view displays the input/output cards (IOCs) that house the 
physical port interfaces that provide external connectivity for the MPE 9500. 
IOCs are installed at the front of the shelf in vertical slots that accommodate 
one full-height or two half-height IOCs. All provisioned ports are shown on 
each card according to card type.

The LEDs of the cards are neutral grey. MDM states are shown for ports by 
coloring the entire port graphic background with the appropriate color for the 
MDM state according to the current conventions (see “MDM state color 
conventions” (page 249)). Cards show the MDM states with an outline 
around the card. This maximizes the card-state visibility when the user zooms 
in, pans, and scrolls. 

In addition to cards and ports, these graphics also represent fans and power 
supplies as well as the shelf chassis itself. The availability of these additional 
components depend on their availability through the fault stack and from the 
device itself. 

When a component is selected in the Navigator tree, and the component is 
represented in either the rear or front chassis, then that view panel is 
automatically shown. Selecting a card or a port in the graphical view updates 
the contents of the Details area. 

Graphical zoom controls are provided within this panel. These controls 
include zoom in, zoom out, restore previous zoom, restore original zoom, and 
zoom to a selection rectangle. There are additional controls for panning the 
display and for selecting objects. For more information, see “Adjusting the 
image size of the MPE 9500 Physical Shelf” (page 190).
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Details area
The Details Area shows specific information for the currently selected 
component in the Examination area. The user can switch between various 
panels of relevant information specific to the selected component.

Details panel selector
The Details Panel selector provides a drop-down menu with the following 
entries:

• Details

• Fault

Figure 17
Details panel selector
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Details panel
The Details panel displays a tabular report of all available attributes of the 
components in the details context. These attribute values are retrieved directly 
from the device NE itself.

Figure 18
Attribute details panel

This panel also provides a refresh button to re-retrieve the attributes and 
updates the table with fresh values. 
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Fault panel
This panel lists the faults (alarms) associated with the component in context. 
The faults are retrieved from the GMDR server whenever the application 
component ID context is changed or active refresh cycle occurs, if any.

Figure 19
Fault details panel

The two left-most columns, the Ack State icon and the alarm Severity column 
are fixed, and do not scroll horizontally. The horizontal scroll bar starts under 
the Event or CompId column (recent or active alarm lists) instead of 
underlining the entire table. When the user scrolls using the horizontal scroll 
bar, the Ack icon and Severity column stay in place while the rest of the 
columns scroll through the remaining available area on the right side of the 
fixed columns.

The Fault panel consists of the following functionality described in the table 
“Fault details panel” (page 246).
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Table 34
Fault details  

Area Description

Refresh Cycle Control a toggle button to activate/deactivate the refresh 
cycle. The default is off.

Active Fault Tab with 
counter

contains a table listing all the active alarms 
buffered by GMDR for the selected component 
only. The label in the tab shows a count of the 
number of active alarms.

Recent Fault Tab with 
counter

contains a table listing all the recent alarms 
buffered by GMDR for the selected component 
and its subcomponents. The label in the tab 
shows a count of the number of alarms in the list.

Detailed Alarm Report includes detailed information related to the alarm

MDM Full Alarm Format presents the selected alarm record formatted as 
the alarm would appear in the MDM Fault Alarm 
Display. 

NTP Description of Fault provides the documentation for the selected 
alarm’s fault code. 
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The Fault details panel provides alarm information for a specific device 
component. It provides both an active and recent alarms list. The tab labels 
for these alarm types indicates the number of alarms in its list. The Active 
Alarms tab displays only uncleared SET alarms. The Recent Alarms tab 
shows all alarms in the GMDR buffer, including SET and CLEAR, for the 
selected component and its subcomponents. 

Both active and recent alarms display all alarm record fields in tabular format. 
A horizontal scroll bar lets you view all fields in the window. By default, the 
alarm tables are sorted by the order in which they are received by GMDR. 
However, you can sort the table based on other columns. You can also control 
whether or not the alarms refresh and the frequency of refreshes.

The alarm details display in a series of tabbed panes. Clicking an alarm in the 
alarm list populates the alarm details panel. In the details panel, both the 
alarm code and component ID are hypertext links. Clicking the alarm code in 
the Detailed Alarm Report tab displays NTP Description of Fault tab which 
contains the alarm help information. Clicking the component ID in the 
Detailed Alarm Report refocuses the Component Details panel on that 
component ID. 
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MDM state color conventions
The Shelf View tool uses standard MDM color conventions to indicate the 
network model states of components. Provisioned components display with a 
background color. For a description of the colors and their meaning, see the 
table “MDM state color conventions” (page 249). 

Shelf View displays alarms in tabular format. The entries in the alarm severity 
column display with colored backgrounds, with different colors representing 
different alarm severities. In addition, the column indicating raw state 
displays its text in color. 

Table 35
MDM state color conventions

If the 
background 
color is...

Then the 
component 
state is...

And its description is...

Green INSV In-service

Yellow/orange ISTB In-service—troubled

Red OOS Out-of-service

Grey UNK Unknown

Light Blue MTCE Maintenance

HIER_MTCE Hierarchical maintenance 

Aqua ACK Acknowledged 

No color UNDEF Undefined. The component 
has not been given a state by 
the Network Model Server.
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Errors and warnings 
The Shelf View provides the following error and warning messages to help 
you take corrective action:

• “Non-device Context” (page 250)

• “Unknown Device” (page 250)

• “Cannot connect to psvagent” (page 251)

• “Cannot Connect To Server” (page 251)

• “Cannot Connect To mnsdagent” (page 251)

• “Invalid or Missing Definition File” (page 252)

Non-device Context

Unknown Device

Message MDM’s current context does not refer to a Passport or MPE. 
Unable to launch the device Shelf View.

Cause: The device Shelf View has tried to start with a component in 
context that is not a Passport or MPE device. 

Action: Acknowledge the message to close device Shelf View. Put a 
device in context and then start the device Shelf View. 

Message: MDM does not recognize the device <Device Name>. Verify 
that the device is accessible and that it belongs to a device group. 

Cause: HGDS cannot find the specified device. The node may be in the 
network model but Service Selection might be focused on a host 
that does not support connections to that host. 
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Cannot connect to psvagent

Cannot Connect To Server

Cannot Connect To mnsdagent

Message: The connection to the psvagent has been lost. Verify the server is 
running, and restart the application. 

Cause: The socket connection between the client and the Shelf View tool 
is no longer available. The cause is usually that the server is 
stopped. This error causes the client to exit. 

Message: A connection to the server could not be made. Verify the server 
is running, and restart the application. 

Cause: The client has started but it cannot connect to the psvagent. The 
cause is usually an error during startup of the psvagent. This 
error causes the client to exit. 

Action: Refer to the MDM System Log for details about the error 
encountered by the psvagent and verify that the Shelf View 
ApplicationServer is reachable. 

Message: A connection to the mnsdagent could not be made. Verify that 
the mnsdagent is running, and restart the application. 

Cause: The client has started but it cannot connect to the mnsdagent. If 
the error occurs when the client is accessing context, the client 
exits. If the error occurs when the client is setting context to 
launch another tool, the client continues but the tool launches 
without context.
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Invalid or Missing Definition File

Message: The file <filename> is missing or contains an invalid definition.

Cause: The client has encountered errors reading or parsing shelf, card, 
or port definition files.
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VPN Monitor 

The VPN Monitor tool provides fault management capabilities for Passport 
Internet Protocol (IP) Virtual Private Network (VPN) services. Using VPN 
Monitor, you can detect and diagnose faults in the components that comprise 
the VPN. You can also start other MDM tools to further diagnose and take 
corrective action.

VPN Monitor supports the following types of Passport VPNs:

• “RFC 2764” (page 278)

• “RFC 2547” (page 287)

• “Direct virtual router to virtual router” (page 294)

Navigation
• “Prerequisites to using the VPN Monitor tool” (page 254)

• “Procedures” (page 255)

• “VPN Monitor interface” (page 268)

• “Tool fundamentals” (page 274)

ATTENTION Passport 6000 nodes with P7.0.x software release do not 
support the VPN ID attribute so the virtual routers are not 
loaded into the MDM Administration Database. 
Consequently, the VPN management tools introduced in 
MDM 14.3, including IP VPN Service Provisioning and 
VPN Monitor cannot be used.
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Prerequisites to using the VPN Monitor tool
• The MDM Administration Database must be configured and running. 

For details, see 241-6001-400 Preside MDM Administration Database 
User Guide.

• The VPN Monitor Extractor and VPN Monitor servers must be 
configured and running. For details, see 241-6001-310 Preside MDM 
Server Reference Guide.
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Procedures
The VPN Monitor tool lets you monitor Passport IP VPN services. The tool 
monitors, calculates, and displays the status of basic services. Based on these 
state values, you can further diagnose problems and take corrective action. 
This section contains the following VPN Monitor procedures:

Starting and stopping the VPN Monitor tool

• “Starting VPN Monitor from the MDM toolset” (page 256)

• “Starting VPN Monitor from the command line” (page 257)

• “Quitting VPN Monitor” (page 258)

Getting online help

• “Displaying VPN Monitor online help” (page 259)

Modifying the VPN Monitor window

• “Opening pop-up menus” (page 260)

• “Adjusting pane sizes” (page 261)

• “Displaying or hiding the tool bar” (page 262)

Working with basic services and service clusters

• “Displaying or hiding subcomponents” (page 263)

• “Displaying service view components” (page 264)

• “Displaying basic service components” (page 265)

• “Finding basic services or service clusters in the provider edge network” 
(page 266)

Starting other MDM tools

• “Starting other MDM tools from VPN Monitor” (page 267)
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Starting VPN Monitor from the MDM toolset
VPN Monitor lets you monitor Passport IP virtual private network (VPN) 
services. 

When the VPN Monitor client starts, it uses the server on the host specified 
in the Service Selection dialog box. For situations where you need to restart 
VPN Monitor, ensure the appropriate host is specified in the Server Selection 
dialog box before you start VPN Monitor.

Prerequisites
Before you can start VPN Monitor, the following items must be up and 
running:

• MDM Administration Database
For details, see 241-6001-400 Preside MDM Administration Database 
User Guide.

• VPN Monitor Extractor
For details, see 241-6001-310 Preside MDM Server Reference Guide.

• VPN Monitor Server
For details, see 241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 On the Preside Multiservice Data Manager window, select Fault and then 

VPN Monitor.

The Configuration Synchronizing dialog box opens and displays the 
status of the configuration loading process.

2 When the Configuration Synchronizing dialog box indicates that the 
configuration has finished loading (configuration loaded), click OK.

The dialog box closes and the VPN Monitor window is populated with 
VPN information.
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Starting VPN Monitor from the command line
VPN Monitor lets you monitor Passport IP virtual private network (VPN) 
services. 

When the VPN Monitor client starts, it uses the server on the host specified 
in the Service Selection dialog box. For situations where you need to restart 
VPN Monitor, ensure the appropriate host is specified in the Server Selection 
dialog box before you start VPN Monitor.

Prerequisites
Before you can start VPN Monitor, the following items must be up and 
running:

• MDM Administration Database|
For details, see 241-6001-400 Preside MDM Administration Database 
User Guide.

• VPN Monitor Extractor
For details, see 241-6001-310 Preside MDM Server Reference Guide.

• VPN Monitor Server
For details, see 241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 From the UNIX command line, type the following command:

/opt/MagellanNMS/bin/VPNMonitorClient

The Configuration Synchronizing dialog box opens and displays the 
status of the configuration loading.

2 When the Configuration Synchronizing dialog box indicates that the 
configuration has finished loading (configuration loaded), click OK.

The dialog box closes and the VPN Monitor window is populated with 
VPN information.
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Quitting VPN Monitor
Use this procedure to quit the VPN Monitor tool. 

Procedure steps
1 On the File menu, click Exit.

The VPN Monitor window closes.
241-6001-011   15.1RSUP   



Chapter 5 VPN Monitor   259
Displaying VPN Monitor online help
Use this procedure to view online help for the VPN Monitor tool. You can 
display various types of online help. Help on Window provides a description 
of the elements of the VPN Monitor window. What’s This? displays online 
information about a specific area of the VPN Monitor window. 

Procedure steps
Help on Window
1 On the Help menu, click Help on Window. 

The online help window opens with a description of the VPN Monitor 
window.

What’s This?
1 On the Help menu, click What’s This?

The mouse pointer changes to a question mark (?).

2 Move the mouse pointer onto an area of the window for which you want 
help and click the mouse button. 

The online help window opens with information specific to the area you 
selected. 
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Opening pop-up menus
Pop-up menus are visible when you right-click on services or service clusters 
in the VPN Monitor window. These pop-up menus provide additional 
commands that are specific to the selected area of the window. Use this 
procedure to open a pop-up menu.

Procedure steps
1 Right-click any basic service or service cluster in the navigation, status, or 

recent events pane. 

A pop-up menu opens.

2 Select a command from the pop-up menu. 

The command executes and the pop-up menu closes.
241-6001-011   15.1RSUP   



Chapter 5 VPN Monitor   261
Adjusting pane sizes 
The VPN Monitor contains various panes. You can adjust these pane sizes. 
Any adjustments that you make remain in effect until you readjust the settings 
or until you close the window. Use this procedure to adjust the sizes of these 
panes 

Procedure steps
1 To adjust the height or width of a pane, drag the box in the sash to the 

desired location.

When you move a sash to increase the amount of space in one pane, the 
space for the other panes decreases correspondingly.

2 To open or close a pane, click the triangles in the sash. 

Drag the sash 
boxes to change 
a panel size

Click the sash triangles to 
open or close a panel
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Displaying or hiding the tool bar
You can display or hide the VPN Monitor tool bar. 

Procedure steps
1 Use one of the following methods: 

• To hide the tool bar, on the Options menu, click to select the 
Standard Tool bar option.

• To display the hidden tool bar, on the Options menu, click to clear the 
Standard Tool bar option.
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Displaying or hiding subcomponents
The navigation pane represents the hierarchical structure of the VPN. Use this 
procedure to display or hide subcomponents within the hierarchy. All 
components in the navigator pane that are not expanded display with a plus 
(+) sign. Components that are fully expanded display with a minus sign (-).

Procedure steps
1 To expand the component, click the plus sign (+) adjacent to the 

component you want to expand or double-click a component.

When the component expands, the plus sign changes to a minus sign.

2 To compress subcomponents, click the minus sign adjacent to the parent 
component.

When the component compresses, the minus sign changes to a plus sign. 
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Displaying service view components
You can display the status of views, service clusters, and basic services. 

Procedure steps
1 Select an entry in the navigation panel.

The states of the selected entry and its associated subcomponents 
display in the status pane.

If you select from the 
navigation panel...

Then the status panel is populated with 
information about...

a core network views that comprise the core network

a view service clusters that comprise the views

a service cluster basic services that comprise the service clusters
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Displaying basic service components
You can display the Passport components that comprise a basic service. 

Procedure steps
1 Select an entry from the navigation panel that displays basic services in 

the status pane.

2 In the status pane, right-click the basic service for which you want to 
display Passport components and then click Show Components.

The Components dialog box opens and displays the Passport 
components that comprise the basic service as well as the state of each 
component.

3 If required, to update the state of basic service components, click 
Refresh. 
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Finding basic services or service clusters in the provider 
edge network

You can search for all occurrences of a specific basic service or service cluster 
in the provider edge (PE) network. 

Procedure steps
1 Use any of the following methods:

• In the navigation pane, right-click any entry in the core routing, 
devices, or VPNs service view.

• In the status pane, right-click a basic or service cluster.

• In the recent event pane, right-click a basic service.

A pop-up menu opens.

2 On the pop-up menu, click Find.

The Find dialog box opens and displays the selected service name, the 
scope, and all occurrences of the selected service in the PE network

3 Optionally, you can search another PE network or search all PE networks 
by selecting an entry from the Scope list.
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Starting other MDM tools from VPN Monitor
The VPN Monitor tool provides a selection of fault capabilities. To perform 
additional fault, configuration, and performance tasks, you can start other 
tools from VPN Monitor.

Procedure steps
1 In the navigation panel, select an entry that displays basic services in the 

status pane.

2 Right-click a basic service entry in the status pane and then click Show 
Components.

The Components dialog box opens and displays a list of the basic 
service components.

3 Right-click an entry in the Components dialog box and then select an 
MDM fault, performance, or system tool.

The MDM tool opens in the context of the selected component.
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VPN Monitor interface
The VPN Monitor tool displays VPN services and the status of those services 
in a single window. VPN Monitor facilitates the diagnosis of IP VPN services 
and components in the Passport network. 

See the following topics for details about the VPN Monitor interface:

• “Menu bar” (page 269)

• “Tool bar” (page 270)

• “Navigation pane” (page 270)

• “Status pane” (page 272)

• “Recent status pane” (page 272)

• “VPN Monitor dialog boxes” (page 272)

The figure “VPN Monitor window” (page 269) shows a sample VPN Monitor 
window with an RFC 2764 VPN network.
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Figure 20
VPN Monitor window

Menu bar
The menu bar contains the following menus:

• “File” (page 270)

• “Options” (page 270)

• “Help” (page 270)

Menu 
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Tool
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pane

Status
pane

Recent status pane
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File 
The File menu contains the following command:

• Exit closes the window and exits the tool. See the procedure “Quitting 
VPN Monitor” (page 258).

Options
The Options menu contains the following command:

• StandardToolbar displays or hides the standard tool bar. See the 
procedure “Displaying or hiding the tool bar” (page 262).

Help
The Help menu contains the following commands:

• Help On Window displays descriptive information about the VPN 
Monitor window components. See the procedure “Displaying VPN 
Monitor online help” (page 259).

• What’s This? changes the pointer to a question mark (?). While the 
cursor is a question mark, you can display help for various parts of the 
window. See the procedure “Displaying VPN Monitor online help” 
(page 259).

Tool bar
The standard tool bar contains icons that let you move backward or forward 
through the selections in the navigation pane. Selecting the back icon (<) 
changes the display in the navigation pane to the previous selection. VPN 
Monitor keeps a history of the previous 10 selections in the tree. Selecting the 
forward icon (>) changes the display to the next most recent selection in the 
navigation pane. 

Navigation pane
The navigation pane displays core networks and their associated views. This 
pane contains 2 columns. The first column indicates the computed state of all 
items in the navigation tree. For details about how the state is derived, see 
“VPN state color conventions” (page 299). As well as the state color 
indicator, the column also displays the number of critical or troubled 
subcomponents. See the figure “VPN Monitor states” (page 271).
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The second column displays the navigation tree which defines the 
hierarchical structure of VPN provider edge (PE) networks and their 
associated views. For RFC 2764 and RFC 2547, the top level of the VPN 
hierarchy in the navigation pane is the PE network. This PE network element 
corresponds to the PE network entity in the MDM. The next level shows the 
service views—core routing, devices, and VPNs.

Figure 21
VPN Monitor states

 For direct VR-VR VPNs, the top level of the VPN hierarchy is direct VR-VR 
This entity is created in VPN Monitor. The next level shows the service views 
—VPNs and devices.

The navigation pane supports a pop-up menu. Right-clicking a service cluster 
in the navigation pane opens a pop-up menu that lets you search for all 
occurrences of the selected service in the Provider Edge (PE) network. See 
the procedure “Finding basic services or service clusters in the provider edge 
network” (page 266).

OSLO_VCG1 service 
cluster has a status of 
1C+ indicating one of its 
basic services is critical 
(1C). The plus (+) 
indicates at least one 
other basic service is 
troubled. 

The status pane shows 
which basic service is 
critical and which is 
troubled
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Status pane
The contents of the status pane depend on what you select in the navigation 
pane. When you make a selection in the navigation pane, the status pane 
displays the components that make up the selected service. For each 
component, the status pane also displays the associated status, service type, 
customer name, and status time stamp.

The status pane supports pop-up menus. For basic services and service 
clusters the pop-up menu lets you search for all occurrences of the selected 
service in the provider edge network. See the procedure “Finding basic 
services or service clusters in the provider edge network” (page 266). The 
pop-up menu for basic services also lets you show all components of the 
selected service. See “Displaying basic service components” (page 265).

Recent status pane
The recent status pane displays basic service status changes generated by the 
VPN Monitor Server. Events display in chronological order.

The recent event pane supports pop-up menus. For basic services the pop-up 
menu lets you search for all occurrences of the selected service in the provider 
edge network. See the procedure “Finding basic services or service clusters 
in the provider edge network” (page 266). The pop-up menu also lets you 
show all components of the selected service. See “Displaying basic service 
components” (page 265).

VPN Monitor dialog boxes
VPN Monitor also contains the following dialog boxes:

• “Find” (page 272)

• “Component” (page 273)

Find
Use the Find dialog box to display all occurrences of a specific basic service 
or service cluster in the provider edge (PE) network.

The Find dialog box contains the following fields:

• Service Name displays the selected basic service or service cluster.
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• Scope indicates the PE network of the selected component. By using the 
associated drop-down menu, you can extend the scope to another PE 
network or all available PE networks.

• Matches lists all occurrences of the selected VPN service. If you select 
a specific entry from this list, the associated container expands in the 
navigation pane and the item is made available in the status pane.

The Find dialog box also contains the following buttons:

• Close closes the dialog box.

• Help displays online help for the Find dialog box. 

Component
The Component dialog box displays the selection of Passport components 
that make up the selected basic service and the state of each of those 
components. 

The Component dialog box contains the following fields:

• State displays the state of each component as it is computed and 
propagated by the VPN Monitor Server. The VPN Monitor Server 
maintains the propagated states for basic service components using the 
NDAM state of the component and any parent components.

• Component Name displays the components of the selected basic 
service. 

The Component dialog box also contains the following buttons:

• Close closes the dialog box.

• Refresh updates the state of basic service components.

• Help displays online help for the Component dialog box. 

Selecting a component in this dialog box puts the component in context for 
use with other MDM tools that also support context.

Right-clicking a component opens a pop-up menu that lets you start other 
MDM fault, performance, and system tools in context of the selected 
component. 
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Tool fundamentals
The VPN Monitor tool monitors network components that make up the VPN 
services so that you can detect and correct troubled elements within the 
service. VPN Monitor displays VPN topology along with state information so 
that you can easily identify and navigate troubled areas. From VPN Monitor, 
you can also start other MDM fault management tools to further investigate 
and correct faults.

For tool fundamental details, see the following topics:

• “Capabilities” (page 275)

• “Service selection” (page 275)

• “Service views” (page 276)

• “VPN Monitor architecture” (page 276)

• “RFC 2764” (page 278)

— “Basic service creation conventions” (page 278)

— “Basic service schema” (page 279)

— “Basic service components” (page 279)

— “Basic service state after component deletion” (page 282)

— “Basic service initial timestamp” (page 282)

— “RFC 2764 service clusters” (page 282)

— “RFC 2764 provider edge network service views” (page 284)

• “RFC 2547” (page 287)

— “RFC 2547 basic services” (page 287)

— “RFC 2547 service clusters” (page 290)

— “RFC 2547 provider edge network service views” (page 291)

• “Direct virtual router to virtual router” (page 294)

— “Direct VR-VR basic services” (page 294)

— “Direct VR-VR service clusters” (page 297)

— “Direct VR-VR VPN views” (page 298)
241-6001-011   15.1RSUP   



Chapter 5 VPN Monitor   275
• “VPN state color conventions” (page 299)

• “Basic service states” (page 300)

• “Service cluster states” (page 300)

• “Core networks and view states” (page 301)

Capabilities
The VPN Monitor tools provides the following capabilities:

• monitoring of Passport VPNs based on RFC 2764, RFC 2547, and direct 
VR-to-VR VPNs

• displaying fault and state information for components that comprise a 
service

• displaying core routing service views for RFC 2764 and RFC 2547

• displaying VPNs service views on IP-enabled Passport network elements

• displaying device service views on IP-enabled Passport network 
elements

• polling the MDM Administration Database on a periodic basis to 
updated the client views

• launching other tools to further diagnose or correct faults in the VPN

Service selection
Service selection is used to define which workstation is to be used to run a set 
of servers for selected MDM applications. System-wide settings are 
determined by the network administrator, but you can set a user-specific 
service selection for the duration of your MDM session. For details about 
service selection, see the section about using the Service Selection tool in 
241-6001-303 Preside MDM Administrator Guide.

If a service selection change occurs during your VPN Monitor session, VPN 
Monitor retains its communication with the original workstation. The next 
time you start VPN Monitor, the new service selection host is used.
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Service views
The VPN Monitor tool extracts VPN-related information from the MDM 
Administration Database and creates service-level views of VPNs. VPN 
Monitor displays these views as basic services or service clusters. 

Basic services
Basic services are logical representations of network services. These services 
are an aggregation of components, some of which have state values. The basic 
service state is derived from the actual state of the components it contains. An 
example of a basic service is the router element which represents the Passport 
software entity that emulates a physical router. 

For details about basic services, see the following topics:

• “RFC 2764 basic services” (page 278)

• “RFC 2547 basic services” (page 287)

• “Direct VR-VR basic services” (page 294)

Service clusters
Service clusters represent an aggregation of basic services or an aggregation 
of other service clusters. These aggregations create the following service 
types: VPN, site, core router, and customer router. Service cluster states are 
derived from the state of its constituent service clusters or basic services. An 
example of a service cluster is the VPN cluster which represents the 
collection of basic services of the whole customer VPN.

For details about service clusters, see the following topics:

• “RFC 2764 service clusters” (page 282)

• “RFC 2547 service clusters” (page 290)

• “Direct VR-VR service clusters” (page 297)

VPN Monitor architecture
VPN Monitor provides a client-server based monitoring system for VPNs and 
consists of the following components:

• VPN Monitor extractor 

• VPN Monitor server
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• VPN Monitor client

The VPN Monitor extractor collects VPN configuration data from the MDM 
Administration Database and delivers this data to the VPN Monitor server 
and client. For details, see the section on the VPN Monitor Extractor section 
in 241-6001-310 Preside MDM Server Reference Guide.

The VPN Monitor server collects fault data consisting of raw state and state 
change notifications for basic service components, calculates the overall state 
of each VPN basic service, and passes this information to the VPN Monitor 
client. For details, see the section on the VPN Monitor Server section in 
241-6001-310 Preside MDM Server Reference Guide.

The VPN Monitor client displays the VPN services and the status of those 
services. From the client, you can start other MDM fault, configuration, and 
performance management tools.
Preside MDM Fault Management User Guide   15.1RSUP



278   Chapter 5 VPN Monitor
RFC 2764
For a description of RFC 2764 VPNs, see the following topics:

• “RFC 2764 basic services” (page 278)

• “RFC 2764 service clusters” (page 282)

• “RFC 2764 provider edge network service views” (page 284)

RFC 2764 basic services
The table “RFC 2764 basic service descriptions” (page 278) lists the RFC 
2764 basic services and their descriptions. 

Basic service creation conventions
During the creation of a tunnel access point when you have created a logical 
interface on a core router but have not yet linked this interface to a customer 
VR, VPN Monitor associates a basic service of core access point with this 
logical interface. When you link a customer VR to the logical interface, VPN 
Monitor changes the association to tunnel access point.

Table 36
RFC 2764 basic service descriptions

Basic service Description

Router element represents the Passport software entity that 
emulates a physical router or a virtual common 
gateway.

Core access point represents the access to the backbone that 
interconnects the virtual common gateways.

Tunnel end point represents the point-to-multipoint (PTMP) tunnel 
end point at the router element and corresponds 
to a private address.

Tunnel access point represents the PTMP tunnel aggregation of the 
router elements on the core router and 
corresponds to a public address. 

Site access point represents an instance of customer access to a 
router element on the Passport device.
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If a loopback logical interface for IP routing is present on the VR (for 
example, when using BGP), then VPN Monitor associates a basic service of 
core access point with the interface.

Basic service schema
The figure “RFC 2764 basic service schema” (page 279) shows these basic 
services in an RFC 2764 IP VPN.

Figure 22
RFC 2764 basic service schema

Basic service components
The table “RFC 2764 basic service components” (page 280) details the 
Passport components that comprise each of the basic service.
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Table 37
RFC 2764 basic service components

Basic services Components

Router element

Customer EM/ Vr/
EM/ Vr/ Ip
EM/ Vr/ Ip Tunnel

Core EM/ Vr/
EM/ Vr/ Ip

Core access point EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ <media component>/ 1

Tunnel end point EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ Vr/ Ip Tunnel

Tunnel access point EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ Vm/ If/

Site access point

Backhaul FrDte at the Fruni connection end point node:
EM/A Fruni/x
EM/A Fruni/ xFramer
EM/A Fruni/ xLMI
EM/A Fruni/ xDlci/ 2

at the IP service node where the router element resides:
EM/B Fruni/y
EM/B FrDte/y
EM/B FrDte/ RemoteGroup/
EM/B Vr/ Pp/
EM/B Vr/ Pp/ IpPort
EM/B Vr/ Pp/ IpPort LogicalIf/
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Direct FrDte EM/ Fruni/x
EM/ Fruni/ Framer
EM/ Fruni/ Lmi
EM/ Fruni/ Dlci/x 2

EM/ Fruni/x
EM/ FrDte/x
EM/ FrDte/ Remote Group/
EM/ Vr/ Pp
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/

IP-optimized FR 
(backhaul)

at the Fruni connection end point node:
EM/A Fruni/x
EM/A Fruni/ LMI
EM/A Fruni/ Framer
EM/A Fruni/ Dlci/x 2

at the IP service node where the virtual router resides:
EM/B Fruni/y
EM/B Vr/ Pp/
EM/B Vr/ Pp/ IpPort
EM/B Vr/ Pp/ IpPort LogicalIf/
EM/B IpDlciGroup/

IP-optimized FR 
(local)

EM/ Fruni/x
EM/ Fruni/ Framer
EM/ Fruni/ Lmi
EM/ Fruni/ Dlci/ 2

EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ IpDlciGroup/

1 Media component may change depending on the backbone.
2 One for each IPCos.

Note:  Where applicable, Fruni can be replaced by Frnni.

Note:  For backhaul scenarios, there may be more than one Fruni with Dlcis. In this case, these 
Frunis and their associated Dlci, Lmi. and Framer components are included in the basic service.

Table 37 (Continued)
RFC 2764 basic service components

Basic services Components
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Basic service state after component deletion
When you delete components of a basic service, the basic service state, as 
shown in VPN Monitor, remains as is until the following events occur:

• the MDM Administration Database is updated to reflect the component 
changes

• the VPN Monitor Extractor detects the changes when it automatically 
polls the MDM Administration Database or the administrator manually 
polls for database changes using the VPNMonitorExtractor.kick script

After VPN Monitor receives these component changes through polling, it 
determines the new state of the basic service.

Basic service initial timestamp
When the VPN Monitor Server starts, it collects and calculates the state of 
each basic service, based on the state of the service’s components. If there are 
no faults against a basic service’s components, the basic service is given a 
state of in-service. To maintain the integrity of performance and scalability, 
when VPN Monitor starts, the client retrieves the states for all basic services 
which are not currently in-service. As a result, the initial time stamp for 
services that are in-service is “00/01/01 00:00:00”. The initial time stamp 
remains until a state change occurs.

RFC 2764 service clusters
The table “RFC 2764 service cluster descriptions” (page 282) lists RFC 2764 
service clusters and their description. The figure “RFC 2764 service clusters” 
(page 284) shows sample service clusters.

Table 38
RFC 2764 service cluster descriptions

Service cluster Description

Core router represents the core router element and its 
access points to tunnels and the backbone 
connection.

Customer router represents the router element and its access 
point to the tunnel and its customer interfaces.
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Site represents a collection of customer site access 
points to one or more router elements.

VPN represents the entire customer VPN and 
includes all associated customer routers and 
sites.

Table 38 (Continued)
RFC 2764 service cluster descriptions

Service cluster Description
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Figure 23
RFC 2764 service clusters 

RFC 2764 provider edge network service views
VPN Monitor uses basic service and service cluster data to construct and 
display VPN information in an hierarchical, or service view, arrangement. 
RFC 2764 has the following service views:

• Core Routing for views of the VCGs on IP-enabled Passport devices

• Devices for views of both VCGs and VRs on IP-enabled Passport devices
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• VPNs for views of the VPNs currently defined on IP-enabled Passport 
devices

For details about service views, see “RFC 2764 provider edge network 
service views” (page 286).
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Figure 24
RFC 2764 provider edge network service views 

Core Network

Core routing

Core router
Router element
Core access point
Tunnel access point

Virtual Private Network

Customer router
Router element
Tunnel end point
Site access point

Site

Site access point

VPNs

Device

Core router
Router element
Core access point
Tunnel access point

Customer router
Router element
Tunnel end point
Site access point

Devices

Service clusters Basic services
241-6001-011   15.1RSUP   



Chapter 5 VPN Monitor   287
RFC 2547
VPN Monitor supports RFC 2547. For details, see the following sections:

• “RFC 2547 basic services” (page 287)

• “RFC 2547 service clusters” (page 290)

• “RFC 2547 provider edge network service views” (page 291)

RFC 2547 basic services
The table “RFC 2547 basic service descriptions” (page 287) lists RFC 2547 
basic services and their description. The figure “RFC 2547 basic service 
schema” (page 288) shows these basic services in an RFC 2547 IP VPN.

Basic service creation conventions
Logical interfaces associated with a loopback address (for example, Rtr/ If/

lb) have a basic service type of core access point.

Table 39
RFC 2547 basic service descriptions

Basic service Description

Router element represents a Passport router or a VPN routing 
function.

Core access point represents the access to the backbone that 
interconnects router elements.

Site access point represents an instance of customer access to a 
customer router element on the Passport device.
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Figure 25
RFC 2547 basic service schema

The table “RFC 2547 basic service components” (page 288) details the 
Passport components that comprise each of the basic services.

Table 40
RFC 2547 basic service components

Basic services Components

Router element

Customer EM/ Rtr/ Vrf/

Core EM/ Rtr/ 

Core access point EM/ Rtr/ If/
EM/ Rtr/ If/ <Media component> 2

EM/ Rtr/ If/ <MPLS signalling component> 3
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Site access point

IP-optimized FR 
(backhaul)

at the Fruni connection end point node:
EM/A Fruni/
EM/A Fruni/ Lmi
EM/A Fruni/ Framer
EM/A Fruni/ Dlci/ 4

at the router node:
EM/B Fruni/x
EM/B Fruni/y
EM/B Rtr/ Vrf/ If/ 
EM/B Rtr/ Vrf/ If/ IpODlci

IP-optimized FR 
(local)

EM/ Fruni/
EM/ Fruni/ Framer
EM/ Fruni/ Lmi
EM/ Fruni/ Dlci/ 4

EM/ Rtr/ Vrf/ If/
EM/ Rtr/ Vrf/ If/ IpODlci

Local ATM EM/ AtmIf/
EM/ AtmIf/ Vcc/4

EM/ Rtr/ Vrf/ If/
EM/ Rtr/ Vrf/ If/ AtmMpe
EM/ Rtr/ Vrf/ If/ AtmMpe Ac/4

1 May differ depending on MPLS type.
2 The media component may change depending on the backbone.
3 An optional component that depends on an EM/ Rtr/ If subcomponent representing the MPLS 
signalling protocol on the interface, for example, LdpIf.
4 One for each IPCos.

Note:  Where applicable, Fruni can be replaced by Frnni.

Note:  For backhaul scenarios, there may be more than one Fruni with Dlcis. In this case, these 
Frunis and their associated Dlci, Lmi. and Framer components are included in the basic service

Table 40 (Continued)
RFC 2547 basic service components

Basic services Components
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RFC 2547 service clusters
The table “RFC 2547 service cluster descriptions” (page 290) lists RFC 2547 
service clusters and their descriptions. The figure “RFC 2547 service 
clusters” (page 291) shows sample service clusters.

Table 41
RFC 2547 service cluster descriptions

Service cluster Description

Core router represents the router and its interfaces to the 
backbone.

Customer router represents the VPN routing function and its 
customer site access points. 

Site represents a collection of customer site access 
points to one or more virtual routers.

VPN represents the entire customer VPN and 
includes VPN routing functions on different 
Passports and all of their corresponding site 
access points.
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Figure 26
RFC 2547 service clusters

RFC 2547 provider edge network service views
The VPN Monitor uses basic service and service cluster data to construct and 
display VPN information in an hierarchical, or service view, arrangement. 
RFC 2547 has the following service views:

• Core Routing for views of the routers on IP-enabled Passport devices.

• Devices for views of both the routers and VRFs on IP-enabled Passport 
devices.
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• VPNs for views of the VPNs currently defined on IP-enabled Passport 
devices.

For details about service views, see “RFC 2547 provider edge network 
service views” (page 293).
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Figure 27
RFC 2547 provider edge network service views 
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Direct virtual router to virtual router
VPN Monitor supports direct virtual router to virtual router (VR-VR) VPNs. 
For details, see the following sections:

• “Direct VR-VR basic services” (page 294)

• “Direct VR-VR service clusters” (page 297)

• “Direct VR-VR VPN views” (page 298)

Direct VR-VR basic services
The table “Direct VR-VR basic service descriptions” (page 294) lists direct 
VR-VR basic services and their description. The figure “Direct VR-VR VPN 
schema” (page 295) details the Passport components that comprise each of 
the basic services.

Table 42
Direct VR-VR basic service descriptions

Basic service Description

Router element represents the Passport software entity that 
emulates a physical router and is used for a 
virtual router.

Core access point represents the access to the backbone that 
interconnects router elements and is a peer to 
other core access points on other router 
elements in the VPN. 

Site access point represents an instance of customer access to a 
router element on the Passport device.
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Figure 28
Direct VR-VR VPN schema

The table “Direct VR-VR VPN basic service components” (page 295) details 
the Passport components that comprise each of the basic services.

Table 43
Direct VR-VR VPN basic service components

Basic services Components

Router element EM/ Vr/
EM/ Vr/ Ip/

Core access point EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ AtmMpe/
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Site access point

Backhaul FrDte at the Fruni connection end point node:
EM/A Fruni/x
EM/A Fruni/ xFramer
EM/A Fruni/ xLMI
EM/A Fruni/ xDlci/ 1

at the IP service node where the router element resides:
EM/B Fruni/y
EM/B FrDte/y
EM/B FrDte/ RemoteGroup/
EM/B Vr/ Pp/
EM/B Vr/ Pp/ IpPort
EM/B Vr/ Pp/ IpPort LogicalIf/

Direct FrDte EM/ Fruni/x
EM/ Fruni/ Framer
EM/ Fruni/ Lmi
EM/ Fruni/ Dlci/x 1

EM/ Fruni/x
EM/ FrDte/x
EM/ FrDte/ Remote Group/
EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/

IP-optimized FR 
(backhaul)

at the Fruni connection end point node:
EM/A Fruni/x
EM/A Fruni/ LMI
EM/A Fruni/ Framer
EM/A Fruni/ Dlci/ 1

at the IP service node where the virtual router resides:
EM/B Fruni/y
EM/B Vr/ Pp/
EM/B Vr/ Pp/ IpPort
EM/B Vr/ Pp/ IpPort LogicalIf/
EM/B IpDlciGroup/

Table 43 (Continued)
Direct VR-VR VPN basic service components

Basic services Components
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Direct VR-VR service clusters
The table “Direct VR-VR service descriptions” (page 297) lists direct VR-
VR basic services and their description. The figure “Direct VR-VR service 
clusters” (page 298) shows sample service clusters.

IP-optimized FR 
(local)

EM/ Fruni/x
EM/ Fruni/ Framer
EM/ Fruni/ Lmi
EM/ Fruni/ Dlci/ 1

EM/ Vr/ Pp/
EM/ Vr/ Pp/ IpPort
EM/ Vr/ Pp/ IpPort LogicalIf/
EM/ IpDlciGroup/

1 One for each IPCos.

Note:  Where applicable, Fruni can be replaced by Frnni.

Note:  For backhaul scenarios, there may be more than one Fruni with Dlcis. In this case, these 
Frunis and their associated Dlci, Lmi. and Framer components are included in the basic service.

Table 44
Direct VR-VR service descriptions

Basic service Description

Customer router represents a virtual router and its interfaces.

Site represents a collection of customer site access 
points to one or more virtual routers. 

VPN represents the entire customer VPN and 
includes customer virtual routers on different 
Passports, the core access points that connect to 
these virtual routers, and all site access points.

Table 43 (Continued)
Direct VR-VR VPN basic service components

Basic services Components

 (Sheet 3 of 3)
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Figure 29
Direct VR-VR service clusters

Direct VR-VR VPN views
The VPN Monitor uses basic service and service cluster data to construct and 
display VPN information in an hierarchical, or service view, arrangement. 
Direct VR-VR has the following views:

• Devices for views of VRs on IP-enabled Passport devices.

• VPNs for views of the direct VR-to-VR IP VPNs currently defined on IP-
enabled Passport devices.

For details about service views, see “Direct VR-VR VPN views” (page 299).

VR

VR

VR

Customer A 
Site 3

Customer A 
Site 1

Customer A 
Site 2

Customer 
Router 
Cluster

VPN Cluster
(includes customer 
router clusters and 

site clusters) Site 
Cluster
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Figure 30
Direct VR-VR VPN views 

VPN state color conventions
The VPN Monitor tool uses standard MDM color conventions to indicate the 
network model states of components. For a description of the default MDM 
state colors and their meaning, see the following tables: 

• “Basic service states” (page 300)

• “Service cluster states” (page 300)

• “Core networks and view states” (page 301)

These tables list MDM states from the most severe (critical) to the least severe 
(normal).

Direct VR-VR

Virtual Private Network

VPNs

Device

Customer router

Devices

Customer router
Router element
Core access point
Site access point

Site

Site access point

Router element
Core access point
Site access point

Service clusters Basic services
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Basic service states
VPN Monitor computes the state of a basic service based on the states of its 
components. The table “Basic service states” (page 300) lists basic service 
colors, their associated MDM states, and rules for state determination.

Service cluster states
The states of service clusters are based on the states of basic services or other 
service clusters that comprise the service clusters. The table “Service cluster 
states” (page 301) lists service cluster colors, their associated MDM states, 
and rules for state determination. 

Table 45
Basic service states

Background color MDM state Description 

Red Critical At least one component is 
out-of-service (OOS).

Grey Unmanaged The current status of all 
components is unknown 
(UNK). This state may occur 
during server startup when 
the server has not fully 
retrieved its data.

Yellow Troubled The service is up but has an 
event against it.

Green Normal The service has a normal 
state.
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Core networks and view states
The states of provider edge (PE) networks and views are based on the most 
severe status of the service clusters that comprise the PE networks or views. 
The order of severity is critical, unmanaged, troubled, and normal. The table 
“Service cluster states” (page 301) lists PE network and view state colors, 
their associated MDM states, and rules for state determination. 

Table 46
Service cluster states

Background color MDM state Description 

Red Critical All basic services and service 
clusters have a critical state. 

Yellow Troubled At least one basic service or 
service clusters is troubled, 
critical, or unmanaged. 

Green Normal All basic services and service 
clusters have a normal state. 

Table 47
Core network and view states

Background color MDM state Description 

Red Critical One or more clusters are 
critical.

Yellow Troubled One or more clusters are 
troubled. Other clusters may 
be normal. 

Green Normal All service clusters are 
normal. 
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Alarm Display

The Alarm Display tool allows you to view and manage logs and active 
alarms in your network.

• “Alarm Display basic procedures” (page 303)

• “Alarm Display interface in the MDM Toolset” (page 328)

• “Alarm Display interface in MDM Operator Client” (page 353)

• “Alarm Display fundamentals” (page 361)

Alarm Display basic procedures
Use Alarm Display to acknowledge alarms, filter alarms and clear alarms. 
The Alarm Display also supports other basic procedures related to changing 
display properties and setting effects.

Navigation
Starting and exiting

• “Starting Alarm Display” (page 305)

• “Exiting Alarm Display” (page 306)

• “Starting other tools from Alarm Display” (page 306)

Changing the alarm display

• “Changing alarm display modes in MDM Toolset” (page 307)

• “Changing alarm display modes in MDM Operator Client” (page 307)

• “Changing alarm display formats in MDM Toolset” (page 308)
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• “Setting the auto-refresh interval in MDM Toolset” (page 315)

• “Sorting the alarm list by component Id in MDM Toolset” (page 319)

• “Sorting the alarm list by time in MDM Toolset” (page 319)

Setting effects

• “Setting alarm effects” (page 308)

Setting and changing alarm display filters

• “Setting alarm filters in MDM Toolset” (page 309)

• “Setting a simple filter in MDM Operator Client” (page 311)

• “Setting an advanced filter in MDM Operator Client” (page 312)

• “Changing filters in MDM Toolset” (page 313)

• “Changing an advanced filter in MDM Operator Client” (page 314)

Sorting alarms

• “Sorting the alarm list by component Id in MDM Toolset” (page 319)

• “Sorting the alarm list by time in MDM Toolset” (page 319)

• “Sorting the alarm list in MDM Operator Client” (page 319)

Clearing alarms

• “Clearing alarms locally” (page 316)

• “Clearing alarms globally” (page 317)

• “Clearing an alarm globally using the Global Clear tool in MDM 
Toolset” (page 318)

 Working with a customer database

• “Setting customer database preferences in MDM Toolset” (page 320)

• “Restoring customer database preferences in MDM Toolset” (page 321)

• “Resetting the customer database information cache in MDM Toolset” 
(page 321)
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Working with log files

• “Saving alarm information to a log file in MDM Toolset” (page 322)

• “Saving alarm information to a log file in MDM Operator Client” 
(page 322)

• “Viewing a log file in MDM Toolset” (page 323)

• “Viewing a log file in MDM Operator Client” (page 323)

Starting Alarm Display
Start the Alarm Display tool to view alarms and logs and perform actions such 
as alarm filter, alarm acknowledgement, and alarm clearing.

Procedure steps
1 From the Fault menu,

if running... select... to..

MDM Toolset Alarm Display: Active

Alarm Display: Log

start Alarm Display in active mode

start Alarm Display in log mode

MDM Operator 
Client

Alarm Display start Alarm Display. 
You can switch modes from the 
main window.
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Exiting Alarm Display
Exit the Alarm Display tool when you are finished viewing and working with 
alarms.

Procedure steps
1 In the Alarm Display window, select File and then Exit.

If you are running Operator Client, a confirmation dialog box opens.

Starting other tools from Alarm Display
Start other tools when you need to perform procedures and access data from 
other tools while working in Alarm Display. For details on the Start Tool 
menu, see the section about the Start Tool in 241-6001-122 Preside MDM 
Using MDM Toolset and Operator Client Interfaces. The content of the list 
varies depending on component context and access control. Start tool menus 
can be customized. For information about customizing start tools, see the 
section on customizing the toolsets and Start Tool menu in 241-6001-301 
Preside MDM Customization Administrator Guide.

Procedure steps
1 Click on an alarm in the alarm list.

2 Select Start Tool, <category>, and then <tool>.
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Changing alarm display modes in MDM Toolset
When the Alarm Display tool is open, you can easily change from one mode 
to another to display different data. Active mode displays only active alarms. 
Log mode displays all alarms (set, clear, message, and warning) that come 
into gmdr from the time that you change to log mode. Historical mode shows 
all alarms in the gmdr database (inactive set, clear, and message) and all 
incoming alarms.

Procedure steps
1 Select View and then <menu command>.

Changing alarm display modes in MDM Operator Client
When the Alarm Display tool is open, you can easily change from one mode 
to another to display different data. Active mode displays only active alarms. 
Log mode displays all alarms (set, clear, message, and warning) that come 
into gmdr from the time that you change to log mode. Historical mode shows 
all alarms in the gmdr database (inactive set, clear, and message) and all 
incoming alarms (For example: log mode).

Procedure steps
1 From the Alarm Display window, select a mode from the Alarm mode list 

box. The choices are as follows: Active Alarms, Alarm Log, and Alarm 
History.

It may take a few seconds for the display to change, but the status bar at 
the bottom of the window will indicate that the tool is actively retrieving the 
necessary information.

Select menu command... to...

Select Active Alarm Mode change the display from log mode to 
active mode

Select Log Mode change the display from active mode to 
log mode
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Changing alarm display formats in MDM Toolset
Change the format in which alarm information is displayed to see certain 
alarm attributes and details and to control the amount of information that you 
see. Three display formats are available in Alarm Display: terse, normal and 
full. See “Format toggle button” on page 332 for a description of the attributes 
and details that are included in each format.

Procedure steps
1 From the Format toggle button on the Alarm Display window, select 

Terse, Normal, or Full.

Setting alarm effects
Set effects to apply sound and color effects to specific alarm conditions. In 
active mode, effect settings are applied to both existing and incoming set 
alarms. In log mode, effects are applied only to incoming set alarms.

Procedure steps
1 From the Alarm Display menu bar, select Options and then Set Effects.

2 Set the values required for an alarm to sound the bell. The bell selector is 
not available active mode.

3 Set the values required to have an alarm displayed with a colored 
background.

4 Click Save to File.

5 Click Set Effects.

6 Select View-->Turn Bell On to activate effects that you have set.

7 Select View-->Turn Highlight On to activate any color effects that you 
have set.
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Setting alarm filters in MDM Toolset
You can set alarm filters according to severity, component ID, fault code, and 
customer ID. Filter action is defined as either Accept or Reject. Alarms are 
reported through Accept filters if they meet defined criteria; Reject filters 
block the display of alarms having the characteristics you define. For 
example, you can filter the Alarm Display main display by accepting critical 
and major alarms from component PM/R66, and rejecting minor and cleared 
alarms from this component or other specified components. You can combine 
up to 10 accept and reject filters to screen alarms.

Prerequisites
• The user of wildcards is valid for specifying some filter attributes. See 

“Pattern matching using wildcards” on page 369.

• To set filters, you must be familiar with how the Set Filter Dialog box 
operates. See “Set Filter Dialog box” on page 335.

Procedure steps
1 From the Alarm Display window, click Options and then Set Filter.

The Set Filter Dialog box opens. 

2 Enter a filter name in In the Filter Name field.

3 Select an action in the Filter Action area.

4 Select an acknowledge status in the Ack State area.

5 Select alarm severities in the Severity area.

6 Enter a component identifier (ID) in the Components area and click Add 
to add it to the components list.

7 Enter a fault code name in the Fault Codes field and click Add to add it 
to the to the fault codes list.

8 Enter a customer ID in the Customer Ids field and click Add to add a it to 
the customer Ids list.

Note:  You can use up to 40 numbers in the Customer Ids list. To set this 
maximum, change the following resource in your resource file: 
AD*maxNumberOfCustomerIdNumbersPerFilter.

9 Enter a userid in the Ack Userid field and click Add add it to the Ack 
Userid list.
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10 Optionally, enter patterns in the Comment Data and Customer Data 
fields. Wild cards are valid for these fields. All other fields in the Set Filter 
Dialog box are mandatory.

11 Click Add Filter.

The new filter name appears in the Inactive Filters list area.

12 Click Save to File.

13 Select the filter in the Inactive Filters list area and click the up transfer 
arrow to move the filter to the Active Filters list area. 

14 Click Set Filters to close the dialog box and apply the filter.

If the Filter On option is enabled in the Alarm Display main window, the 
filter settings are applied.
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Setting a simple filter in MDM Operator Client
A simple filter filters the display of alarms based on severity. To apply a 
simple filter, Simple must be selected in the Filter list box. Because simple 
filters perform filtering based on only one attribute (severity) only one simple 
filter can be applied at a time. To change the settings of a simple filter, you 
enable or disable the appropriate check boxes.

Procedure steps
1 From the Alarm Display window, select Simple from the Filter Option list 

box.

The check boxes in the Simple Filter area are enabled.

2 Click the check boxes to indicate the severity levels that you want to filter. 
You can enable more than one severity level at a time. When you are in 
active mode, the Cleared check box is disabled.

3 Click Save.

A Message box is displayed stating that your selections are saved.
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Setting an advanced filter in MDM Operator Client
An advanced filter filters the display of alarms based settings for the 
following attributes: component id, fault code, acknowledgement state, event, 
timestamp, comment data and customer id. You can apply one, all, or any 
combination of the available attributes.

Prerequisites
To set advance filters you must be familiar with how the Advanced Filter 
dialog box operate. See “Advanced Filter dialog box” on page 357.

Procedure steps
1 From the Alarm Display window, select Advanced from the Filter Option 

list box.

The Settings and Save buttons in the Advanced Filter area are enabled.

2 Click Settings in the Advanced Filter area.

The Advanced Filter dialog opens.

3 Select an attribute from the attributes list box.

4 Select an option from the options list box.

5 Enter the ID of the component that you want to filter in the target value 
field.

6 Click Add.

The filter is added to the filter list.

7 Click OK.

The filter is applied, and the dialog box closes. The result of the applied 
filter is shown in the alarm list area of the Alarm Display window.

8 Click Save to save the advanced filter.
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Changing filters in MDM Toolset
You can make changes to either inactive or active filters. If you change an 
active filter, the changes are applied to this session. If you change an inactive 
filter, the changes are not applied to this session. An inactive filter is not used 
by the Alarm Display when the filtering option is enabled. 

Procedure steps
1 From the Alarm Display window, click Options and then Set Filter.

The Set Filter Dialog opens.

2 Select a filter. You can select and active or inactive filter.

The Filter Name field updates with the name of the selected filter an the 
corresponding filter attributes are displayed

3 Change filter attributes.

4 Click Change Filter.

5 Click Set Filters.

6 Click Save to File.

All filters are saved to a file. The next time the Alarm Display is started, 
alarms are filtered accordingly.
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Changing an advanced filter in MDM Operator Client
You can make changes to an advanced filter and apply them to the alarms list 
in the Alarm Display.

Prerequisites
• To change advanced filters you must be familiar with how the Advanced 

Filter dialog box operates. See “Advanced Filter dialog box” on 
page 357.

Procedure steps
1 From the Alarm Display window, select Advanced from the Filter Option 

list box.

The Settings and Save buttons in the Advanced Filter area are enabled.

2 Click Settings in the Advanced Filter area.

3 Select a filter from the list.

4 Change the attribute settings as required.

5 Change the value in the target value field, if required.

6 Click Change.

The filter is changed in the filter list.

7 Click OK.

The filter changes are applied, and the dialog box closes. The result of the 
changed filter is shown in the alarm list area of the Alarm Display window.

8 Click Save to save the changes.
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Setting the auto-refresh interval in MDM Toolset
In the active mode you can set the interval between display refreshes. This 
setting controls the time when new, active alarms are inserted or cleared 
alarms are removed from the display.

Procedure steps
1 From the Alarm Display window, click Options and then Set Auto-

Refresh Interval.

2 Use the slider to set the interval.

3 Click OK.

The Set Auto-Refresh Interval dialog box closes. 

4 Set the Auto-Refresh toggle button to On.
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Clearing alarms locally
Clear alarms locally to remove them from the alarm list in Alarm Display and 
from MDM server databases. When you clear an alarm locally, your userID, 
hostname, and the “DISPLAY” environment variable value are displayed in 
the comment data.

Note: When re-synchronized with devices that have an active alarm list, 
the locally cleared alarm may be re-introduced in the servers databases.

Prerequisites
• The GMDR server must be running.

• Alarm Display must be running in active mode.

Procedure steps
1 From the Alarm Display window, click the alarm or alarms that you want 

to clear from the alarm list. To select multiple alarms, hold down the 
Control key while you click the alarms.

2 Right-click on the selected alarm(s).

3 Select Local Clear from the Alarm Menu pop-up menu.

4 In the confirmation dialog, click Yes to clear the alarms.

5 Click Refresh or wait for the next refresh period to have the cleared alarm 
removed from the alarm list.

If one or more requests failed, a dialog box opens with the error 
messages.
241-6001-011   15.1RSUP   



Chapter 6 Alarm Display   317
Clearing alarms globally
Clear alarms globally to remove them from the alarm list in Alarm Display, 
from MDM server databases and from component databases. When you clear 
an alarm globally, your userID, hostname, and the “DISPLAY” environment 
variable value will be displayed in the comment data.

This procedure can only be used to globally clear Passport an DPN alarms..

Prerequisites
• GMDR server must be running.

• To clear alarms globally, global alarm clearing must be configured on the 
DMA server and the GMDR server must be able to access the DMA 
server.

• Alarm Display must be running in active mode.

Procedure steps
1 From the Alarm Display window, click the alarm that you want to clear 

from the alarm list. To select multiple alarms, hold down the Control key 
while you click the alarms.

2 Right-click on the selected alarm.

3 Click Global Clear.

4 Click Refresh or wait for the next refresh period and the cleared alarm will 
be removed from the alarm list.

If one or more requests failed, a dialog box opens with the error 
messages.
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Clearing an alarm globally using the Global Clear tool in 
MDM Toolset

Clear an alarm using the Global Clear tool to remove it from the alarm list in 
Alarm Display, MDM server databases, and the alarm database. When you 
clear an alarm globally, your userID, hostname, and the “DISPLAY” 
environment variable value will be displayed in the comment data. 

This procedure requires that the MDM operator set up connection 
authentication first. Only one alarm can be cleared at a time.

This procedure cannot be used for MPE 9500 alarms. Use the procedure 
“Clearing alarms locally” (page 316).

Prerequisites
• You must have an authenticated connection to the target switch.

• The Host Group Directory Services (HGDS) server and the Passport 
Comms Mgr server (FDTM) must be up and running. 

• You must be running Alarm Display in active mode.

Procedure steps
1 From the Alarm Display window, right-click the alarm you want to clear. 

2 Click Start Tool, Fault and then Global Clear of Alarm.

The Connection Console dialog box opens and displays the first group 
to which the node belongs. The Connection Console dialog box does not 
display if you are already connected to a group that contains the Passport. 

3 Connect to a destination. Use the default selected destination or select 
another destination.

4 Type a valid user ID in the User Id field.

5 Type a valid password in the Password field.

Repeat steps 5-7 as often as needed.

6 Click Connect.

7 Select a connected network destination in the Destination list and then 
click Select.
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Wild cards are also valid. Wild cards allow you to direct commands to 
nodes in any of the connected groups without having to know which group 
the node belongs to.

If the request failed, a dialog box opens with the error message.

Sorting the alarm list by component Id in MDM Toolset
Sort the alarm list by component Id to see the list ordered by component id 
with the new incoming alarms at the top.

Procedure steps
1 From the Alarm Display window, Click View and then Sort by 

Component Id.

Sorting the alarm list by time in MDM Toolset
Sort the alarm list by time to see the most recent alarms at the bottom of the 
list. After the initial sorting, new alarms are simply appended at the bottom of 
the list with no sorting. You can resort the alarms in time order.

Procedure steps
1 From the Alarm Display window, click View and then Sort by Time.

2 Click View and then Resort Displayed Alarms to resort the alarms by 
time after the initial sort was performed.

Sorting the alarm list in MDM Operator Client
Sort the alarm list to see the alarms ordered based on the column header. After 
the initial sorting, new alarms are simply appended at the bottom of the list 
with no sorting. 

Procedure steps
1 From the Alarm Display window, click the column header.

The alarms become sorted based on the header.
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Setting customer database preferences in MDM Toolset
Set customer database preferences to determine the database and host settings 
that will be used by Alarm Display.

Procedure steps
1 From the Alarm Display window, Click Options and then Set CDB 

Preferences.

The Set CDB Preferences Dialog box opens. 

2 Click Insert matching data from CDB server check box.

The Database name and Server host fields are enabled.

3 If you have enabled support for alias substitution, an additional check box 
displays in the dialog—Display component ID alias from CDB server. 
Select the checkbooks to turn on the alias function. To turn off the alias 
function, click to clear the checkbooks.

4 Enter a customer database name in the Database name field.

5 Enter a server host name in the Server host field.

6 Click Save to File to preserve the CDB preferences for later use.

The Alarm Display saves the settings to the file $HOME/MagellanNMS/
IADCdbPrefs.cfg.

The next time Alarm Display is started, these settings will be used.

7 Click Set CDB Preferences to activate the preferences.

The Set CDB Preference Dialog closes and the Alarm Display activates 
the preferences. If you have enabled the display of customer database 
information and the Alarm Display is able to communicate with the server, 
the Alarm Display displays the database name and host in the Alarm 
Display’s connection status field.
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Restoring customer database preferences in MDM Toolset
If you have previously saved your preferences in a file, you can restore them 
for later use.

Procedure steps
1 From the Alarm Display window, Click Options and then Set CDB 

Preferences.

The Set CDB Preferences Dialog box opens. 

2 Click Restore from File.

The Alarm Display restores the last saved preferences from the file 
$HOME/MagellanNMS/IADCdbPrefs.cfg.

3 Click Set CDB Preferences to activate the preferences.

The Set CDB Preference Dialog closes and the Alarm Display activates 
the preferences. If you have enabled the display of customer database 
information and the Alarm Display is able to communicate with the server, 
the Alarm Display displays the database name and host in the Alarm 
Display’s connection status field.

Resetting the customer database information cache in 
MDM Toolset

To reduce the communication costs with the Customer Database server, the 
Alarm Display maintains a cache of the latest information fetched. This cache 
may need to be reset if, for example, the Customer Database has been updated 
with new information.

Procedure steps
1 From the Alarm Display window, Click Options and then Set CDB 

Preferences.

The Set CDB Preferences Dialog box opens. 

2 Click Reset CDB Cache to reset the customer database information 
cache.
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Saving alarm information to a log file in MDM Toolset
Save alarm information to a file so that you can view it later.

Procedure steps
1 From the Alarm Display window, click File and then Save Active Alarms 

to a File.

The Save Active Alarms to a File Dialog box opens.

2 Select a directory and file from the lists in the Directories dialog box, or 
type a filename in the Selection field.

3 Click Save Active Alarms to File.

Saving alarm information to a log file in MDM Operator 
Client

Save alarm information to a file so that you can view it later.

Procedure steps
1 From the Alarm Display window, click Options and then Log Alarms to 

File.

The Open dialog box opens.

2 Specify the name of the file in which you want to save the alarm 
information.

3 Click Save.
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Viewing a log file in MDM Toolset
You can view the files of alarm information that you have previously saved 
to a log file.

Procedure steps
1 Select File and then View Log File.

2 Select the appropriate directory and file name from the lists, or type the 
complete path name in the Selection field. 

3 Click View Log File.

The Log Browser Dialog opens.

4 To pause the display of incoming alarms, click Pause.

A red outline surrounds the log information and the label on the Pause 
button changes to Resume.

5 To resume the display of paused alarms, click Resume.

6 To refresh the display of alarms with the current content of the log file, 
click Show. 

Viewing a log file in MDM Operator Client
You can view the files of alarm information that you have previously saved 
to a log file in MDM Operator Client using any text editor.
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Customizing Alarm Display Start Tool submenus
You can customize the contents of the Start Tool menu in the active and log 
mode. For procedures on customizing the Start Tool menu, see the section on 
customizing the toolsets and Start Tool menus section in 241-6001-301 
Preside MDM Customization Administrator Guide. 

When you modify the Start Tool menu file, use one of the following 
substitution variables in the command line:

• $COMP: the component’s internal representation

• $DCOMP: the component’s display name

• $SEVERITY: the Common severity, which can be UNKNOWN, 
CRITICAL, MAJOR, MINOR, WARNING, or CLEARED

• $DPNSEV: the DPN severity, which can be DEGRADE, OVERLOAD, 
MINOR, MAJOR, WILDCARD, CRITICAL, or OTHER

• $EVENT: CLEAR, SET, or MSG

• $DPNMNEM: the Network Control System (NCS) condition mnemonic, 
which can be TRAPDATA, ACTIVATE, INVALID, MISSING, 
DUPLICAT, MEMORY, CONJEST, FAILED, REFUSED, 
TIME_OUT, CRITICAL, OOS, THRESHLD, ENABLED, 
DISABLED, PROBE, CALL_BLK, or DISCARD

• $DPNACTION: the NCS action value, which can be ncsServiceData, 
ncsHardwareFault, ncsSoftwareFault, ncsSecurityViolation, 
ncsProtocolViolation, ncsDebugInfo, ncsNetwork, ncsEngineering, 
ncsUnclassified, or ncsOperations. This value is an empty string for 
Passport-originated alarms.

• $FCODE: the alarm fault code. The fault code is an 8-digit code used to 
specify the alarm. The first 4 digits are used to identify the source of the 
alarm, and the last 4 digits are used to identify the alarm. 

• $DATE: the date information in the format ‘year:month:day’

• $TIME: the time information in the format ‘hour:min:sec’

• $DTYPE: the DPN device type. This value is an empty string for 
Passport-originated alarms.
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• $FORMAT: the present format of an alarm, which can be TERSE, 
NORMAL, or FULL

• $RAWSTATE: the Raw state, which can be insv, oos, trb, unk, nex, or 
nea. This value is an empty string for DPN-originated alarms.

• $TYPE: the alarm type, which can be communications, 
qualityOfService, processing, equipment, environment, security, 
operator, debug, or unknown. This value gives a general explanation of 
the cause of the alarm.

• $CMT: the operator comment data text

• $OPER: the operator data text

Example:

 If you want to invoke the tool called Customer Tool Kit Script with the 
component id and the fault code contained in the alarm, add the following two 
lines to the /opt/MagellanNMS/IADAlarm.menu file. The 
CustomerToolKitScript script is called with this information when you use 
the Start Tool submenu and select the Customer Tool Kit Script:

• labelString: Customer Tool Kit

• tMCommandLine: CustomerToolKitScript COMP:”$COMP” 
DCOMP:” FAULTCODE:”$FCODE” 
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Customizing resources
You can customize the resources to control the colors of the alarm format by 
severity. You can also customize the resources to control whether the 
problem states are shown in the related components list, and to control 
whether the bell rings upon error.

The table “Resources for color control of common alarm formats by Alarm 
Display” (page 326) lists the resources you use to control the colors 
associated with the common alarm format severity displayed by the Alarm 
Display components.

The table “Resources for customizing the Acknowledge/Unacknowledge 
Alarms Dialog” (page 327) lists the resources you use to customize the 
Acknowledge Alarms Dialog and the Unacknowledge Alarms Dialog.

Table 48
Resources for color control of common alarm formats by Alarm Display

Resource Description Legal value

*BackgroundColorUnknown
*ForegroundColorUnknown
*BackgroundColorCritical
*ForegroundColorCritical
*BackgorundColorMajor
*ForegroundColorMajor
*ForegroundColorMinor
*BackgroundColorMinor
*BackgroundColorWarning
*ForegroundColorWarning
*BackgroundColorCleared
*ForegroundColorCleared
*BackgroundColorDefault
*ForegroundColorDefault

Specifies the 
background and 
foreground color-
to-severity 
mappings for the 
common alarm 
formats.

Any legal X windows 
color or specification. 
See 241-6001-301 
Preside MDM 
Customization 
Administrator Guide.

IAD*cdbSupportAlias Enables support for 
Customer 
Database 
component name 
aliasing.

True to enable alias 
support, False 
(default) to prevent 
alias support
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Table 49
Resources for customizing the Acknowledge/Unacknowledge Alarms 
Dialog

Resource Description Legal value

*AckAlarmDlog*userIdFieldF
ield.editable

If True, the User field in the 
dialog used for 
acknowledging or 
unacknowledging alarms 
can be modified. The default 
is False.

True or False

*AckAlarmDlog*commentDa
ta.maxLength

The maximum length of 
Reason text that can be 
specified when 
acknowledging or 
unacknowledging alarms. 
The default length is 256.

Any legal Motif 
value 
associated 
with the 
MaxLength 
resource.
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Alarm Display interface in the MDM Toolset
In the MDM Toolset environment, the Alarm Display tool can be opened in 
Active mode or Log mode. Some parts of the interface are only available in 
Active mode or Log mode. The main window and overall interface of the 
Alarm Display tool in the MDM Toolset environment is made up of the 
following parts:

• “Menu bar” (page 328)

• “List area” (page 331)

• pop-up menus

• dialog boxes

You may also want to view the following Alarm Display information:

• “Alarm Display basic procedures” on page 303

• “Alarm Display fundamentals” on page 361

Menu bar
The Alarm Display provides the following menus:

• “File” (page 329)

• “Edit” (page 329)

• “View” (page 330)

• “Options” (page 331)

The command description specifies when a command is available exclusively 
in active or log mode.
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File

Edit

Table 50
File menu commands

Command Description

Save Active Alarms to 
File

Opens the Save Active Alarms to File dialog box. 
This dialog box allows you to specify the name of 
the file where you want to save the list of active 
alarms. This command is available in active 
mode.

View Active Alarms File Opens the View Active Alarms File dialog box. 
This dialog box allows you to select the name of 
the file you want to view. This command is 
available in active mode.

Log to File Opens the Log to File dialog box. This dialog box 
allows you to select the name of the file where 
new logs and possibly the current set of logs 
would be written. This command is available log 
mode.

View Log File Opens the View Log File dialog box. This dialog 
box allows you to select the file that you want to 
view. This command is available in log mode.

Exit Closes the tool and windows. You are warned if 
any setting have been changed but not saved.

Table 51
Edit menu commands

Command Description

Copy Copies the selected alarms so that you can paste 
them later.

Select All Selects all logs or active alarms.

Deselect All Deselects all logs or active alarms.
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View
Table 52
View menu commands

Command Description

Select Log Mode Sets the Alarm Display mode to Log. The alarm 
list is refreshed and the incoming logs are 
displayed as they are received (subject to 
filtering). This command is available in active 
mode.

Sort by Time Sorts active alarms by time with the most recent 
at the bottom. This command is available in 
active mode.

Sort by Component Sorts active alarms by their component IDs. This 
command is available in active mode when the 
Sort by Time setting is enabled.

Resort Displayed Alarms Resorts the active alarms by time. This 
command is available in active mode when the 
Sort by Time setting is enabled.

Turn Highlight Off/On Enables or disables highlighting (background 
coloring). When Alarm Display in active mode, all 
alarms are highlighted. When Alarm Display in 
log mode, new alarms are highlighted.

Select Active Alarm Mode Sets the Alarm Display mode to Active. The 
alarm list is refreshed and the active alarms are 
displayed (subject to filtering). This command is 
available in active mode

Turn Bell Off/On Turns bell sounds on or off for certain types of 
alarms based on the settings enabled in the Set 
Effects dialog box. This command is available in 
log mode.
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Options

List area
The list area displays information on alarms in the network. The amount and 
format of the information displayed can be changed using the “Format toggle 
button” (page 332) toggle button.

Pause toggle button
The Pause toggle button allows you to pause the addition of new alarms to the 
display. When you select Off, any new alarms that are received are displayed 
at the bottom of the alarm list and the list automatically scrolls to the bottom. 
If the list contains the maximum number of alarms when a new alarm is 
received, the oldest alarm is removed. When you select On, the display of 
incoming alarms is stopped and they are buffered. If more than 500 alarms are 
received in the buffer, Pause is automatically reset to Off.

Auto-Refresh toggle button
The Auto-Refresh button allow you to the automatic refreshing of the display 
on or off. When you select On, the display is refreshed at a default rate of once 
per minute.When the display is refreshed, the SET alarms that were cleared 
are removed and the new SET alarms are inserted. When you select Off, the 

Table 53
Options menu commands

Command Description

Set Filter Opens the Set Filter dialog box. This dialog box 
allows you to set and modify filters.

Set Effects Opens the Set Effects dialog box. This dialog box 
allows you to set and modify effects such as 
highlighting and bell sounds.

Set CDB Preferences Opens the Set CDB Preferences dialog box. This 
dialog box allows you to modify the display of 
customer database information.

Set Auto-Refresh Interval Opens the Set Auto-Refresh dialog box. This 
dialog box allows you to modify the auto-refresh 
interval. This command is available in active 
mode.
Preside MDM Fault Management User Guide   15.1RSUP



332   Chapter 6 Alarm Display
display is not refreshed and new SET alarms are buffered. If more than 500 
SET alarms are received in the buffer, Auto-Refresh is automatically reset to 
On. When Auto-Refresh is turned On, a refresh occurs immediately.

Format toggle button
The Format toggle button allows you to choose the format for displaying 
alarm information. The different formats vary in the amount of information 
that is displayed. The available formats are:

• Terse

Terse format displays alarm information on a single line. Long 
component identifiers are truncated to fit on the single line. Terse format 
contains the following details: severity, event, fault code, date, time and 
component ID. The following is an example of alarm details in terse 
format:

CRITICAL SET 09990001 98-03-03 16:57:16 EM/NODER8.

• Normal

Normal format displays alarm information on multiple lines. Normal 
format contains the same details as terse format as well as the notification 
ID, alarm type and probably cause of the alarm. In normal syntax long 
component identifiers are not truncated. Depending on availability, 
normal format can also contain labeled comment data and the operator 
data details.The following is an example of alarm details in normal 
format:

CRITICAL SET 09990001 98-03-03 16:57:16 EM/NODER8
ID: FFFFFFFF TYPE:equipment CAUSE: equipmentFailure
CO: NMS:bcary9b0 has lost connectivity to this node.

• Full
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• Alarm details are not truncated in full format, so the information can 
occupy more that one line. Full format contains all of the same details as 
normal format as well as some additional information that is displayed in 
labeled fields (when applicable). The following is and example of alarm 
details in full format:

CRITICAL SET 09990001 98-03-03 16:57:16 EM/NODER8
ID: FFFFFFFF TYPE:equipment CAUSE: equipmentFailure
CO: NMS:bcary9b0 has lost connectivity to this node.
RAW:unk ADMIN:unlocked OPER:disable USAGE:idle

AVAIL: PROC: CNTRL:
ALARM: STBY:notSet UNKNW:

INT: ;;;;

Filter toggle button
The Filter toggle button allows you to turn alarm filter on or off. The effect 
of the filters depends on the operational mode (log or active). 

In log mode, selecting On starts the filtering of incoming alarms based on the 
current filter settings. Selecting Off stops the filtering of incoming alarms. In 
active mode, selecting the On refreshes the display of alarms based on the 
current filter settings. Selecting Off causes all active alarms to be displayed.

Print toggle button
The Print toggle button allows you to turn the printing of alarms on or off. 
When you select On, incoming alarms are sent to the printer. Before sending 
the alarms to the printer, the environment is checked to see if a variable 
named PRINTER is defined. If so, its value is assumed to be the name of the 
desired printer. If this fails, the printing job is sent to the system wide default 
printer.

Refresh toggle button
Pressing this button manually refreshes the Active Alarm display. When the 
display is refreshed, the SET alarms that were cleared are removed and the 
new SET alarms are inserted. When the display is refreshed, the SET alarms 
that were cleared are removed and the new SET alarms are inserted.
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Log Menu pop-up menu
The Log Menu is a pop-up menu that opens when you right click on a log in 
the list area. You must be operating in log mode to open the Log Menu. The 
Log Menu contains the following commands: 

Alarm Menu pop-up menu
The Alarm Menu is a pop-up menu that opens when you right click on an 
alarm in the list area. You must be operating in active mode to open the Alarm 
Menu. The Alarm Menu contains the following commands:

Table 54
Log Menu commands

Command Description

Copy Copies all the selected logs so that they can be 
pasted later.

Select All Selects all the logs.

Deselect All Deselects all the logs.

Set Terse Format Displays the selected logs in terse format.

Set Normal Format Displays the selected logs in normal format.

Set Full Format Displays the selected logs in full format.

Start Tool Allows you to access various tools.

Table 55
Alarm menu commands

Command Description

Copy Copies all the selected alarms so that they can 
be pasted later.

Select All Selects all the logs.

Deselect All Deselects all the logs.

Set Terse Format Displays the selected logs in terse format.

Set Normal Format Displays the selected logs in normal format.
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Set Filter Dialog box
The Set Filter Dialog box allows you to set the conditions that an alarm must 
meet to be listed in the display area.

Dialog Layout
The dialog contains the following major areas: 

Set Full Format Displays the selected logs in full format.

Start Tool Allows you to access various tools. For details on 
the Start Tool menu, see the section about the 
Start Tool in 241-6001-122 Preside MDM Using 
MDM Toolset and Operator Client Interfaces. 
Start tool menus can be customized. For 
information about customizing start tools, see the 
section on customizing the toolsets and Start 
Tools menu in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Acknowledge Alarms Opens the Acknowledge Alarms dialog box. This 
dialog box allows you to select and acknowledge 
alarms.

Unacknowledge Alarms Opens the Unacknowledge Alarms dialog box. 
This dialog box allows you to select and 
unacknowledge alarms.

Local Clear Removes the selected alarms from the SDM, 
NMDR, or GMDR local database. The selected 
alarm is not removed from the Alarm Display 
alarm list until a Clear is received from SDM, 
NMDR, or GMDR.

Global Clear Removes the selected alarm from the NCS 
active alarm list. The selected alarms are not 
removed from the Alarm Display alarm list until a 
Clear is received from NCS. (This selection is 
only available for DPN alarms). Global Clear is 
disabled for proxy alarms.

Table 55
Alarm menu commands

Command Description
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Active Filters List Displays a single select list which contains the 
names of the filters that will be used if the filtering 
option is on. When an item is selected the right 
part of the dialog is refreshed with the content of 
the selected filter. The arrow button at the right of 
the Transfer label is also enabled. 

The default maximum number of Active filters is 
10. You can change the default by setting the 
AD.ad resource. By default, the Active Filter List 
contains no filter. You can remove a filter from the 
list by clicking Delete at the bottom of the Active 
Filters list. 

Inactive Filters List Displays a list that contains the names of the 
filters that will not be used if the filtering option is 
on. When you select an item, the right part of the 
dialog refreshes with the content of the selected 
filter. The arrow button at the left of the Transfer 
label is also enabled. You can remove a filter from 
the list by clicking Delete at the bottom of the 
Inactive Filters list. 

Transfer Arrow Buttons Transfers a selected item from the Active Filter 
List to the Inactive Filter List or to move an item 
from the Inactive Filter List to the Active Filter List. 
The arrows are enabled when items are selected 
from the Active Filter List or Inactive Filter List.

Name Text Field Displays an editable field used to name a filter. If 
you type a name which already exists in one of the 
filter lists, the Change Filter push button is 
enabled and the Add Filter push button is 
disabled. The corresponding item in the Active 
Filter List or Inactive Filter List is selected but the 
content of the filter selectors is NOT updated until 
you press Restore Values. If you type a name that 
does not exist, the Add Filter push button is 
enabled and the Change push button is disabled.
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Action Selector Indicates whether the named filter will be used to 
accept or reject alarms matching the values 
defined in the severity, component, fault code and 
customer id selector. 
Accept passes alarms matching the criteria you 
specify to other control areas of this dialog. Reject 
blocks the display of alarms matching the criteria 
you specify.

Severity Selector Specifies the severity values that will be used by 
the named filter to filter the alarms. 

Component Selector Specifies the component id expressions that will 
be used by the named Filter to filter the alarms. 
The maximum is set by default to 40 but can be 
changed. Both the "*" and "?" characters can be 
used as pattern matching characters. 

The component selector contains a scrollable list 
of component patterns, a component pattern text 
entry field and two push buttons (Add and Delete). 
When the user selects an entry in the list, it is 
automatically displayed in the text entry field.

The text entry field is used to type a component 
pattern for addition to the list. The component 
pattern must be specified by using a valid 
combination of pattern matching characters (* and 
?) and category/name pairs. Entries are case-
sensitive.
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Fault Code Selector Specifies the fault code expressions that will be 
used by the named Filter to filter the alarms. The 
maximum is set by default to 40 but can be 
changed. Both the "*" and "?" characters can be 
used as pattern matching characters. 

The Fault Code selector contains a scrollable list 
of fault code patterns, a fault code pattern text 
entry field and two push buttons (Add and Delete). 
When the user selects an entry in the list, it is 
automatically displayed in the text entry field.

The text entry field is used to type a fault code 
pattern for addition to the list. The fault code 
pattern must be specified by using a valid 
combination of pattern matching characters (* 
and?) and hexadecimal digits. 

Customer Id Selector Specifies the customer id numbers that will be 
used by the named Filter to filter the alarms. 

The Customer Id selector contains a scrollable list 
of customer id numbers, a customer id text entry 
field and two push buttons (Add and Delete). 
When the user selects an entry in the list, it is 
automatically displayed in the text entry field. 

The text entry field is used to type a customer id 
number for addition to the list. The customer id 
number must be specified by using an integer.

Ack State Selector Specifies whether ack’ed alarms, unack’ed 
alarms or alarms which have never been ack’ed 
(or any combination of the three) will be used by 
the named filter to filter the alarms.

Ack Userid Selector Specifies the ack userid expressions that will be 
used by the named filter to filter the alarms. The 
default maximum number of patterns is 40, but 
you can change this setting. You can use both the 
* and the ? characters as pattern matching 
characters.
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Comment Data Selector Specifies the comment text expressions that will 
be used by the named filter to filter the alarms. 
The default maximum number of patterns is 40, 
but you can change this setting. You can use both 
the * and the ? characters as pattern matching 
characters. 

The comment data selector contains a scrollable 
list of patterns, a pattern text entry field, an Add 
button, and a Delete button. When you select an 
entry in the list, it is automatically displayed in the 
text entry field.

The text entry field is used to type a pattern for 
addition to the list. Specify a pattern by using a 
valid combination of the pattern matching 
characters * and ?.

Customer Data Selector Specifies the customer data expressions that will 
be used by the named Filter to filter the alarms. 
The default maximum number of patterns is 40 
but you can change this setting. You can use both 
the "*" and "?" characters as pattern matching 
characters. 

The customer data selector contains a scrollable 
list of patterns, a pattern text entry field, an Add 
button, and a Delete button. When the user selects 
an entry in the list, it is automatically displayed in 
the text entry field.

The text entry field is used to type a pattern for 
addition to the list. Specify a pattern by using a 
valid combination of the pattern matching 
characters * and ?.

Dialog Buttons Provides a set of buttons that operate on the 
dialog. For details of these buttons, refer to the 
"Commands" section of this help panel.
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Commands

Add (Component Adds the content of the Component text entry to 
the Component list. 

Delete (Component) Removes the item matching the content of the 
Component text entry from the Component list. 

Add (Fault Code) Adds the content of the Fault Code text entry to 
the Fault Code list. 

Delete (Fault Code) Removes the item matching the content of the 
Fault Code text entry from the Fault Code list. 

Add (Customer Id) Adds the content of the Customer Id text entry to 
the Customer Id list. 

Delete (Customer Id) Removes the item matching the content of the 
Customer Id text entry from the Customer Id list.

Delete (Filter Lists) Removes the above selected named filter from 
the Inactive or Active Filter lists.

Arrow Up Moves the filter selected in the Inactive Filter List 
to the Active Filter List. 

Arrow Down Moves the filter selected in the Active Filter List to 
the Inactive Filter List. 

Change Filter Updates the content of the named filter with the 
content of the activity, severity, component, fault 
code and customer id selectors. 

Add Filter Creates a new inactive named filter with the 
content of the activity, severity, component, fault 
code and customer id selectors. The new filter 
name is added to the Inactive Filter List. 

Restore Values Updates the content of the selectors with the 
previous values of the named filter. This button is 
only enabled when you change an existing filter. 
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Set Effects Dialog box
Dialog Layout
The dialog contains the following elements: 

Use Defaults Selects all the severities and removes all the 
items from the component, fault code and 
customer id selection lists. The Filter Action is also 
set to Accept Alarms. The name of the filter is not 
changed. 

Set Filters Closes the dialog. If the Filter On button in the 
main window is selected, the filter settings are 
applied. The filter settings are applied as follows:

In the Log mode the activity, severity, fault code 
component and customer id selections of each 
active named filter are applied to the incoming 
alarms. Previously displayed alarms are 
unaffected.

In the Active Alarm mode previously displayed 
alarms are removed and then alarms are 
displayed according to the new activity, severity, 
fault code, component and customer id selections 
of each active named filter. 

Save to File Saves the current filter settings for this operational 
mode (Log or Active Alarm). Saving the changes 
does not dismiss the window or apply the changes 
for the current session. 

Restore from File Updates the dialog with the currently saved 
settings. 

Cancel Dismisses the dialog. Any changes made to the 
filter settings are lost. 

Help Displays online help about the Filter Dialog. 
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Commands

Log to File Dialog box
Use this dialog to select the directory and file name into which the new 
incoming logs and possibly the current ones will be saved. The Directory list 
allows the selection of the destination directory simply by clicking. The File 
list does the same for the selection of existing file names. Alternatively, both 
the directory path and the file name can be entered or modified by typing in 

Bell Selector Indicates whether a bell should ring when an 
alarm with a specific severity is displayed. You 
can choose the severity the alarm must have for 
the bell to ring by checking the appropriate check 
buttons. 

Highlight Selector Specifies when a special background color should 
be used to display alarms having specific 
severities. You can choose the severity for which 
the special background will be drawn by checking 
the appropriate cheekbones. 

Push buttons Enable you to apply, save, restore, or cancel the 
changes made in the dialog. 

Set Effects Applies the effects settings for the current session 
and dismisses the dialog. If the Bell On and/or the 
Highlight On are enabled (Set Effects Dialog), the 
new selections are in effect. 

Save to File Saves the effect settings permanently for the 
current application mode (Log or Active Alarm). 
Saving the changes does not dismiss the window 
or apply the changes to the current session.

Restore from File Updates the dialog with the last saved effect 
settings for the current application mode.

Cancel Dismisses the dialog. Any changes made to the 
effect settings are lost.

Help Displays online help for the Set Effects Dialog.
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the Selection text. To record the logs to a new file in the default directory 
(shared by all Alarm Display users), just append the file name to the contents 
of the text entry item. To record the logs to a private directory, just select a 
new directory from the Directory list or type the full path name in the 
Selection area. To overwrite an existing file, just select its name from the File 
list. 

Commands
Clicking on a name in the Directory list will select that specified directory 
name. Selecting the "Change Directory" command then will update the File 
list to show the files contained in that directory and display the directory name 
in the Selection text. Clicking on a name in the File list will put the full path 
name of the specified file in the Selection area. Double-clicking on a list item 
(Directory or File) invokes the command of the current default button 
("Change Directory" or "Log to File"). 

The following commands are available for the Alarm Display Log to File 
Selection Dialog: 

Include Current Logs Appends the current logs to your file.

Log to File Closes the dialog and selects the current contents 
of the Selection text as the name of the 
destination for the logs. This command can also 
be invoked by double- clicking on a name in the 
File list. If the file already exists, you will be 
prompted to confirm the overwrite.

Change Directory Displays the currently selected directory name in 
the Selection area and displays the files it 
contains in the File list. This command can also be 
invoked by double-clicking on a name in the 
Directory list. 

Cancel Closes the dialog without any file name selection 
and aborts the Log to File operation.

Help Displays online help.
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Save Active Alarms to File Dialog box
This dialog is a File Selection Dialog used to select the directory and file 
name into which the set of alarms displayed on the screen will be saved. The 
Directory list allows the selection of the destination directory simply by 
clicking. The File list does the same for the selection of existing file names. 
Alternatively, both the directory path and the file name can be entered or 
modified by typing in the Selection area. To save the alarms to a new file in 
the default directory (shared by all Alarm Display users), just append the file 
name to the contents of the text entry item. To save the alarms to a private 
directory, just select a new directory from the Directory list or type the full 
path name in the Selection area. To overwrite an existing file, just select its 
name from the File list. 

Commands
Clicking on a name in the Directory list will select the specified directory 
name in the Selection area. Selecting the "Change Directory" command will 
update the File list to show the files contained in that directory. Clicking on a 
name in the File list will put the full path name of the specified file in the 
Selection area. Double-clicking on a list item (Directory or File) invokes the 
command of the current default button ("Change Directory" or "Save 
Alarms"). 

The following commands are available for the Alarm Display Save Active 
Alarms to File Selection Dialog: 

Save Active Alarms to File Closes the dialog and selects the current contents 
of the Selection area as the name of the 
destination for the active alarms. This command 
can also be invoked by double-clicking on a name 
in the File list. If the file already exists, you will be 
prompted to confirm the overwrite. 

Change Directory Displays the currently selected directory name in 
the Selection area and displays the files it 
contains in the File list. This command can also be 
invoked by double-clicking on a name in the 
Directory list. 
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Set Auto-Refresh Interval Dialog box
This dialog is used to set the interval between list refreshes, that is the interval 
before new active alarms are inserted and active alarms that were cleared are 
removed. Use the slider to set the interval. 

Commands

Set CDB Preferences Dialog box
This dialog controls the Customer Database information display capabilities. 
You can choose to display matching Customer Database information in each 
alarm (displayed in Common Full format) and the Customer Database (by 
database name and server hostname) from which the information will come. 
You can reset the Customer Database Information cache, in case the database 
has been reset. Finally, you can save your CDB preferences to file or restore 
them.

Commands

Cancel Closes the dialog without any file name selection 
and aborts the Save Active Alarm operation. 

Help Displays online help. 

OK Closes the dialog and uses the Auto-Refresh 
interval set on the slider. 

Cancel Closes the dialog without changing the Auto-
Refresh interval. 

Help Displays online help. 

Reset CDB Cache Resets the Customer Database information 
cache.

Set CDB Preferences Closes the dialog and uses the CDB settings 
specified in the dialog. 

Save to File Saves the dialog’s settings to file. The settings are 
automatically restored when the Alarm Display 
starts.
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View Log File Dialog box
Use this dialog to select the directory and file name that you want to browse. 

The Directory list allows the selection of the destination directory simply by 
clicking. The File list does the same for the selection of existing file names. 
Alternatively, both the directory path and the file name may be entered or 
modified by typing in the Selection area. 

Commands
Clicking on a name in the Directory list will select the specified directory 
name in the Selection area. Selecting the "Change Directory" command will 
then update the File list to show the files contained in that directory. Clicking 
on a name in the File list will put the full path name of the specified file in the 
Selection area. Double-clicking on a list item (Directory or File) invokes the 
command of the current default button ("Change Directory" or "View Log 
File"). 

The following commands are available for the View Log File Dialog: 

Restore from File Resets the dialog’s settings to those last saved to 
file.

Cancel Closes the dialog without changing the preference 
settings. 

Help Displays online help. 

View Log File Closes the dialog and starts the Browser dialog on 
the current contents of the Selection area. This 
command can also be invoked by double-clicking 
on a name in the File list. 

Change Directory Displays the currently selected directory name in 
the Selection area and displays the files it 
contains in the File list. This command can also be 
invoked by double-clicking on a name in the 
Directory list. 
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View Active Alarms File Dialog box
This dialog is a File Selection Dialog used to select the directory and file 
name that you want to browse. 

The Directory list allows the selection of the destination directory simply by 
clicking. The File list does the same for the selection of existing file names. 
Alternatively, both the directory path and the file name may be entered or 
modified by typing in the Selection area. 

Commands
Clicking on a name in the Directory list will select the specified directory 
name in the Selection area. Selecting the "Change Directory" command will 
then update the File list to show the files contained in that directory. Clicking 
on a name in the File list will put the full path name of the specified file in the 
Selection area. Double-clicking on a list item (Directory or File) invokes the 
command of the current default button ("Change Directory" or "View Active 
Alarms File"). 

The following commands are available for the View Log File Dialog: 

Cancel Closes the dialog without any file name selection. 

Help Displays online help. 

View Active Alarms File Closes the dialog and starts the Browser dialog on 
the current contents of the Selection area. This 
command can also be invoked by double-clicking 
on a name in the File list. 

Change Directory Displays the currently selected directory name in 
the Selection area and displays the files it 
contains in the File list. This command can also be 
invoked by double-clicking on a name in the 
Directory list. 

Cancel Closes the dialog without any file name selection. 

Help Displays online help. 
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Alarm Browser Dialog box
The browser dialog displays the contents of the alarms as they are logged to 
a file. Depending on the Alarm Display mode, you can view active mode 
alarms or log mode alarms. 

The Show button refreshes the contents of the dialog with the current content 
of the specified alarm file.

The Pause button lets you pause the display of incoming alarms. When the 
display has been paused, a red border surrounds the alarm information and the 
label on the button changes to Resume. Clicking the Resume button removes 
the red border and resumes the display the incoming alarms. 

The Close button closes the dialog.

File Exist Warning Dialog box
The file you picked to dump the Alarm Display log to, already exists. You can 
overwrite the file, but any data it contained will be lost. If you do not wish to 
kill this file, press "No, keep the file", select "Log to File..." or "Save Active 
Alarms to File", and specify a different file name. 

Commands

Alarm Display - Help
There is one set of help information which describes the Alarm Display 
anchor window. It gives a brief overview of the Alarm Display tool. It has 
sub-sections that describe key parts of the main window. You can view it by 
pulling down the Help menu and selecting the On Window option. 

There is also help for each menu. It is available from the last entry on each 
menu, appropriately labeled "Help". 

Overwrite Starts a new log and overwrites the existing file.

Cancel Stops the start log operation.

Help Displays online help. 
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There is also one set of help information for each major dialog of the user 
interface. You can view the help for a dialog by clicking on the "Help" button 
on that dialog. This includes dialogs. 

Alarm Display - Keys
The Alarm Display is built using the Motif user interface library. 

There can be a default action button in a dialog. This button is visually 
distinguished by an extra box around it. If you press the Return key anywhere 
in the dialog, Motif will activate the default button. Not all dialogs have a 
default action button. 

Mnemonics are available only from menu bar menus. They are single 
characters. The characters are identified by an underscore. To use 
mnemonics, you must first press either F10 (from which menus can be opened 
using mnemonics) or hold down the Meta key and press the mnemonic for the 
menu bar menu you wish to open. From there, the mnemonic of the specific 
command on the open menu can be pressed (once the Meta key has been 
released). For example, the following key sequence causes the Alarm Display 
tool to exit: "Meta-F E". As does: "F10 F E". 

Command shortcuts can be used by experienced users of Alarm Display 
instead of using the mouse to select commands from menus. 

Command shortcuts use combinations of various modifier keys with regular 
character keys. Modifier keys are Shift, Control, and Meta. 

As users become familiar with the commands, they remember the shortcut 
and can invoke that command directly from the keyboard without having to 
pull down menus. 

Useful Shortcuts
Some useful shortcuts are: 

Ctrl+Y : Set Filter to On 
Ctrl+N : Set Filter to Off 
Ctrl+P : Set Print to On 
Ctrl+O : Set Print to Off 
Ctrl+T : Set Format to Terse 
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Ctrl+M : Set Format to Normal 
Ctrl+U : Set Format to Full 
Ctrl+S : Set Auto-Refresh to Off 
Ctrl+Q : Set Auto-Refresh to On 
Ctrl+S : Set Pause to On 
Ctrl+Q : Set Pause to Off 
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Keyboard shortcuts
The table “Accelerator keys” (page 351) lists the accelerator keys for the 
Alarm Display.

Command line arguments
The table “Command line arguments” (page 351) lists the Command line 
arguments for the Alarm Display.

Table 56
Accelerator keys

Mode                                                Function

Logs Mode Pause Format Filter Print

Ctrl+s (on) Ctrl+t (terse) Ctrl+y (on) Ctrl+p (on)

Ctrl+m (normal)

Ctrl+q (off) Ctrl+u (full) Ctrl+n (off) Ctrl+o (off)

Active Alarm 
Mode

AutoRefresh Format Filter

Ctrl+s (off) Ctrl+t (terse) Ctrl+y (on)

Ctrl+m (normal)

Ctrl+q (on) Ctrl+u (full) Ctrl+n (off)

Table 57
Command line arguments

Command line Description

[ -h <host> ] The name of the remote host on which the General 
Manager Data Router (GMDR) is running. If a 
surveillance service selection exists, the default is 
the selected host; otherwise, the default is the local 
host. 

[ -s <GMDR> ] The name of the GMDR server from which you want 
to extract data. The default is GMDR.

 (Sheet 1 of 2)
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[ -r <number> ] The maximum number of active alarms that the 
Alarm Display buffers when the Auto-Refresh option 
is deactivated. The default is 500.

[ -b <number> ] The maximum number of logs that the Alarm Display 
buffers while the Pause option is activated. The 
default is 500.

[ -a <number> ] The maximum number of logs that Alarm Display 
keeps in the Log mode window. The default is 500.

[ -o DPN ] DPN mode only. It displays DPN alarms in NCS 
format. The default is Passport- and DPN-originated 
alarms in common format. This is now outdated.

[ -m [ACTIVE | LOG] ] Can be Log or Active mode. The default is Log 
mode.

[ -w <number> ] The time interval between refreshes of the Log 
display. The default is two seconds.

Table 57 (Continued)
Command line arguments

Command line Description

 (Sheet 2 of 2)
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Alarm Display interface in MDM Operator Client
The main window and overall interface of the Alarm Display tool in the 
MDM Operator Client environment is made up of the following parts:

• “Menu bar” (page 353)

• “Alarm display area” (page 356)

• “Filter area” (page 357)

• “Advanced Filter dialog box” (page 357)

• “Details area” (page 359)

• “Alarm Menu pop-up menu” (page 359)

You may also want to view the following Alarm Display information:

• “Alarm Display basic procedures” on page 303

• “Alarm Display fundamentals” on page 361

Menu bar
The Alarm Display provides the following menus:

• “File” (page 353)

• “Edit” (page 354)

• “Options” (page 354)

• “Help” (page 355)

File 
The following commands are available from the File menu:
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Edit
The following commands are available from the Edit menu:

Options
The following commands are available from the Options menu:

Table 58
File menu commands

Command Description

Reconnect to Server Resets the connection to the general 
management data router (GMDR) server. Use 
this command if the GMDR server stops 
responding to the client, for example, if you set a 
new filter but receive no alarms.

Save Alarms to File Lets you save the alarm display information to a 
specified file.

Print Selected Alarm 
Details

Prints these details on the currently selected 
alarm: component, state, time, type, customer 
ID, fault, severity, cause, event, comments, 
acknowledge state, acknowledge reason, and 
acknowledge user ID.

Print All Alarm Summary Prints this summary alarm information on each 
alarm in the alarm list area: alarm number, 
severity, component, event, date, and time.

Exit Closes the alarm display window and exits the 
application.

Table 59
Edit menu commands

Command Description

Copy Copies the full format of a selected alarm from 
the alarm list to the system clipboard. You can 
then paste this information into another 
application.
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Help
The following commands are available from the Help menu:

Table 60
Options menu commands

Command Description

Log Alarms to File Opens a Java Open dialog and prompts you for 
information on where to store the log file.

Bell on Critical Alarm Turns sound effects on or off for critical alarms. 
Use this command only if your resource file has 
sound definitions and your hardware supports 
sound.

Bell on Major Alarm Turns sound effects on or off for major alarms. 
Use this command only if your resource file has 
sound definitions and your hardware supports 
sound.

Bell on Minor Alarm Turns sound effects on or off for minor alarms. 
Use this command only if your resource file has 
sound definitions and your hardware supports 
sound.

Bell on Warning Alarm Turns sound effects on or off for warning alarms. 
Use this command only if your resource file has 
sound definitions and your hardware supports 
sound.

Table 61
Help menu commands

Command Description

Help on Window Displays help on the Alarm Display window.

What’s This? Displays information about a selected area of the 
Alarm Display window.
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Alarm display area
The alarm list area consists of the following items: a list box and check boxes 
that let you determine what displays in the alarm list, an alarm count, and a 
detailed alarm list.

Alarm count field
This field displays the total number of alarms in the alarm list, based on any 
filters in effect.

Alarm mode list box
This list box allows you choose the mode for displaying alarms. The 
following modes are available:

• Active Alarms mode display only active alarms.

• Alarm Log mode displays recent alarms as they are received by MDM. 
This mode includes all alarms including set, clear, and message events

• Alarm History mode is similar to Alarm Log mode but also includes 
past alarms. In some networks, selecting this mode can result in large 
amounts of alarm data.

Pause Alarms check box
When you enable this check box, no subsequent alarms display in the alarm 
list. When this check box is not enabled, the alarm display continues to add 
alarms to the alarm list. 

Auto-scroll check box
When you enable this check box, the alarm display automatically scrolls the 
alarm list so that the most recent alarm is visible. When this check box is not 
enabled, the alarm list does not automatically scroll.

Alarm list
The alarm list displays information on alarms in the network. The information 
is displayed in the following columns: Ack, Severity, Event, Fault, 
Timestamp, Component ID, Notification ID, Alarm Type, Probably Cause, 
Comment Data, Operator Data, Expert Data, Ack State, Ack Timestamp, Ack 
User ID, Ack Reason, Raw State, Administration State, Operator State, 
Usage State, Availability Status, Procedural Status, Control Status, Alarm 
Status, Standby Status, Unknown Status, Related Components, Alarm 
Process ID, File Name, File Line Number, File Version and Customer ID.
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Filter area
The Filter area allows you to activate and define simple and advanced filters. 
See for information about how to set filters.

Filter list box
The Filter list box allows you to set the filter mode. The following modes are 
available:

• Off turns all filters off.

• Simple filters alarms based on severity. You can define the severity 
levels that you want to filter using the check boxes in the Simple Filter 
sub-area. 

• Advanced filters alarms based on the settings enabled from the 
“Advanced Filter sub-area” (page 357).

Simple Filter area
The Simple Filter area allows you define a filter based on alarm severity. You 
use the check boxes in the Simple Filter sub-area to define the alarm severity 
that you want the filter to use. You can enable one of more of the check box 
options and click the Save button to save your selections.

Advanced Filter sub-area
The Advanced Filter area allows you to define filters based on several criteria. 
When you select the Advanced option from the Filter list box, you enable the 
Settings button in the Advance Filter sub-area. You click the Settings button 
to open the Advanced Filter dialog box and then you set your filter criteria 
using the options in the dialog box. See “Advanced Filter dialog box” 
(page 357) for a description of the Advanced Filter dialog box and its options. 

Advanced Filter dialog box
The Advanced Filter dialog box opens when you click the Settings button in 
the Advance Filter sub-area. You can use the options in the Advanced Filter 
dialog box to set filter criteria. You can also name and save multiple filters and 
apply different filters for each mode of the alarm browser. It is also possible 
to create default filters for groups of users and enable users to override the 
settings as required.
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The dialog box is made up of the following parts:

• Filtering area

All filters that you set are displayed in this area after you click the Add 
button.

• attribute list box

This is the first list box in the window. It contains eight alarm attributes 
that you can choose from.

• options list box

This is the second list box in the window. It contains options that can be 
applied to the attribute you selected in the attribute list box.

• target value field

This is the field where you enter the component ID of the device that the 
you want to filter.

• Add button

Click this button to add your filter to the list in the Filter area.

• Change button

Click this button to make changes to the selected filter. You must select 
a filter in the Filtering area to make this button active.

• Delete button

Click this button to delete the selected filter. You must select a filter in 
the Filtering area to make this button active.

• OK button

Click this button to apply your filters and close the dialog box.

• Cancel button

Click this button to close the dialog box without applying any of your 
filters.
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Details area
The details area provides tabs that display additional alarm information:

Detailed Alarm Report tab
The Detailed Alarm Report tab displays all of the same alarm information that 
is displayed in the Alarm List area, except only for the selected alarm. The 
details are organized and displayed in logical groups.

MDM Full Alarm Format tab
The MDM Full Alarm Format tab displays all of the same alarm information 
that is displayed in the Alarm List area, except only for the selected alarm. 
The details are organized and displayed in full format. 

NTP Description of Fault tab
The NTP Description of Fault tab displays the NTP description for the 
selected alarm.

Alarm Menu pop-up menu
The Alarm Menu is a pop-up menu that opens when you right click on an 
alarm in the list area. You must be operating in active mode to open the Alarm 
Menu. The Alarm Menu contains the following commands:

Table 62
Alarm menu commands

Command Description

Copy Copies all the selected alarms so that they can 
be pasted later.

Acknowledge Alarms Opens the Acknowledge Alarms dialog box. This 
dialog box allows you to select and acknowledge 
alarms.

Unacknowledge Alarms Opens the Unacknowledge Alarms dialog box. 
This dialog box allows you to select and 
unacknowledge alarms.
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Local Clear Removes the selected alarms from the SDM, 
NMDR, or GMDR local database. The selected 
alarm is not removed from the Alarm Display 
alarm list until a Clear is received from SDM, 
NMDR, or GMDR.

Global Clear Removes the selected alarm from the NCS 
active alarm list. The selected alarms are not 
removed from the Alarm Display alarm list until a 
Clear is received from NCS. (This selection is 
only available for DPN alarms). Global Clear is 
disabled for proxy alarms.

Start Tool Allows you to access various tools. For details on 
the Start Tool menu, see the section about the 
Start Tool in 241-6001-122 Preside MDM Using 
MDM Toolset and Operator Client Interfaces. 
Start tool menus can be customized. For 
information about customizing start tools, see the 
section on customizing the toolsets and Start 
Tools menu in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Table 62
Alarm menu commands

Command Description
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Alarm Display fundamentals
The Alarm Display provides a list of logs and active alarms in the network. It 
lets you view alarms received from Passport, MPE 9500, DPN and selected 
SNMP devices in a single window. You can use the Alarm Display in 
conjunction with other surveillance tools to isolate faults in your network.

You access the Alarm Display tool from the Fault toolset in the Preside MDM 
window. The Alarm Display provides two modes of operation: Active and 
Logs. The Alarm Display displays all alarms in a common format. You can 
launch Alarm Display with an Active Alarm List or a window that displays a 
log of all alarms received.

Alarm details
Regardless of the type of device that is generating an alarm, Alarm Display 
provides the same set of details about each alarm, where applicable. The 
details provided by Alarm Display are as follows:

Display formats for alarm details
When you are viewing alarm details in Alarm Display, you can control the 
number of details that are displayed using display formats. The method that 
you use to control the display format is different for the MDM Toolset 
Environment and the MDM Operator Client environment.

Alarm severity
Passport and MPE 9500 switch alarms are shown in common format. The 
table “Common alarm severity mapping” (page 362) shows the mapping 
between the Preside Multiservice Data Manager (MDM) Alarm Display 
common alarm severities and Passport and MPE 9500 switch severities.
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Alias substitution for component names in MDM Toolset
The Alarm Display provides an option that lets you substitute an alias for the 
component name when displaying alarms. This function is an extension of the 
Customer Database (CDB) support. To use the alias function, you need to 
customize the tool’s Motif resources. To enable alias substitution set the 
cdbSupportAlias resource to a value of True. For details, see “Resources for 
color control of common alarm formats by Alarm Display” (page 326).

When you enable support for alias substitution, the CDB Preferences Dialog 
box opens with an additional checkbox—Display component ID alias from 
CBC server. Use this checkbox to turn alias substitution on or off in Alarm 
Display. 

When alias substitution is turned on, the component name is replaced by the 
alias in the Customer Database’s Related Component field. The alias displays 
in all alarm formats. However, a new second line displays in the normal and 
full formats to indicate the real component name. For more information, see 
“Displaying Customer Database Information in MDM Toolset” (page 364). 

Table 63 
Common alarm severity mapping

MDM Alarm Display 
common alarm 
severity label

Passport and MPE 
9500 switch severity 
label

DPN switch severity 
label

CRITICAL Critical Major

MAJOR Major Minor

MINOR Minor

CLEAR Clear Wildcard

WARNING Warning Degrade, Overload

UNKNOWN Indeterminate others
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Active mode
The Active mode shows the SET alarms for which there is no corresponding 
CLEAR. The display is auto refreshed at a default rate of once every minute; 
it removes cleared alarms and inserts new SET alarms. You can turn the auto 
refresh off and refresh the display as needed by pressing the Refresh button.

Note: If more than 500 SET alarms are received with the Auto Refresh 
turned off, it automatically resets to On and forces a refresh of the 
display.

You can perform the following actions in Active mode:

• Double click on an alarm to change the alarm display format. 

• Press the Shift key and double click on an alarm to change the alarm 
display format to full syntax.

• Press the Control key and double click on an alarm to acknowledge or 
unacknowledge an alarm. For details on acknowledging and 
unacknowledging alarms, see “Acknowledging and Unacknowledging 
Alarms” (page 364).

• Select an alarm and press the up or down arrow key to scroll through the 
list of alarms displayed on the screen.

Log mode
When the Alarm Display tool is in the Log mode, the SET, CLR, and MSG 
alarms are shown as they are asynchronously received. 

Babbler alarms are kept by Preside Multiservice Data Manager (MDM). A 
babbler alarm is defined as a SET alarm generated by the switch, without a 
corresponding CLR alarm. The babbler alarms carry a different notification 
ID but the same component ID, the same fault code, and the same alarm 
severity as the previous SET alarms they are duplicating. 

In the case of successive SET alarms, FMDR and NMDR retain the latest 
received alarm, and previous alarms become historical alarms. By default, 
DPN babbler alarms are discarded by MDM. To enable DPN babbler alarms, 
run the DMDR server with the -B option. For information on the DMDR 
server startup options, see 241-6001-310 Preside MDM Server Reference 
Guide. 
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You can perform the following actions in Log mode:

• Double click on an alarm to change the alarm display format.

• Press the Shift key and double click on an alarm to change the alarm 
display format to full syntax.

• Press the Control key and double click on an alarm to acknowledge or 
unacknowledge an alarm. For details on acknowledging or 
unacknowledging alarms, see “Acknowledging and Unacknowledging 
Alarms” (page 364).

• Select an alarm and press the up or down arrow key to scroll through the 
list of alarms displayed on the screen.

Acknowledging and Unacknowledging Alarms
See “Alarm acknowledgement and unacknowledgement” (page 381) for 
fundamental information related to acknowledging and unacknowledging 
alarms.

Displaying Customer Database Information in MDM Toolset
By default, the Alarm Display does not display customer database 
information. You can, however, override this default and control the display 
of customer data in alarms by using the Set CDB Preferences Dialog. See 
“Setting customer database preferences in MDM Toolset” on page 320. 

Enabling the display of customer data in alarms can help you diagnose faults. 
When you do enable the display, the Alarm Display shows information on an 
alarm’s component ID from a customer database server. You can view this 
information in the full common alarm format (for both the Active and Logs 
mode) in the “CDB:” tagged field. For more information on common alarm 
format, see “Alarm severity” (page 361). 

For more information on common alarms, see “Alarm severity” (page 361). 
For details on how to setup and populate a customer database server, see 
241-6001-804 Preside MDM Workstation Utilities User Guide, “Customer 
Data Tool”. 

Note: Populate the customer database with information in the display 
component ID format. For example, use the format EM/NODE1 LP/0 
rather than EM NODE1 LP 0.
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Alarm Display provides on option that lets you use alias substitution for 
component names. To do so, you must first turn on the support for this 
capability by modifying the Motif resource files (see “Alias substitution for 
component names in MDM Toolset” (page 362). When support is enabled, 
you can use the CDB Preferences Dialog to control whether or not to display 
the alias in Alarm Display.

Filtering alarms
The Alarm Display Filter Dialog defines the conditions that alarms need to 
meet to be reported in the Alarm Display main display. Use the filter dialog 
to define filter characteristics, save or restore filter settings, and apply defined 
filter characteristics to the Alarm Display main display.

Defining filters
Alarms can be filtered to display specific severities, fault codes, customer ids 
and alarms from certain components. Filtering can be enabled or disabled at 
any time with the Filter buttons on the main window. 

Multiple filters can be active at a given time. Filters can be defined to reject 
or accept alarms. 

Applying filters in MDM Toolset
You can apply your filters to the Alarm Display main display after you define 
them. 

The figure “Filtering process” (page 366) illustrates the filtering process. The 
Alarm Display shows an alarm if it matches the conditions of at least one 
Accept filter; it blocks the display of an alarm if it matches the conditions of 
one Reject filter. Alarm Display uses a two-stage filtering process. First, 
accept the alarm types you want displayed, and then reject a subset of the 
accepted alarms that you do not want to see in the Alarm Display main 
display.
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Figure 31
Filtering process

You can combine up to 10 Active filters in any combination of Accept or 
Reject filters. To set this maximum, change the AD*maxNumberActiveFilters 
resource in your resource file.

Saving filters in MDM Toolset
After you define a set of filters, you can save them to a file. Saved filters are 
automatically restored when you start the Alarm Display. Filters are stored in 
your $HOME/MagellanNMS directory under the following names: 
ADActiveModeFilterDpn.cfg (outdated), ADActiveModeFilter.cfg, 
ADLogModeFilterDpn.cfg (outdated), and ADLogModeFilter.cfg. Each filter 
is defined by a separate record and each record is separated by a blank line. A 
filter must contain a filter name, the action it performs, and its activity.

This is an example of a filter set in the Log mode: 

Reject filtersAccept filters

R2R1F2

F1

Fn DiscardedDiscarded

or

or

DisplayAlarm
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FILTERNAME: x
ACTION: ACCEPT
ACTIVE: TRUE
SEVERITY:CRITICAL
SEVERITY: MAJOR
SEVERITY: MINOR
SEVERITY: CLEARED
COMPONENT: PM/R66*
FAULTCODE:1*
CUSTOMERID:1
ACKSTATE: acked
ACKUSERID: dmei

FILTERNAME: xx
ACTION: REJECT
ACTIVE: TRUE
SEVERITY: CRITICAL
SEVERITY: MAJOR
SEVERITY: MINOR
SEVERITY: CLEARED
COMPONENT: PM/R66 PE/2*
FAULTCODE: 1*
CUSTOMERID: 1
ACKSTATE: acked
ACKUSERID: dmei

Active and Inactive Named Filters
An active filter will be used by Alarm Display when you turn your filtering 
option on. An inactive filter will not be used by Alarm Display when you turn 
your filtering option on. 

Accept and Reject Filters
Filters can be defined to reject or accept alarms. 

Setting the radio button of a named filter to Accept Alarms means that the 
named filter conditions will be used positively. To pass an Accept Filter an 
alarm needs to match the conditions specified in its definition. 
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Setting the radio button of a named filter to Reject Alarms means that the 
named filter conditions will be used negatively. An alarm matching the 
conditions specified in a reject filter will be discarded no matter what other 
accept or reject filters are in use. 

Combining Named Filters
Multiple filters can be active at a given time. When multiple filters are 
combined Alarm Display will accept an alarm if it matches the conditions of 
at least one accept filter and will discard an alarm if it matches the conditions 
of at least one reject filter. The filtering mechanism used by Alarm Display 
can be modeled as a two stage filtering process where you first choose the set 
of alarms you want to be accepted by Alarm Display and then the alarms from 
the accepted set that you want to reject.

Figure 32
Accept and reject filters

Filters Storage Format
Your filter sets are stored in your directory $HOME/MagellanNMS under the 
following names: 

Accept Filters Reject Filters

F1

F2

Fn

R1 R2

or

or

and

DisplayAlarm

Discarded Discarded
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IADActiveModeFilter.cfg, 
IADActiveModeFilterDpn.cfg (outdated), 
IADLogModeFilter.cfg and 
IADLogModeFilterDpn.cfg (outdated). 

Each filter is defined by a unique record and each record is separated by a 
blank line. A filter must contain a filter name, its activity and the action 
performed by that filter. 

FILTERNAME: <name of the filter> 
ACTION: <ACCEPT | REJECT > 
ACTIVE: <TRUE |FALSE > 
SEVERITY: < as shown in filter dialog>. 
COMPONENT: < component pattern in display format 
FAULTCODE: < a fault code pattern> 
CUSTOMERID: < a customer id number > 
ACKSTATE: < as shown in filter dialog>
ACKUSERID: <an ack userid pattern>

Saving and viewing Alarm Display files
You can save the information displayed by the Alarm Display to a file and also 
view saved files. The appearance and control areas differ slightly depending 
on whether you are in Active Alarms or Logs mode.

For situations in which you do not wish to have an operator logged in to the 
Alarm Display Tool, there is another way to extract alarms from Preside 
Multiservice Data Manager (MDM) with the rncslarm utility. For 
information about this utility, see the section on extracting alarms in text 
format in 241-6001-301 Preside MDM Customization Administrator Guide.

Pattern matching using wildcards
Alarm Display supports two types of pattern matching wildcards for the 
component id, the fault code, the acknowledgement user id, and comment 
data. The first one is "*" which matches any string, including the null string. 
The second one is "?" which matches any single character. You can use more 
than one pattern matching character.
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Example
Component id pattern PM/R66* would get all the alarms on a component 
starting with PM/R66 and its subcomponents.

Example
The component id pattern PM/R66* PO/* would filter the port alarms on 
the PM/R66.

Example
The fault code pattern 30* retrieves all alarms with a fault code beginning 
with 30.

Example
The Ack userid pattern dmei* retrieves all alarms that are acked or 
unacked by user dmei, regardless of which workstation is used.

DPN Alarm Display
The DPN Alarm Display tool displays DPN alarms in the DPN format. 

See “Alarm Display interface in the MDM Toolset” on page 328 for more 
information related to the Alarm Display interface, procedures and 
fundamentals.
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Alarm Help

Alarm Help lets you view alarm code descriptions from the following 
documents on the workstation to assist in problem detection and correction:

• 241-1001-506 DPN-100 Alarm Console Indications contains DPN 
alarms

• NN10600-500 Nortel Networks Multiservice Switch 7400/15000/20000 
Alarms Reference contains Passport alarms

• 241-6001-501 Preside MDM Alarms Reference Guide contains MDM 
proxy alarms and alarms for SNMP devices supported by MDM

• NN10700-014 Nortel Networks Multiservice Provider Edge 9500 
Alarms Reference contains MPE 9500 alarms

Navigation
• “Alarm Help basic procedures” (page 371)

• “Alarm help window” (page 380)

Alarm Help basic procedures
Alarm Help is a utility that lets you view alarm code descriptions for the 
following:

• DPN devices

• Passport devices

• MPE 9500 devices

• Preside Multiservice Data Manager (MDM) proxy alarms
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• SNMP-supported devices

In addition, you can use Alarm Help to add and edit your own user-defined 
alarm code descriptions.

Navigation
• “Starting Alarm Help” (page 372)

• “Stopping Alarm Help” (page 373)

• “Searching for an alarm code” (page 373)

• “Searching for a text string” (page 374)

• “Viewing alarm codes from Alarm Display or Component Information 
Viewer” (page 374)

• “Adding and editing alarm codes” (page 375)

— “Adding a description for a new alarm code” (page 376)

— “Adding a description using an existing alarm code” (page 377)

— “Editing an alarm code description” (page 377)

— “Deleting an alarm code description” (page 379)

Starting Alarm Help 
Start Alarm Help for access to online documents.

Procedure step
1 On the Preside MDM window, select Fault -> Alarm Help

The Alarm Help window opens with the Introduction of the Alarm Console 
Indications document.
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Stopping Alarm Help
Start Alarm Help to close the display window.

Procedure step
1 Use one of the following methods to stop Alarm Help:

• Close the Netscape browser. Minimizing the window does not stop 
the alarm help display.

• Select any context-sensitive help menu item.

• Click any help button.

Searching for an alarm code
You can search for a particular alarm code in Alarm Help. To do so, you need 
to specify all characters in the 8-digit code. You cannot search based on 
partial matches or wildcards.

Procedure steps
1 Enter the 8-digit alarm code in the text entry field. 

The fault code is eight hexadecimal digits entered as XXXX XXXX or 
XXXXXXXX.

2 Click the Search Alarm button. 

If the alarm code is matched with one or more occurrences, all the 
occurrences are displayed in the navigation area. If no alarm code is 
matched, the words No matches is displayed.

Note 1:  You can replace any of the eight hexadecimal digits in the fault 
code with a wildcard character. Type the wildcard characters in the text 
entry field.

Note 2:  Valid wildcard characters are n, x, y, and z. These can take on 
the hexadecimal values of 0 (zero) through F. You can also use the 
question mark (?) as a wildcard character to replace a single digit, and the 
asterisk (*) to replace a number of digits at the end of the alarm code.
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Searching for a text string
Search for a text string to locate specific information.

Procedure steps
1 Type the text string, enclosed by single quotes, in the text entry field. 

2 Click the Search Text button.

If the string is matched with one or more occurrences, all the occurrences 
of the text string will appear in the navigation area. If the text string cannot 
be matched, the phrase No Matches is displayed in the view area.

Note:  Matched strings can occur both in headings and in any other text 
within a document.

Viewing alarm codes from Alarm Display or Component 
Information Viewer

Open alarm help from the Alarm Display or Component Information Viewer 
using the Start Tool.

Procedure steps
1 If Alarm Help is not running, open Alarm Help:

a. Select an alarm in Alarm Display or Component Information Viewer. 

b. With the right mouse button, select Start Tool.

c. From the Start Tool menu, select Alarm Help.

2 Select the alarm code you want to view.

The text for the selected alarm code will be displayed in Alarm Help.
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Adding and editing alarm codes
Alarm Help allows you to add alarm code descriptions. You can add a new 
alarm code or you can reuse an existing alarm code. You can also edit or 
delete alarm code descriptions.

Note: If you add or modify alarm code descriptions in the Online 
Documentation (UNIX) and then switch to Online Documentation 
(Web), the revisions may not be available to Online Documentation 
(Web). If this occurs, use the following procedure:

Navigation
• “Adding a description for a new alarm code” (page 376)

• “Adding a description using an existing alarm code” (page 377)

• “Editing an alarm code description” (page 377)

• “Deleting an alarm code description” (page 379)
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Adding a description for a new alarm code
Add a description to a user-defined alarm code.

Procedure steps
1 Enter a new alarm code in the text entry field. 

The code should consist of eight hexadecimal digits. Make sure the code 
does not conflict with any other alarm codes.

The SNMP Surveillance Adapter has a CD (customer-defined) labelling 
feature. If you enter only six digits, CD is automatically added to the start 
of the six-digit code. For example, 123456 becomes CD 123456. This CD 
label helps to ensure that the alarm code will not conflict with any other 
alarm code.

If you enter eight digits, CD is not added to the start of the alarm code. 
Make sure the code does not conflict with any other alarm codes.

Note 1:  The CD labelling feature is unique to the SNMP Surveillance 
Adapter. This feature does not apply to the SNMP Integrator.

Note 2:  The first two numbers should match the device type value for the 
device being managed.

2 Click the Add/Edit button.

The Edit Alarm Text window is displayed with the new alarm code in the 
title bar of the window.

3 Type the text of the alarm code description in the window.

4 Click the Apply button.

The new alarm code is added to the end of the list in the navigation area.
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Adding a description using an existing alarm code
Add a description to an existing user-defined alarm code.

Procedure steps
1 Select an existing alarm code:

Select an existing alarm code one of the following ways:

• Enter an existing alarm code in the text entry field as an eight 
hexadecimal digit. For example, enter CD12 3456, or 5004 0100.

• Select an alarm code in the navigation area.

2 Click the Add/Edit button.

The Edit Alarm Text window is displayed with the existing alarm code in 
the title bar of the window.

3 Type the text of the alarm code description in the window.

4 Click the Apply button.

Note:  You can only add user-defined alarm codes. If you use this 
procedure to edit an existing alarm code that was provided to you, a 
duplicate alarm code description will be created.

The new alarm code is added to the end of the list in the navigation area.

Editing an alarm code description
Edit a description to an existing alarm code.

Procedure steps
1 Select an existing alarm code:

Select an existing alarm code one of the following ways:

• Enter the alarm code in the text entry field as an eight hexadecimal 
digit. For example, enter CD12 3456, or 5004 0100.

Select an alarm code in the navigation area.

2 Click the Add/Edit button.

The Edit Alarm Text window is displayed with the existing alarm code in 
the title bar of the window.

3 Edit the text of the alarm code description in the window.

4 Click the Apply button.
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Deleting an alarm code description
Delete a description to an existing user-defined alarm code.

Procedure steps
1 Select an existing alarm code:

Select an existing alarm code one of the following ways:

• Enter the alarm code in the text entry field as an eight hexadecimal 
digit. For example, enter CD12 3456, or 5004 0100.

• Select an alarm code in the navigation area.

2 Click the Add/Edit button.

The Edit Alarm Text window is displayed with the existing alarm code in 
the title bar of the window.

3 Click the Delete button.

A warning is displayed asking if you want to delete the alarm code 
description. 

4 Click the Yes button to confirm you want to delete the alarm code 
description.

Note:  You can only delete user-defined alarm code descriptions.
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Alarm help window
When you start Alarm Help, a Netscape browser opens and displays the alarm 
in context. The alarm in context is the last alarm that was selected from the 
Alarm Display or Component Information Viewer tool. If no alarm is in 
context when you start Alarm Help, the top of the Alarm Console Indications 
document displays in the window. After you start Alarm Help, the contents of 
the window update automatically as the alarm in context changes.

Alarm help buttons and fields
The following buttons and fields are available from the Alarm help window:

Alarm help areas
The Alarm Help window has the following areas:

• a navigation area on the left that contains a table of contents.

• a view area on the right that contains the text of the alarm documents.

Table 64
Alarm help buttons and fields

Command Description

Reset  returns you to the top of the Alarm Console 
Indications document when you have been doing 
other viewing or searching. 

Note:  Note: By default the word Introduction is 
displayed in the text entry field because that is 
the first text found.

Text Text entry field lets you type in an alarm code or 
other text that you want searched.

Search Alarm Initiates a search for an alarm code. 

Search Text Initiates a search through the alarm documents 
for a specific text string.

Add/Edit Lets you add you own alarm code descriptions to 
Alarm Help and edit them
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Alarm acknowledgement and 
unacknowledgement

The Alarm acknowledgement and unacknowledgement tools enable you to 
acknowledge and unacknowledge alarms.

Navigation
• “Alarm acknowledgement and unacknowledgement procedures” 

(page 381)

• “Alarm acknowledgement and unacknowledgement overview” 
(page 388)

Alarm acknowledgement and unacknowledgement 
procedures

• “Acknowledging alarms in MDM Toolset” (page 382)

• “Unacknowledging alarms in MDM Toolset” (page 383)

• “Acknowledging active alarms on selected components in MDM 
Toolset” (page 384)

• “Unacknowledging active alarms on selected components in MDM 
Toolset” (page 385)

• “Acknowledging alarms in Operator Client” (page 386)

• “Unacknowledging alarms in Operator Client” (page 387)
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Acknowledging alarms in MDM Toolset
You can acknowledge selected active alarms when Alarm Display is in active 
mode. When you acknowledge an alarm, a checkmark icon is displayed to the 
left of that alarm in the alarm list. The icon appears in both active and log 
modes. You can also view the date and time of the acknowledgment, the 
userid of the person who acknowledged the alarm, and the reason for the 
acknowledgement, depending on the display format you are using.

Procedure steps
1 From the Alarm Display window, select the alarm that you want to 

acknowledge.

2 Right-click on the selected alarm.

3 Select Acknowledge Alarms from the pop-up menu.

4 In the Acknowledge Alarm(s) Dialog box, type a reason for the action in 
the Reason field. You may also need to enter a userid in the User field, if 
the system administrator has enabled changes to this field. The default 
value for the User field is <UnixUserID@hostname>.

5 Click Ack Alarm(s).
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Unacknowledging alarms in MDM Toolset
You can unacknowledge selected acknowledged alarms when the Alarm 
Display is in active mode. When you unacknowledge an alarm, a crossed out 
checkmark icon to the left of that alarm is displayed in the alarm list. The icon 
appears in both active and log modes. You can also view the date and time of 
the unacknowledgement, the userid of the person who unacknowledged the 
alarm, and the reason for the unacknowledgement, depending on the display 
format you are using.

Procedure steps
1 From the Alarm Display window, select the alarm that you want to 

unacknowledged.

2 Right-click on the selected alarm.

3 Select Unacknowledge Alarms from the pop-up menu.

4 In the Unacknowledge Alarm(s) Dialog box, type a reason for the action 
in the Reason field. You may also need to enter a userid in the User field 
if the system administrator has enabled changes to this field. The default 
value for the User field is <UnixUserID@hostname>.

5 Click Unack Alarm(s). 
Preside MDM Fault Management User Guide   15.1RSUP



384   Chapter 8 Alarm acknowledgement and unacknowledgement
Acknowledging active alarms on selected components in 
MDM Toolset

Active alarms for selected components from within the Network Viewer, 
Component Status Display, Network Status Bar, and Component Information 
Viewer can be acknowledged.

1 When the Acknowledge Alarms Dialog opens, enter a reason or modify 
the existing reason. 

2 If the dialog is configured to allow the user value to be changed, modify it 
if required.

3 Click Also ack all alarms on related sub-components.

This acknowledges all active alarms for all subcomponents belonging to 
the selected component.

4 Click Ack Alarm(s). 

The dialog closes.

An attempt is made to acknowledge each alarm. If a given alarm fails to 
be acknowledged, other alarms are not affected and they can still be 
acknowledged.
241-6001-011   15.1RSUP   



Chapter 8 Alarm acknowledgement and unacknowledgement   385
Unacknowledging active alarms on selected components in 
MDM Toolset

Active alarms for selected components from within the Network Viewer, 
Component Status Display, Network Status Bar, and Component Information 
Viewer can be unacknowledged. 

1 When the Unacknowledge Alarms Dialog opens, enter a reason or modify 
the existing reason. 

2 If the dialog is configured to allow the user value to be changed, modify it 
if required. 

3 Click Also unack all alarms on related sub-components.

This unacknowledges all active alarms for all subcomponents belonging 
to the selected component.

4 Click Unack Alarm(s). 

The dialog immediately closes.

An attempt is made to unacknowledge each alarm. If a given alarm fails 
to be unacknowledged, other alarms are not affected and they can still be 
unacknowledged. 
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Acknowledging alarms in Operator Client
You can acknowledge selected active alarms when Alarm Display is in active 
mode. When you acknowledge an alarm, a checkmark icon is displayed to the 
left of that alarm in the alarm list. The icon appears in both active and log 
modes. You can also view the date and time of the acknowledgment, the 
userid of the person who acknowledged the alarm, and the reason for the 
acknowledgement, depending on the display format you are using.

Procedure steps
1 From the Alarm Display window, click Active Alarms from the Alarm mode 

list box.

2 Select the alarm that you want to acknowledge.

3 Right-click on the selected alarm.

4 Select Acknowledge Alarms from the pop-up menu.

5 In the Input Dialog box, type a reason for the action in the Enter 
acknowledgement comment field and click OK. You may also need to 
enter a userid in the User field, if the system administrator has enabled 
changes to this field. The default value for the User field is 
<UnixUserID@hostname>.
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Unacknowledging alarms in Operator Client
You can unacknowledge selected acknowledged alarms when Alarm Display 
is in active mode. When you unacknowledge an alarm, a crossed out 
checkmark icon to the left of that alarm in the alarm list. The icon appears in 
both active and log modes. You can also view the date and time of the 
unacknowledgement, the userid of the person who unacknowledged the 
alarm, and the reason for the unacknowledgement, depending on the display 
format you are using.

Procedure steps
1 From the Alarm Display window, click Active Alarms from the Alarm mode 

list box.

2 Select the alarm that you want to unacknowledge.

3 Right-click on the selected alarm.

4 Select unacknowledge Alarms from the pop-up menu.

5 In the Input Dialog box, type a reason for the action in the Enter 
unacknowledgement comment field and click OK. You may also need 
to enter a userid in the User field, if the system administrator has enabled 
changes to this field. The default value for the User field is 
<UnixUserID@hostname>.
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Alarm acknowledgement and unacknowledgement 
overview

The Alarm Acknowledgment tool lets you notify others that you are 
investigating a problem associated with one or more active alarms. When you 
no longer need alarms acknowledged, use the Alarm Unacknowledgement 
tool. Rather than removing acknowledgement, the Alarm 
Unacknowledgement tool changes the acknowledged status to 
unacknowledged. 

Alarm acknowledgment and unacknowledgement behave as a SET/
REPLACE. For example, a previously unacknowledged alarm can be 
acknowledged using the SET operation; a currently acknowledged or 
unacknowledged alarm can be changed using the REPLACE operation.

You can unacknowledge previously acknowledged alarms and acknowledge 
previously unacknowledged alarms. You can also append acknowledgement/
unacknowledgement information to an alarm that has previously been 
acknowledged/unacknowledged.

Alarm Acknowledgment is started from the Acknowledge Alarm(s) Dialog 
under the following conditions:

• on a set of selected active alarms from within the Alarm Display.

• on a set of selected active alarms from within the Component 
Information Viewer. 

• on a selected component from within the Network Viewer.

• on a selected component from within the Component Status Display.

• on a selected component from within the Network Status Bar.

• on a selected component from within the Component Information 
Viewer.
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These scenarios cause an ackAlarm request to be issued to the GMDR server 
to perform the required acknowledgment. For additional information, see 
241-6001-303 Preside MDM Administrator Guide, and the section on 
Inbound Alarm API in 241-6001-203 Preside MDM Alarm and Status API 
Reference Guide. 

For more details about Alarm Acknowledgement and Unacknowledgement, 
see, the following topics:

• “Acknowledging and unacknowledging single or multiple alarms in 
MDM Toolset” (page 389)

• “Changing state by acknowledging all active alarms on a component in 
MDM Toolset” (page 390)

• “Displaying alarm acknowledgment and unacknowledgement 
information in MDM Toolset” (page 390)

• “Acknowledge Alarm(s) Dialog in MDM Toolset” (page 390)

• “Unacknowledge Alarm(s) Dialog in MDM Toolset” (page 392)

• “Input dialog in Operator Client” (page 394)

• “Customizing the Alarm Acknowledgment Dialog in MDM Toolset” 
(page 394)

Acknowledging and unacknowledging single or multiple 
alarms in MDM Toolset

You can acknowledge or unacknowledge a selection of active alarms and you 
can acknowledge all alarms for a given component. To acknowledge and 
unacknowledge one or more active alarms, use the following commands 
available from MDM alarm-based fault management tools (for example, 
Alarm Display and Component Information Viewer): 

• Acknowledge Alarms to acknowledge one or more selected active 
alarms 

• Unacknowledge Alarms to remove acknowledgement from one or more 
selected acknowledged alarms
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To acknowledge and unacknowledge all active alarms for a selected 
component, and optionally its related subcomponents, use the following 
commands from MDM state-based fault management tools (for example, 
Network Viewer and Component Information Viewer):

• Acknowledge Alarms on Component to acknowledge all active alarms 
for a selected component, and optionally its subcomponents.

• Unacknowledge Alarms on Component to unacknowledge any 
currently acknowledged alarms for a selected component.

Changing state by acknowledging all active alarms on a 
component in MDM Toolset 

The Alarm Acknowledgement and Unacknowledgement tool provides a link 
between alarm-based and state-based surveillance. Acknowledging all active 
alarms on a component masks the component state during propagation. When 
you acknowledge all active alarms on a component from an alarm-based tool 
such as Alarm Display, the propagated state of the component becomes 
acknowledged. The effect is similar to manually acknowledging a component 
state from a state-based tool such as the Network Viewer, where the raw state 
remains unchanged. For details, see the section on the General Management 
Data Router (GMDR) in 241-6001-310 Preside MDM Server Reference 
Guide.

Displaying alarm acknowledgment and 
unacknowledgement information in MDM Toolset

When you acknowledge or unacknowledge alarms, a dialog opens and 
displays the user ID from which the acknowledge or unacknowledge request 
was made and prompts for the reason for the request. Displaying alarm 
information in full format from the Alarm Display or Component Information 
Viewer tool includes the user ID, time, and reason for acknowledgement or 
unacknowledgement. Acknowledged alarms in Alarm Display and 
Component Information Viewer display with checkmark to the left of the 
alarm. Unacknowledged alarms display with an X on top of the checkmark.

Acknowledge Alarm(s) Dialog in MDM Toolset
The Acknowledge Alarm(s) Dialog is used to acknowledge one or more 
active alarms. 
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The figure “Acknowledge Alarm(s) Dialog for selected active alarms” 
(page 391) illustrates an Acknowledge Alarm(s) Dialog for selected active 
alarms.

Figure 33
Acknowledge Alarm(s) Dialog for selected active alarms

The data entry fields for the Acknowledge Alarm(s) Dialog are as follows:

• User indicates the identifier stored as part of the alarm (the person 
associated with the acknowledgment or unacknowledgement). This value 
is non-editable (by default) but can be made editable through the resource 
modification described in “Customizing the Alarm Acknowledgment 
Dialog in MDM Toolset” (page 394).

• Reason specifies the reason for the acknowledgment and is stored as part 
of the alarm. You can enter text description of up to 256 characters 
(maximum allowable length by default). You can alter the maximum 
allowable length for the reason text through the resource modification 
described in “Customizing the Alarm Acknowledgment Dialog in MDM 
Toolset” (page 394). If you select a single alarm that was previously 
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acked or unacked, the reason text associated with that alarm 
automatically appears by default. You can delete this text by typing new 
text, or you can modify it by clicking the text using the left mouse button.

The Acknowledge Alarms Dialog has the following buttons:

• Ack Alarms sends an ackAlarm request to the General Management Data 
Router (GMDR) server for each selected active alarm (if this dialog is 
invoked from an alarm list menu item) or for every active alarm for the 
current component (if this dialog is invoked from a toolset menu item)

• Cancel ignores the request and pops down the dialog.

• Help displays information about Alarm Acknowledgment and 
Unacknowledgement. 

The following button is displayed only when you acknowledge all active 
alarms on a selected component using the Start Tool menu item: 

• Also ack all alarms on related sub-components allows you to perform a 
hierarchical alarm acknowledgment to acknowledge all active alarms on 
the component you select and on any of its subcomponents.

Unacknowledge Alarm(s) Dialog in MDM Toolset
The UnAcknowledge Alarm(s) Dialog is used to unacknowledge one or more 
active alarms. 

The figure “UnAcknowledge Alarm(s) Dialog for selected active alarms” 
(page 393) illustrates a sample Unacknowledge Alarm(s) Dialog for selected 
active alarms.
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Figure 34
UnAcknowledge Alarm(s) Dialog for selected active alarms

The data entry fields for the Unacknowledge Alarm(s) Dialog are as follows:

• User indicates the identifier stored as part of the alarm (the person 
associated with the acknowledgment or unacknowledgement). This value 
is non-editable (by default) but can be made editable through the resource 
modification described in “Customizing the Alarm Acknowledgment 
Dialog in MDM Toolset” (page 394).

• Reason specifies the reason for the unacknowledgement and is stored as 
part of the alarm. You can enter text description of up to 256 characters 
(maximum allowable length by default). You can alter the maximum 
allowable length for the reason text through the resource modification 
described in “Customizing the Alarm Acknowledgment Dialog in MDM 
Toolset” (page 394). If you select a single alarm that was previously 
acked or unacked, the reason text associated with that alarm 
automatically appears by default. You can delete this text by typing new 
text, or you can modify it by clicking the text using the left mouse button.
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The Unacknowledge Alarms Dialog has the following buttons:

• UnAck Alarms sends an ackAlarm request to GMDR for each selected 
active alarm (if this dialog is invoked from an alarm list menu item) or 
for every active alarm for the current component or subcomponent (if this 
dialog is invoked from a toolset menu item).

• Cancel ignores the request and pops down the dialog.

• Help displays information about Alarm Acknowledgment and 
Unacknowledgement. 

The following is displayed only when you unacknowledge all active alarms 
on a selected component using the Start Tool menu item: 

• Also unack all alarms on related sub-components allows you to perform 
a hierarchical alarm unacknowledgement to unacknowledge all the active 
alarms on the component you select and on any of its subcomponents.

Input dialog in Operator Client
The Input dialog in Operator client enables you to input an acknowledgement 
comment in the Enter acknowledgement comment field when you 
acknowledge an alarm. The Input dialog also enables you to enter an 
unacknowledgement comment in the Enter unacknowledgement comment 
field when you unacknowledge an alarm.

Customizing the Alarm Acknowledgment Dialog in MDM 
Toolset

The dialogs used for acknowledgment/unacknowledgement of alarms use 
resources to control their functional and visual aspects. You can customize 
some of these resources. 

The table “Resources for customizing the Acknowledge/Unacknowledge 
Alarms Dialog” (page 395) lists the alarm acknowledgment resources that 
you can customize. These resources apply to both the Acknowledge Alarm(s) 
Dialog and the Unacknowledge Alarm(s) Dialog. 
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Resource Files
The following files contain resources for the Acknowledge and 
Unacknowledge Alarm(s) Dialogs:

• /opt/MagellanNMS/lib/app-defaults/C/CIV contains resources for the 
dialog when invoked from selected alarms in the Component Information 
Viewer. 

• /opt/MagellanNMS/lib/app-defaults/C/IAD contains resources for the 
dialog when invoked from selected alarms in Alarm Display.

• /opt/MagellanNMS/lib/app-defaults/C/ACKALARM contains resources 
for the dialog when invoked from selected components in Network 
Viewer, Component Status Display, Component Information Viewer, and 
Network Status Bar.

You can make resource changes to the Alarm Acknowledgment Dialogs that 
affect a particular application or all applications that provide Alarm 
Acknowledgment. For example, you can change the following resource:

IAD*AckAlarmDlog*UserIdFieldField.editable: True

Table 65
Resources for customizing the Acknowledge/Unacknowledge Alarms 
Dialog

Resource Description Legal value

*AckAlarmDlog*userId
FieldField.editable

If True, the User field in the 
dialog used for 
acknowledging or 
unacknowledging alarms, 
can be modified. The default 
is False.

True or False

*AckAlarmDlog*
commentData.max
Length

The maximum length of 
Reason text that can be 
specified when 
acknowledging or 
unacknowledging alarms. 
The default length is 256.

Any legal Motif 
value associated 
with the MaxLength 
resource.
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This enables the user field to be editable when acknowledging or 
unacknowledging alarms from the Alarm Display. If you omit the IAD prefix, 
all applications are affected.

See the section on customizing resources used by MDM tools in 
241-6001-301 Preside MDM Customization Administrator Guide, for more 
information on setting and overriding resources.
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Network Status Bar

Use the Network Status Bar to view the current status of network components 
and see status changes.

Navigation
• “Network Status Bar procedures” on page 397

• “Network Status Bar fundamentals” on page 400

• “Network Status Bar interface in Preside MDM Toolset” on page 402

• “Network Status Bar interface in Preside MDM Operator Client” on 
page 409

Network Status Bar procedures
You can perform the following tasks using the Network Status Bar:

• “Starting the Network Status Bar” (page 397)

• "Acknowledging all current values" on page 398

• "Customizing the Troubled Components pop-up menu for Preside MDM 
Toolset" on page 398

• "Customizing resources in the Network Status Bar for Preside MDM 
Toolset" on page 399

Starting the Network Status Bar
You can leave the Network Status Bar open continuously, so that changes in 
the network can be monitored while you use the workstation for other 
applications.
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Procedure steps
1 From the Fault menu, select Network Status Bar.

The Network Status window opens.

2 Select Refresh to view the latest information from the GMDR database.

The Network Status window is updated with the latest information from 
the GMDR database.

Acknowledging all current values
Acknowledging the current values for each severity changes the background 
to the same color for all counts. When any severity value changes, the 
background color reverts back to its unacknowledged color. This visible 
feedback helps you to identify changes in values.

Procedure steps
1 Acknowledge all current values:

The background color changes.

2 Refresh the display if you want to force all background colors back to their 
original color:

Customizing the Troubled Components pop-up menu for 
Preside MDM Toolset

For procedures on customizing the pop-up menu in the Troubled Components 
window, see the section on customizing the toolsets and Start Tools menus in 
241-6001-301 Preside MDM Customization Administrator Guide. 

If running.... Action

MDM Toolset Click Acknowledge.

MDM Operator client Select Options and then Acknowledge.

If running.... Action

MDM Toolset Click Refresh.

MDM Operator client Select Options and then Refresh.
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When you modify the menu, use one of the following substitution variables 
in the command line:

• $COMP: The internal component name of the target

• $DCOMP: The display component name of the target

Customizing resources in the Network Status Bar for Preside 
MDM Toolset

The Network Status Bar uses resources to describe certain functional and 
appearance aspects. Some of these aspects can be customized. Others must 
not be tampered with without affecting the functionality of the Network 
Status Bar.

For details about customizing resources, see the section on customizing 
resources used by MDM tools in 241-6001-301 Preside MDM Customization 
Administrator Guide. The original resource file for the Network Status Bar is 
/opt/MagellanNMS/lib/defaults/C/StatsBar.

The table “Resources in the Network Status Bar that you may customized” 
(page 400) lists the Network Status Bar resources that you may customize.

CAUTION
Risk of altering the functionality of the NSB
Do not modify resources that are not listed in the table: 
"Resources in the Network Status Bar that you may 
customized" on page 400. Changing unlisted resources 
may negatively affect the appearance and functionality of 
the Network Status Bar.
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 Network Status Bar fundamentals
The Network Status window provides a high-level view of the current 
network status. This window also monitors a set of statistical indicators 
gathered from the general management data router (GMDR) database. Some 
of these indicators quantify troubled elements in the network, including the 
number of active alarms and the number of out-of-service components. 
Because the Network Status Bar is context-linked to the Component 
Information Viewer and the Alarm Display tools, you can drag and drop 
components onto these tools to diagnose faults in the network

The Network Status window supports the following capabilities:

• global network status monitoring and indicator thresholding

• a Troubled Components window that displays troubled components from 
the network model Preside MDM Toolset

• service selection of the network model for Preside MDM Toolset

• service selection of the GMDR servers

Table 66
Resources in the Network Status Bar that you may customized 

Resource Description Legal values

compOOSThresh
dbnlCountThresh
critAlmThresh
majorAlmThresh
minorAlmThresh
warnAlarmThresh 

Indicator thresholds Integer (def: 0)

refreshPeriod Main window refresh interval Integer (def: 60s)

errorColor Major indicators’ background color Color

warningColor Minor indicators’ background color Color

plainColor Non-threshold background color Color

ackedColor Acked indicators’ background color Color
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The Network Status window displays the number of alarms by severity. 
Severity levels include the following: 

• C (critical)

• M (major)

• m (minor)

• W (warning)

Each severity is color coded according to the color scheme in effect. You can 
use the Preside Multiservice Data Manager (MDM) or standard color scheme. 
For details, see the table "MDM state color conventions" on page 249. In 
addition to color, each severity level contains an indicator value (a value that 
indicates the number of alarms at that level).
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Network Status Bar interface in Preside MDM Toolset
The main window and the overall notifies of the Network Status Bar in the 
MDM Toolset environment is made up of the following parts: 

• “Menu bar” (page 403)

• “Component information area” (page 403) 

• “Alarm information” (page 404) 

• “Button bar” (page 405)

• "Troubled Components Dialog" on page 406

• "Error Dialogs" on page 407

• "Warning Dialogs" on page 408

See the figure “Network Status Bar window in MDM Toolset” (page 402) for 
a sample Network Status Bar window.

Figure 35
Network Status Bar window in MDM Toolset

Active alarms and out-of-service components indicate troubled network 
elements. Troubled elements display with a colored background: red for 
major trouble and orange for minor trouble. This puts emphasis on their 
values if a customizable threshold is crossed. If no threshold is crossed, their 
background remains a neutral color. 

menu bar

alarm 
information 
area
command 
buttons

component 
information 
area
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The information displayed is refreshed on a regular basis, typically every 
60 seconds. The time interval can be set by using the refreshPeriod resource 
or the -refresh command line option. For additional information, see 
“Customizing resources in the Network Status Bar for Preside MDM Toolset” 
(page 399).

Menu bar
The menu bar contains the following menus: 

• “File” (page 403)

• “Help” (page 403)

File
The File menu contains the following command: 

• Exit closes the window and exits the tool.

Help
The following commands are available from the Help menu:

Component information area
The component information area displays information on the total number of 
components managed by GMDR and its breakdown into per state counts (the 
states here are raw states, as opposed to those visible from a Network Model 
base tool). Counts are shown for both modules/subcomponents and plain and 
dynamic links (DBNL): 

Command Description

on Window Provides help on the Network Status Bar 
window.
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Alarm information
The alarm information area displays information on the number of active 
alarms in the GMDR database. This count is broken down in terms of 
(common format) alarm severities and the alarm arrival rate in alarms per 
minute.

State Description
Totals The total number of modules or subcomponents

* OOS The number of out-of-service components 
(modules and subcomponents) (threshold 
resource: compOOSThresh)

+ ISTB The number of in-service components that are 
troubled (threshold resource: compISTBThresh)

   INSV The number of in-service components.

   UNKN The number of components in other states 
(unknown to GMDR)

+ Totals The total number of plain and dynamic links (for 
example, DBNL) known to GMDR to be active 
(threshold resource: dbnlCountThresh for 
dynamic links)

State Description
* Critical The number of active alarms of severity 

CRITICAL (threshold resource: critAlmThresh)

* Major The number of active alarms of severity MAJOR 
(threshold resource: majorAlmThresh)

+ Minor The number of active alarms of severity MINOR 
(threshold resource:     minorAlmThresh)
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Note 1:  The ‘*’ indicates a major trouble indicator displaying a red 
background when its value is above threshold

Note 2:  The ‘+’ indicates a minor trouble indicator displaying an orange 
background when its value is above threshold. For links, the number of 
DBNLs is checked.

Button bar
The Network Status Bar button bar provides the following buttons:

+ Warning The number of active alarms of severity 
WARNING (threshold resource: 
warnAlarmThresh)

Unknown The number of active alarms of severity 
INDETERMINATE (or other)

Total/Rate The number of active alarms or the alarm arrival 
rate (alarms per minute) 

Table 67
Button bar commands

Command Description

Refresh Updates the dialog with the latest information 
from the GMDR database. Acknowledgment is 
removed and thresholded background colors are 
displayed as required.

State Description
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Troubled Components Dialog
The Troubled Components Dialog displays the troubled components in the 
Network Model. A list on the left shows all components and links known to 
the Network Model to have a Troubled state (out-of-service or in-service–
troubled) or to have subcomponents with a Troubled state. It also displays all 
Dial Backup Network Links (DBNLs) known to be active. When a 
component in this list is selected, the list on the right is updated to include the 
troubled subcomponents for the selected component module or link (for links, 
both endpoints are shown as in the Component Information Viewer's Related 
List). 

Note that the contents of the dialog are not updated automatically as that of 
the main window. To update the information in the dialog, select the Refresh 
button. 

The subcomponents in the troubled subcomponents list support a pop-up start 
tools menu that lets you to start another Preside Multiservice Data Manager 
(MDM) tool in the context of the selected component. For details on the Start 
Tool menu, see the section about the Start Tool in 241-6001-122 Preside 

Troubled Components Starts the Troubled Components Dialog to show 
what components are currently in the Troubled 
state (OOS or ISTB) as indicated by the Network 
Model. 

Acknowledge Acknowledges the current status values by 
changing the background color of the trouble 
indicator fields (aquamarine) on the display. As 
the values of these indicators change, their 
background color reverts to either the OK color 
(gray) or the trouble-indicating color (red or 
orange). This enables you to ignore the current 
issues in the network but be informed of any 
change in the indicators. Pressing the Refresh 
button forces all indicators to display their 
unacknowledged background color. 

Table 67
Button bar commands

Command Description
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MDM Using MDM Toolset and Operator Client Interfaces. Start tool menus 
can be customized. For information about customizing start tools, see the 
section on customizing the toolsets and Start Tools menu in 241-6001-301 
Preside MDM Customization Administrator Guide.

The component text field can be populated in these ways: 

• by dropping a component from another tool onto the dialog

• by selecting a component in the module or component list 

• by entering a component name from the keyboard 

• by selecting the Get Context button 

Note: You can also drag the components of the dialog and drop them 
(component name) onto other tools.

Components selected with the select mouse button in the subcomponents list 
(rinh) are also automatically put into (Hot) context as if the Put Context 
command had been issued.

Buttons in the dialog are as follows:

• The Find button displays the component in the component list and the 
subcomponent in the subcomponent list. The lists are scrolled so that the 
component is visible. A standard warning dialog is displayed if the 
entered component is not found. 

• The Get context button performs the Find Component operation, for the 
component in context. 

• The Put context button puts the current component in context. 

• The Refresh button updates the dialog with the latest information from 
the database.

Error Dialogs
Error dialogs warn you of an error condition. You need to respond before you 
can proceed. Click on OK to return to the application at the point before the 
error condition occurred. 
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Warning Dialogs
Warning dialogs warn of possible danger. You need to respond before you can 
proceed. Click on OK to proceed, or click on Cancel to return to the 
application at the point before the dialog appeared. 

Keyboard shortcuts
The Network Status Bar provides the following command shortcuts:

• Ctrl+E exits from the Network Status Bar tool. 

• Shift+Help displays help information for the dialog, menu item, or button 
that he cursor is currently on. When you press Shift+Help, the cursor 
changes to a question mark. Move the cursor to the item for which you 
want help and press the Select button to display help information for the 
item. 
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Network Status Bar interface in Preside MDM Operator 
Client

The main window and the overall interface of the Network Status Bar in the 
MDM Operator Client environment is made up of the following parts:

• “Menu bar” on page 409

• “Component information area” on page 413

See the figure “Network Status Bar window in MDM Operator Client” 
(page 409) for a sample Network Status Bar window.

Figure 36
Network Status Bar window in MDM Operator Client

You may also want to view the following information related to Network 
Status Bar:

• “Network Status Bar procedures” on page 397

• “Network Status Bar fundamentals” on page 400

Menu bar
Network Status bar provides the following menus:

• "File" on page 410

• "Options" on page 410

• "Help" on page 412

menu bar

command 
buttons

alarm 
information 
area
Preside MDM Fault Management User Guide   15.1RSUP



410   Chapter 9 Network Status Bar
File
The File menu contains the following command:

• Exit allows you to exit the tool and closes the window.

Options
The Options menu contains the following commands:

Command Description

Acknowledge Acknowledges the values for each severity level. 
When you select this command, the background 
color of all severity levels changes to gray. 
However, if any indicator value changes, the 
background color of its severity level reverts to its 
unacknowledged color.

Refresh Refreshes the screen by checking for indicator 
value changes. By default, the network status 
application refreshes every 60 seconds. 
Selecting this command causes an immediate 
refresh and all counts revert to the 
unacknowledged color.

Beep When Count 
Changes

Sets an audible warning when the a current 
indicator value changes. For Windows 2000, 
Windows NT, or Windows XP platforms, you may 
need to assign a sound to the default beep 
setting in the Sounds control panel. To turn on 
the beep when counts change, select the Beep 
When Count Changes check box. To turn off the 
beep, clear the check box.
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Show Component Counts Turns the display of component counts by state 
on or off. To display the number of components 
by state in the network window, select the Show 
Component Counts command. A check mark 
beside the command indicates that the 
command is enabled. The status bar application 
displays the number of components for each of 
the following states:

OOS (out-of-service)

ISTB (in-service – troubled)

INSV (in-service)

UNKN (unknown)

Command Description
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Help
The following commands are available from the Help menu:

Show Totals Turns the display of alarm count and state count 
totals on or off. To turn on the display, select the 
Show Totals command. A check mark beside the 
command indicates that the command is 
enabled. If the network status displays only alarm 
information when you select this command, then 
the following summary alarm information is 
added to the display:

-total number of alarms

-alarm rate

If the network status displays both alarm and 
component information when you select this 
command, then the following alarm and 
component summary information is added to the 
display:

-AA totals (total number of active alarms)

-AA rate (active alarm rate)

-Mod (total number of modules being monitored)

-Sub (total number of subcomponents being 
monitored)

-Links (total number of plain links)

-DBNL (total number of dynamic dial backup 
network links)

To turn off the display of state and alarm counts, 
clear the check box.

In addition to alarm count by severity, you can 
display component count by state.

Command Description
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Component information area
The component information area displays information on the total number of 
components managed by GMDR and its breakdown into per state counts.

Command Description

Help on Window Provides help on the Network Status Bar 
window.

What’s This? Displays information about a selected area of the 
Network Status Bar window.
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Component Information Viewer 

The Component Information Viewer performs diagnostic analysis of 
components identified by the first-alert surveillance tools. 

Navigation
• “Component Information Viewer procedures” (page 415)

• “Component Information Viewer fundamentals” (page 460)

• “Component Information Viewer interface in MDM Toolset” (page 479)

• “Component Information Viewer interface in MDM Operator Client” 
(page 497)

Component Information Viewer procedures
This section provides procedures for using the Component Information 
Viewer tool.

Getting Started

• “Starting Component Information Viewer” (page 418)

• “Starting Component Information Viewer with context” (page 419)

• “Exiting Component Information Viewer” (page 420)

• “Setting component filters in MDM Toolset” (page 421)

• “Setting filters in MDM Operator Client” (page 422)
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Using filters and preferences

• “Setting Preferences in MDM Toolset” (page 423)

• “Using previously saved preference settings in MDM Toolset” 
(page 426)

Working with related components

• “Setting a target in the related components panel in MDM toolset” 
(page 427)

• “Setting the acknowledge state for a component” (page 428)

• “Setting the maintenance state for a component” (page 430)

• “Starting the Start Tools from the Component Information Viewer” 
(page 432)

• “Setting a target in the information panel in MDM Toolset” (page 433)

Displaying additional information

• “Displaying additional component information in MDM Toolset” 
(page 434)

• “Clearing alarms using Local Clear” (page 435)

• “Clearing alarms using Global Clear” (page 437)

• “Clearing alarms using the Global Clear tool in MDM Toolset” 
(page 439)

• “Acknowledging active alarms” (page 441)

• “Unacknowledging active alarms” (page 443)

Displaying diagnostics

• “Displaying diagnostic information in MDM Toolset” (page 445)

• “Selecting a new command route in MDM Toolset” (page 447)

• “Selecting a new command route in MDM Toolset” (page 447)

• “Querying historical alarms from Component Information Viewer in 
MDM Toolset” (page 449)
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Customizing the tool

• “Customizing the Component Information Viewer display in MDM 
Toolset” (page 453)
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Starting Component Information Viewer
By starting the Component Information Viewer from the Fault menu, it is 
started without context. As a result, the Component Information Viewer 
opens without displaying any component information. To display 
information on a particular component, specify the component after the 
window opens.

Procedure steps
1 From the Fault menu, select Component Information Viewer.

The Component Information Viewer window opens.
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Starting Component Information Viewer with context
Context lets you transfer component information among those MDM tools 
that also support context. You can start the Component Information Viewer 
tool with context from the following Preside Multiservice Data Manager 
(MDM) tools: 

• Network Viewer

• Alarm Display

• Network Status Bar

• Component Status Display

• Circuit Viewer

When you start the Component Information Viewer tool from these MDM 
tools, the Component Information Viewer tool opens and automatically 
displays information about the component in context. 

Procedure steps
1 From any of the Preside Multiservice Data Manager (MDM) tools that 

support context, select a component.

2 Open the Start Tools pop-up menu, point to Fault and then select 
Component Information Viewer.

The Component Information Viewer opens and the Related 
Components for and Information for fields are populated with the 
component in context. 
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Exiting Component Information Viewer
Procedure steps

1 Select File and then Exit.

2 From the exit dialog box,

If running... The result is:

MDM Toolset The Exit CIV dialog opens only if you made changes 
to the Component Information Viewer. If you did not 
make changes, the Component Information Viewer 
closes.

MDM Operator 
Client 

The Exit Confirmation dialog opens.

If running... Action:

MDM Toolset select one of the following actions:
-Exit and Save to exit Component Information Viewer 
and save the modified settings.
-Exit without Saving to exit Component Information 
Viewer without saving the changes.
-Cancel Exit to cancel the exit operation and return to 
the Component Information Viewer window.
-Help to display online help.

MDM Operator 
Client

answer the following question by clicking Yes or No: 
Do you really want to exit the Component Information 
Viewer?
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Setting component filters in MDM Toolset
Use the Component Filter Settings Dialog box to limit the number of related 
components that display in the related components panel. You can filter 
components based on raw or propagated states. 

The Troubled Network State (OOS or ISTB) filter option displays only those 
components that have a raw state of Out-Of-Service (OOS) or In-Service-
Troubled (ISTB). Components with a state of Acknowledged or Maintenance 
but are still OOS or ISTB are also included. 

The Propagated State/Criticality filter option displays only those components 
that have the propagated states and state criticalities that you select. You need 
to select at least one propagated state and one state criticality. The criticality 
values range from 1 (lowest) to 5 (highest) and are only used for the OOS and 
ISTB states.

Procedure steps
1 From the Options menu, select Change Component Filter Settings….

The Component Filter Settings Dialog box opens.

2 Select either the Troubled Network State (OOS or ISTB) or 
Propagated State/Criticality filter option. If you select Propagated 
State/Criticality, then you also need to specify at least one state value 
and one criticality value.

3 When you finish modifying filter settings, use one of the following buttons 
to specify how the settings are to be used:

• To apply the new settings, click Use Filters. 

• To save the new settings to a file, click Save to File. The settings are 
saved to the file $HOME/MagellanNMS/CIVFilt.cfg.

• To restore filter settings from an existing $HOME/MagellanNMS/
CIVFilt.cfg file, click Restore from File. 

• To cancel any changes that you made to the Component Filter 
Settings Dialog box, click Cancel.
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Setting filters in MDM Operator Client
You use the options in the filter panel area of the Component Information 
Viewer window when working in the MDM Operator Client environment.

Procedure steps
1 Enable the Propogated State/Criticality radio button.

A list of check boxes appear that you can use to set state and threshold 
information for filters.

2 Click Set Filter once you have selected all of your filter settings.
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Setting Preferences in MDM Toolset
Use the Preference Settings Dialog box to control the following set of 
Component Information Viewer operating parameters:

• Auto-Context controls whether or not the Component Information 
Viewer window automatically updates the related components and 
information panels whenever a new component is put in context. 

• Auto-Raise Window controls whether or not the Component 
Information Viewer window automatically moves to the top of the 
window stack when a context operation occurs. If Auto-Raise window is 
turned off, the Component Information Viewer window will not move to 
the top of the window stack, however a bell will sound to indicate a 
context change. Auto-Raise Window is available only when Auto-
Context is turned on.

• Auto-Refresh controls whether or not the Component Information 
Viewer window regularly refreshes the contents of the related 
components and information panels. 

• Refresh Interval (sec) controls the number of seconds between 
refreshes. Refresh Interval (sec) is available only when Auto-Refresh is 
turned on. The interval represents the number of seconds the Component 
Information Viewer waits after a completed refresh before attempting 
another one. If one panel cannot refresh in time before a new cycle starts, 
it is ignored. The failure of one panel being refresh in time does not stop 
the other from being updated. 

• Alarm Format controls the level of alarm information that displays in 
the information panel. Terse displays the least amount of alarm 
information, Full displays the most, and Normal displays a mid range.

• The CDB database name and server host fields identify the name and 
server to access for customer database (CDB) information. Customer 
information displays in the information panel when the Information Type 
box is set to Customer Data. Customer information also displays when 
you select Recent Alarms or Active Alarms using full format. 

• The Insert matching data from CDB server in alarms check box 
controls whether or not the Component Information Viewer window 
automatically displays customer information that matches the 
component IDs in common full format alarms.
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• Display component ID alias from the CDB server in alarms is 
available only if you have enabled alias substitution. Use this check box 
to specify whether or not to display aliases in alarms.

Prerequisite
The Alarm Display provides an option to substitute an alias for a component 
name in the display of alarms. By default, this functionality is disabled. To 
use aliases, you first need to enable the functionality. Then, you can use the 
CDB Preferences Dialog to turn the display of aliases on or off. 

To enable alias substitution, you need to modify the CIV*cdbSupportAlias 
resource. For details, see the section on customizing resources used by MDM 
tools in 241-6001-301 Preside MDM Customization Administrator Guide. 

After alias substitution has been enabled, an additional check box (Display 
component ID alias from the CDB server in alarms) displays in the CDB 
Preferences Dialog so that you can chose whether or not to display the aliases.

Expected results
When alias substitution is enabled, the component name is replaced by the 
alias in the Customer Database’s Related Component field. The alias displays 
in all alarm formats. However, a new second line displays in the normal and 
full formats to indicate the real component name. 

Procedure steps
1 From the Options menu, select Change Preference Settings….

The Preference Settings Dialog box opens.

2 To change the automatic context setting, in the Auto-Context list box, 
select On to enable automatic context, or Off to disable it.

3 To change the setting for raising the Component Information Viewer 
window to the top of multiple windows whenever the context changes, in 
the Auto-Raise list box, select On to enable raising the window, or Off to 
disable it. 

4 To change the automatic refresh setting, in the Auto-Refresh list box, 
select On to enable automatic refreshing, or Off to disable it.

5 To set the refresh interval, move the Refresh Interval (sec) slider left to 
decrease the time interval or right to increase it.
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6 To set the alarm format, from the Alarm Format list, select Terse, Normal, 
or Full. 

7 To display customer database information in the window, specify the 
name of the customer database to use for data retrieval in the CDB 
database name field and the name of the server host in the and server 
host field. 

8 To display customer data in the alarms, select the Insert matching data 
from CDB server in alarms check box. 

9 If you have enabled alias substitution and the Display component ID 
alias from the CDB server in alarms check box is available, select the 
check box to turn on the display of aliases, or clear the check box to turn 
off the display.

10 When you finish modifying preferences, use one of the following buttons 
to specify how the preferences are to be used:

• To apply the new settings, click Use Preferences. 

• To save the new settings to a file, click Save to File. The settings are 
saved to the file $HOME/MagellanNMS/CIVPref.cfg.

• To restore preference settings from an existing $HOME/
MagellanNMS/CIVPrefs.cfg file, click Restore from File. 

• To cancel any changes that you made to the Preference Settings 
Dialog box, click Cancel.
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Using previously saved preference settings in MDM Toolset
Use this procedure to retrieve and apply previously stored preference settings. 
The settings are restored from your $HOME/MagellanNMS/CIVPrefs.cfg 
file.

Procedure steps
1 From the Options menu, select Change Preference Settings….

The Preference Settings Dialog window opens. 

2 Click Restore from File.

The restored settings display in the dialog box.

3 To apply the filter settings, click Use Preferences.

The restored settings, with the exception of the sash position, are applied 
to the Component Information Viewer window.
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Setting a target in the related components panel in MDM 
toolset

To display related information about a component in the Component 
Information Viewer window, you need to target, or specify, the name of a 
component or subcomponent for which you want related information. 

Expected results
The type of related component information that the Component Information 
Viewer displays is shown in the table “Related components” (page 427). 

Procedure steps
1 To target a component in the related components panel, select one of the 

following methods:

• Type the name of the component in the Related Components for 
text field and then press the Enter key.

• Right-click the triangle at the end of the Related Components for 
field and from the resulting Get Context pop-up menu select a 
component.

• If the related components list has entries, right-click on an entry and 
from the resulting pop-up menu select Show Related.

• From the Auto-Context list box, select On and then select a 
component in another monitoring tool. 

Table 68
Related components

Target component Related information

Organizational node Next level links, nodes, and the parent node.

Link Endpoint components, parent components, and links.

Module All subcomponents of the module, all links terminating 
on the module and the parent component. 

Subcomponent All subcomponents of the subcomponent, all links 
terminating on the subcomponent, any crucial 
subcomponents of the ancestors, and all parents up 
to the module. 
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Setting the acknowledge state for a component
Use this procedure to set the acknowledge state on or off. Setting the 
acknowledged state on temporarily hides the current troubled state of a 
component causing the acknowledged component to behave as if in-service.

The availability of the on or off command depends on the current 
acknowledge state of the component. If a component is not in acknowledge 
state, you can set the acknowledge state on. If a component is currently in 
acknowledge state, you can set the acknowledge state off.

Expected results
 If no related components are troubled, the acknowledged component 
displays a state of acknowledged (ACKED). When an acknowledged 
component changes state, the acknowledgment is automatically removed and 
the real state of the component is shown. For more information on 
Acknowledged state, see 241-6001-015 Preside MDM Network Model 
Administrator Guide. A component is also put into acknowledged state by 
acknowledging all active alarms against the component.

Procedure steps
1 To set the acknowledge state on or off, perform one of the following 

actions:

if running... the result is...

MDM Toolset -To set the acknowledge state on, right-click on a 
component in the related components list and then from the 
resulting pop-up menu, select Set Acknowledge State 
On

-To set the acknowledge state off, right-click on an 
acknowledged component in the related components list 
and then from the resulting pop-up menu, select Set 
Acknowledge State Off
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MDM 
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-To set the acknowledge state on, right-click on a 
component in the related components list and then from the 
resulting pop-up menu, select Turn Acknowledgement 
State On

-To set the acknowledge state off, right-click on an 
acknowledged component in the related components list 
and then from the resulting pop-up menu, select Turn 
Acknowledgement State Off

if running... the result is...
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Setting the maintenance state for a component
Use this procedure to set the maintenance state on or off. Setting the 
maintenance state permanently hides the current troubled state of a 
component. Any children of the selected component are also put into 
maintenance state. For more information on maintenance state, see 
241-6001-015 Preside MDM Network Model Administrator Guide.

The availability of the on or off command depends on the current 
maintenance state of the component. If a component is not in maintenance 
state, you will be able to set the maintenance state on. If a component is 
currently in maintenance state, you will be able to set the maintenance state 
off.

Procedure steps
1 You can set the maintenance state on or off. Use one of the following 

actions.

• To set the maintenance state on, right-click on a component in the 
related components list and then from the resulting pop-up menu, 
select Set Maintenance State On.

• To set the maintenance state off, right-click on an acknowledged 
component in the related components list and then from the resulting 
pop-up menu, select Set Maintenance State Off.

if running... the result is...

MDM Toolset -To set the maintenance state on, right-click on a 
component in the related components list and then from the 
resulting pop-up menu, select Set Maintenance State On.

-To set the maintenance state off, right-click on an 
acknowledged component in the related components list 
and then from the resulting pop-up menu, select Set 
Maintenance State Off
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-To set the maintenance state on, right-click on a 
component in the related components list and then from the 
resulting pop-up menu, select Turn Maintenance State 
On.

-To set the maintenance state off, right-click on an 
acknowledged component in the related components list 
and then from the resulting pop-up menu, select Turn 
Maintenance State Off.

if running... the result is...
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Starting the Start Tools from the Component Information 
Viewer

Use this procedure to start other MDM tools to view additional fault 
management data without exiting from the Component Information Viewer.

Procedure steps
1 From the Component Information Viewer, right-click on a component in 

the related components list.

A pop-up menu opens.

2 On the pop-up menu, point to Start Tool, then point to one of the Start 
Tool categories, and then select the appropriate MDM software tool.
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Setting a target in the information panel in MDM Toolset
To display additional component information in the Component Information 
Viewer window, you need to target, or specify, the name of a component or 
subcomponent for which you want additional information. 

Procedure steps
1 To target a component in the information panel, select one of the following 

methods:

• Type the name of the component in the Information for text field and 
then press the Enter key.

• Right-click the triangle at the end of the Information for field and 
from the resulting Get Context pop-up menu select a component.

• Right-click on a component in the related components list and select 
Show Information from the resulting pop-up menu.

• With Auto-Context turned off, double-click on a component in the 
related components list.

• With Auto-Context turned on, select a component in the related 
components panel. 

• With Auto-Context turned on, select a component from another 
MDM tool that supports component context.
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Displaying additional component information in MDM 
Toolset

Use the information panel to further investigate information. You can display 
management or diagnostic information to help diagnose a fault and determine 
its impact.

Procedure steps
1 Set a target in the Information for field. For details, see “Setting a target 

in the information panel in MDM Toolset” (page 433).

2 In the information panel, click the Information Type: list box to display a 
list of information types to apply to the target component.

• To display the currently active alarms for the component, select 
Active Alarms. To display alarms for the component and all its 
subcomponents, in the Include Subcomps: list box, select On. 

• To display the most recent status record from a DPN component, 
select Status.

• To display the alarm history, select Recent Alarms.

• To display network model information, select Model Data. 

• To display data from the customer database, select Customer Data.

• To display diagnostic commands, select Diagnostics. 
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Clearing alarms using Local Clear
Clear alarms locally to remove them from the alarm list in Alarm Display and 
from MDM server databases. When you clear an alarm locally, your userID, 
hostname, and the “DISPLAY” environment variable value are displayed in 
the comment data. Multiple alarms can be cleared at once only in MDM 
Toolset. You can only perform a local clear against DPN and Passport.

Note: When re-synchronizing with devices that have an active alarm list, 
the locally cleared alarm may be re-introduced in the servers databases.

Prerequisites
• The GMDR server must be running.

• Alarm Display must be running in active mode.

Procedure steps
1 Display the list of alarms:

2 Select alarms that you wish to clear locally:

If running... Action...

MDM Toolset If the information panel is not set to display alarms, 
display alarms by specifying a target for which you 
want alarms in the Information for: field. Then, from 
the Information Type: list box, select Active Alarms

MDM Operator 
Client 

From the Alarm list, select Active Alarms
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3 Right-click on a selected alarm in the information list to open the Alarm 
Menu pop-up menu.

4 Select Local Clear and then release the mouse button.

Expected results
• The alarm is cleared from the GMDR/DMDR/FMDR/NMDR/SMDR/

IMDRdatabases.

• Your userID, hostname, and the “DISPLAY” environment variable 
value will be displayed in the comment data of the resulting Clear Alarm.

If running... Action...

MDM Toolset -To select a single alarm, click an alarm.
-To select contiguous multiple alarms, click the first 
alarm in the range and then shift-click the last alarm 
in the range.
-To select non-contiguous multiple alarms, click the 
first alarm and then ctrl-click additional alarms. 

MDM Operator 
Client 

-To select an alarm, click an alarm.

If running... The result is: 

MDM Toolset A Local Clear Confirmation dialog box is displayed 
stating “You are about to clear the selected alarm(s) 
locally from MDM. Are you sure you want to clear the 
alarm(s)?” Select Yes if you are sure you want to 
locally clear the alarms. Select No if you do not want 
to clear the alarms. Click Refresh Display or wait for 
the next refresh period for alarms to disappear.

MDM Operator 
Client 

The alarm is removed from the list.
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Clearing alarms using Global Clear
Clear alarms globally to remove them from the alarm list in Alarm Display 
and from MDM server databases and on-switch databases. When you clear an 
alarm globally, your userID, hostname, and the “DISPLAY” environment 
variable value are displayed in the comment data. Multiple alarms can be 
cleared at once only in MDM Toolset.

This procedure can only be used to globally clear Passport an DPN alarms.

Prerequisites
•  Global alarm clearing must be configured on the DMA server.

• The GMDR servers must be up and running. 

• The GMDR server must be able to access a DMA server through its 
configuration.

Procedure steps
1 Display the list of alarms:

2 Select alarms that you wish to clear globally:

If running... Action...

MDM Toolset If the information panel is not set to display alarms, 
display alarms by specifying a target for which you 
want alarms in the Information for: field. Then, from 
the Information Type: list box, select Active Alarms

MDM Operator 
Client 

From the alarm list, select Active Alarms
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3 Right-click on a selected alarm in the information list to open a pop-up 
menu.

4 Select Global Clear and then release the mouse button.

Expected results
• Your userID, hostname, and the “DISPLAY” environment variable 

value will be displayed in the comment data of the resulting Clear Alarm.

• The alarm is cleared from the GMDR/FMDR databases and from the 
active alarm list stored in the network.

If running... Action...

MDM Toolset -To select a single alarm, click an alarm.
-To select contiguous multiple alarms, click the first 
alarm in the range and then shift-click the last alarm 
in the range.
-To select non-contiguous multiple alarms, click the 
first alarm and then ctrl-click additional alarms. 

MDM Operator 
Client 

-To select an alarm, click an alarm.

If running... The result is...

MDM Toolset A confirmation dialog box is displayed asking “You 
are about to clear the selected alarm(s) globally from 
MDM. Are you sure you want to clear the alarm(s)?” 
Select Yes if you are sure you want to globally clear 
the alarms. Select No if you do not want to clear the 
alarms. Click Refresh Display or wait for the next 
refresh period for alarms to disappear.

MDM Operator 
Client 

The alarm is removed from the list.
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Clearing alarms using the Global Clear tool in MDM Toolset
You can clear a alarm globally from the Component Information Viewer 
window to clear it out of the MDM servers and the on-switch database. This 
procedure requires that the MDM operator set up connection authentication 
first. Only one alarm can be cleared at a time.

Prerequisites
• The Host Group Directory Services (HGDS) server and the Passport 

Comms Mgr server (FDTM) must be up and running. 

Procedure steps
1 If the information panel is not set to display alarms, display alarms using 

the following steps:

a. Specify a target for which you want alarms in the Information for: 
field. 

b. From the Information Type: list box, select Active Alarms. 

2 In the information list, select the alarm that you want to clear. 

3 Right-click on a selected alarm in the information list to open a pop-up 
menu.

4 Select Start Tool and then Global Clear of Alarms and then release the 
mouse button.

A Confirmation dialog box is displayed asking “You are about to clear the 
selected alarm(s) globally from MDM. Are you sure you want to clear the 
alarm(s)?” Select Yes if you are sure you want to globally clear the 
alarms. Select No if you do not want to clear the alarms.

The Connection Console dialog box opens and displays the first Passport 
group to which the node belongs. The Connection Console dialog box 
does not display if you are already connected to a group that contains the 
Passport. 

5 Connect to a destination. Use the default selected destination or select 
another destination.

6 Type a valid user ID in the User Id text box.

7 Type a valid password in the Password text box.

You can repeat step 5 through step 7 as often as needed.

8 Click Connect.
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9 Select a connected destination using one of the following steps: 

• Double-click on a connected network destination in the Destination 
list.

• Select a connected network destination in the Destination list and 
then click Select.

• Select the wild-card route (*). The wild card lets you direct commands 
to nodes in any of the connected groups without having to know 
which group the node belongs to. 

If the request failed, a dialog box opens with the error message.

Expected results
• Your userID, hostname, and the “DISPLAY” environment variable 

value will be displayed in the comment data of the resulting Clear Alarm.

• The alarm is cleared from the GMDR/FMDR databases and from the 
active alarm list stored in the network.
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Acknowledging active alarms
Use this procedure to acknowledge an active alarm. You acknowledge an 
alarm to let others know that the fault is under investigation. You can remove 
the acknowledgement with the unacknowledge command. 

Expected results
Acknowledged alarms display a check mark on the left of the alarm list, both 
in active mode and log mode, even though alarms can only be acknowledged 
from active mode. If you display the alarms in full format the date and time 
of the acknowledgement, the user ID, and the reason for the 
acknowledgement displays in the alarm list.

Procedure steps
1 Acknowledge active alarms:

2 In the information list, select the alarm that you want to acknowledge. 

• To select contiguous multiple alarms, click the first alarm in the range 
and then shift-click the last alarm in the range.

• To select non contiguous multiple alarms, click the first alarm and 
then ctrl-click additional alarms. 

3 Select alarms that you wish to acknowledge:

If running... Action...

MDM Toolset If the information panel is not set to display alarms, 
display alarms by specifying a target for which you 
want alarms in the Information for: field. Then, from 
the Information Type: list box, select Active Alarms

MDM Operator 
Client 

From the Alarm list, select Active Alarms
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4 Right-click on a selected alarm in the information list and select 
Acknowledge Alarms.

5 Type a reason for the action and a user ID (if the user ID field has been 
configured to be editable). The default is <UnixUserID>@<Hostname>.

6 To close the dialog:

If running... Action...

MDM Toolset -To select a single alarm, click an alarm.
-To select contiguous multiple alarms, click the first 
alarm in the range and then shift-click the last alarm 
in the range.
-To select non-contiguous multiple alarms, click the 
first alarm and then ctrl-click additional alarms. 

MDM Operator 
Client 

-To select an alarm, click an alarm.

If running... The result is...

MDM Toolset The Acknowledge Alarm(s) Dialog box opens.

MDM Operator 
Client 

The Input dialog box opens.

If running... Action...

MDM Toolset Click Ack Alarm(s)

MDM Operator 
Client 

Click OK
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Unacknowledging active alarms
Use this procedure to remove the acknowledgement from active alarms.

Expected results
Unacknowledged alarms display a crossed-out check mark icon on the left of 
the alarm list, both in active mode and log mode, even though alarms can only 
be unacknowledged from active mode. If you display the alarms in full format 
the date and time of the unacknowledgement, the user ID, and the reason for 
the unacknowlegement display in the alarm list.

Procedure steps
1 Remove acknowledgement from active alarms:

2 Select alarms that you wish to unacknowledge:

3 Right-click on a selected alarm in the information list and select 
Unacknowledge Alarms.

If running... Action...

MDM Toolset If the information panel is not set to display alarms, 
display alarms by specifying a target for which you 
want alarms in the Information for: field. Then, from 
the Information Type: list box, select Active Alarms

MDM Operator 
Client 

From the Alarm list, select Active Alarms

If running... Action...

MDM Toolset -To select a single alarm, click an alarm.
-To select contiguous multiple alarms, click the first 
alarm in the range and then shift-click the last alarm 
in the range.
-To select non-contiguous multiple alarms, click the 
first alarm and then ctrl-click additional alarms. 

MDM Operator 
Client 

-To select an alarm, click an alarm.
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4 Type a reason for the action and a user ID (if the user ID field has been 
configured to be editable). The default is <UnixUserID>@<Hostname>.

5 To close the dialog:

If running... The result is...

MDM Toolset The Unacknowledge Alarm(s) Dialog box opens.

MDM Operator 
Client 

The Input dialog box opens.

If running... Action...

MDM Toolset Click Unck Alarm(s)

MDM Operator 
Client 

Click OK
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Displaying diagnostic information in MDM Toolset
Use the diagnostic capability to diagnose network faults. The Component 
Information Viewer tool supports a range of diagnostics. For details about 
each diagnostic, see “Diagnostic commands in MDM Toolset” (page 462).

Note: The list of diagnostics for MPE contains only Query Historical 
Alarms 

The availability of diagnostic commands depends on several factors 
including the type of device and whether or not the diagnostic menu has been 
customized at your installation. For information about customizing 
diagnostic menus, see the section on customizing Component Information 
Viewer diagnostics in 241-6001-301 Preside MDM Customization 
Administrator Guide. 

Expected results
Diagnostic information in the Component Information Viewer window does 
not support manual or automatic refresh commands. To update diagnostic 
information, you need to execute the diagnostic command again. 

Procedure steps
1 Set a target in the Information for: field to specify the component for 

which you want diagnostic information.

2 In the Information Type: list box, select Diagnostics. 

3 In the Commands: list box, select one of the following commands:

• Select Command Route… to open the Connection Console dialog 
box. For details, see “Selecting a new command route in MDM 
Toolset” (page 447).

• Command Console… to start the Command Console tool. If no 
connection has been made the Connection Console dialog box 
opens first.

• Query Historical Alarms… to open the Real Time Alarm Collection 
(RTAC) tool to access RTAC spooled alarms. For details, see 
“Querying historical alarms from Component Information Viewer in 
MDM Toolset” (page 449).

• Passport Commands to execute a selection of Passport diagnostic 
commands
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• Passport Tests to execute a selection of Passport tests.

• Passport Inventory to execute a selection of Passport inventory 
reporting utilities

• DPN Commands to execute a selection of DPN diagnostic 
commands

• DPN Inventory to execute a selection of DPN inventory reporting 
utilities

• NRS Commands to execute a selection of Network Reporting 
System (NRS) utilities

• Passport Port Test Console to open a dialog box that prompts for 
the test parameters and target component ID.
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Selecting a new command route in MDM Toolset
The Component Information Viewer retains the last OA and Passport Group 
command routes. Use this procedure only if you need to establish a new 
connection or change the route of an OA or Passport Group. 

This procedure only applies to Passport.

You select a new route using the Connection Console dialog box. This dialog 
box lets you manage network connections by connecting to or disconnecting 
from a network destination and by setting a default destination. 

Expected results
The Connection Console dialog box is similar to the Command Console 
Connection Management dialog box except for the addition of the Select 
button. For details, see the section on the Command Console Connection 
Management dialog in 241-6001-804 Preside MDM Workstation Utilities 
User Guide. The Connection Console dialog supports the Passport wild card 
route (*) as a legal Passport group. Although you can select the Passport wild-
card route, you cannot establish a connection with it.

Procedure steps
1 In the Information Type: list box, select Diagnostics.

2 In the Commands: list box, select Select Command Route….

The Connection Console dialog box opens.

3 If needed, establish a connection to another network destination.

• Click on an entry in the Destination list to populate the Destination: 
text box.

• Type a valid user ID in the User Id text box.

• Type a valid password in the Password: text box.

• Click Connect.

4 Select a connected destination using one of the following steps: 

• Double-click on a connected network destination in the Destination 
list.

• Select a connected network destination in the Destination list and 
then click Select.
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• For Passports only, select the Passport wild-card route (*). The wild 
card lets you direct commands to Passport nodes in any of the 
connected groups without having to know which group the node 
belongs to. 
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Querying historical alarms from Component Information 
Viewer in MDM Toolset

Use this procedure to start the Real-time Alarm Collection (RTAC) search 
tool to from Component Information Viewer. This tool accesses RTAC 
spooled alarms so that you can extract short-term historical alarms.

• “Prerequisite” (page 449)

• “Procedure steps” (page 449)

• “Procedure job aid” (page 450)

Prerequisite
RTAC must be running on the same workstation as the Component 
Information Viewer host, or its database directory must be accessible by the 
Network File System (NFS).

Procedure steps
1 In the Information Type: list box, select Diagnostics.

2 In the Commands: list box, select Query Historical Alarms…

The Query Historical Alarms dialog opens and displays the first of the two-
page dialog. 

3 On the first page of the dialog, refine the alarm query by using the 
following filters. For a description of the filters, see the table “Query 
Historical Alarm filters” (page 450)“. 

4 If you do not require any further filters, click OK to start the query, 
otherwise click Advanced to open the second page of the dialog.

5 Further refine the alarm query. by using any of the following filters. For a 
description of the filters, see the table “Query Historical Alarm filters” 
(page 450). 

6 Optionally, to save the Customer Database (CDB) options and alarm 
output format settings so that they are used the next time you start the 
Query Historical Alarms tool, click Save CDB and Format specifications 
as defaults.

7 To begin the historical alarm query, click OK.
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Depending on the length of time to search for matching alarms, a tracking 
dialog may open. This dialog tracks the search progress. As matching 
alarms are identified, they display in the Historical Alarms output window.

8 To save the contents of the Historical Alarms dialog to a file, click Save 
output to file... or to close the dialog, click OK.

The Historical Alarms dialog closes. 

Procedure job aid
Table 69
Query Historical Alarm filters

Filter Description

First page of dialog:

Component specifies the component for which you want to 
retrieve alarms. By default, the Component field 
is populated with the component in context. If you 
specify a component filter, the alias filter is 
ignored.

 (Sheet 1 of 3)
241-6001-011   15.1RSUP   



Chapter 10 Component Information Viewer   451
or Alias specifies the component alias. The alias 
replaces the component ID in the display with the 
matching Related Component ID value from the 
customer database. If you do not use a customer 
database, or if you specify a component filter, 
this alias filter is ignored.

From date/time specifies the start of the time period for which you 
want alarms. The initial value for this field is the 
current date and time minus one day. If you 
override the initial value in this field or in the To 
date/time field and need to reestablish the initial 
values, click the Reset Date-Time button.

To date/time specifies the end of the time period for which you 
want alarms. The initial value for this field is the 
current date and time. If you override the initial 
value in this field or in the From date/time field 
and need to reestablish initial values, click the 
Reset Date-Time button

Fault code specifies the fault code to use for filtering alarms. 
You can use GREP style patterns to specify 
these fault codes.

Alarm event specifies the alarm event to use for filtering 
alarms. If needed, you can specify multiple alarm 
events. 

Alarm severity specifies the alarm severity to use for filtering 
alarms. If needed, you can specify multiple 
severities.

Display format specifies the level of alarm output to display, from 
the least output (terse) to the most output (full).

Advanced page of 
dialog:

Alarm type specifies the alarm type to use for filtering. If 
needed, you can select multiple types.

Table 69 (Continued)
Query Historical Alarm filters

Filter Description

 (Sheet 2 of 3)
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Comment text text specifies the comment data pattern (GREP) 
to use for filtering.

Customer Database
Server

specifies the service name of the Customer 
Database (CDB) that has the customer data and 
alias information. The Query Historical Alarms 
tool supports the same CDB interaction as the 
Alarm Display and Component Information 
Viewer tools. 

Customer Database
Host

specifies the host name of the CDB that has the 
customer data and alias information.

Table 69 (Continued)
Query Historical Alarm filters

Filter Description
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Customizing the Component Information Viewer display in 
MDM Toolset

You can customize the following items in the Component Information 
Viewer:

• “Alarm list” (page 453) 

• “Related components list menu” (page 454) 

• “Information for field pop-up menu” (page 455) 

• “Component Information Viewer Diagnostic Command menu” 
(page 455)

• “Other resources” (page 455)

Alarm list
For procedures on customizing the Start Tool menu for the Alarm List, see the 
section on customizing the toolsets and Start Tools menus in 241-6001-301 
Preside MDM Customization Administrator Guide. 

When you modify the Start Tool menu file, use one of the following 
substitution variables in the command line:

• $SEVERITY: the Common format severity of the alarm, which can be 
UNKNOWN, CRITICAL, MAJOR, MINOR, WARNING, or 
CLEARED

• $DPNSEV: the DPN format severity of the alarm which can be 
ncsUnknown, ncsDEGRADE, ncsOVERLOAD, ncsMINOR, 
ncsMAJOR, or ncsWILDCARD

• $EVENT: the type of the alarm which can be CLEAR, SET, or 
MESSAGE

• $DPNMNEM: the DPN alarm mnemonic, which can be TRAPDATA, 
ACTIVATE, INVALID, MISSING, DUPLICAT, MEMORY, 
CONJEST, FAILED, REFUSED, TIME_OUT, CRITICAL, OOS, 
THRESHLD, ENABLED, DISABLED, PROBE, CALL_BLK, or 
DISCARD. This variable has a value for DPN alarms only. 
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• $DPNACTION: the Network Control System (NCS) action value, which 
can be ncsServiceData, ncsHardware, ncsSoftware, ncsSecurity, 
ncsProtocol, ncsDebug, ncsNetwork, ncsEngineering, ncsOperations, 
ncsUnclassified, or ncs Wildcard. This substitution value is for DPN 
alarms only.

• $FCODE: the alarm fault code. This eight-digit fault code is used to 
specify the alarm. The first four digits are used to identify the source of 
the alarm, and the last four digits are used to identify the alarm. 

• $DATE: the date of the alarm in the format:YY-MM-DD

• $TIME: the time of the alarm in the format:HH:MM:SS

• $COMP: the internal component name of the target

• $DCOMP: the display component name of the target

• $DTYPE: the DPN device type. This variable has a value for DPN 
alarms only

• $FORMAT: the present format of an alarm, which can be TERSE, 
NORMAL, or FULL

• $TYPE: the alarm type, which can be communications, 
qualityOfService, processing, equipment, environment, security, 
operator, debug, or unknown. This value gives a general explanation of 
the cause of the alarm.

• $RAWSTATE: the corresponding component’s raw state

• $CMT: the operator comment data text

• $OPER: the operator data text

Related components list menu
For procedures on customizing the Start Tool menu for the Related 
Components List, see the section on customizing the toolsets and Start Tools 
menus in 241-6001-301 Preside MDM Customization Administrator Guide.

When you modify the file, you one of the following substitution variables on 
the command line:

• $COMP: the internal component name of the target

• $DCOMP: the display component name of the target
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Information for field pop-up menu
You can customize the pop-up menu that opens when you right-click on the 
triangle at the right of the Information for field. This pop-up menu contains 
the Get Context command and a list of up to 10 of the last targeted 
components. If you frequently use the same components, you can customize 
the list so that it contains these frequently used component names or name 
patterns. To customize the list, create one of the following files:

• To customize the list for a single user ($HOME), create the file
$HOME//MagellanNMS/CIVInfoTargets.cfg.

• To customize the list for all users of the workstation, create the file 
/opt/MagellanNMS/cfg/CIVInfoTargets.cfg.

• For second-party integrators customizing the list for all users of the 
workstation, create the file 
/opt/MagellanNMS/ext/lib/cfg/CIVInfoTargets.cfg

The Component Information Viewer searches for custom files in the order 
they are listed in the preceding bulleted list. The first file found is used to 
populate the list. 

The file format is as follows:

# comments are blank lines, or lines that 
# start with #, !, or *
labelString: <label to appear in the menu>
value: <component name or patterns to be used

as a target upon selection>

Component Information Viewer Diagnostic Command menu
For details about customizing the Diagnostic Command menu, see the section 
on diagnostic menu management in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Other resources
You can customize the resources to control

•  the colors associated with propagated states, problem states, and severity 

• whether or not the problem states are shown in the related components 
list
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• whether or not the bell rings upon error

The table “Resources for color control of propagated states” (page 456) lists 
the resources you use to control the colors associated with the propagated 
states displayed by Component Information Viewer components. This table 
also lists the resources you use to control the state color at the module level. 
If the value of this resource is true, then the unknown state color at the module 
level is different from the default unknown color. 

The table “Resources for color control of common alarms” (page 457) lists 
the resources you use to control the colors associated with the common alarm 
format severity displayed by the Component Information Viewer 
components.

Table 70
Resources for color control of propagated states

Resource Description Legal values

*stateINVALID
*stateUNKNOWN
*stateINSV
*stateISTB_1
*stateISTB_2
*stateISTB_3
*stateISTB_4
*stateISTB_5
*stateOOS_1
*stateOOS_2
*stateOOS_3
*stateOOS_4
*stateOOS_5
*stateMTCE
*stateHIER_MTCE
*stateACKED
moduleStateUNKNOWN

Specifies the state-to- 
color mapping used to 
indicate the current 
state of the 
components in the 
Related Components 
List. (These are the 
same resources used 
for the NV.)
.

Any legal X windows 
color or specification. 
See 241-6001-301 
Preside MDM 
Customization 
Administrator Guide.
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The table “Resources to control the ringErrorBell” (page 457) lists the 
resources you use to control the ringErrorBell.

Table 71
Resources for color control of common alarms

Resource Description Legal values

*BackgroundColorUnknow
n
*ForegroundColorUnknow
n
*BackgroundColorCritical
*ForegroundColorCritical
*BackgorundColorMajor
*ForegroundColorMajor
*ForegroundColorMinor
*BackgroundColorMinor
*BackgroundColorWarning
*ForegroundColorWarning
*BackgroundColorCleared
*ForegroundColorCleared
*BackgroundColorDefault
*ForegroundColorDefault

Specifies the 
background and 
foreground color-to- 
severity mappings for 
the common alarm 
formats.

Any legal X windows 
color or specification. 
See 241-6001-301 
Preside MDM 
Customization 
Administrator Guide.

.

Table 72
Resources to control the ringErrorBell

Resource Description Legal values

CIV*ringErrorBell If True, the 
Component 
Information Viewer 
rings the bell when it 
cannot find data for a 
target. If False, the 
Component 
Information Viewer 
does not ring the bell. 
The default is True.

True or False
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The table “Resources for customizing the Acknowledgement/
unacknowledgement Alarms Dialog” (page 458) lists the resources you use to 
customize the Acknowledge Alarms Dialog and the Unacknowledge Alarms 
Dialog.

Table 73
Resources for customizing the Acknowledgement/unacknowledgement 
Alarms Dialog

Resource Description Legal values

*AckAlarmDlog*userIdFiel
dField.editable

If True, the User field 
in the dialog used for 
acknowledging or 
unacknowledging 
alarms, can be 
modified. The default 
is False.

True or False

*AckAlarmDlog*commentD
ata.maxLength

The maximum length 
of Reason text that can 
be specified when 
acknowledging or 
unacknowledging 
alarms. The default 
length is 256.

Any legal Motif value 
associated with the 
MaxLength resource.

CIV*differentModuleUnkno
wnColor

If 
differentModuleUnkno
wnColor is true, then 
the unknown color for 
the node at the module 
level is different from 
the default unknown.

True or False
241-6001-011   15.1RSUP   



Chapter 10 Component Information Viewer   459
Table 74
Resources for Customer Database component ID alias

Resource Description Legal values

CIV*cdbSupportAlias Enables support for 
Customer Database 
component name 
aliasing.

True to enable alias 
support, False 
(default) to prevent 
alias support
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Component Information Viewer fundamentals
The Component Information Viewer is the primary Multiservice Data 
Manager (MDM) tool for diagnosing network faults. This tool provides in-
depth information on components and subcomponents of a network element. 
You can view surveillance information for a component and navigate to other 
components, subcomponents, or associated links. The Component 
Information Viewer uses information from active and recent alarms to assess 
the cause of a fault. The tool also determines the impact of a fault by 
providing state information for related components. 

The Component Information Viewer uses alarm- based surveillance to find 
more information on the impact and history of the fault. It also uses state-
based surveillance to provide more information on the probable cause and 
context of the fault.

Table 75
Component Information Viewer features

Feature Description

Textual view View a group of related components. View pertinent 
information such as alarms.

Access to network 
information

Access all available Network Model information.

Get active alarm information.

Look up recent alarm history.

Access status information (DPN-100).

Component state View the state of all components displayed. The state 
is indicated by name and color.

Put components into maintenance or acknowledged 
states.

Alarms Clear an active alarm.

Look and feel View only components for the states that you select.

Have the Component Information Viewer 
automatically updated whenever you select a different 
component in the Network Viewer.
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Using the Component Information Viewer, you can perform the following 
tasks:

• put a component into acknowledge or maintenance state

• acknowledge, unacknowledge, or clear active alarms

• start other tools 

• set preferences for parameters such as automatic context, automatic 
refresh interval, alarm format, and customer database server 
identification

• set component filters

• obtain management information including active alarms, recent alarms, 
status records (DPN only), model data, and customer data

• execute diagnostic commands

Component Information Viewer data
The tool facilitates fault diagnosis by providing access to the following 
management and diagnostic information:

Management data
The information panel provides various types of management data 
information on a component including active alarm, recent alarms, status, 
model data, and customer data. 

• Active alarm information includes active alarms for the target 
component extracted from the General Management Data Router 
(GMDR).

Navigation Navigate to related components.

Access Directly access the Component Information Viewer, 
General Data Reporter, DPN Performance Viewer, 
Data Viewer, and Customer Database.

Access your tools and macros.

Table 75 (Continued)
Component Information Viewer features

Feature Description
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• Recent alarms information includes recent alarms, active or not, for that 
component extracted from the GMDR buffer.

• Status information includes the most recent status record received for the 
target component extracted from the GMDR.

• Model information includes information on the component that is stored 
in the Network Model.

• Customer Database includes information for the component. The 
information is retrieved from the Customer Database server identified in 
the Preference Settings Dialog.

Diagnostic information in MDM Toolset
The Component Information Viewer provides commands that let you directly 
access information to diagnose network faults without having to start other 
fault management tools. 

Before you can access diagnostic information, you need to specify a 
component and the type of diagnostic information you want to retrieve. 
Diagnostic information displays in the Component Information Viewer 
window or, in some cases, another window. For details about the available 
diagnostic commands, see “Diagnostic commands in MDM Toolset” 
(page 462). 

Diagnostic commands in MDM Toolset
The Component Information Viewer window supports the following 
diagnostics:

Note: Only Query Historical Alarms diagnostic or user customized 
diagnostics are available for MPE 9500.

• “Select Command Route” (page 463)

• “Command Console” (page 463)

• “Query Historical Alarms” (page 463)

• “Help” (page 464)

• “Passport Commands” (page 464)

• “Passport Tests” (page 466)
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• “Passport Inventory” (page 467)

• “DPN Commands” (page 468)

• “DPN Inventory” (page 470)

• “NRS Commands” (page 471)

• “Passport Port Test Console” (page 472)

• “Port test console output” (page 474)

The availability of the commands varies according to the configuration at 
your installation. The following subset of diagnostic commands are always 
available: 

• Select Command Route…

• Command Console…

• Query Historical Alarms…

• Help

Select Command Route
The Select Command Route… command is always available from the 
Commands list. Selecting this command opens the Connection Console 
dialog box to connect to, or disconnect from, a destination. This dialog also 
lets you select the default destination for diagnostic commands.

Command Console
The Command Console… command is always available from the Commands 
list. Selecting this command starts the Command Console tool with the 
component specified in the Component Information Viewer. 

Query Historical Alarms
The Query Historical Alarms… command is always available from the 
Commands list. This command opens the Real-Time Alarm Collection 
(RTAC) Access tool. This tool consists of a two-page dialog that lets you 
specify filters for retrieving RTAC spooled alarms. For details about this tool, 
see “Query Historical Alarms” (page 517). For procedures on using this tool 
from Component Information Viewer, see “Querying historical alarms from 
Component Information Viewer” (page 463). 
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Help
The Help command is always available from the Commands list. Selecting 
this command opens the online documentation for Command diagnostics.

Passport Commands
Except where indicated, commands in the table “Passport Command 
diagnostics” (page 478) apply to all Passport component types. The table lists 
all Passport diagnostic commands, however the list of available Passport 
Commands at your installation may differ.

Table 76
Passport Command diagnostics

Passport Command Description Command line equivalent 

Describe Component Displays all attributes of the target 
component and any of its 
subcomponents. The 
subcomponents are listed by 
instance. For example, if multiple 
Dlcis are defined for a specified 
FrUni, all are listed.

List Comps Lists the first level subcomponents of 
the Passport. 

list -o -p

Display LPs Displays all attributes of all LPs. display -o -p lp/*

Display LP Opens the Passport Component 
Selector dialog box and lets you 
select a single LP for which the 
attributes will display.

display -notab -o -p lp/
<selected>

Display Cards Displays all attributes of all. display -notab -o -p shelf 
cards/* CARDs

Display Trunks Displays all attributes of all Passport 
Trunks.

display -notab -o -p trk/
*

Display Software Displays the current loaded software 
versions.

display -p sw

Display Provisioning Displays all attributes of provisioned 
components.

display -o prov
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List Files Opens a dialog box that prompts for 
a file path and then lists the files in 
the specified path. 

list -file -path (“<file 
path>”) fs

List Subcomponents Lists all subcomponents of a target 
component.

list -o -p <target>
(for subcomponents only

Display Attributes Displays all attributes of the target 
component.

display -notab -o -p 
<target>
(for subcomponents only)

Display Subcomps Displays all attributes of all 
subcomponents of the target 
component. 

display -notab -o -p 
<target> *
(for subcomponents only)

Display Stats Delta Opens a dialog box that prompts for 
the time delta and optional repeat 
count and then starts the MDM 
Passport Delta script. The script 
displays changes in all the attribute 
values of the target between 
sampling intervals. Use for 
subcomponents only.

Display Connections Available for Frame Relay (FrUni, 
FrNNi, FrAtm), and AtmIf and their 
subcomponents. This command lists 
their connection components (Dlcis, 
Vccs, Vpcs, Vpts, and Vpt-Vccs) 
indicating their state and any 
correlation IDs.

Display Troubled 
Conn

Similar to Display Connections, but 
only lists the disabled connections. 
This command requires that the 
target Passport node support be at 
least PCR 2.x software. Otherwise, it 
acts like the Display Connections 
command.

Help Opens the online documentation for 
Passport Commands.

Table 76 (Continued)
Passport Command diagnostics

Passport Command Description Command line equivalent 
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Passport Tests
The table “Passport Test diagnostics” (page 466) lists all Passport test and 
trace commands, however the list of available commands at your installation 
may differ.

Table 77
Passport Test diagnostics

Passport Test Description Command line equivalent

Ping IP Address Prompts with an input dialog the IP 
address to ping and then pings that 
address through the corresponding 
Virtual Router.

ping -ipAddr (<IP 
address>) -traceRoute 
<target VR prefix> ip icmp 
(for virtual routers and their 
subcomponents only)

Trace AtmIf Circuit Traces the Atm Virtual Circuit. trace <target VCC 
prefix> (for ATM VCCs only)

Trace AtmIf Path Traces the Atm Virtual Path. trace <target VPC or VPT 
prefix> 
(for ATM VCCs and VPTs only)

Ping DPRS Node Starts the DPRS Ping command and 
traces the path followed to reach the 
target RID, MID, or remote DLCI.

ping -roundTripDelay -
allPaths <target RID 
prefix>
(for RTG-RID components only)

ping -roundTripDelay -
allPaths <target MID 
prefix>
(for RTG-MID components only)

ping -roundTripDelay 
<target DLCI prefix>
(for Frame Relay DLCI 
components only)
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Passport Inventory
For details on Passport Inventory reports, see the section on Passport 
Inventory reports in 241-6001-808 Preside MDM Device Inventory Tools 
User Guide. Passport Inventory commands are applicable to any Passport 
component type. Depending on availability, you may see the following set of 
Passport inventory reporting utilities

The table “Passport Inventory diagnostics” (page 482) lists all of the Passport 
Inventory reporting utilities, however the list of available utilities at your 
installation may differ.

Trace PORS 
Connection

Traces a PORS connection across 
one or more routing regions (through 
the gateways), and reports the 
Logical Channels, Gateway Calls, 
and applications used (applicable to 
TRK, RGTY,TRK-LCH, RGTY-
CALL, VS, HTDS, and BTDS 
components. For TRK and RGTY, 
connections on the Trunk or Routing 
Gateway are traced)

Port-Interface Test starts the Passport Port Test 
Console. Use for port-interface and 
service components only. For 
details, see “Passport Port Test 
Console” (page 486).

Help Opens the online documentation for 
Passport Tests.

Table 77 (Continued)
Passport Test diagnostics

Passport Test Description Command line equivalent
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DPN Commands

Table 78
Passport Inventory diagnostics

Passport Inventory Description

Module Report Opens the Passport Module Summary Inventory report for the 
target module.

Card Report Opens the Passport Card Inventory report for the target module.

Trunk Report Opens the Passport Trunk Inventory report for the target module.

Software Report Opens the Passport Software Inventory report for the target 
module.

ATM Report Opens the Passport ATM Services Inventory report for the target 
module.

FrameRelay Report Opens the Passport FrameRelay Services Inventory report for the 
target module.

Help Opens the online documentation for Passport Inventory.

Table 79
DPN Command diagnostics

DPN Command Description Command line equivalent

List Active DPNs Lists the currently active DPNs 
below the current default OA 
destination. 

This command maps to the 
existing dpnup macro. Use for DPN 
AN CA components

Display DPN Calls Lists all active calls on the target 
port. 

This command maps to the AllCall 
macro. Use for port components 
only.

OA Directory Lists the OA hierarchy below the 
target OA.

<target OA name> DIR
(for OA components only)

OA List Lists the OZ hierarchy below the 
target OA. 

<target OA name> OA LIST

Module Stats Displays the module level statistics. (D STATS)

Display MCFs Displays the active MCF information. (D MCF)
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Display Spooling Sys. Displays the current state of the 
spooling system (local or remote).

DSP D

Display File Sys. Displays the current state of the file 
system.

FILE D

List PEs Lists the available PEs on the target 
module. 

D

List MCFs Lists the available MCFs on the 
target module.

LIST MCF

List File(s)… Prompts for a file name pattern and 
then lists the matching files from the 
file system of the target module.

FILE DIR <name pattern>

Query Module Displays the module level 
configuration information for the 
target module.

Q MOD

Query Switch Displays the switch level 
configuration information for the 
target module

Q SWITCH

Query Network Displays network level configuration 
for the target module.

Q NET

Query All on Module Displays configuration for the target 
module.

Q *

PE Hardware Displays hardware status 
information for the target PE.

<target PE> D HARD
(for PEs and their subcomponents 
only)

PE Image Displays the active software image 
for the target PE.

<target PE> D IMAGE
(for PEs and their subcomponents 
only)

PE Stats Displays statistics for the target PE. <target PE> D STAT
(for PEs and their subcomponents 
only)

Table 79 (Continued)
DPN Command diagnostics

DPN Command Description Command line equivalent
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DPN Inventory
For details on DPN Inventory reports, see the section on DPN Inventory 
reports in 241-6001-808 Preside MDM Device Inventory Tools User Guide. 

Query PE Displays configuration information 
for the target PE.

<target PE> Q
for PEs and their 
subcomponents only

Display Ports Displays the Ports below the target 
PI.

<target PI> D
(for PIs and their subcomponents 
only)

Query PI Displays configuration information 
for the target PI.

<target PI> Q
(for PIs and their subcomponents 
only)

Display Link Displays link information for the 
target PO.

<target PO> D LINK
(for Ports and their subcomponents 
only)

Display Service Displays service information for the 
selected PO.

<target PO> D SERV
(for Ports and their subcomponents 
only)

Display Stats Displays statistics information for the 
target PI.

<target PO> D STATS
(for Ports and their subcomponents 
only)

Query Link Displays link level configuration for 
the target PO.

<target PO> Q LINK
for Ports and their subcomponents 
only)

Query Service Displays service level configuration 
information for the target PO.

<target PO> Q SERV
(for Ports and their 
subcomponents only)

Query DNA Displays DNA/CUG level 
configuration information for the 
target PO.

<target PO> Q DNA
(for Ports and their subcomponents 
only)

Help Opens the online documentation for 
DPN commands.

Table 79 (Continued)
DPN Command diagnostics

DPN Command Description Command line equivalent
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The table “DPN Inventory diagnostics” (page 485) lists all of the DPN 
Inventory reporting utilities, however the list of available utilities at your 
installation may differ.

NRS Commands
For details about the Network Reporting System (NRS), see 241-6001-022 
Preside MDM Network Reporting System User Guide. Except where 
indicated, all commands apply to any DPN or Passport component types. The 
table “NRS Command diagnostics” (page 486) lists all of the NRS reporting 
utilities, however the list of available utilities at your installation may differ.:

Table 80
DPN Inventory diagnostics

DPN Inventory Description

Full Module Report Opens the DPN Full Module Inventory report for the target module

Module Summary Report Opens the DPN Module Summary Inventory report for the target 
module.

PE Report Opens the DPN PE Inventory report for the target module.

PI Report Opens the DPN PI Inventory report for the target module.

SCR Report Opens the DPN Source Call Router Inventory report for the target 
module.

NL/Trunk Report Opens the DPN Network Link and Trunk Inventory report for the 
target module.

Help Opens the online documentation for DPN inventory.

Table 81
NRS Command diagnostics

NRS Command Description

Find DNA opens a dialog and prompts for a DNA GREP pattern. The pattern 
is then passed to the nrsFinddna utility to identify the component(s) 
that support it. 

Configuration Report opens the xnrsdatah utility for multiple graphical display reports with 
the parameters Module, Report on fields, Filtered and Current set. 
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Passport Port Test Console
The Passport Port Test Console opens a dialog that prompts for the test 
parameters and target component ID. The component ID can be the name of 
the actual port-interface to test or a service component that uses the port.

The figure “The Passport Port Test Console dialog” (page 473) shows the 
Passport Test Dialog

Configuration Diff opens the xnrsdiff utility for multiple graphical display reports with 
the Module parameter set to the target component, the Dated 
parameter set to the latest dated configuration (source) and the 
Current parameter (destination) set.

DPN Service Config opens the nrsdserv NRS utility and reports the target node’s service 
configuration. Use for DPN components only.

Help Opens online documentation for NRS Command. 

Table 81 (Continued)
NRS Command diagnostics

NRS Command Description
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Figure 37
The Passport Port Test Console dialog

Passport Port Test Console dialog
.ha.CIV Passport Port Test Console

The dialog controls map to the standard Passport Port-Interface Test 
components, with the exception of display interval. The controls are as 
follows:

• Test parameters for: specifies the target component name. The 
component name can be either a port interface (for example, V35, X21, 
DS1, Sonet) or a service component (for example, FrUni, Trk, 
DpnGate). If you specify a service component, the tool automatically 
identifies the port-interface in use.

• Test type: supports a list of port tests. Port tests include card, manual, 
localLoop, remoteLoop, externalLoop, payloadLoop, 
remoteLoopThisTrib, v54RemoteLoop, and pn127RemoteLoop.
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• Frame size: specifies the size of frames to send.

• Pattern type: supports a list of pattern types to send in those frames. 
Pattern types include ccitt32kBitPattern, ccitt8MBitPattern, and 
customizedPattern. 

• Custom pattern: is available only if you use the pattern type 
customizedPattern and lets you specify a bit pattern for the test frames.

• Start delay: specifies (in seconds) the delay before the test starts.

• Test duration: specifies (in minutes) the duration of the test.

• Display interval: specifies (in seconds) the delay between the sampling 
of intermediate results. Note that this is not the same as the on-switch 
attribute. Passport only emits results in minute intervals. So, to provide 
intermediate results in less than one-minute intervals, this tool polls for 
results rather than waiting for Passport to send them. 

• Purpose: lets you specify the reason for performing the test.

For more information about Passport port tests, see NN10600-551 Nortel 
Networks Multiservice Switch 7400/15000/20000 FP Configuration 
Reference.

Port test console output
The Port Test Console automatically locks the interface, starts the test, and 
regularly polls the port-interface for the test’s intermediate results. The output 
goes to standard output (Component Information Viewer Diagnostics). When 
started from a UNIX Access window or macro, the output can be sent to an 
xmsg window or a file.

The figure “Passport Port Test Console output (xmsg window)” (page 489) 
shows a sample port test output.
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Figure 38
Passport Port Test Console output (xmsg window)

The test output consists of a header, test parameters, a summary of the current 
configuration and operational parameters of the port, a table with the 
intermediate results, and a footer summarizing the test results, and the current 
operational state once again, in case it changed. 

Sample Passport Port Test Console output (full text)
The following example shows the a sample of the full text of the Passport Port 
Text output. 

Port-interface card test
for EM/NODEYBC5 LP/4 V35/3 (EM/NODEYBC5 FRUNI/4300). 
-----------------------------------------------------
---------------------------
Test Parameters:
    Test Frames: 1024 byte(s) frames with  pattern 
       Duration: 1 minute(s) with a 0 second(s) start 
delay
                 polling for results every 10 seconds
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Current port-interface configuration:

     applicationFramerName = FrUni/4300 Framer
            clockingSource = local
               commentText = 
        customerIdentifier = 0
     dataTransferLineState = rfs dsr dcd rts
        dteDataClockSource = fromDce
        enableDynamicSpeed = no
             ifAdminStatus = up
                   ifIndex = 59
                 lineSpeed = 192000 bit/s
         lineStatusTimeOut = 1000 msec
                  linkMode = dte
            readyLineState = rfs dsr dcd rts
                    vendor = 

Current port-interface state:

            actualLinkMode = dte
         actualRxLineSpeed = 192000 bit/s
         actualTxLineSpeed = 192000 bit/s
      dataXferStateChanges = 4
                 lineState = rfs dsr dcd ~rts

Sample Frames       Bytes        Bits         Err. Frms    
Bit Err    Remaining
       Sent/Recv    Sent/Recv    Sent/Recv    Received     
Rate       (min)
------ ------------ ------------ ------------ -------
----- ---------- ----------
1              2359      2415616     19324928            0      
0e+00          1
               2358      2414592     19316736
2              4469      4576256     36610048            0      
0e+00          1
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               4468      4575232     36601856
3              6589      6747136     53977088            0      
0e+00          1
               6588      6746112     53968896
4              8711      8920064     71360512            0      
0e+00          1
               8710      8919040     71352320
5             10831     11090944     88727552            0      
0e+00          1
              10830     11089920     88719360
6             12570     12871680    102973440            0      
0e+00          0
              12570     12871680    102973440
-----------------------------------------------------
---------------------------

    Test completed (testTimeExpired) after 60 seconds.

        Frame Rate:        209 Frames/sec
         Byte Rate:     214528 Bytes/sec
          Bit Rate:    1716224 Bits/sec
  Frame Error Rate:          0 %

Current port-interface state:

            actualLinkMode = dte
         actualRxLineSpeed = 192000 bit/s
         actualTxLineSpeed = 192000 bit/s
      dataXferStateChanges = 5
                 lineState = rfs dsr dcd rts

The tool expects that the appropriate Passport group is already connected. For 
this reason, the Component Information Viewer Diagnostics uses this tool as 
an argument to the execWithDest utility.

The tool’s command line follows:

/opt/MagellanNMS/bin/ppPortTest
        [-ask|-noask]
        [-stay]
        [-o <output file> | -x]
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        [-fsize <frame size>]
        [-type <test type>]
        [-pat <pattern type>]
        [-cust <custom pattern>]
        [-delay <start delay in seconds>]
        [-duration <test duration in minutes>]
        [-interval <display interval in seconds>]
        [-purpose <string>]
        <port-interface/service component ID>

where:

-ask|-noask specifies whether the dialog is invoked. If you specify 
-ask, the dialog always opens and prompts for the test parameters. If you 
specify -noask, the dialog does not open and testing proceeds with the 
parameters provided on the command line.

-stay does not close the dialog after the test completes to allow you to 
start a test on a different component. This option is most useful with the -
x option).

-o <output file>|-x  specifies the destination of the test output. If 
you specify -o and an output file name, the test output is sent to that file. 
If you specify -x, the output is sent to an independent xmsg window. A 
new window opens for each test. By default, the output is send to the 
standard output stream.

-fsize <frame size> specifies the size of frames to send.

-type <test type> specifies the port type test.

-pat <pattern type> specifies the pattern types to send in the 
frames.

-cust <custom pattern> specifies a bit pattern for the test frames.

-delay <start delay> specifies (in seconds) the delay before the 
test starts.

-duration <test duration> specifies (in minutes) the duration of 
the test.

-interval <results polling interval> specifies (in seconds) 
the delay between the sampling of intermediate results.

-purpose <test purpose> specifies the default values for the 
corresponding fields in the dialog.
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<port-interface/service component ID> specifies the target 
component for the test in display or canonical format with the specified module 
specified (for example, EM/NODEYBC5 LP/4 V35/4 or EM/NODEYBC5 
FRUNI/44).

Component Information Viewer interface in MDM Toolset
The Component Information window contains the following areas:

• “Menu bar” (page 482) 

• “Message area” (page 483) 

• “Related components panel” (page 483) 

• “Sash” (page 486) 

• “Information panel” (page 487) 
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The figure “Sample Component Information Viewer window in MDM 
Toolset” (page 480) shows a sample Component Information Viewer window. 

Figure 39
Sample Component Information Viewer window in MDM Toolset
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components 
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information 
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command buttonpreference boxes
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The figure “Component Information Viewer pop-up menus in MDM Toolset” 
(page 481) shows commands that are available from pop-up menus in the 
Component Information Viewer tool. 

Figure 40
Component Information Viewer pop-up menus in MDM Toolset

The contents of this pop-up menu 
varies according to the 
information type. This sample 
pop-up menu displays 
commands for alarm information 
types.

The contents of this 
pop-up menu varies 
according to the 
components put into 
context during your 
session or as a result of 
customizing the menu.
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Menu bar
The Component Information Viewer menu bar contains the following menus:

• “File menu” (page 482) 

• “Options menu” (page 482) 

• “Help menu” (page 482) 

File menu
The File menu contains the following command:

Options menu
The Options menu contains the following commands:

Help menu
The Help menu contains the following commands:

Command Description

Exit closes the Component Information Viewer tool. If 
you modified preferences or filter settings, a 
dialog box opens and prompts for the appropriate 
course of action for these changes before the 
session closes. 

Command Description

Change Component Filter 
Settings…

opens the Component Filter Settings dialog box 
where you can modify, save, and restore 
component filter settings. For the procedure to 
change filter settings, see “Setting component 
filters in MDM Toolset” (page 421).

Change Preference 
Settings…

opens the Preference Settings Dialog where you 
can modify, save, and restore Component 
Information Viewer preferences. For the 
procedure the change preference settings, see 
“Setting Preferences in MDM Toolset” 
(page 423).
241-6001-011   15.1RSUP   



Chapter 10 Component Information Viewer   483
Message area
The message area displays the name of the servers used by the Component 
Information Viewer. This area also displays a message when a command 
returns a non-zero error code. 

Related components panel
The related components panel lets you view the impact of a component failure 
and the name and state of any related components. From this panel, you can 
start other MDM tools and interact with the Information Panel to find the 
cause of a particular fault.

The related components panel contains the following items:

• “Related Components for” (page 483) 

• “Filtering box” (page 484) 

• “Related components list” (page 484) 

Related Components for
Use the Related Components for field to specify the component name for 
which you want related component information. Related component 
information displays in the related components list. 

The Related Components for field supports two pop-up menus. One pop-up 
menu collects the names of components that you target during a session. You 
can select an entry from this list of components to populate the field. To open 
this menu, right-click on the triangle at the right of the Related Components 
for field. The other pop-up menu lets you edit existing text in the field. To 
open this pop-up menu, right-click in the field. The figure “Component 
Information Viewer pop-up menus in MDM Toolset” (page 481) shows these 
pop-up menus. 

Command Description

Help on Window displays general information about the 
Component Information Viewer window. 

What’s This? Displays information about a selected area of the 
Component Information Viewer window.
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You can use various methods to specify a component name in the Component 
Information Viewer window.

• Typing an entry.
If you type the component name in a format other than the display 
format, the Component Information Viewer reformats the component 
name to the display format.

• Using component context
To use component context, right-click on the left pointing triangle at the 
end of the Related Components for field and select the an appropriate 
entry from the Get Context pop-up menu. For more information about 
component context, see “Context” (page 42). 

• Selecting an item from the target component pop-up menu
The Component Information Viewer tool maintains a list of the last 10 
components that you have targeted during your session. To recall a 
targeted component, right-click on the triangle to the right of the Related 
Components for field and select an entry from the Get Context pop-up 
menu. 

Filtering box
You set filters by using the Change Component Filter Settings… command in 
the Options menu. The Filtering box contains a drop-down list that lets you 
turn filtering on or off for related components. When filtering is on, only those 
components matching the current component filter settings display in the 
related components list. When filtering is off, all related components display. 

The Component Information Viewer saves the value specified in the Filtering 
box as a preference setting. Therefore, the filter setting applies each time the 
Component Information Viewer tool opens. For more information on 
preference settings, see “Setting Preferences in MDM Toolset” (page 423). 

Related components list
The related components list displays the parents, children, related links, a 
crucial subcomponent of an ancestor component and any special relationships 
of the component specified in the Related Components for field. This list also 
supports a pop-up menu that lets you perform tasks on selected entries in the 
list.
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The list displays the propagated state, time, and name of each related 
component. For a description of the propagated states, see the table 
“Propagated states” (page 485). 

The time shown in the list is the time of the last state change. The time 
displays in yy-mm-dd hh:mm:ss format. If the component has never had a 
state change, the text “Never Changed” displays.

Table 82
Propagated states

Propagated state Description

UNKNOWN The component is unknown.

INSV The component is in service and working 
properly.

ISTB The component is in service but has a non-fatal 
fault, or one of its subcomponents is ISTB or 
OOS. The number represents the criticality of the 
faulty component.

OOS The component is out of service because of a 
fatal fault or one of its parents is OOS. The 
number represents the criticality of the faulty 
component.

OOS (Hierarchical-Out-
Of-Service)

An ancestor component of the component is 
known to be out-of-service, or a crucial 
subcomponent of an ancestor component is 
known to be out-of-service.

MTCE The component or a crucial subcomponent of an 
ancestor component is in maintenance state.

HIER MTCE The component is in a hierarchical maintenance 
state. This state occurs when a parent of the 
component, or a crucial subcomponent of an 
ancestor component is in maintenance state.

ACKED The component is in acknowledged state and no 
other faults are apparent.
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Related components pop-up menu
The related components pop-up menu lets you perform tasks on selected 
entries in the related components list. To open the pop-up menu, right-click 
on an entry in the related components list. The figure “Component 
Information Viewer pop-up menus in MDM Toolset” (page 481) shows the 
related components pop-up menu. This pop-up menu contains the following 
commands:

• Show Information updates the Information Panel to show information 
on the selected component.

• Show Related updates the Related Components Panel to show the 
related components of the selected component.

• Set Acknowledge State On/Off sets the acknowledged state of a 
selected component. For more information, see “Setting the 
acknowledge state for a component” (page 428) 

• Set Maintenance State On/Off sets the maintenance state of a 
component and the hierarchical maintenance for all its subcomponents. 
For more information, see “Setting the maintenance state for a 
component” (page 430) 

• Start Tool allows you to start other MDM tools. For details, see “Starting 
the Start Tools from the Component Information Viewer” (page 432). 

• Copy copies the text of the selected item to the Primary selection and the 
clipboard.

• Copy All copies the text of all the related components to the Primary 
selection and the clipboard.

Sash
The sash is positioned between the related components and information 
panels. Moving the sash up or down changes the amount of space each panel 
occupies. For example, if you move the sash down to increase the amount of 
space for the related components panel, the amount of space for the 
information panel decreases. To move the sash, drag the box on the right side 
of the sash up or down. 
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Information panel
Use the information panel to display additional management data for a 
component including alarms, network model data, customer data, and 
diagnostics. 

The Information Panel contains the following items:

• “Information for” (page 487) 

• “Pop-up menu” (page 489) 

• “Information type” (page 489) 

• “Include subcomps” (page 490) 

• “Commands (diagnostic commands)” (page 491) 

• “Information list” (page 492) 

Information for
To view additional information about a component, you need to specify the 
component name in the Information for field and specify the type of 
information you want in the Information Type box. For information about the 
types of information you can display, see “Information type” (page 489). This 
field also supports a pop-up menu that lets you edit the text in the field.

The Information for field supports two pop-up menus. One pop-up menu 
collects the names of components that you target for information during a 
session. You can use this pop-up menu to populate the field. To open this 
menu, right-click on the triangle at the right side of the Information for field. 
The other pop-up menu lets you edit existing text in the field. To open this 
pop-up menu, right-click in the field. The figure “Component Information 
Viewer pop-up menus in MDM Toolset” (page 481) shows these pop-up 
menus. 

To specify a component name in this field, you can use the following 
methods: 

• Typing an entry
If you type the component name in a format other than the display 
format, the Component Information Viewer reformats the component 
name to the display format. 
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• Using the field’s pop-up menus
There are two pop-up menus in the Information for field. One provides 
commands to edit the text in the field, the other pop-up menu provides 
access to component context and a list of components from which you 
can select. You can use the second pop-up menu to target a component. 
To open this pop-up menu, right-click on the triangle at the end of the 
Information for field. You can then target the component in context by 
selecting the Get Context command, or you can target a component by 
selecting from a list of the ten most recently targeted components. For 
more information about component context, see “Context” (page 42). If 
you frequently use the same component names, you can customize the 
entries in this pop-up menu. For details, see “Customizing the 
Component Information Viewer display in MDM Toolset” (page 453). 

• Using the related components list
Selecting an entry in the related components list, populates the 
Information for field with the selected component name.

• Using search patterns
You can use search patterns for active alarm and recent alarm 
information types. Patterns of components have a vertical bar (‘|’) in the 
name, typically the first character if there is only one pattern. All alarms 
matching the specified patterns display in the information panel. The 
pattern language is the same as extended GREP style patterns.

A search pattern is first matched to the component ID in canonical format 
(blank separated). Then the pattern is matched to the component ID in 
display format (/ separated), then to the fault code, and finally to the 
comment text of the alarms. 

When you specify a search pattern, information is not automatically 
refreshed. Refresh the display manually by clicking the Refresh button or 
by pressing the Return key in the text field.

The table “Sample search patterns” (page 489) provides sample search 
patterns and a description of their function.
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Pop-up menu
To edit the text in the Information for field, use the field’s pop-up menu. To 
open the pop-up menu, right-click in the Information for field. The pop-up 
menu contains commands that let you cut, copy, paste, delete, select or 
deselect text in this field. This pop-up menu is the same as the Related 
Components for pop-up menu.

Information type
The Information Type: box lets you select the type of information to display 
in the information panel. The table “Component Information Viewer 
Information types” (page 490) lists the available information types.

Table 83
Sample search patterns

Search pattern Function

EM .* SONET .*|EM .* DS3 .* Reports all alarms in the network for 
Passport DS3 and SONET port-
interfaces

|EM .* SONET .* Reports only SONET alarms. The 
vertical bar at the beginning 
distinguishes the specification from a 
plain component name:

^7039....$|^7041....$|^7001....$ Displays all Passport ATM and Frame 
Relay related alarms. The caret (^) 
indicates the beginning of the string to 
match. The $ character indicates the 
end of the string to ensure 
occurrences of these numbers are not 
matched in the middle of another 
string
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The Component Information Viewer saves the value in the Information Type 
box as a preference setting. Therefore, the information type applies each time 
the Component Information Viewer application opens. For more information 
on preference settings, see “Setting Preferences in MDM Toolset” 
(page 423). 

Include subcomps
The Include Subcomps box is available only when the current information 
type is Active Alarms. This box lets you choose whether or not to display 
active alarms for all subcomponents of a specified component. 

Table 84
Component Information Viewer Information types

Information type Description

Active Alarms Displays the currently active alarms for 
the specified component

Status Displays the most recent status record 
received from the specified component 
(DPN only)

Recent Alarms Displays the alarm history for the 
specified component

Model Data Displays the information about the 
specified component, as started in the 
network model. 

Diagnostics Displays diagnostic information based 
on the type of information selected with 
the Command button. For details about 
available diagnostic commands, see 
“Commands (diagnostic commands)” 
(page 491).

Customer Data Displays customer database information 
matching the specified component. This 
information is retrieved from the 
Customer Database server identified in 
the Preferences dialog. See “Setting 
Preferences in MDM Toolset” 
(page 423).
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The Component Information Viewer saves the value in the Include Subcomps 
box as a preference setting. Therefore, the setting for this option applies each 
time the Component Information Viewer application opens. For more 
information on preference settings, see “Setting Preferences in MDM 
Toolset” (page 423). 

Commands (diagnostic commands) 
The Commands box is available only when the current information type is 
Diagnostics. Clicking on the box opens a menu of diagnostic commands. The 
commands vary depending on the available tools and whether the menu of 
diagnostic commands has been customized at your installation. You may see 
the following items:

• commands to select a command route, start the Command Console tool, 
and display online help

• Passport and DPN commands to

— help diagnose components

— send inventory reports to the Information Panel

• Passport commands to execute Passport tests

Output from these diagnostic commands display in the Information panel.

For a list of default Component Information Viewer Diagnostic commands, 
see “Commands (diagnostic commands)” (page 491). For details about 
customizing the diagnostic menu, see the section on customizing the 
Component Information Viewer diagnostics in 241-6001-301 Preside MDM 
Customization Administrator Guide.The Commands menu and its submenus 
are all detachable to make their commands easier and faster to use. To detach 
a menu, press the middle mouse button on the dotted white line at the top of 
the menu and drag the menu off the window. Since the commands in a menu 
are sensitive to the type of component currently targeted by the Information 
panel, the availability of these commands will be re-evaluated when you 
change the value in the Information for field or when the field loses the focus. 

The figure “Detachable Commands menu in MDM Toolset” (page 492) 
shows the available commands. 
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Figure 41
Detachable Commands menu in MDM Toolset

Information list
The information list displays information about selected components. The 
content of the information list depends on the type of information that you 
select from the Information Type box. You can display active alarms, status 
records (DPN only), recent alarms, model data, customer data, and 
diagnostics. 

Each information type has its own pop-up menu. The figure “Component 
Information Viewer pop-up menus in MDM Toolset” (page 481) shows the 
pop-up menu for the diagnostic information type. 
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When active alarms and recent alarms display in the Information list, the 
following commands are available from the pop-up menu:

• Copy copies the text of the selected alarm in the information panel to the 
clipboard and a specified destination.

• Copy All copies all the alarms in the information panel to the clipboard 
and a specified destination. 

• Set Terse Format lets you to display the selected alarms in terse format. 
For detailed information on terse format, see “Format toggle button” 
(page 332). 

• Set Normal Format lets you to display the selected alarms in normal 
format. For detailed information on normal format, see “Format toggle 
button” (page 332). 

• Set Full Format lets you to display the selected alarms in full format. For 
detailed information on full format, see “Format toggle button” 
(page 332). 

• Start Tool lets you to start other tools and utilities. For details, see 
“Starting other MDM tools from Shelf View in MDM Toolset” 
(page 214) and “Starting other MDM tools from Shelf View in Operator 
Client” (page 216). 

• Acknowledge Alarms… lets you to indicate to other network operators 
that you are currently investigating a fault causing an alarm. This is 
available for Active Alarms only. For more information, see 
“Acknowledging active alarms” (page 441). 

• Unacknowledge Alarms… lets you take selected alarms out of the 
Acknowledged state and indicate to other network operators that the fault 
causing the alarm has been resolved or needs to be investigated. This is 
available for Acknowledged Active Alarms only. For more information, 
see “Unacknowledging active alarms” (page 443). 

• Local Clear clears the selected alarms on the Preside Multiservice Data 
Manager (MDM) system only. This is available for Active Alarms only. 
For more information, see “Clearing alarms using Local Clear” 
(page 435). 
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• Global Clear clears alarms from the appropriate DPN-100 OAs, 
Passport, and from MDM. For more information, see “Clearing alarms 
using Global Clear” (page 437). 

When status records, model data, customer data, and diagnostic information 
display in the Information list, the following commands are available from 
the pop-up menu:

• Copy copies selected text the clipboard.

• Select All selects all text in the Information list.

• Deselect All cancels the selection of any text.

• Copy Component to Target Field copies the current text selection, or 
the text surrounding the cursor position, to the Information for field for 
use as another command. In the absence of a selection, the command tries 
to identify a component ID in the text around the cursor position and then 
uses this text as the subcomponent portion in the Information for field. 
For example, using the output of a Passport list command, click 
somewhere on one of the output component names and select Copy 
Component to Target Field. The copied component becomes the 
subcomponent in the Information for field. Pressing the Shift key and 
double-clicking the middle mouse button on text in the information list 
performs the same function as the Copy Component to Target Field 
command.

Preference boxes
The Component Information Viewer contains the following boxes:

• Auto-Context

• Auto-Refresh

• Refresh Display

Auto-Context
 The Auto-Context button controls whether or not the Component 
Information Viewer tools automatically retrieves components from context. 
For example, if you turn on automatic context and then select a component in 
any of the MDM tools that support context, that component information 
automatically displays in the Component Information Viewer window. You 
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can also set Auto-Context in the Preference Settings Dialog box. For details 
on using this dialog, see “Setting Preferences in MDM Toolset” (page 423). 
For more information about component context, see “Context” (page 42). 

Auto-Refresh
The Auto-Refresh button controls whether or not the information in the 
Component Information Viewer window automatically refreshes. The refresh 
interval is set in the Preference Settings Dialog. You can also set Auto-
Refresh in the Preference Settings Dialog. For details on using this dialog, see 
“Setting Preferences in MDM Toolset” (page 423). 

Refresh button
The Refresh Display button lets you immediately refresh the contents of the 
Component Information Viewer window. 
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Errors and warnings 
The Component Information Viewer provides the following error and 
warning messages to help you take corrective action:

• “Service Selection Warning Dialog” (page 496)

• “Save Settings Error Dialog” (page 496) 

• “Restore Settings Error Dialog” (page 496) 

• “Manual Alarm Clearing Error Dialog” (page 497) 

Service Selection Warning Dialog
The Service Selection Warning Dialog box indicates that the Component 
Information Viewer is using a new management data server due to a LAN 
selection change. 

Update the contents of the Component Information Viewer window by 
clicking the Refresh Display button.

Save Settings Error Dialog
The Save Settings Error Dialog box indicates that the preference file cannot 
be saved to the $HOME/MagellanNMS/CIVPrefs.cfg file or the component 
filter settings file cannot be saved to the $HOME/MagellanNMS/ 
CIVCFilt.cfg file. 

Ensure that there is write access to the home directory and the configuration 
file. Ensure there is sufficient disk space for the home directory. 

Restore Settings Error Dialog
The Restore Settings Error Dialog indicates that the preference file cannot be 
restored from the $HOME/MagellanNMS/CIVPrefs.cfg file or the 
component filter settings cannot be restored from the $HOME/
MagellanNMS/ CIVCFilt.cfg file. 

Ensure that the configuration file exists and that there is read access to the 
home directory and the configuration file. If the file exists and has the 
appropriate permissions but the file contents are not recognized, recreate the 
appropriate settings using the Component Filter or Preference Settings Dialog 
boxes, and save them again. 
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Manual Alarm Clearing Error Dialog
The Manual Alarm Clearing Error Dialog box opens when an alarm cannot 
be cleared. The dialog box displays a message indicating the cause and 
information used to clear the alarm. 

Component Information Viewer interface in MDM Operator 
Client

The component information viewer contains alarm information and 
diagnostics information that help you diagnose network problems. Selecting 
a window tab displays the applicable information.

The component information viewer window consists of the following areas:

• “Menu bar” (page 499) 

• “Filter panel area” (page 501) 

• “Component list area” (page 502) 

• “Filter option boxes” (page 503) 

• “Status bar” (page 503) 

• “Alarms tab” (page 503) 

The figure “Sample Component Information Viewer window in MDM 
Operator Client” (page 498) shows a sample Component Information Viewer 
window. 
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Figure 42
Sample Component Information Viewer window in MDM Operator Client

menu bar

component 
list area

status bar
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Figure 43
Sample Component Information Viewer window in MDM Operator Client

Menu bar
The component information viewer provides the following menus:

• “File” (page 499) 

• “Edit” (page 500) 

• “Options” (page 500) 

• “Help” (page 501) 

File 
The File menu contains the following commands:

menu bar

component 
list area

alarm list area

status bar
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Edit
The Edit menu contains the following command:

Options
The Options menu contains the following commands:

Command Description

Reconnect to server resets the connection to the general 
management data router (GMDR) server. Use 
this command if the GMDR server stops 
responding to the client, for example, if you set a 
new filter but receive no alarms.

Exit  closes the component information viewer 
window and exits the application. 

Command Description

Copy copies the full format of a selected alarm from the 
alarm list to the system clipboard. You can then 
paste this information into another application

Command Description

Bell On Critical Alarm turns sound effects on or off for critical alarms. To 
play a sound whenever the alarm display 
receives a critical alarm, select the check box. To 
turn off sounds for critical alarms, clear the check 
box

Bell On Major Alarm turns sound effects on or off for major alarms. To 
play a sound whenever the alarm display 
receives a major alarm, select the check box. To 
turn off sounds for major alarms, clear the check 
box. 
241-6001-011   15.1RSUP   



Chapter 10 Component Information Viewer   501
Help
The Help menu contains the following command:

Filter panel area
The filter panel area provides filters which display components based on the 
component state. When you first open the Component Information Viewer, 
filtering on Troubled Network State is enabled by default. The Component 
Information Viewer supports filtering on the following conditions:

• “Troubled Network State” (page 501)

• “Propagated State/Criticality” (page 502)

Troubled Network State
The Troubled Network State filter only displays components that have a 
troubled raw state including out-of-service (OOS) and in-service troubled 
(ISTB). 

Bell On Minor Alarm turns sound effects on or off for minor alarms. To 
play a sound whenever the alarm display 
receives a minor alarm, select the check box. To 
turn off sounds for minor alarms, clear the check 
box

Bell On Warning Alarm  turns sound effects on or off for warning alarms. 
To play a sound whenever the alarm display 
receives a warning alarm, select the check box. 
To turn off sounds for warning alarms, clear the 
check box

Command Description

Help on Window displays general information about the 
Component Information Viewer window. 

What’s This? Displays information about a selected area of the 
Component Information Viewer window.

Command Description
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Propagated State/Criticality
The Propagated State/Criticality filter enables you to select the specific 
propagated states and state criticalities that you wish to display that include:

• “State filter options” (page 502)

• “Threshold filter options” (page 502)

State filter options
To filter by state, select from the following options:

• OOS (out of service)

• ISTB (in service, troubled)

• INSV (in service)

• Unknown

Threshold filter options
To filter the components based on their threshold, select any of the values 
from 1 to 5. The more outages a component’s fault causes, the higher its 
threshold value. If you filter on INSV or Unknown states, any selected 
threshold values are ignored.

Set Filter button
The Set Filter button activates any selected state and threshold filters.

Component list area
The component list area is where you can request a component to view. The 
area contains a Component field and Enter button, component list box, and 
component list options boxes.

Component field
The Component field lets you enter the name of the node that you want to 
view. 

Enter button
As an alternative to pressing the enter key to enter a a component ID in the 
component field, click Enter.
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Component list
After you enter a component ID, a component list opens. This list shows all 
the related components including parents and children.

Filter option boxes
The filter option boxes let you turn hot context on or off and to set an auto- 
refresh interval.

Hot Context
If you select this check box, hot context is turned on. If you do not select this 
check box, hot context is turned off. 

Auto-Refresh
This option refreshes (reloads) the network model information. The 
Component Information Viewer application does not update component state 
information as the network status changes. You need to reload model 
information to capture state changes. If you select this check box, the 
applications reload based on the time specified in the Interval field. If you do 
not select this check box, the application does not reload network model 
information.

Interval
This option specifies the number of seconds between automatic network 
model reloads. The default value is 60 seconds. When you change the interval 
value and then press the enter key, an immediate refresh occurs. To set an 
interval, ensure that you also select the auto-refresh check box. The 
component information viewer does not accept a refresh interval less than 15 
seconds.

Status bar
The status bar provides information about whether filtering is on or off, the 
login user ID, and the server being accessed.

Alarms tab
The alarm list area consists of a list area and check boxes that let you 
determine what displays in the alarm list, an alarm count, and a detailed alarm 
list.
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Note: The alarm list area information is displayed when the alarms 
window tab is selected.

Alarm mode list box
This list box provides lets you choose from the following alarm modes. 

— Active Alarms display only active alarms.

— Alarm Log displays recent alarms as they are received by MDM. 
This mode includes all alarms including set, clear, and message 
events

— Alarm History is similar to Alarm Log but also includes past 
alarms. In some networks, selecting this mode can result in large 
amounts of alarm data.

Pause Alarms
If you select this check box, no subsequent alarms display in the alarm list. If 
you do not select this check box, the alarm display continues to add alarms to 
the alarm list. 

Alarm list area
Alarms are displayed in this area based on the selected alarm mode. Full 
alarm details are provided in this list area and details are displayed according 
to labelled columns at the top of the list area.

Detailed Alarm Report tab
The Detailed Alarm Report tab displays all of the same alarm information that 
is displayed in the Alarm List area, except only for the selected alarm. The 
details are organized and displayed in logical groups.

MDM Full Alarm Format tab
The MDM Full Alarm Format tab displays all of the same alarm information 
that is displayed in the Alarm List area, except only for the selected alarm. 
The details are organized and displayed in full format. 

NTP Description of Fault tab
The NTP Description of Fault tab displays the NTP description for the 
selected alarm.
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Query Historical Alarms

Query Historical Alarms tool is used to search and display short-term 
historical alarms.

Navigation
• “Query Historical Alarms procedures” (page 505)

• “Query Historical Alarms interface” (page 516)

• “Query Historical Alarms fundamentals” (page 518)

Query Historical Alarms procedures
Use these procedures to query historical alarms from MDM Toolset window, 
the command line interface (CLI), and from other tools.

• “Querying historical alarms tool from the Preside MDM tool set 
window” (page 506)

• “Querying historical alarms from the command line interface” 
(page 511)

You can also query historical alarms from the Component Information 
Viewer. To do so, see the following procedures:

• “Starting Component Information Viewer” (page 418) 

• “Starting Component Information Viewer with context” (page 419) 
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Querying historical alarms tool from the Preside MDM tool 
set window

You can start the Query Historical Alarms tool using various methods. Use 
this procedure to start the tool from the Preside MDM tool set window. 

• “Procedure steps” (page 506)

• “Procedure job aid” (page 509)

Procedure steps
1 In the Preside Multiservice Data Manager window, select Fault -> Query 

Historical Alarms.

The Query Historical Alarms dialog opens and displays the first of the two-
page dialog. 
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2 On the first page of the dialog, refine the alarm query by using the 
following filters. For a description of the filters, see the table “Query 
Historical Alarms filters” (page 509).

3 If you do not require any further filters, click OK to start the query, 
otherwise click Advanced to open the second page of the dialog.

4 Further refine the alarm query by using any of the following filters. For a 
description of the filters, see the table “Query Historical Alarms filters” 
(page 509).

5 Optionally, to save the Customer Database (CDB) options and alarm 
output format settings for the next time you start the Query Historical 
Alarms tool, click Save CDB and Format specifications as defaults.

6 Optionally, to display a tracking dialog that counts the alarms scanned 
during the search, click to select the Enabled check box. 

• To control the number of alarms scanned before the tracking dialog 
refreshes, change the value in the Tracking count box. Turning on 
tracking may slow the search.

7 To begin the historical alarm query, click OK.
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The Historical Alarms dialog box opens.

If you enabled tracking, the tracking dialog also opens. 

As matching alarms are identified they display in the Historical Alarms 
output window. When the scan is complete, the tracking dialog closes.

8 To save the contents of the Historical Alarms dialog box to a file, click 
Save output to file... or to close the dialog box, click OK.

The Historical Alarms dialog box closes and the Query Historical Alarms 
dialog box reopens so that you can make further alarm queries.
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Procedure job aid
Table 85
Query Historical Alarms filters

Filter Description

First page of dialog:

Component specifies the component for which you want to 
retrieve alarms. By default, the component is 
EM/*, which retrieves all Passport alarms. 
Alternatively, you can specify the component for 
which you want alarm information. If you specify 
a component filter, the alias filter is ignored.

or Alias specifies the component alias. The alias 
replaces the component ID in the display with the 
matching Related Component ID value from the 
customer database. If you do not use a customer 
database, or if you specify a component filter, 
this alias filter is ignored.

From date/time specifies the start of the time period for which you 
want alarms. The initial value for this field is the 
current date and time minus one day. If you 
override the initial value in this field or in the To 
date/time field and need to reestablish the initial 
values, click the Reset Date-Time button.

To date/time specifies the end of the time period for which you 
want alarms. The initial value for this field is the 
current date and time. If you override the initial 
value in this field or in the From date/time field 
and need to reestablish initial values, click the 
Reset Date-Time button

Fault code specifies the fault code to use for filtering alarms. 
You can use GREP style patterns to specify 
these fault codes.

Alarm event specifies the alarm event to use for filtering 
alarms. If needed, you can specify multiple alarm 
events. 
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Alarm severity specifies the alarm severity to use for filtering 
alarms. If needed, you can specify multiple 
severities.

Display format specifies the level of alarm output to display, from 
the least output (terse) to the most output (full).

Advanced page of 
dialog:

Alarm type specifies the alarm type to use for filtering. If 
needed, you can select multiple types.

Comment text text specifies the comment data pattern (GREP) 
to use for filtering.

Customer Database
Server

specifies the service name of the Customer 
Database (CDB) that has the customer data and 
alias information. The Query Historical Alarms 
tool supports the same CDB interaction as the 
Alarm Display and Component Information 
Viewer tools. 

Customer Database
Host

specifies the host name of the CDB that has the 
customer data and alias information.

Table 85 (Continued)
Query Historical Alarms filters

Filter Description
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Querying historical alarms from the command line interface
You can start the Query Historical Alarms tool using various methods. Use 
this procedure to start the tool from the command line.

• “Procedure steps” (page 511)

• “Variable definitions” (page 512)

• “Procedure job aids” (page 513)

Procedure steps
1 Execute the real-time alarm search tool by typing the following command 

syntax as one continuous command:

/opt/MagellanNMS/bin/rtacsrch 
[-format <TERSE|NORMAL|FULL|DUMP>]
[-output <WINDOW|MORE|STDOUT|FILE <output file>]
[-noseparator]
[-start <date> [<time>]]
[-end <date> [<time>]]
[-component <component id pattern>
[-fault <fault code pattern>]
[-cid <customer id pattern>]
[-<any alarm field name> <pattern>]
[-h]
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Variable definitions

Variable Definition

-format [<TERSE|NORMAL|FULL|DUMP>] specifies the alarm output level. The output 
formats correspond to those of the Alarm Display 
tool. Output ranges from the least output 
(TERSE) to the complete alarm output (FULL). 
DUMP format is an output of the non-empty 
alarm fields in format:

<field 1 name> = <file 1 value>
<field 2 name> = <file 2 value>
336

.
<field n name> = <file n value>

The default format is TERSE. 

-output [<WINDOW|MORE|STDOUT|FILE 
<output file>]

specifies where the output displays. WINDOW 
displays alarms in a scrollable window. MORE 
sends output to standard output using the more 
program. STDOUT sends output to the standard 
output stream. FILE sends output to the named 
file. The default output is WINDOW.

-noseparator omits separators between alarms

-start <date> [<time>] specifies the start date for the query. <date> and 
<time> specify the start range of the alarm 
records. The default start date and time is 1900-
01-01 00:00:00.

<date> can be in the form yymmdd, 
yyyymmdd, yy-mm-dd, or yyyy-mm-dd.

<time> can be in the form hhmmss or 
hh:mm:ss.
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Procedure job aids
The table “Command line abbreviations” (page 514) details those command 
line options that support abbreviations:

-end <date> [time] specifies the end date for the query. <date> and 
<time> specify the end range of the alarm 
records. The default start date and time is 9999-
12-31 23:59:59.

<date> 

can be in the form yymmdd, yyyymmdd, yy-mm-
dd, or yyyy-mm-dd.

<time> can be in the form hhmmss or 
hh:mm:ss.

-component <component ID pattern> specifies the component identifier pattern.

<component ID pattern> is considered anchored 
(^<pattern>$).

-fault <fault code pattern> specifies a fault code pattern.

<fault code pattern> is considered anchored 
(^<pattern>$).

-cid <customer Id pattern> specifies a customer identifier pattern.

<customer Id pattern> is considered 
anchored (^<pattern>$).

-<any alarm field name> <pattern> <any alarm field name> can be any field 
present in an alarm record. The list of available 
fields is available in the ala.rdf file.

<pattern> is considered anchored 
(^<pattern>$).

-h displays command line usage information.

Variable Definition

 (Sheet 2 of 2)
Preside MDM Fault Management User Guide   15.1RSUP



514   Chapter 11 Query Historical Alarms
The figure “Sample rtacsrch command lines” (page 515) provides sample 
rtacsrch command lines

Table 86
Command line abbreviations

Option Abbreviation

format fo

output o

noseparator nos

start s

end e

component co or compId

fault fa or faultcode

cid ci or customerId
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Figure 44
Sample rtacsrch command lines

The table “Exit codes for rtacsrch command” (page 515) details the exit codes 
from rtacsrch command.

Table 87
Exit codes for rtacsrch command

Exit code Description

0 Normal success

1 Major errors were found

2 Terminated because of signal received

Examples:

rtacsrch

This command extracts every alarm and prints them in TERSE format. 
The alarms are displayed in a scrollable window.

rtacsrch -s 00-01-12 -e 20000227 13:04:58 -fo normal -co 
“EM/NODEA FRUNI/7.*” -o file NODEA_7.alarms

This command line extracts the alarms related to FRUNI 7 on Passport 
NODEA that were generated between January 12, 2000 at midnight and 
February 27, 2000 at 13:04:58. The alarms are printed in NORMAL 
format and saved in file NODEA_7.alarms
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Query Historical Alarms interface
The Query Historical Alarms interface consists of a single two-page dialog 
that contains a selection of fields to help refine the search criteria. Each field 
has a Help button that displays a brief explanation of the associated field. You 
can filter the alarm search on such parameters that include date and time 
ranges, fault codes, events, alarm severity, alarm types, alarm output level, 
and customer database services. The figure “Sample Query Historical Alarms 
dialog” (page 517) shows a sample dialog.
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Figure 45
Sample Query Historical Alarms dialog

Clicking the 
Advanced 
button opens 
the second 
page of the two-
page dialog

Clicking the Previous button 
returns to the first page.
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Query Historical Alarms fundamentals
You can start the Query Historical Alarms tool from the Preside Multiservice 
Data Manager (MDM) tool set window, from within the Component 
Information Viewer tool, or through a command line interface.

The Query Historical Alarms tool lets you search and display short-term 
historical alarms. The collection and saving of these short-term alarms are 
done by the real-time alarm collection (RTACCOL) server. Each day, the 
RTACCOL creates a file for the collection of alarms (using the format 
“alarms.<yyyy>-<mm>-<dd>” for the file name) and stores this file in the 
directory defined in the RTAC.cfg configuration file. For further details about 
RTACCOL, see the section on the real time alarm collection tool in 
241-6001-310 Preside MDM Server Reference Guide. 

The Query Historical Alarms tool extracts information from the historical 
alarm files and displays its output in the Historical Alarms output dialog. 
When you close the output dialog, the Query Historical Alarms dialog 
reopens if you started the tool from the Preside MDM tool set window. If you 
started the Query Historical Alarms tool using Component Information 
Viewer, the Query Historical Alarms dialog does not automatically reopen. In 
this case, you need to select the Query Historical Alarms command from 
Component Information Viewer once again. 
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Component Status Display

This section describes the Component Status Display and provides you with 
instructions on how to use this tool. The following information is included:

• “Component Status Display overview” (page 519)

• “Component status” (page 521)

• “Component Status Display main window” (page 524)

• “Keyboard shortcuts” (page 531)

• “Component Status Display dialogs” (page 532)

• “Component Status Display procedures” (page 540)

• “Setting Component Status Display preferences” (page 546)

• “Customizing the Component Status Display” (page 548)

Component Status Display overview
The Component Status Display is a monitoring tool that provides a textual 
display of the current state or criticality of network model components. 
Component Status Display allows you to view status at the following levels:

• region

• site

• module

• components
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The Component Status Display provides a textual representation of the 
organization at region, site, module, component, and subcomponent levels in 
the network. For a graphical representation of the same information, use the 
Network Viewer. 

The Component Status Display is equipped with preference dialogs that let 
you

• set up filtering to display the status of one or more component types 
based on Troubled Raw state, or Propagated state and Criticality

• sort information displayed for components based on the component 
name, the Propagated state and Criticality, or the time of the last state 
change

• set the refresh interval for component states

• turn on or turn off automatic refreshing of component states

You can customize the Component Status Display. The Component Status 
Display features a Start Tool command from which you can launch other 
Preside Multiservice Data Manager (MDM) tools. You can customize the list 
of tools available from the Start Tool command. For details, see the section on 
customizing the toolsets and Start Tools menu in 241-6001-301 Preside 
MDM Customization Administrator Guide. You can also customize resources 
such as alarm colors. For details, see “Customizing the Component Status 
Display” (page 548).

The Component Status Display also allows you to react to a fault by putting 
the component into Acknowledged state or Maintenance state.

See also…

• “Component Status Display overview” (page 519)

• “Component status” (page 521)

• “Component Status Display main window” (page 524)

• “Component Status Display dialogs” (page 532)

• “Component Status Display procedures” (page 540)

• “Setting Component Status Display preferences” (page 546)
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• “Setting Component Status Display preferences” (page 546)

• “Customizing the Component Status Display” (page 548)

Component status
The status of a component is determined by its state. Each component in the 
network model contains a set of core attributes to model its state. There are 
two categories of states: raw and propagated. Raw states apply to a single 
component and are produced by the Surveillance Data Servers. Propagated 
states reflect the impact of raw states on related components and are 
computed by the Surveillance Network Updater (SURNUP) or, in the case of 
Acknowledgment and Maintenance, are originated by the operator.

For further information on component states and criticality, see 241-6001-015 
Preside MDM Network Model Administrator Guide.

Raw state values
Raw state values are provided by the Surveillance Data Servers and only 
apply to a single component. Possible raw state values are shown in the table 
“Raw state values” (page 521).

Table 88
Raw state values

Raw state value Label Meaning

Unknown UNK MDM has not heard from the 
component and does not know its state

In-Service INSV The component is known to be working 
properly.

Out-Of-Service OOS The component is not working.

In-Service–Troubled ISTB The component is known to be In-
Service but experiencing some 
difficulties, for example, overloaded
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Propagated state values
Propagated states consist of two elements—a state value and a criticality 
value (N). Possible propagated state values are shown in the table 
“Propagated state values” (page 522).

Table 89
Propagated state values

Propagated state value Label Meaning

Unknown UNK MDM has not heard from the 
component and does not know its 
state.

In-Service INSV The component, its parents, and 
all its children are working 
properly.

Out-Of-Service-N OOS-N The component is not working 
because of a fatal fault or 
because one of its parents is out-
of-service. N is its criticality.

Hierarchical-Out-Of-
Service-N

OOS-N The component’s parents or one 
of its grandparents is not working 
and N is the component’s 
criticality.

In-Service-Troubled-N INST-N The component is working but 
has suffered a non-fatal fault, or 
one of its subcomponents is 
troubled or out-of-service. N is 
the criticality of the most 
important subcomponent 
affected, if not that of the 
component itself.

Acknowledged ACKED The component has been put in 
acknowledged state and no other 
faults are apparent.
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Propagated values are computed by the Surveillance Network Updater 
(SURNUP). In addition, the operator can assign the following state values: 

Acknowledged
In the Acknowledged state, a component’s true raw state is masked. The 
component behaves as though it is in-service (that is, if other related 
components are troubled, the component’s Propagated state reflects this). If 
no troubled-related components exist, the Acknowledged component 
displays an ACKED propagated state instead of INSV. If at least one endpoint 
of a link is ACKED and the others are ACKED, INSV, or UNKNOWN, the 
link also displays an ACKED propagated state. As soon as another raw state 
change is received from the network for the component (through alarms or 
other network management data), the Acknowledged state is automatically 
removed; the new raw state is applied and propagated. The Acknowledged 
state therefore acts as a temporary Maintenance state. See “Putting a 
component into Acknowledged state” (page 543) for procedures.

Maintenance
In the Maintenance state, a component’s true raw state, and that of its 
subcomponents, are masked. The component displays a propagated state of 
MTCE (its children display HIER MTCE). In contrast to the Acknowledged 
state, components in the Maintenance state ignore any additional raw state 
change from the network. The component can only be removed from the 
Maintenance state manually or when the model is reloaded. See “Putting a 
component into Maintenance state” (page 543) for procedures.

Maintenance MTCE The component has been put into 
maintenance state

Hierarchical Maintenance HIER_MTCE One of the component’s parents 
has been put in maintenance 
state.

Table 89 (Continued)
Propagated state values

Propagated state value Label Meaning
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Component Status Display main window
The Component Status Display main window is divided into the following 
areas:

• “Menu Bar” (page 524)

• “Message area” (page 526)

• “Components Panel” (page 526)

• “Control panel” (page 531)

The figure “Component Status Display main window” (page 524) shows a 
sample Component Status Display main window.

Figure 46
Component Status Display main window

Menu Bar
The menu bar contains the following command menus:

• “File menu” (page 525)

components 
panel

control panel

message area

menu bar
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• “View menu” (page 525)

• “Options menu” (page 526)

• “Help menu” (page 526)

File menu
The File menu contains the following command:

• Exit closes the Component Status Display and its dialogs. If any 
Preference or Component Filter settings are modified, a dialog opens and 
prompts you to save either, both, or none of these settings before exiting. 
You can also close the dialog without exiting.

View menu
The View menu contains the following commands:

• Select Organization displays the available organizations and lets you 
choose a new organization from the current network model. Select the 
desired organization, then choose the Open Organization menu item on 
the display, or simply double-click on the organization. All region nodes 
in the selected organization are displayed. 

• Show Region Level displays all region nodes in the current organization. 

• Show Site Level displays all site nodes in the current organization.

Note: If you expand downwards (that is, the current display shows 
regions), you see only sites that are under the selected region(s). If no 
selected regions are in the list, all sites in the selected organization are 
shown. 

• Show Module Level displays all module nodes in the current 
organization.

Note: If you expand downwards (that is, the current display shows sites) 
you see only modules that are under the selected site(s). If no selected 
sites are in the list, then all modules in the selected organization are 
shown.

• Show Component Level displays all component nodes in the current 
organization. 
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Note: If you expand downwards (that is, the current display shows 
modules), you see only components that are under the selected 
module(s). If no selected modules are in the list, then all components in 
the selected organization are shown.

Options menu
The Options menu contains the following commands:

• Change Component Filter Settings… opens the Component Filter 
Settings Dialog to allow you to modify, save, and restore these settings. 

• Change Preference Settings… opens the Preference Settings Dialog to 
allow you to modify, save, and restore these settings.

Help menu
The Help menu contains the following commands:

• Help on Window displays descriptive information about the Component 
Status Display window components.

• What’s This? displays information about a selected area of the 
Component Status Display window.

Message area
The Message Area displays the name of the network model, the level that is 
currently being displayed (that is, the Region, Site, Module, or Component) 
and the number of components in the current list. The number of components 
may be a subset of the total at the given level, if filtering is turned on. This 
area is also used for displaying a user prompt that indicates you need to select 
a new organization. This prompt could be the result of your request to choose 
a new organization, or the result of a new network model being loaded while 
Component Status Display is running.

Components Panel
The Components Panel lets you monitor components at a particular level. 
This panel takes its information from the Network Model Coordinator and 
displays it in a format similar to that of the Related Components Panel of the 
Component Information Viewer. 
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The Components Panel lists components at a particular level within the 
organization (region, site, module, and component). For example, you can 
monitor only the components that meet a selected state criteria (if filtering is 
turned on) based on a specified sort criteria. Even with filtering turned off, 
you can view a subset of components at a particular level by selecting a subset 
of components at one level and requesting to view a lower level. For example, 
you can select a set of Site components and then ask to view the Module level. 
In this case, only the modules that are found under the selected sites are 
displayed at the Module Level. Then filtering can be used to further reduce 
the displayed list. 

Component fields
The following fields are provided for each component listed in the 
Components Panel:

• State displays the component Propagated state by name and color. The 
colors and names are the same as those used by the Network Viewer. See 
“Propagated state values” (page 522) for more information about the 
displayed states.

• Time displays the date and time of the last Propagated state change that 
the component has undergone. If no state change has yet occurred, this 
field displays the string Never Changed.

• Component displays the actual component display name.

Component filtering
You can filter the contents of the Component Panel based on the components’ 
Raw or Propagated states, and component types. Component filter settings are 
modified through the Component Filter Settings Dialog, which can be opened 
from the Options menu; filtering is turned On or Off by means of the Filtering 
option button. Filtering is disabled at the Region Level and Site Level, and 
when organizations are displayed. 

Context
When a component is selected in the Components Panel, its name is 
automatically put into hot context. Any tools that are running and are set up 
to respond to a change in hot context automatically home to the selected 
component.
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Pop-up menu
The Components Panel contains a pop-up menu that displays the following 
commands:

• Open Organization opens (loads) the selected organization, clears the 
contents of the Components Panel, and displays the Region components 
for the selected organization.

Note: The Components Panel displays components at a particular level 
within the current organization. It also displays a list of the available 
organizations within the network model. Therefore, this menu item is 
only enabled when the Components Panel contains a list of 
organizations.

• Show Region Level clears the current contents of the Components Panel 
and populates it with the regions in the current network model. This is 
subject to filtering and the current selection.

• Show Site Level clears the current contents of the Components Panel and 
populates it with the sites in the current network model. This is subject to 
filtering and the current selection.

• Show Module Level clears the current contents of the Components Panel 
and populates it with the modules in the current network model. This is 
subject to filtering and the current selection.

• Show Component Level clears the current contents of the Components 
Panel and populates it with the components found in the current network 
model. This is subject to filtering and the current selection.

• Set Acknowledge State On/Off puts a component in the Acknowledged 
state or removes it from the Acknowledged state.

If the component is a module or subcomponent, holds a Troubled Raw 
state (OOS or ISTB) and is not already in the Acknowledged or 
Maintenance state, the Components Panel pop-up menu shows the Set 
Acknowledge State On command. Selecting the command puts the 
component in the Acknowledged state and triggers a refresh of the 
Components Panel. Since this refresh may be done automatically before 
the operation is complete, the resulting display might only reflect a 
transitional state. If in doubt, refresh the panel again within a few 
seconds.
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If the component is already in the Acknowledged state, the pop-up menu 
shows the Set Acknowledge State Off command which, when selected, 
removes the component from the Acknowledged state and refreshes the 
Components Panel.

If none of the outlined conditions exists, the pop-up menu shows the Set 
Acknowledge State On command in a disabled state.

• Set Maintenance State On/Off puts a component in the Maintenance state 
or removes it from the Maintenance state.

If the component is not already in the Maintenance state (MTCE or HIER 
MTCE), the pop-up menu shows the Set Maintenance State On 
command. Selecting the command puts the component and its 
subcomponents into the Maintenance state and triggers a refresh of the 
Components Panel. Since this refresh may be done automatically before 
the operation is complete, the resulting display might only reflect a 
transitional state. If in doubt, refresh the panel again within a few 
seconds.

If the component is already in the Maintenance state (MTCE only), the 
pop-up menu shows the Set Maintenance State Off command which, 
when selected, removes the component and its subcomponents from the 
Maintenance state and refreshes the Components Panel.

If none of the outlined conditions exists, the pop-up menu shows the Set 
Maintenance State On command in a disabled state.

• Start Tool opens a menu that lists various categories of tools and utilities 
that you can start from Component Status Display. 

• Copy copies the text of an item selected in the Components Panel to the 
Primary Selection (accessed with the middle mouse button in a text field) 
and the Clipboard (accessed with the Paste Edit menu items).

• Copy All copies the text of all items in the Components Panel to the 
Primary Selection (accessed with the middle mouse button in a text field) 
and the Clipboard (accessed with the Paste Edit menu items).
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Filtering option button
The Filtering option button lets you activate or deactivate the Components 
Panel component filtering. This button provides the following options:

• On enables component filtering. Only the components that match the 
current filter settings are displayed in the Components Panel.

• Off disables component filtering.

Note: The value of this option button is part of the Component Status 
Display Preference Settings, and is saved and restored with the other 
settings. The Filtering state is, therefore, persistent across Component 
Status Display invocations. See “Changing the Component Filter 
Settings” (page 544) for procedures. See “Using previously saved filter 
settings” (page 545) to reverse the procedures.

Component Status Display supports these forms of component state filtering:

• filtering on Troubled Raw states

• filtering on Propagated states and Criticalities

If filtering on Troubled Raw states is selected, only components that currently 
hold a Troubled Raw state (OOS or ISTB) are displayed (the components for 
which the network sends MDM information indicating a fault). If Propagated 
State Filtering is selected, you can specify the specific (Propagated) states and 
state criticalities to be displayed. You need to select at least one state and one 
state criticality. 

Each type of state filtering is subject to the component types that are currently 
selected. You need to select at least one component type.

To change the current component filter settings, open the Component Filter 
Settings Dialog from the Options menu.

Auto Refresh option button
The Auto-Refresh option button turns on or turns off automatic refreshing of 
the Component Panel at a scheduled interval. This interval is set in the 
Preference Settings Dialog.
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The options for the Auto-Refresh option button are 

• On enables Auto-Refresh.

• Off disables Auto-Refresh.

Note:  When the network model changes, the network model 
Coordinator notifies the Component Status Display of the change. The 
Component Status Display automatically refreshes its Components 
Panel. Auto-Refresh does not apply to the Components Panel when 
organization components are displayed.

Refresh Display Button
The Refresh Display button forces an immediate refresh of the Components 
Panel. If the Auto-Refresh button is currently set to On, and the refresh 
triggered by the Refresh Display button is complete, the refresh timer is 
reactivated.

Control panel
The Control Panel provides controls that apply to it, namely the Filtering and 
Auto-Refresh controls, and the Refresh Display command button. The values 
of controls contained within the Panel can be saved across Component Status 
Display invocations as part of the Preference Settings.

Keyboard shortcuts
The Component Status Display provides the following keyboard shortcuts:

• Ctrl + E closes the Component Status Display tool and its dialogs.

• Ctrl + 0 executes the Select Organization command.

• Ctrl + G executes the Show Regional Level command.

• Ctrl + I executes the Show Site Level command.

• Ctrl + M executes the Show Module Level command.

• Ctrl + C executes the Show Component Level command.

For details on the commands run by the Ctrl + 0, G, I, M, and C options, see 
“View menu” (page 525).
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Component Status Display dialogs
The Component Status Display provides the following dialogs:

• “Component Filter Settings Dialog” (page 532)

• “Preference Settings Dialog” (page 534)

• “Exit CSD Dialog” (page 537)

• “Warning and error dialogs” (page 538)

Component Filter Settings Dialog
The Component Filter Settings Dialog, sets up the Component Status Display 
so that it displays the component status for one or more component types. The 
component status is based on the raw state Troubled, or on the propagated 
state and criticality.

The figure “Component Filter Settings Dialog” (page 533), shows a sample 
Component Filter Settings Dialog.
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Figure 47
Component Filter Settings Dialog

If you select Troubled Network State (OOS or ISTB), only components that 
currently hold an out-of-service (OOS) Troubled Raw state or an in-service 
Troubled Raw state (ISTB) are displayed. These are components for which 
the network sent the Preside Multiservice Data Manager (MDM) information 
indicating a fault. 

If you select Propagated State/Criticality, you can select the specific 
(propagated) states and state criticalities to be displayed. You need to select 
at least one state and one state criticality.

Each type of state filtering is subject to the component types that are currently 
selected. You need to select at least one component type.
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The Component Filters Setting Dialog buttons provide the following 
functions:

• Use Filters applies the new settings to the main Component Status 
Display main window and closes the dialog. If Filtering is already On, 
the Components Panel immediately refreshes to display the new settings. 
Applied settings are not automatically saved to file (see Save to File 
button).

• Save to File saves the current settings to file $HOME/MagellanNMS/
CSDCompFilt.cfg. The settings are not automatically applied to the main 
Component Status Display window (see Use Filters button). If the 
settings cannot be saved, an error dialog is displayed.

• Restore from File restores the settings from file $HOME/MagellanNMS/
CSDCompFilt.cfg. Restored settings are applied to the dialog but not to 
the main Component Status Display window (see Use Filters button). If 
the settings cannot be restored, an error dialog is displayed. 

• Cancel closes the dialog. Closing the dialog neither applies nor saves the 
settings (click Use Filters or Save to File first). 

Preference Settings Dialog
The Preference Settings Dialog lets you 

• sort information displayed for components based on the Propagated state 
and Criticality, or the time of the last state change

• turn on or turn off the Auto-Refresh

• set the refresh interval for the component status displayed with the tool

See the figure “Preference Settings Dialog” (page 535) for an overview of the 
dialog.
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Figure 48
Preference Settings Dialog

The Preference Settings Dialog buttons provide the following functions:

• Sort By controls the sort key used by the Component Status Display for 
displaying the components in the Components Panel. This button 
provides the following options:

— Component Name sorts the Components Panel in ascending order by 
component name.

— Propagated State/Criticality sorts the Components Panel based on 
the predefined State/Criticality order listed in the table “State/
Criticality label definition” (page 535).

Table 90
State/Criticality label definition

State/Criticality Label

1. OOS (5-1) Out of Service 

2. ISTB (5-1) In Service Troubled

3. ACKED Acknowledged

4. MTCE Maintenance

5. HIER MTCE Hierarchical Maintenance

6. INVS In Service

 (Sheet 1 of 2)
Preside MDM Fault Management User Guide   15.1RSUP



536   Chapter 12 Component Status Display
Time of Last State Change sorts the Components Panel in descending order 
by the date/time that the component is last changed. The last component to 
have changed state appears at the top of the panel. Components that never 
changed state (that is, the time value is Never Changed) always appear at the 
end of the list.

See “Setting the sort key for the components list” (page 546) for procedures.

• Auto-Refresh turns on or turns off automatic refreshing of the 
Components Panel. This button provides the following options:

— On enables Auto-Refresh and the Refresh Interval scale.

— Off disables Auto-Refresh and the Refresh Interval scale.

Note: Turning on and turning off Auto-Refresh is also controlled from the 
Control Panel in the main window.

• Refresh Interval controls the number of seconds between refreshes when 
Auto-Refresh is enabled. The scale allows you to set the interval between 
refreshes to a value from 30 to 600 seconds (1/2 to 10 minutes).

To set the interval with the scale, see the procedures in “Setting the Auto-
Refresh interval” (page 547).

• Use Preferences applies the new settings to the main Component Status 
Display window and closes the dialog. If any of the settings change, the 
Components Panel refreshes. Applied settings are not automatically 
saved to file; you need to save them using the Save to File button. 

7. UNKNOWN Unknown

8. INVALID Invalid

Table 90 (Continued)
State/Criticality label definition

State/Criticality Label

 (Sheet 2 of 2)
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• Save to File saves the current dialog’s Preference Settings to file 
$HOME/MagellanNMS/CSDPrefs.cfg. This file is automatically restored 
when the Component Status Display starts up and maintains your saved 
settings across Component Status Display invocations.

The settings are not automatically applied to the Components Panel; you 
need to apply them using the Use Preferences button.

Note: When you sort by Propagated State/Criticality, you cannot 
rearrange the predetermined order of states.

• Restore from File retrieves the preferences that are stored in $HOME/
MagellanNMS/CSDPrefs.cfg. This button does not automatically apply 
the preferences that have been retrieved. You need to apply them using 
the Use Preferences button.

Exit CSD Dialog
If you close the Component Status Display and do not save modified 
preference or component filter settings to their respective user-files, the Exit 
Component Status Display dialog opens. This dialog provides the following 
buttons and choices:

• Exit and Save saves the preferences or settings to a file and closes the 
Component Status Display Tool and its dialogs.

• Exit without Saving closes the Component Status Display Tool and its 
dialogs without saving the preferences or settings to a file.

• Cancel Exit aborts the exit.

See the figure “Exit CSD dialog window” (page 538) for an overview of the 
Exit dialog.
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Figure 49
Exit CSD dialog window

Warning and error dialogs
The Components Status Display provides a number of warning and error 
dialogs. If a warning or an error dialog opens, take the action indicated.

Save Settings Error Dialog
The Save Settings Error Dialog indicates that the preference or component 
filter settings (or both) could not be saved to their use-specific files 
(CSDPrefs.cfg and CSDCompFilt.cfg respectively in the user’s home account 
under the directory MagellanNMS). Possible reasons for this failure are

• the home directory or the configuration files are protected (no write 
permission)

• there is insufficient disk space in the home directory

Ensure that the files and home directory have write permission and that 
enough disk space is left; then retry the operation. 

Restore Settings Error Dialog
The Restore Settings Error Dialog indicates that the preference or Component 
Filter Settings (or both) could not be restored from their user-specific files 
(CSDPrefs.cfg and CSDCompFilt.cfg respectively in the user’s home account 
under the directory MagellanNMS). Possible reasons for this failure are 

• the home directory or the configuration files are protected (no read 
permission)

• the files do not exist
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• the files exist but their contents are not recognized 

If files exist in the home directory and in MagellanNMS directory ensure that 
they have read permission. If the files do not exist, or if they exist but their 
contents are not recognized, recreate the appropriate settings using the 
Component Filter and Preference Settings dialogs; then save them again.

Maximum Components Warning Dialog
This Maximum Components Warning Dialog warns you that the Component 
Status Display may take a few minutes to display the list of components that 
you requested.

No Network Model Coordinator Error Dialog
The Network Model Coordinator Error Dialog indicates that the Component 
Status Display cannot establish a connection to the Network Model 
Coordinator. After the Component Status Display closes, verify whether or 
not the Network Model Coordinator is running. If it is not running, start with 
the Server Manager Administration Tool (if you have access to it), or contact 
your system administrator for assistance. 

Network Model Access Error Dialog
The Network Model Access Error Dialog indicates that the Component Status 
Display cannot access the network model. Most likely, the Network Model 
Coordinator is running, but a network model is not loaded in shared memory. 
Verify whether or not a network model is loaded. If it is not loaded, load one, 
or contact your system administrator for assistance. 

Service Selection Warning Dialog
The Service Selection Warning Dialog indicates that your workstation has 
been renamed to a new network model host. This affects only tools such as 
the CIV that use the Network Model Server to access the LAN-selected host. 
However, the Component Status Display is unaffected since it uses only the 
local network model that runs on your workstation. 

No Model Error Dialog
The No Model Error Dialog indicates that the network model is either empty 
or corrupted. Verify that a network model is loaded in shared memory. If it is 
not loaded, load one. However, if a network model is already loaded, reload 
the model, or contact your system administrator for assistance.
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Lost Connection Error Dialog
The Lost Connection Error Dialog indicates that the Component Status 
Display has lost its connection to the Network Model Coordinator. The most 
likely cause is that the Network Model Coordinator has terminated. Verify 
whether or not the Network Model Coordinator is running. Either restart or 
contact your system administrator for assistance. 

Model Locked Error Dialog
The Model Locked Error Dialog indicates that the Component Status Display 
is attempting to access the network model while it is locked by another 
network model application. The network model is probably being updated; 
therefore, retry the command that you were attempting. If this dialog appears 
after successive attempts, you may want to contact your system administrator 
for assistance. 

Organization Not Found Error Dialog
The Organization Not Found Error Dialog indicates that the Component 
Status Display cannot locate the selected organization in the network model 
that is currently loaded in shared memory. The organization may have been 
deleted by another network model application while you were running the 
Component Status Display. Choose Select Organization from the View menu 
to get an updated list of the available organizations in the network model. 
Select and open one of the organizations on the list. 

Component Status Display procedures
You can perform the following tasks with the Component Status Display:

• “Starting the Component Status Display” (page 541)

• “Refreshing the Components Panel” (page 541)

• “Choosing a new organization” (page 542)

• “Putting a component into Acknowledged state” (page 543)

• “Putting a component into Maintenance state” (page 543)

• “Changing the Component Filter Settings” (page 544)

• “Exiting the Component Status Display” (page 545)
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Starting the Component Status Display
Your system administrator may have the Component Status Display 
configured to open automatically. If not, you can open the Component Status 
Display tool from the fault management toolset. 

Note: The Component Status Display does not use the network model 
server referred to by the current service selection. The Component Status 
Display needs to run on the same workstation as the network model 
shared memory.

Starting the Component Status Display tool
1 In the Preside MDM Toolsets window, select Fault -> Component Status 

Display

The Component Status Display window opens. Any preferences that were 
saved to a file during a previous session are automatically used.

Refreshing the Components Panel
You can refresh the Components Panel

• manually by using the Refresh Display button in the Main Window at any 
time

• automatically by using the Auto-Refresh feature. Auto-Refresh updates 
the contents of the Components Panel based on the interval that you set 
in the Preferences Settings Dialog. After you set the interval, you can 
activate it from the Preference Settings Dialog or from the main window.

When the network model changes, the Network Model Coordinator notifies 
the Component Status Display of the change. The Component Status Display 
then automatically refreshes the Components Panel. 

Note: You cannot apply the Auto-Refresh feature to the Components 
Panel while organization components are displayed.

Activating and deactivating Auto-Refresh from the Main Window
Use this procedure to activate or deactivate Auto-Refresh from the Component 
Status Display window. For instructions to set the Auto-Refresh interval and 
activate it from the Preferences Setting Dialog, see “Setting the Auto-Refresh 
interval” (page 547).
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1 Select On from the Auto-Refresh option button to turn the function on, or 
select Off to turn the function off.

On appears next to the button to indicate that the function is activated or 
Off to indicate that the function is deactivated.

Choosing a new organization
The network model can contain one or more organizations. Depending on the 
number of organizations present, the following actions can occur:

• One organization The Component Status Display automatically opens 
the organization and displays all regions within the organization.

• Two organizations If the first organization is DEFAULT ALL, the 
Component Status Display automatically opens the other organization; 
otherwise, it opens DEFAULT ALL.

• More than two organizations Component Status Display displays a list 
of all available organizations found in the network model and then 
prompts you to select and open one. Select the desired organization and 
choose Open Organization from the Components Panel pop-up menu. 
All the regions within the selected organization are displayed. If more 
than one organization is displayed, you can switch to a different 
organization by following the procedure “Choosing and opening a new 
organization” (page 542).

Note: You can also specify an organization value as a parameter in the 
startup command for the tool, by using the -O option. For example, the 
command /opt/MagellanNMS/bin/csd -O “DPN R3_ORG” & starts the 
Component Status Display and tells it to open the organization DPN 
R3_ORG. The region records for this organization are automatically 
shown when the Component Status Display starts.

Choosing and opening a new organization
1 From the View menu select Select Organization

The organizations appear in the Components Panel.

2 From the pop-up menu in the Component Panel, select Open 
Organization.

The organizations are automatically replaced by the region records for the 
selected organization.
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Putting a component into Acknowledged state
The Acknowledged state temporarily hides the current troubled state of a 
component (as indicated by the network). When a component is 
acknowledged, it acts as though it is in an In-Service state. If no other related 
components are troubled, the acknowledged component displays a state of 
ACKED instead of In-Service. When the component changes state, the 
acknowledgment is automatically removed and the real state of the 
component is shown. Only troubled modules and subcomponents (from the 
network) can be put into the Acknowledged state. For more information on 
the Acknowledged state, see 241-6001-015 Preside MDM Network Model 
Administrator Guide.

Note: You can put a component into the Acknowledged state by 
acknowledging all active alarms against the component.

Putting a component into and taking it out of the Acknowledged 
state
1 In the Components Panel, click on the component you want to put into the 

Acknowledged state.

The component is highlighted.

2 From the pop-up menu in the Components Panel, select Set 
Acknowledged State On.

The next time the menu appears, the command changes to Set 
Acknowledged State Off. 

Note:  You can also put a component into the Acknowledged state by 
acknowledging all active alarms against the component using the Start 
Tool menu.

3 From the pop-up menu, select Set Acknowledged State Off to remove the 
component from the Acknowledged state.

Putting a component into Maintenance state
Maintenance state permanently hides the current troubled state of a 
component. When a module or component is put into maintenance, its state is 
propagated downwards. For more information on the Maintenance state, see 
241-6001-015 Preside MDM Network Model Administrator Guide.

Putting a component into Maintenance state
1 In the Components Panel, click on the component you want to put into the 

Maintenance state.
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The component is highlighted.

2 From the Components Panel pop-up menu, select Set Maintenance State 
On.

Note:  The next time the menu is displayed, the command changes to Set 
Maintenance State Off. Select this new command to remove the 
components from the Maintenance state.

Changing the Component Filter Settings
You can modify the Component Status Display to reduce the amount of 
information displayed in the Components Panel using the Component Filter 
Settings Dialog. For information about the items in this dialog, see 
“Component Filter Settings Dialog” (page 532).

You can use the component filter settings in these ways:

• You can set the components filter parameters and use them immediately. 
or, you can also save the settings to a file for reuse.

• You can retrieve previously stored filter settings from a file and use them.

Setting component filtering from the Component Filter Settings 
Dialog
Use this procedure to set the component filter parameters from the 
Component Filter Settings Dialog and to save the settings to the 
CSDCompFilt.cfg file in your $HOME/MagellanNMS directory.

1 Ensure that Filtering is turned to On in the Component Status Display 
main window.

2 From the Options menu, select Change Component Filter Settings

The Component Filter Settings Dialog opens.

3 Click on Troubled Network State or Propagated State/Criticality.

4 If you click Propagated State/Criticality, select one or more States and 
one or more Criticality values.

Note:  The criticality values, which range from 1 (lowest) to 5 (highest), 
are used only for the In-Service Troubled and Out of Service states.

5 Select one or more components that you want to filter from the component 
types list. All component types are automatically selected by default.
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To add a component to your existing selection, press Control and click on 
the component you wish to add.

To add a contiguous group of components, click on one component, then 
drag the mouse to select the other components. Alternatively, click on the 
first component and on the last component; all components between them 
are selected automatically.

6 Select Save to File to permanently save the filter settings to the 
CSDCompFilt.cfg file in your $HOME/MagellanNMS directory.

7 Select Use Filters to apply the new filter settings.

If filtering is turned to On in the Component Status Display main window, 
the newly filtered components are displayed in the Components List.

Note:  Any changes made to the filter settings are lost if you do not apply 
them before closing. The last set of applied filters are displayed the next 
time the dialog is opened.

8 Click Cancel to close the dialog.

Using previously saved filter settings
Use this procedure to retrieve and apply previously stored filter settings. The 
settings are restored from the CSDCompFilt.cfg file in your $HOME/
MagellanNMS directory.

1 From the Options menu, select Change Component Filter Settings….

The Component Filter Settings Dialog window opens.

2 Click Restore from File.

The restored settings are displayed in the dialog.

3 Click Use Filters to apply the filter settings to the Component Status 
Display main window.

The restored settings are applied to the Component Status Display main 
window.

Exiting the Component Status Display
To close the Component Status Display and all its dialogs, select Exit from 
the File menu.
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If you have made modifications in the Component Filter Settings Dialog or 
the Preferences Setting Dialog but did not save them, the Exit CSD dialog 
opens. For details about this dialog and the choices it provides, see “Exit CSD 
Dialog” (page 537).

Setting Component Status Display preferences
The Preference Setting Dialog, described in “Preference Settings Dialog” 
(page 534), lets you tailor the Component Status Display main window and 
perform the following functions:

• set the Sort key

• turn Auto-Refresh on or off

• set the Auto-Refresh interval

• save the preferences to a file or restore them from a file

• apply the settings to the main window

Setting the sort key for the components list
Use this procedure to set up the sort key to sort components according to 
Troubled Network state, Propagated State/Criticality, the component name, 
and the time that the component is last modified.

1 From the Options menu, select Change Preference Settings

The Preference Settings Dialog opens.

2 From Sort-By, select one of the sort keys.

Note:  When you sort by Propagated State/Criticality, you cannot 
rearrange the order of states. Also, out-of-service (OOS) and in-service 
troubled (ISTB) states are sorted in descending order from most critical 
(5) to least critical (1). 

3 Click Use Preferences to apply the sort key to the Components Panel in 
the Component Status Display main window.

The Components Panel refreshes to show the components according to 
the specified sort order.

4 Select Cancel to close the dialog.

The Preference Settings Dialog closes.
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Setting the Auto-Refresh interval
Use this procedure to set the interval at which information in the Main 
Window is refreshed. 

You can set the interval to a value from 30 to 600 seconds. To set the value, 
click to the left or right of the slider to decrease or increase the setting by five-
second increments; or, drag the slider to the left or right to decrease or 
increase the setting by one-second increments.

1 From the Options menu, select Change Preference Settings

The Preference Settings Dialog opens.

2 Select On from the Auto Refresh option button.

3 Set the Refresh Interval to the desired number of seconds.

4 Select Save to File if you want to save the settings to the CSDPrefs.cfg file 
in your $HOME/MagellanNMS directory.

The settings made in the dialog and preference settings that are exclusive 
to the Component Status Display main window, such as Filtering, are 
saved. The changes are not applied and the dialog remains open.

5 Click Use Preferences to apply these settings to the Component Status 
Display main window.

6 Click Cancel to close the dialog.

The Preference Settings Dialog closes.

Note:  This preference setting is dependant on the Auto-Refresh 
preference being enabled. If Auto-Refresh is deactivated, the Refresh 
Interval is disabled.

Using previously saved preference settings
Use this procedure to retrieve and apply previously stored preference settings. 
The settings are restored from the CSDPrefs.cfg file in your $HOME/
MagellanNMS directory.

1 From the Options menu, select Change Preference Settings

The Preference Settings Dialog opens.

2 Click Restore from File.

The restored settings are displayed in the dialog.
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3 Click Use Preferences to apply these settings to the Component Status 
Display Main Window.

The restored settings are applied to the Component Status Display main 
window.

Customizing the Component Status Display
The Component Status Display lets you customize the following items:

• the Component List Start Tool menu

• other resources including

— colors associated with propagated states and problem states

— whether or not the problem states are shown in the Components 
Panel

— whether or not a bell rings upon error

Customizing the Components List Start Tool menu
For procedures on customizing the Start Tool menu for the Components Panel 
List, see the section on customizing the toolsets and Start Tools menus in 
241-6001-301 Preside MDM Customization Administrator Guide. 

To customize the Components Panel List Start Tool menu, copy the file /opt/
MagellanNMS/lib/tsets/$LANG/tools/surv/ and save it in either $HOME/
MagellanN MS/tools/ for a single user customization or /opt/MagellanNMS/
cfg/tsets/$LANG/tools/ for all users of a workstation

When you modify the file, use one of the following substitution variables in 
the command line:

• $COMP: the internal component name of the target

• $DCOMP: the display component name of the target

Customizing other resources
The table “Resources for color control of propagated states by Component 
Status Display” (page 549) lists the resources you use to control the colors 
associated with propagated states displayed by Component Status Display.
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Table 91
Resources for color control of propagated states by Component Status 
Display

Resource Description Legal values

*stateOOS_1
*stateOOS_2
*stateOOS_3
*stateOOS_4
*stateOOS_5
*stateISTB_1
*stateISTB_2
*stateISTB_3
*stateISTB_4
*stateISTB_5
*stateACKED
*stateMTCE
*stateHIER_MTCE
*stateINVS
*stateUNKNOWN
*stateINVALID
moduleStateUNKNOWN

Specifies the state-to- 
color mapping used to 
indicate the current 
state of the 
components in the 
Components Panel 
(These are the same 
resources used for the 
NV.)

Any legal X windows 
color or specification. 
See 241-6001-301 
Preside MDM 
Customization 
Administrator Guide.
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The table “Resources for color control of problem states by Component 
Status Display” (page 551) lists the resources you use to control the colors 
associated with the problem states displayed by Component Status Display 
components.

Table 92
Resources for customizing the Acknowledgement/unacknowledgement 
Alarms Dialog

Resource Description Legal values

*AckAlarmDlog*userIdFiel
dField.editable

If True, the User field 
in the dialog used for 
acknowledging or 
unacknowledging 
alarms, can be 
modified. The default 
is False.

True or False

*AckAlarmDlog*commentD
ata.maxLength

The maximum length 
of Reason text that can 
be specified when 
acknowledging or 
unacknowledging 
alarms. The default 
length is 256.

Any legal Motif value 
associated with the 
MaxLength resource.

CIV*differentModuleUnkno
wnColor

If 
differentModuleUnkno
wnColor is true, then 
the unknown color for 
the node at the module 
level is different from 
the default unknown.

True or False
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Table 93
Resources for color control of problem states by Component Status 
Display

Resource Description Legal value

*stateNameOOS_1
*stateNameOOS_2
*stateNameOOS_3
*stateNameOOS_4
*stateNameOOS_5
*stateNameISTB_1
*stateNameISTB_2
*stateNameISTB_3
*stateNameISTB_4
*stateNameISTB_5
*stateNameACKED
*stateNameMTCE
*stateNameHIER_MTCE
*stateNameINVS
*stateNameUNKNOWN
*stateNameINVALID

Specifies the state-
to-name mappings 
used to indicate the 
current state of the 
components in the 
Components Panel. 
(These are the same 
resources used for 
the NV.) 

Any legal character 
string. Caution must 
be exercised when 
modifying state 
names to ensure that 
the new name 
correctly and clearly 
identifies the state; 
otherwise, problem 
states could be 
shown for 
components which 
are in service and 
conversely.
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IP Discovery

Internet Protocol (IP) Discovery application is used to discover Simple 
Management Network Protocol (SNMP) devices. 

Note: This document does not include software rollback procedures. See 
Preside MDM Release Supplement.

Navigation
• “Basic procedures” (page 553)

• “IP Device Discovery window” (page 573)

• “Discovery window” (page 586)

• “IP discovery fundamentals” (page 591)

• “Troubleshooting” (page 593)

Basic procedures
This section contains the following procedures:

• “Starting IP Discovery” (page 555)

• “Setting a password for IP Discovery” (page 556)

• “Starting IP Discovery with password protection” (page 557)

• “Changing a password for IP Discovery” (page 558)

• “Disabling password protection for IP Discovery” (page 559)

• “Discovering devices using direct discovery” (page 560)
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• “Discovering devices using route-based discovery” (page 561)

• “Deleting devices” (page 562)

• “Updating devices” (page 564)

• “Finding devices” (page 565)

• “Adding an address” (page 567)

• “Creating a network setting” (page 568)

• “Changing network settings” (page 569)

• “Deleting network settings” (page 570)

• “Moving rows in network settings” (page 571)
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Starting IP Discovery 
Use this procedure to start IP Discovery without password protection. 

To set a password, see “Setting a password for IP Discovery” (page 556).

Prerequisites
• The IP Discovery server must be running.

Procedure
1 From the Preside MDM window, select Fault -> IP Discovery.

A warning dialog box opens informing the user that IP Discovery is in non-
secure mode.

2 Click OK.

The IP Device Discovery window is displayed.
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Setting a password for IP Discovery
Setting a password for the IP Discovery tool increases the security of your 
network by adding a layer of protection to your network settings. The network 
settings control access to the devices. Accessing or changing network settings 
can disrupt network surveillance of these devices and cause potential security 
problems. By adding a password to IP Discovery, you are decreasing the 
chances that an unauthorized user could get access to your network settings.

Prerequisites
• You must be logged in as root to set the password for IP Discovery.

Procedure steps
1 From the Fault menu, click IP Discovery.

The IP Device Discovery window opens.

2 From the Security menu, click Set/Change Password.

The Set Password dialog box opens.

3 Type a new password in the New Password field.

4 Type the same password again in the Confirm Password text field.

5 Click OK.
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Starting IP Discovery with password protection
When you start IP Discovery any time after you have set a password, you will 
be starting with password protection. 

To find out how to set a password, see “Setting a password for IP Discovery” 
(page 556).

Procedure steps
1 From the Preside MDM window, select Fault -> IP Discovery.

The User Logon dialog box opens.

2 Enter the password and click OK

If you do not enter the correct password after three attempts, the IP 
Discovery GUI shuts down.
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Changing a password for IP Discovery
Changing passwords on a regular basis ensures that your network settings 
remain secure from unauthorized users. You should also change your 
passwords when you feel that your network security might be compromised 
by events such as changes in your network or organization.

Attention!
If another user is running an IP Discovery session when you change the 
password, that user will be prompted to relogin and enter the new password.

Prerequisites
• You must be logged in as root to reset the password for IP Discovery.

Procedure steps
1 From the Preside MDM window, select Fault -> IP Discovery.

The IP Device Discovery window opens.

2 From the Security menu, click Set/Change Password.

The Change Password dialog box opens.

3 Type the current password in the Old Password field.

4 Type a new password in the New Password field.

5 Type the new password again in the Confirm Password field.

6 Click OK.
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Disabling password protection for IP Discovery
Disabling password protection for IP Discovery may be necessary in 
situations where customers require non-secure access. This procedure 
removes the password protection file.

Prerequisites
• You must be logged in as root to reset the password for IP Discovery.

Procedure steps
1 From the command console, type the following command

rm /opt/MagellanNMS/cfg/private/IPM.passwd

Once this file is removed, the password for IP Discovery is disabled and 
it can be accessed in non-secure mode.
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Discovering devices using direct discovery
Use direct discovery to discover a device by its hostname or by its IP address. 
You can use both hostnames and IP addresses in one discovery session. See 
“Discovery window” (page 586) for more information.

Procedure steps
1 From the IP Device Discovery window, select Device -> Discover.

The Discovery window opens.

2 In the Method field, select Direct

3 Enter the device you wish to discover by one of the following methods:

a. Type the IP address or hostname in the IP Address field. If you are 
discovering more than one device, separate the IP addresses and 
hostnames with a comma.

b. Click Load from to open a seed file which contains IP addresses and 
hostnames of devices to be discovered.

4 When you have finished choosing the parameters, click Start to begin 
discovery.

During the discovery process, the Status area shows the progress of the 
discovery as well as any errors.

Note:  Several options are available during direct discovery. You can 
specify the device type with which you want the device discovered by 
using the Discover As option.You can also specify the option to Register 
to Receive Traps. For more information on these options, see 
“Discovery window” (page 586).
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Discovering devices using route-based discovery
Discover devices using route-based discovery in order to discover a network 
or part of it using an initial address or set of addresses as a starting point. See 
“Discovery window” (page 586) for more information.

Procedure steps
1 From the IP Device Discovery window, select Device -> Discover.

The Discovery window opens.

2 In the Method field, select Route based.

3 Enter the device you wish to be used as a starting point for route-based 
discovery by one of the following methods:

a. Type the IP address or hostname in the IP Address field. If you are 
using more than one starting point, separate the IP addresses and 
hostnames with a comma.

b. Click Load from to open a seed file which contains IP addresses and 
hostnames of devices to be used as starting points.

4 When you have finished choosing the parameters, click Start to begin 
discovery.

During the discovery process, the status area shows the progress of the 
discovery.

Note:  Several options are available during route-based discovery. In the 
Exclude field in the Options area, select the device types that you wish 
to exclude from the discovery. In the IP Address Range field in the 
Options area, enter the range of IP addresses to be discovered. 
Addresses outside of this range are ignored. For more information on 
these options, see “Discovery window” (page 586).
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Deleting devices
The delete command deletes selected devices in the Devices tab. The delete 
command is only available when you select the Devices tab and there is at 
least one selected entry in the table.

Procedure steps
1 From the IP Device Discovery window, select Devices tab.

2 Highlight one or more devices in the table. To select more than one 
device, do one of the following:

• Press the Shift key and the left mouse.

• Press the Ctrl key and the left mouse.

3 Right click on the item.

4 From the pop-up menu, select Delete.

A dialog opens to confirm the delete request with the following options:

• Attempt device deletion from Network Model

• Attempt trap deregistration with device

Note 1:  The option Attempt device deletion from Network Model will 
delete a device from the Network Model, if possible, even if the option for 
automatic deletion of obsolete components in the surveillance update 
server SURNUP is disabled. This option may fail if the network model is 
not available for an update. This may occur if another user is in Edit mode 
in the Network Viewer when you attempt to delete the device. For more 
information, see the Surveillance Network Model Updater (SURNUP) 
section in the 241-6001-310 Preside MDM Server Reference Guide.

Note 2:  The option Attempt trap deregistration with device may 
significantly slow down the deletion process. 

5 Click OK to delete the device.

The selected device disappears from the table. If the deletion is 
unsuccessful, an error message is displayed.

A log containing the result of the delete operation is created by default in 
/opt/MagellanNMS/data/log/ipm/ipDiscovery.out. For more information, 
see “Logging” (page 592).

Note 1:  The device may be deleted from the Network Model 
automatically if the fault servers support automatic deletion of obsolete 
components and the option for automatic deletion of obsolete 
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components is enabled in the surveillance updater server SURNUP. This 
is true even if Attempt device deletion from Network Model is not 
selected.

Note 2:  A delete command may fail if the device cannot be found in the 
General Management Data Router (GMDR).
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Updating devices
You can update a device when it changes its configuration and/or MIB 
information.

Procedure steps
1 From the IP Device Discovery window, select Devices tab.

The currently managed devices list is displayed in the table.

2 Highlight one or more devices in the table. To select more than one 
device, press the Shift key.

3 Right click on the item.

4 From the pop-up menu, select Update.

The updated devices are refreshed from the table. If the update is 
unsuccessful, an error message is displayed.

Note:  An update command may fail if the device cannot be found in the 
General Management Data Router (GMDR).
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Finding devices
You can locate a device in the device table using a device name or IP address.

Procedure steps
1 From the IP Device Discovery window, select Devices tab.

The currently managed devices list is displayed in the table.

2 Select the Device -> Find Device.

3 Input a device name or IP Address in the name field of the Find Device 
dialog.

4 Press the Find button or press Enter to locate the row with the matching 
device.

5 To continue searching for another match in the table, press Find again.

6 Press Close to close the Find Device dialog.

Note:  The Find functionality searches the table from the first row to the 
very end of the table; however, if a row is selected before Find is used, 
the searching begins from the selected row to the end of the table and 
wraps around.
Preside MDM Fault Management User Guide   15.1RSUP



566   Chapter 13 IP Discovery
Saving device IP addresses to a file
Save device IP addresses of a specific device type to a file for record keeping 
and organizational purposes. 

Procedure steps
1 From the IP Device Discovery window, select Devices tab.

The currently managed devices list is displayed in the table.

2 Select the File -> Save As.

3  In the Save Devices dialog, type a file name in the Enter file name field 
or click Browse... to select a file from the Save dialog.

4 Select a device type from the Select Device Type pull-down.

5 Click Save to save the IP addresses for the specified device type to the 
file.
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Adding an address
You can add a polling or trap address (depending on the device cartridge’s 
capabilities) to the address list for a specified device.

Procedure steps
1 From the IP Device Discovery window, select Devices tab.

The currently managed devices list is displayed in the table.

2 Highlight one device from the table.

3 From the Device menu, select AddAddress. You can also right-click the 
device and select AddAddress from the pop-up menu.

The AddAddress dialog opens.

Note:  If multiple address capability is not supported, a dialog opens 
indicating that multiple addressing is not supported by the device 
cartridge. In this case, you will not see the AddAddress dialog.

4 In the IP Address field, type in the IP Address of the device you wish to 
add.

5 In the Community field, type in the Read community string of the device 
you wish to add (for example, public).

6 In the Type field, select Trap or Poll.

Note:  The options in the Type field depend on the device cartridge’s 
capability. You may see Trap or Poll, or both Trap and Poll.

7 Click Add.

A message at the bottom of the IP Device Discovery window informs you 
when the address is added.
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Creating a network setting
Create network settings to add a new network device and its attributes.

Prerequisites
• To perform network settings procedures, you must be in edit mode. Only 

one person at a time can perform these procedures. For more 
information, see “Network Settings” (page 582)

Procedure steps
1 From the IP Device Discovery window, select Network Settings.

The current network settings list is displayed.

2 From the Edit menu, select Add Row.

A new row is added into the table.

3 Enter the network setting attributes:

• IP Address or address range

• Read Community String

• Read Write Community String (optional)

• Port

• Device Type (optional)

• SNMP Version (optional)

4 Select File -> Save to save the new settings into the network settings 
configuration file.
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Changing network settings
Change network settings to restore communication with devices that are 
unreachable and are in an “unknown” state in MDM.

Prerequisites
• To perform network settings procedures, you must be in edit mode. Only 

one person at a time can perform these procedures. For more 
information, see “Network Settings” (page 582)

Procedure steps
1 From the IP Device Discovery window, select Network Settings.

The current network settings list is displayed.

2 Select and highlight the row you want to modify.

3 Enter the network setting attributes:

• IP Address or address range

• Read Community String

• Read Write Community String (optional)

• Port

• Device type (optional)

• SNMP Version (optional)

4 Select File -> Save to save the new settings into the network settings 
configuration file and apply them.
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Deleting network settings
Deleting network settings removes an entry from the list of network settings.

Prerequisites
• To perform network settings procedures, you must be in edit mode. Only 

one person at a time can perform these procedures. For more 
information, see “Network Settings” (page 582)

Procedure steps
1 From the IP Device Discovery window, select Network Settings.

The current network settings list is displayed.

2 Highlight the entry or row you want to delete.

3 Select Edit -> Delete Row(s).

Note:  You can also right-click the item, and select Delete Row(s) from 
the pop-up menu.

4 Select File -> Save to save the new settings into the network settings 
configuration file.
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Moving rows in network settings
You may need to change the order of network settings because the ordering 
is important in IP Discovery. See “Network settings during discovery” 
(page 591) for more information.

Prerequisites
• To perform network settings procedures, you must be in edit mode. Only 

one person at a time can perform these procedures. For more 
information, see “Network Settings” (page 582)

Procedure steps
1 From the IP Device Discovery window, select Network Settings.

The current network settings list is displayed.

2 Highlight the row you wish to move.

3 Perform one of the following:

a. To move a row up, select Edit -> Move Row Up.

b. To move a row down, select Edit -> Move Row Down.

4 The highlighted row has moved up or down in the table.

5 Save the settings by selecting File -> Save.
Preside MDM Fault Management User Guide   15.1RSUP



572   Chapter 13 IP Discovery
Changing the IP Discovery log location
Use this procedure to change the location of IP Discovery logs.

Procedure steps
1 Close all instances of the IP Discovery application.

2 With root privileges, edit the file /opt/MagellanNMS/bin/ipDiscovery and 
set the values for MDM_IPM_OUT_FILE and MDM_IPM_ERROR_FILE 
to direct output to the desired log location.

3 Launch IP Discovery again.
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IP Device Discovery window
The IP Device Discovery window contains the following areas:

• “Menu bar” (page 573)

• “Devices” (page 578)

• “Network Settings” (page 582)

Menu bar
The IP Device Discovery menu bar consists of the following menus:

• “File” (page 573)

• “Edit” (page 574)

• “Device” (page 575)

• “Security” (page 576)

• “Help” (page 577)

File 
The following commands are available from the File menu:

Table 94
File menu commands

Command Description

Save Saves the current network settings. The Save 
option is greyed out when the Devices tab is 
selected.

Save As Opens the Save Devices dialog which allows the 
user to save the IP addresses for devices of a 
specific type to a file. The Save As command is 
not available when the Network Settings tab is 
selected.

Exit Closes the IP Discovery application. If there are 
unsaved changes, you are prompted to save the 
changes before exiting the application.
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Edit
The following commands are available from the Edit menu:

Table 95
Edit menu commands

Command Description

Add Row Either adds a new row to the top of the list of 
settings profiles if no row has been selected, or 
adds a new row below an already selected row. 
The new entry does not have an IP address, but 
consists of default values for the other 
parameters. The Add Row command is only 
available when: 

• the network settings tab is selected

• you are in edit mode

Move Row Up Moves the selected row up one entry in the table. 
The Move Row Up command is only available 
when:

• the network settings tab is selected

• you are in edit mode

• there is an entry in the table

Move Row Down Moves the selected rows down one entry in the 
table. The Move Row Down command is only 
available when:

• the network settings tab is selected

• you are in edit mode

• there is an entry in the table
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Device
The following commands are available from the Device menu:

Delete Row Deletes selected row(s). The Delete Row(s) 
command is only available when:

• the network settings tab is selected

• you are in edit mode

• there is an entry in the table

Select All Selects all devices or settings profiles depending 
on which tab is visible.

Deselect All Deselects all devices or settings profiles, 
depending on which tab is visible.

Table 96
Device menu commands

Command Description

Discover Opens the Discovery window. You can discover 
devices using the direct discovery or route-based 
discovery.

Refresh List Rereads the list of SNMP-managed devices. The 
Refresh list command is only available when you 
select the Devices tab.

Update Rediscovers the selected devices. The Update 
command is only available when you select the 
Devices tab, and there is a selected entry in the 
table.

Delete deletes any selected devices in the Devices tab.

Table 95
Edit menu commands

Command Description
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Security
The following command is available from the Security menu: (This 
command is only available when you are logged in as root.)

Add Address Adds a polling or trap address to the address list 
for a specified device. The Add Address 
command is only available when you select the 
Devices tab, and there is a selected entry in the 
table. The Add Address command may fail if one 
of the following items occur:

• the device profile does not allow this action 
(not supported in the device cartridge)

• the address has been assigned to another 
device, and this device is currently using the 
address for polling

The following attributes must be specified in the 
request:

• there is an entry in the table

• IP address

• community string

• address type (poll or trap)

Find Device Locates a device in the device table using the 
device name or IP address. When Find Device is 
selected, a dialog box is displayed. You can 
enter a device name or IP address to search the 
Devices table. When the device is located, the 
row associated with the device is highlighted.

Table 96
Device menu commands

Command Description
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Help
Invoking a help command launches online documentation. The following 
command is available from the Help menu:

Save Devices dialog
The Save Device dialog allows a user to save all the IP addresses of a specific 
device type to a file.

Table 97
Security menu commands

Command Description

Set/Change Password Displays the Set Password dialog box if you have 
never set a password for IP Discovery. If you 
have previously set a password for IP Discovery, 
this command displays the Change Password 
dialog box.

Table 98
Help menu commands

Command Description

Discovery Help Displays information on how to discover devices. 
This command is also available by clicking Help 
on the Discovery window

Network Settings Help Displays information on how to use network 
settings.

Devices Help Displays information on how to use Device menu 
options. You must have installed the MDM NTP 
package for these commands to work.
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Save dialog
The Save dialog allows a user to select a directory and file to save IP 
addresses to.

Devices
The Devices tab is displayed by default when you launch the IP Discovery 
application. This window tab lists discovered devices that have an IP address 
and name. The fields are as follows:

Table 99
Save Devices dialog

Fields/Buttons Description

Enter file name Allows the user to specify a file name and path of 
the saved file.

Select Device Type Displays a list of device types from a drop-down 
menu, and allows the user to select one.

Browse... Displays the Save dialog.

Save Saves the IP addresses of the specified device 
type to the specified file.

Table 100
Save As dialog

Fields/Buttons Description

File name Allows the user to specify a file name.

Files of Type Allows the user to specify a file type.

Save Saves the file name to the Enter file name field in 
the Save Devices dialog.
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Note: The listing described is the default format by which the device 
information is displayed. You can display the information in any order 
by holding down the left mouse button on the heading, and moving it to 
the left or the right.

You can right click on a device to display a pop-up menu. From the pop-up 
menu, you can open the Discovery window, refresh the device list, update the 
device list or delete devices. 

Note 1:  The pop-up menu does not display if you do not select an entry.

Note 2:  Discovery or deletion of a large number of devices may take 
quite a while to propagate to the IP discovery device list. Allow time for 
the changes to propagate, and then refresh the list to see these update.

Sorting devices
You can sort the listed devices by clicking one of the following headings:

Table 101
Devices fields

Command Description

Name Contains the Preside Multiservice Data Manager 
(MDM) assigned component ID for the device.

IP Address Contains the management address used by 
Preside MDM to communicate with the device

Read Community String Contains the community string used to query and 
poll the device.

SNMP Version Contains the Simple Network Management 
Network Protocol (SNMP) version number that is 
used to query and communicate with the device. 
The SNMP version number is specified as 
SNMPv1 or SNMPv2c.
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The figure “Devices tab” (page 581) shows the device fields

Table 102
Sort fields

Command Description

Name sorts the devices alphabetically from top to 
bottom.

IP Address Sorts the devices by IP address, with the 
smallest numerical IP address at the top.

Community String Click on the Read Community String heading to 
sort the devices alphabetically from top to 
bottom.

SNMP Version Sorts the devices by Simple Network 
Management Protocol (SNMP) version.
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Figure 50
Devices tab
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Network Settings
Network settings lets you add, delete, modify and rearrange SNMP read and 
read/write community strings and other attributes that control access to 
network devices.

Network settings can be edited by one user at a time. When the network 
settings tab is selected, you are put in edit mode, or in read-only mode if you 
are not the only person accessing this tab. One of the following messages is 
displayed in the status bar to indicate which mode you are in:

• Viewing as read-only. Network settings currently locked by either 
another editing session or a discovery process. This message indicates 
that another user is in edit mode, and that you can only view the network 
settings. You cannot modify the network settings in this mode.

• Edit Network Settings. This message indicates that you are in edit 
mode, and can modify the network settings.

When you exit the edit mode after making changes, a dialog prompts you to 
save the changes. If there is an error in an IP address field, a message is 
displayed, and you cannot proceed.

The network settings fields are as follows:
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Table 103
Network Settings fields

Command Description

IP Address  (includes wildcards) contains an IP address 
range specification used to match management 
addresses of devices as they are discovered, in 
order to determine its network settings. 
Examples of the valid pattern specifications are 
as follows:
-134.177.125.31: matches the specified IP 
address

-134.177.125.1-31: matches all addresses in the 
range 134.177.125.1 to 134.177.125.31

-134.177.125.*: matches all addresses in the 
range 134.177.125.1 to 134.177.125.255

-134.177.125-128.*: matches all addresses in 
the range 134.177.125.* to 134.177.128.*

-*.*.*.*: matches all addresses.

Read Community String Contains the community string used to query and 
poll the device.

Read Write Community 
String

Contains the write community string used to 
perform SNMP writes to the device. You can 
write to a device when the Register to Receive 
Traps option is enabled during the discovery of a 
device that supports the SNMP Target MIB, and 
the SNMP view based ACM MIB.

Port Contains the port number to be used by SNMP 
for device discovery.
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In edit mode, you can right click on a network setting to display a pop-up 
menu that displays the following:

• Add Row

• Move Row Up

• Move Row Down

• Delete Row(s)

Note: The pop-up menu does not display if you do not select an entry.

The figure “Network Settings tab” (page 585) shows the network settings 
fields.

Devices Contains the type of devices supported by IP 
Discovery. If the device type is blank, this field 
matches against any device type.

SNMP Version Contains the Simple Network Management 
Network Protocol (SNMP) version number that is 
used to query and communicate with the device. 
The SNMP version number is specified as 
SNMPv1 or SNMPv2c.

• SNMPv1 indicates that SNMP1 will be used to 
discover and manage the device.

• SNMPv2c  indicates that SNMP2c will be 
used to discover and manage the device.

• a blank entry (“ ”) indicates that the SNMP 
version in the DCD will be used to manage the 
device.

Table 103
Network Settings fields

Command Description
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Figure 51
Network Settings tab
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Discovery window
The Discovery window opens when you select Device -> Discover from the 
IP Device Discovery window. The window is split in to three sections. The 
Options area is hidden by default. View the Options area by clicking on the 
splitter bar and dragging the bar to the desired location.

See the figure “Discovery window” (page 586), which shows the Options 
area.

Figure 52
Discovery window

Discovery window items
The following items are available on the Discovery window:

splitter bar

splitter bar
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Table 104
Discovery window items

Command Description

Method Contains a pull-down menu to chose the device 
discovery type. The options are Direct and 
Route-based discovery.

IP Address Lists the IP addresses or hostnames separated 
by a comma. When you select direct discovery, it 
lists the IP addresses or hostnames to be 
discovered. When you select route-based 
discovery, this field holds IP addresses or 
hostnames of seed devices. The IP Address field 
also contains the a pop-up menu.

Load from Displays a file browser to let you select a file from 
which to read the IP addresses. The format of the 
file can be one of the following:

• a comma separated list of hostnames and/or 
IP address

• a host name or IP address entry per line 
without any punctuation (commas are allowed 
at the end of the line).

An example of the file format is as follows:

• 12.2.2.3

• 12.2.4.5

• xyz123
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Register to Receive 
Traps

When you check this box, the discovery process 
attempts to register with the device to receive 
traps using the SNMP Target MIB specification in 
RFC 2573, and the SNMP view based ACM MIB 
specification in RFC 2575. If the process is 
successful, then Preside Multiservice Data 
Manager (MDM) receives traps from these 
devices without having to log in to the devices 
and configure them manually for sending traps to 
the management workstation.

IP Address Range Is available for route-based discovery and 
provides a range to discover IP addresses. If the 
device is not contained within the range, they will 
not be discovered. This field is greyed out if direct 
discovery is selected. The IP Address Range 
field contains the a pop-up menu.

Examples of the valid pattern specifications are 
as follows:
-134.177.125.1-31: matches all addresses in the 
range 134.177.125.1 to 134.177.125.31.

-134.177.125.*: matches all addresses in the 
range 134.177.125.1 to 134.177.125.255.

-134.177.125-128.*: matches all addresses in 
the range 134.177.125.* to 134.177.128.*

-*.*.*.*: matches all addresses

Table 104
Discovery window items

Command Description
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Discover As Contains a pull-down menu for direct discovery 
that lists all supported device types. When no 
device type is selected, the device is discovered 
as the type of device indicated by querying its 
sysObjectId. When a specific device type is 
selected, the device is discovered explicitly as 
the device type, without any queries being 
performed to verify the settings. To select more 
than one device type, press the shift key or the 
control button while selecting devices. To 
deselect an item, press the Ctrl key and left-click 
the mouse. The Discover As field is disabled 
automatically. 

Note:  Note 1: “Discover As” does not guarantee 
that a device will be added to the device lists 
immediately, later, or not at all. It depends on the 
driver, the state of the device, and the network 
settings under the network settings tab.

Note:  Note 2:Specifying a device type is an 
optional step. For most device discoveries, it is 
typical to leave the Discover As option blank 
(default value)

Exclude Disables the discovery of selected device types 
for route-based discovery. 

Start Starts the discovery process.

Stop Stops the discovery process.

Close Closes the Discovery window.

Help Displays help on how to use the Discovery 
window.

Status Shows the status of the discovery process.

Table 104
Discovery window items

Command Description
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Edit pop-up menu
Table 105
Edit pop-up menu

Command Description

Cut Lets you cut an IP address range.

Copy Lets you copy an IP address range.

Paste Lets you delete an IP address range.

Select All Lets you select IP address ranges.
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IP discovery fundamentals
Network settings during discovery

Network settings are applied during the discovery process as follows:

• The discovery process searches for a matching network setting entry 
starting at the top of the network settings list. Therefore, it is important 
to order the rows in the network settings properly.

• The matching, which includes wild carding, is performed on the IP 
address, device type (if specified). A blank (empty) value for a device 
type matches any device type in the network settings list. Then matching 
is done on port, community string and SNMP version.

• The discovery process attempts to apply the first match that it finds in the 
network settings that fits its criteria. If all constraints (such as valid IP 
range, device type exclusion, and absence of a similar device) are 
satisfied, then it tries to add the device with these settings.

• If the first match fails because constraints are not satisfied, the searching 
process continues down the network settings list for another best match.

This process continues until the discovery attempt is successful, or the end of 
the network settings list is reached.

The data collection daemon (DCD) attempts to discover the device for up to 
three days after the discovery request is made. A discovery request is shown 
as Pending in the Status column of the Discovery window. When the device 
is successfully discovered, the status changes to Succeeded.

Route-based discovery
Route-based discovery reads the addresses of neighbouring devices from 
ipRouteNextHop in the routing table of the seed device found in the IP 
Address field of the Discovery window. The discovery process is then able to 
obtain a list of devices to reseed the algorithm with. The address resolution 
protocol (ARP) cache is also examined for potential devices. When a device 
type is included in the exclude list, that device cannot be discovered. It does 
not, however, prevent the devices in its routing table from being discovered.
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Direct discovery
Direct discovery accepts a list of devices, and attempts to discover each 
device as a SNMP-managed device.

Why a discovery may fail
A discovery request may fail for the following reasons:

• The IP address or IP Address Range entered are not properly formatted.

• The device cannot be communicated with using he current settings.

• The device has already been discovered.

• A device with the same IP address and community string is already being 
managed by Preside Multiservice Data Manager (MDM).

Logging
When a user performs any IP Discovery functions, the output messages and 
errors are displayed in the status area of the IP Device Discovery window. 
These messages and additional debugging information are also logged in log 
files. The log files are located in the directory 
/opt/MagellanNMS/data/log/ipm by default. Error log files have an extension 
of .err by default. The standard output log file has an .out extension by 
default.

Two variables determine the location where the output messages and errors 
are logged. They are contained in the file /opt/MagellanNMS/bin/
ipDiscovery. These variables and their defaults are: 

• MDM_IPM_OUT_FILE=/opt/MagellanNMS/data/log/ipm/
ipDiscovery.out

• MDM_IPM_ERROR_FILE=/opt/MagellanNMS/data/log/ipm/
ipDiscovery.err

Setting these variables to an appropriate file name causes output/errors from 
all scripts in the IP Discovery tool to be logged to the specified files. 

To change the location of these files, see “Changing the IP Discovery log 
location” (page 572).
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Troubleshooting
Error messages and warning messages should be used to troubleshoot 
problems that may occur.

Error messages
The table “IP Discovery error messages” (page 593) contains information on 
error messages, their cause, and required actions.

Table 106
IP Discovery error messages

Message Details Remedial action

Error: cannot resolve IP Address 
for host <host>

Verify that the hostname is 
correct.

Error: cannot find hostname 
<host>

Verify that the hostname is 
correct.

Error: cannot setup SNMP 
session to <IP address>

Verify software installation.

Error: unable to walk routing table During route-based 
discovery, an attempt to 
read the routing table of a 
device was unsuccessful. 
No new devices were 
learned from the routing 
table of this device.

Error: unable to walk ARP table During route-based 
discovery, an attempt to 
read the ARP table of a 
device was unsuccessful. 
No new devices were 
learned from the ARP table 
of this device.

<IP Address> could not be added.

APPLICATION_ERROR No 
process to query

DCD cartridge is not 
installed.

Install the required device 
integration cartridge.

 (Sheet 1 of 3)
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Could not communicate with <IP 
Address> using community 
"<SNMP read community string>" 
on port 161

Possible causes:

1. The IP Address is 
unreachable.

2. MDM was not registered 
on the device to allow the IP 
Discovery tool to 
communicate using that 
SNMP community string.

3. The wrong community 
string was specified by the 
Network Settings in IP 
Discovery.

1. Verify IP address is correct

2. Make the necessary 
configurations on the device to 
allow SNMP communication 
with MDM IP Discovery tool.

3. Verify the correct community 
string used in IP Discovery

Error: unable to register to receive 
traps

The trap registration option 
was used during discovery. 
The discovery was 
successful, but the trap 
registration was not.

Manually register for traps with 
the device.

Error: device doesn’t support trap 
registration

Trap registration was 
selected during discovery, 
but the device does not 
support the required MIBs, 
as outlined in RFC 2573 and 
RFC 2575.

Manually register for traps with 
the device.

Error: unable to open <file>. 
Defaulting to port 162.

Trap registration attempted 
to read Preside MDM’s trap 
port from the appropriate 
file, but it was unable to. It 
proceeded to register to 
receive traps on the default 
SNMP trap port 162.

Error: calculated 
SnmpTargetAddrParams too 
long. Try a shorter community 
string.

The read community string 
for this device is too long.

Shorten the read community 
string.

Table 106 (Continued)
IP Discovery error messages

Message Details Remedial action
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Error: cannot get sysObjectId from 
<IP address>.

Discovery was unable to 
perform an SNMP query to 
retrieve the device’s 
sysObjectID.

Verify the SNMP community.

Error: Application unable to read 
device list.

IP Discovery encountered 
an application error while 
trying to retrieve the current 
list of devices. This is most 
likely caused by system 
resource issues. This error 
is usually seen when there 
are other Java applications 
running on the workstation, 
and there are multiple 
launches of IP Discovery.

Exit unnecessary Java 
applications. Verify swap 
space is configured as 
recommended in 
241-6001-101 Preside MDM 
Engineering Guide.

The help server is not running, 
please launch nmstool.

For IP Discovery’s help to 
work, the help server must 
be running. This server is 
started when you launch 
nmstool.

Launch nmstool and retry the 
IP Discovery help.

Table 106 (Continued)
IP Discovery error messages

Message Details Remedial action
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Warning messages
The table “IP Discovery warning messages” (page 596) contains information 
on warning messages, their cause and action required.

Table 107
IP Discovery warning messages

Message Details Remedial action

Warning: entry not found in 
Vacm Security Table. 
Unable to Delete.

The feature to remove trap 
registration with the specified 
device is being used during 
device deletion, but trap 
registration from IP Discovery 
was never successfully 
performed against the device.

Manually unregister for traps with the 
device.

Warning: no entry in SNMP 
target address table.

The feature to remove trap 
registration with the specified 
device is being used during 
device deletion, but trap 
registration from IP Discovery 
was never successfully 
performed against the device

Manually unregister for traps with the 
device

Warning: no entry in SNMP 
target params table.

The feature to remove trap 
registration with the specified 
device is being used during 
device deletion, but trap 
registration from IP Discovery 
was never successfully 
performed against the device

Manually unregister for traps with the 
device

Network Model is in edit 
mode: device deletion from 
Network Model failed.

The network model is currently 
being edited, so the device is 
only partially deleted. It is 
deleted from the DCD, but 
remains in the network model.

Manually delete the device from the 
network model.

 (Sheet 1 of 2)
241-6001-011   15.1RSUP   



Chapter 13 IP Discovery   597
Warning: network settings 
currently locked by either 
an editing session or 
another discovery process. 
Discovery results may be 
less predictable.

The network settings are in 
edit mode. The network 
settings tab has been selected 
by a user either on the same 
instance or another instance of 
IP Discovery. 

Stop the discovery process. Verify 
that no instance of the IP Discovery 
window has the network setting tab 
selected. Select the Devices tab and 
restart.

xx.xx.xx.xx could not be 
added. 
APPLICATION_ERROR 
No process to query.

IP Discovery attempts to add 
the device but cannot find the 
DCD process to communicate 
with.

Ensure that SMDR is connected with 
the DCD process and the DCD is 
running.

Table 107 (Continued)
IP Discovery warning messages

Message Details Remedial action
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Circuit Viewer 

The Circuit Viewer tool allows you to retrieve and view detailed information 
about circuit in the network. This information can be used for 
troubleshooting.

Navigation
• “Circuit Viewer basic procedures” (page 599)

• “Circuit Viewer fundamentals” (page 652)

• “Circuit Viewer interface” (page 631)

Circuit Viewer basic procedures
Use Circuit Viewer to view and diagnose circuits.

Starting and exiting

• “Starting the Circuit Viewer tool without component context” (page 601)

• “Starting the Circuit Viewer tool with component context” (page 602)

• “Displaying Circuit Viewer online help” (page 603)

• “Setting the server configuration options” (page 604)

• “Setting log file information levels” (page 605)

• “Setting authentication information” (page 606)
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Working with circuit information

• “Retrieving a list of circuits from the Administration Database” 
(page 607)

• “Using the Component Selection Dialog” (page 610)

• “Sorting a list in the Circuit(s) found panel” (page 611)

• “Displaying circuit component information” (page 612)

• “Displaying provisioned or operational attributes of a component” 
(page 614)

Diagnosing circuits

• “Displaying a connection trace” (page 617)

• “Setting the polling configuration options” (page 619)

• “Starting state polling” (page 621)

• “Stopping state polling” (page 622)

• “Viewing circuit component statistics” (page 623)

Using component context

• “Putting a component or circuit into context” (page 626)

• “Getting a component or circuit from context” (page 627)

Starting other tools from Circuit Viewer

• “Starting a service provisioning tool without context” (page 628)

• “Starting a service provisioning tool with context” (page 629)

• “Starting the MDM Database Administration tool from Circuit Viewer” 
(page 630)
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Starting the Circuit Viewer tool without component context
Use this procedure to start the Circuit Viewer tool without component 
context.

Procedure steps
1 In the Preside Multiservice Data Manager window, select Fault and then 

Circuit Viewer.

The MDM Administration Database authentication dialog opens.

2 In the MDM Administration Database authentication dialog, type a valid 
user name and password and click OK. 

The Circuit Viewer tool opens.
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Starting the Circuit Viewer tool with component context
Context lets you transfer component information among other Preside 
Multiservice Data Manager (MDM) tools that also support context. Starting 
Circuit Viewer with context populates the Component field in the Circuit 
retrieval panel with the component in context. Use this procedure to start the 
Circuit Viewer tool with component context.

Procedure steps
1 From any of the Preside Multiservice Data Manager (MDM) tools that 

support context, select a component.

2 Open the Start Tools menu and select Fault ->Circuit Viewer.

The MDM Administration Database dialog opens.

3 In the MDM Administration Database dialog, type a valid user name and 
password and click OK. 

The Circuit Viewer window opens with a circuit list that displays all circuits 
containing the selected component.

Note: The Network Viewer tool lets you select multiple nodes. If you 
select more than one node in Network Viewer and then start Circuit 
Viewer, Circuit Viewer opens with the first node that you selected.
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Displaying Circuit Viewer online help
Help is available in most Preside Multiservice Data Manager (MDM) tools 
from either a Help menu or a Help button. Use this procedure to view online 
help for the Circuit Viewer tool. You can view general descriptive 
information for the tool or context-specific help information. 

Procedure steps
1 For an overview description, from the Circuit Viewer window Help menu, 

select On Window. 

The online help window opens with a general description of the Circuit 
Viewer tool.

2 For help on a specific area of the main window, from the Circuit Viewer 
Help menu, select What’s This?.

The mouse changes to a question mark (?).

a. Move the mouse pointer onto an area of the Circuit Viewer window 
for which you want help and click the mouse button. 

The online help window opens with information specific to the area you 
selected.
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Setting the server configuration options 
Use the Server Configuration dialog to change the settings for the MDM 
server host and port for accessing on-switch data. You need to change the 
server configuration information for the following reasons: 

• If the Circuit Viewer tool resides on a client, then you need to specify the 
appropriate IP address of the MDM server host. 

• If you are not using the default server port of 6601 for the Passport 
Command Access server, then you need to specify the server port 
number in the startup command for the server in the Server 
Administration tool. For details about configuring the Passport command 
access server, see the section on the Passport command access server 
(PPAccessServer) in 241-6001-310 Preside MDM Server Reference 
Guide

Procedure steps
1 From the Options menu, select Server Configuration.

The Server Configuration dialog opens.

2 In the MDM Server Host field, type a valid host name.

3 In the MDM Server Port field, type a valid port number.

4 To save the settings and close the dialog, click Save.
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Setting log file information levels
Use the Logging Options dialog to set the appropriate information level to 
save in the Circuit Viewer log file. Circuit Viewer stores the specified log 
information in the /opt/MagellanNMS/data/log/CircuitManagement.log file. 

• “Procedure steps” (page 605)

• “Related information” (page 605)

Procedure steps
1 From the Options menu, select Logging.

The Logging Options dialog opens.

2 From the dialog, select the level of messages you want to log.

3 Click Apply.

Related information
For more information about log files and their file size restrictions, see the 
section on circuit management log files in 241-6001-400 Preside MDM 
Administration Database User Guide
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Setting authentication information
Use this procedure to specify authentication information to be used to log into 
a PassportPassport node to retrieve polling and statistical information.

Procedure steps
1 From the Options menu, select Authentication….

The Authentication dialog opens.

2 In the Default User ID field, specify the default user ID for authentication 
to Passport devices.

3 In the Default Password field, specify the default password to 
authenticate to Passport devices.

4 If there are nodes where user IDs and passwords differ from the default, 
then complete the following steps: 

• In the Node field, type the node name to which you want to connect. 
Or, click the browse button […] to the right of the Node field to display 
a list of nodes from which you can select.

• In the User ID field, type the user ID for the specified node.

• In the Password field, type the password for the specified node.

5 To save the authentication information and close the dialog, click Apply.
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Retrieving a list of circuits from the Administration 
Database

Use this procedure to retrieve one or more circuits from the Administration 
Database.

• “Procedure steps” (page 607)

• “Job aid: How to specify retrieval criteria” (page 608)

• “Related information” (page 609)

Procedure steps
1 In the Circuit retrieval criteria panel, specify a circuit identifier in the 

Circuit ID field.

Note:  The name of an IP VPN Access circuit is stored in the database as 
’IPCoS’. The display name described in the Circuit(s) Found section is 
constructed. Therefore, when you search for an IP VPN Access circuit, 
you must specify the Customer, Site and IP Access Point information 
separately (do not enter the display name in the Name field).

2 To refine your search, complete any remaining fields in the general 
retrieval criteria panel. If you use the Component browse button to open 
the Component Selection Dialog and want information on using this 
dialog, see “Using the Component Selection Dialog” (page 610).

3 To include service-specific retrieval criteria, from the Service type drop-
down list, select one of the following service types: 

• ATM

• Frame Relay

• IP VPN Access

The service retrieval criteria panel opens. If you select Any, the service-
specific retrieval panel does not open.

4 Complete the appropriate fields in the service retrieval criteria panel to 
refine your search.

Note:  If you wish to search for circuits under a Site or Access Point, 
select the radio button to the left of the fields to enable the fields. If you 
wish to search for circuits terminating on a logical interface, select the 
radio button to the left of the Interface field.

5 Click Retrieve.
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Job aid: How to specify retrieval criteria
To retrieve circuits from the Administration Database, you need to specify the 
criteria for searching the database. The Circuit Viewer window contains a 
circuit retrieval panel where you specify the required criteria. The more fields 
you complete, the more specific the search. The following list details the 
various methods for specifying retrieval criteria. 

• Accept the default value
When Circuit Viewer opens, some fields in the window have values in 
them. These values are default values. For example, the Circuit ID field 
has an asterisk (*) as a default value. The asterisk matches all values for 
the field in the database. You can accept the default value or specify a 
different value. A default value of "Any" matches any possible value for 
the field.

• Type a value
Some fields let you type a value in the field. You can type a specific value 
or a search pattern. For example, a specific value such as west_spvc2 in 
the Circuit ID field causes the Circuit Viewer tool to search the database 
for the single circuit named west_spvc2. If you use a search pattern, then 
the Circuit Viewer tool searches the database for all circuit identifiers 
that satisfy the search pattern. For example, a search pattern such as 
west* causes the Circuit Viewer tool to search the database for all circuit 
identifiers that begin with the string "west".

• Use the browse button
Some fields have a browse button […] on the right side of the field. 
Clicking the browse button opens a selector dialog that lists all possible 
values. You can then select a value from this list. The browse buttons for 
Circuit ID and Customer Name open their corresponding Selection 
Dialogs. The browse button for Component opens the Component 
Selection Dialog. 

• Use the drop-down list
Some fields have a drop-down list from which you can make a selection. 
The Circuit Type field is an example of a field with a drop-down list.

• Get Context
Some fields, such as Circuit ID support context. To retrieve a value name 
from context, position the cursor over the field and right-click to open a 
pop-up menu. From the pop-up menu, select the Get Context command.
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Related information
For a description of the fields in the Circuit retrieval criteria panel, see 
“Circuit retrieval criteria panel” (page 636).
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Using the Component Selection Dialog
Use this dialog to select an interface or connection component to retrieve 
from the Administration Database. 

Procedure steps
1 In the Circuit retrieval criteria panel, click the Component browse [...] 

button.

The Component Selection Dialog opens.

2 Select a node by clicking on an entry in the Node list. 

3 In the Interface box, select an interface type from the drop down list.

The Interface list displays a list of interfaces.

4 To select an interface, click on an entry in the Interface list. 

5 If needed, to select a connection component: 

• Double-click on an interface to display connection components.

• Select a connection component in the Connection list. 

6 Click OK.
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Sorting a list in the Circuit(s) found panel
Use this procedure to sort the items in the Circuit(s) found panel. You can sort 
by ascending or descending order.

Procedure steps
1 If no list of circuits displays in the Circuit(s) found panel, specify retrieval 

criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 To sort any column in descending order, position the mouse pointer in the 
column header and while pressing the Shift key, click the left mouse 
button. 

3 To sort any column in ascending order, position the mouse pointer in the 
column header and click the left mouse button.
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Displaying circuit component information
Use this procedure to display information about nodes, interfaces, 
connections, states, and traffic management profiles related to a circuit and to 
view provisional and operational information for a circuit component. 

• “Procedure steps” (page 612)

• “Related information” (page 613)

Procedure steps
1 If no list of circuits displays in the Circuit(s) found panel, then specify the 

retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 Select a circuit from the Circuit(s) found list.

3 Click the Circuit information tab.

The General circuit information is displayed in the top panel. Circuit 
specific information is displayed in the bottom panel. For IP VPN Access 
circuits, the component Id of the Logical Interface is displayed if it is 
known.

4 Click the Circuit components tab.

The Circuit components pane opens. By default, the pane displays 
component information in text tables.

5 Optionally, you can change the way the information displays in the 
Circuits component pane.

• To reorder the display of columns in the table, drag and drop columns 
on the desired location.

• To change the width of a column, drag the boundary line on the right 
side of the column heading until the column is the desired width.

• To change from a text to a graphical format, click Circuit Path. To 
return to text format, click Component List. 

6 Optionally, to start another MDM tool in context with the selected circuit, 
right-click on a component in the Circuit components pane to open a 
pop-up menu. From the pop-up menu, select an appropriate entry from 
the list of tools.

The selected MDM tool opens.
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7 Optionally, you can view provisioned or operational attributes of a 
component. Go to the procedure “Displaying provisioned or operational 
attributes of a component” (page 614), step 4.

Related information
The Circuit components pane supports a pop-up menu to get additional 
component information or start other Multiservice Data Manager (MDM) 
tools. You can customize the lists tools that you can open from this pop-up 
menu. For details, see the section on customizing menus that start other tools 
in 241-6001-400 Preside MDM Administration Database User Guide. 
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Displaying provisioned or operational attributes of a 
component

Procedure steps
Use this dialog to view provisioned or operational attributes of a component

1 If no list of circuits displays in the Circuit(s) found panel, then specify the 
retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 Select a circuit from the Circuit(s) found list.

3 Click the Circuit components tab.

The Circuit components pane opens. By default, the pane displays 
component information in text tables.

4 Double-click on a component in the tabular or graphical display. 
Alternatively, right-click on a component to open a pop-up menu. From the 
pop-up menu, select Get Component Information.
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The Components Information dialog opens using information in context 
from the Circuit Viewer. 

5 Provide the appropriate information to log on to a node using one of the 
following methods:

• If no logon defaults exist in the current session and none are needed, 
type the appropriate values in the User name and Password fields.

• When the Use Default Logon check box is selected, it is used for 
setting the logon information for the current session by using the 
default authentication information set in the Circuit Viewer (under the 
menu item Option and then Authentication).
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• To reset any existing default logon information for the current 
session, clear the Use Default Logon check box and then type the 
appropriate values in the User name and Password fields and then 
select the Use Default Logon check box.

6 From the Information type drop-down list, select one of the following 
options: 

• Operational

• Provisioned

7 Click Retrieve.

The specified component information displays in the Component 
Information dialog.

8 To close the Component Information dialog, click Cancel.
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Displaying a connection trace
By default, the Circuit Viewer tool displays only the source and, if 
provisioned, the destination connection components for an SPVC or SPVP. 
Use this procedure to perform a PNNI connection trace on the source 
component of an SPVC or SPVP circuit to determine the intermediate 
components that make up a circuit. 

Prerequisites
• You need to supply a Passport user ID and password for a source node 

that has "config" impact before you can request a trace. If you have not 
already done so, see the procedure “Setting authentication information” 
(page 606)

Procedure steps
1 If no list of circuits displays in the Circuit(s) found panel, then specify the 

retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 In the Circuit(s) found panel, click on the SPVC or SPVP circuit for which 
you want circuit details.

3 In the Circuit detail(s) panel, click the Circuit components tab.

The SPVC or SPVP endpoints display in the table.

4 In the Circuit detail(s) panel, click Trace.

If you have not already authenticated to the node, the Authentication 
Dialog opens. See the procedure “Setting authentication information” 
(page 606) for details about completing the Authentication Dialog. 

If you have already authenticated, the trace begins. While the trace is in 
progress, the Trace button changes to Tracing… 

If the trace is successful, the intermediate components display in the 
table. If state polling is turned on, the states of the intermediate circuit 
components will also be polled. The results of the trace include the egress 
components for the source node, the intermediate nodes, and the 
destination node. The trace does not include ingress virtual connections. 
If the circuit re-routes, the state of obsolete components displays as "does 
not exist". You can request another trace at this point, if the circuit re-
routes.

If the trace is unsuccessful, a dialog opens and displays the reason for 
failure.
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Setting the polling configuration options
The Polling Configuration dialog lets you set the circuit state polling interval, 
the number of times the Circuit Viewer tool polls for interface and connection 
statistics, and the polling interval for interface and connection statistics. Use 
this procedure to set the configuration options for circuit state and circuit 
component statistics polling.

Procedure steps
1 From the Options menu, select Polling Configuration….

The Polling Configuration dialog opens.

2 To change the polling options for circuit state 

• in the State: Polling Interval field, type the required number of 
seconds between polls 

3 To change the polling options for interface component statistics 

• in the Interface/Port Defaults: Number of Polls field, type a value 
for the required number of polls for interface and port statistics. 
Leaving this field blank causes polling to continue indefinitely.
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• in the Interface/Port Defaults: Polling Interval field, type the 
required number of seconds between polls for interface statistics

Note:  Port Statistics is only available for ATM circuits.

4 To change the polling options for the connection component statistics 

• In the Connection Defaults: Number of Polls field, type a value for 
the required number of polls for connection statistics. Leaving this 
field blank causes polling to continue indefinitely.

• in the Connection Defaults: Polling Interval field, type the required 
number of seconds between polls for connection component 
statistics.

5 If you want to have the option of changing the polling options each time 
you request statistics, select the check box Always ask for Statistics 
Polling Information. 

When you request statistics, a Polling Parameters dialog opens with 
those parameters that are appropriate for the requested statistics. 
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Starting state polling
Use this procedure to start the polling of circuit component state. An overall 
circuit state is determined from the polled component states. 

Prerequisites
• Before you can turn on state polling, you need to supply Passport 

authentication information. For the authentication procedure, see 
“Setting authentication information” (page 606)

Procedure steps
1 If no list of circuits displays in the Circuit(s) found panel, then specify the 

retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 In the Circuit(s) found panel, right-click on the circuit for which you want 
the circuit state.

A popup menu opens.

3 From the popup menu, select Start State Polling. 

If you have already authenticated to the node for which you want 
information, then the circuit state displays in the Circuit detail(s) panel.

If you have not already authenticated to the node, the Authentication 
Dialog opens. See the procedure “Setting authentication information” 
(page 606) for details about completing the Authentication Dialog. When 
authentication to the node is successful state polling begins.

4 To view the components of a circuit and their states, in the Circuit 
detail(s) panel, click the Circuit components tab.

5 To view the values of the connection state attributes, in the Circuit 
detail(s) panel, click the Connection states tab.
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Stopping state polling
Use this procedure to stop circuit state polling.

Procedure steps
1 In the Circuit(s) found panel, right-click to open the popup menu.

2 Stop state polling using one of the following methods:

• From the popup menu, select Stop State Polling
Circuit state polling stops and the component states change to "not 
polled".

• Select another circuit and the polling for the previous circuit will be 
stopped automatically.
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Viewing circuit component statistics 
Use this procedure to view a subset of key statistics for circuit components.

• “Prerequisites” (page 623)

• “Procedure steps” (page 623)

• “Expected results” (page 624)

• “Related Information” (page 624)

Prerequisites
Before you can turn on component statistics polling, you need to supply 
Passport authentication information. For the authentication procedure, see 
“Setting authentication information” (page 606).

Procedure steps
1 If no list of circuits displays in the Circuit(s) found panel, then specify the 

retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 In the Circuit(s) found panel, right-click on the circuit for which you want 
statistical information.

A popup menu opens.

3 From the popup menu, select Statistics and then one of the following 
entries:

• Connection Statistics

• Interface Statistics

• Port Statistics

Note:  Port Statistics is only available for ATM circuits.
Preside MDM Fault Management User Guide   15.1RSUP



624   Chapter 14 Circuit Viewer
A dialog opens displaying the requested statistics in tabular format.

Expected results
If you have set the polling configuration options to always ask for statistics 
polling information, the Polling Parameters dialog opens and displays only 
those parameters that are appropriate to the requested statistics. For 
information on polling configuration, see the procedure “Setting the polling 
configuration options” (page 619).

When you request connection statistics, a dialog opens and displays the 
statistics in tabular format. If the Circuit Viewer tool is unable to retrieve a 
statistic, "n/a" appears in the table cell and the reason for failure displays in 
the message panel below the statistics table. The reason for failure is logged 
in the /opt/MagellanNMS/data/log/CircuitManagement.log file

Related Information
The Statistics dialogs contain a subset of key circuit component statistics. 
When you request statistics, the Circuit Viewer polls for this information. 
Each time a poll occurs, the dialog refreshes with the new statistics. Where 
relevant, changes from the previous poll are shown in brackets (). Polling for 
statistics continues until the maximum number of polls has been reached or 
until you click the Stop Polling button. To view or set the maximum number 
of polls, see “Setting the polling configuration options” (page 619). 
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While polling is in effect, a Stop Polling button is available. If you click the 
Stop Polling button or if the number of polls has been reached, the button 
changes to Re-start Polling. When you restart polling, polling resumes for the 
specified number of polls. 

Job aid: Getting more statistics
If you require more comprehensive statistical information, you can start the 
MDM Data Viewer tool.

1 In the Connection Statistics dialog, right-click on a node for which you 
want detailed statistics. 

A popup menu opens.

2  From the popup menu, select Performance -> Data Viewer.

The Data Viewer tool opens with the selected node in context. For 
information about this tool, see 241-6001-031 Preside MDM Performance 
Management User Guide.
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Putting a component or circuit into context
Context lets you pass component information from Circuit Viewer to other 
Preside Multiservice Data Manager (MDM) tools that support context. Use 
this procedure to put a component or circuit into context. 

Procedure steps
1 To put a component into context, in the Circuit details panel, select the 

Circuit components tab and then select the component you want to put in 
context from either the text list or the graphical display.

2 To put a circuit into context, in the Circuit(s) found list, select the circuit you 
want to put in context
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Getting a component or circuit from context
Use this procedure to get a component or circuit from context. The Circuit ID 
and Component fields in the Circuit retrieval panel support the use of context. 

Procedure steps
1 Position the cursor over any of the fields in the Circuit retrieval panel that 

support context and right-click.

A popup menu opens.

2 From the popup menu, select Get Context. 

The Circuit Viewer tool retrieves the value in context and then performs a 
search based on that value. 
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Starting a service provisioning tool without context
Use this procedure to start the service provisioning tool without context from 
the Circuit Viewer tool. The service provisioning tool that opens depends on 
the service type of the selected circuit. 

• “Procedure steps” (page 628)

• “Related information” (page 628)

Procedure steps
1 From the Tools menu, select one of the following:

• ATM Service Provisioning

• FR Service Provisioning

The selected service provisioning window opens. 

Note:  The FR Service Provisioning tool is only launchable when the 
selected IP VPN Access circuit is in "Normal" status and it has been 
assigned to an IP Access Point.

2 Launch the IP VPN service provisioning tool to modify an ATM local VPN 
access circuit.

Related information
For details about the ATM service provisioning tool, see 241-6001-600 
Preside MDM Service Provisioning for ATM User Guide. 

For details about the Frame Relay service provisioning tool, see 
241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide.

For details about the IP VPN service provisioning tool, see 241-6001-616 
Preside MDM IP VPN Service Configuration User Guide.
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Starting a service provisioning tool with context
Use this procedure to start a service provisioning tool with circuit context 
from the Circuit Viewer tool. 

• “Procedure steps” (page 629)

• “Related information” (page 629)

Procedure steps 
1 If no list of circuits displays in the Circuit(s) found panel, then specify the 

retrieval criteria. For details, see “Retrieving a list of circuits from the 
Administration Database” (page 607).

2 In the Circuit(s) found field, select the circuit that you want to put in 
context.

3 Right-click on the selected circuit to display the popup menu.

4 On the popup menu, point to Launch Service Provisioning and then 
select one of the following commands.

• Edit Circuit to start the service provisioning tool in Edit mode.

• Delete Circuit to start the provisioning tool in Delete mode.

The service provisioning tool opens in context to the selected circuit ID. 

Related information
For details about the ATM service provisioning tool, see 241-6001-600 
Preside MDM Service Provisioning for ATM User Guide. 

For details about the Frame Relay service provisioning tool, see 
241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide.
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Starting the MDM Database Administration tool from Circuit 
Viewer

Use this procedure to start the MDM Database Administration tool from 
Circuit Viewer. The MDM Database Administration tool lets you perform 
administration tasks on a selection of objects in the Administration Database.

Procedure steps
1 From the Tools menu, select MDM Database Administration.

The MDM Database Administration window opens.
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Circuit Viewer interface
The Circuit Viewer window consists of the following elements:

• “Menu bar” (page 632)

• “Circuit retrieval criteria panel” (page 636)

• “Circuit(s) found panel” (page 640)

• “Circuit details panel” (page 642)

• “Sashes” (page 651)

The figure “Circuit Viewer window” (page 632) shows a sample Circuit 
Viewer window. 
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Figure 53
Circuit Viewer window

Menu bar
The menu bar contains the following menus:

• “File” (page 633)

• “Edit” (page 633)

• “Options” (page 634)

menu bar

Circuit 
retrieval panel 
(general)

Circuit(s) 
found panel

Circuit details 
panel 
(general)

Sash

Circuit retrieval 
panel (service 
specific)

Circuit details 
panel (service 
specific)

Sash
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• “Tools” (page 635)

• “Help” (page 636)

File

Edit 

Table 108
File menu commands

Command Description

Exit Closes the Circuit Viewer main window and exits 
the application.

Table 109
Edit menu commands

Command Description

Copy Copies the selected alarms so that you can paste 
them later.

Cut Deletes any selected text.

Paste Copies the current contents of the system 
clipboard to the current cursor position. 

Select All Selects all entries in any editable text area.

Deselect All Cancels the selection of the Select All command.
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Options 
Table 110
Edit menu commands

Command Description

Server Configuration… Opens the Configuration dialog. Using this 
dialog, you can specify an MDM server host and 
port for accessing on-switch component 
information.To set the configuration options, see 
the procedure “Setting the server configuration 
options” (page 604)

Polling Configuration… Opens the Polling Configuration dialog for setting 
the circuit state and circuit component state 
polling. To set the polling configuration options, 
see the procedure “Setting the polling 
configuration options” (page 619)

Authentication… Opens the Authentication dialog where you 
specify default and node specific user names 
and passwords. To authenticate, see the 
procedure “Setting authentication information” 
(page 606)

Logging… Opens the Logging Options dialog where you 
select the type of information to log. To set the 
level of log information, see the procedure 
“Setting log file information levels” (page 605). 
Log messages are saved in the /opt/
MagellanNMS/data/log/CircuitManagement.log 
file. For details about managing the size of log 
files, refer to “Circuit management log files” 
(page 653) and the section on circuit 
management log files in 241-6001-400 Preside 
MDM Administration Database User Guide.
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Tools 

You can customize the contents of the Tools menu. For details, see the section 
on customizing menus that start other tools in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Table 111
Tools menu commands

Command Description

ATM Service Provisioning Starts the ATM service provisioning tool. To start 
the ATM service provisioning tool, see the 
procedure “Starting a service provisioning tool 
without context” (page 628) and “Starting a 
service provisioning tool with context” 
(page 629). For information about ATM service 
provisioning, see 241-6001-600 Preside MDM 
Service Provisioning for ATM User Guide.

FR Service Provisioning Starts the Frame Relay service provisioning tool. 
To start the Frame Relay service provisioning 
tool, see the procedure “Starting a service 
provisioning tool without context” (page 628) and 
“Starting a service provisioning tool with context” 
(page 629). For information about Frame Relay 
service provisioning, see 241-6001-603 Preside 
MDM Service Provisioning for Frame Relay User 
Guide.

MDM Database 
Administration 

Starts the MDM Database Administration tool. To 
start the MDM Database Administration tool, see 
the procedure “Starting the MDM Database 
Administration tool from Circuit Viewer” 
(page 630).
Preside MDM Fault Management User Guide   15.1RSUP



636   Chapter 14 Circuit Viewer
Help 

Circuit retrieval criteria panel
Use the circuit retrieval panel to specify the criteria for searching the 
Administration Database. For some fields in this panel you can type an entry 
or a search pattern. For other fields you can use the drop down menu to select 
an entry. 

This circuit retrieval panel has two sections: a general retrieval criteria area 
and a service retrieval criteria area. The general area lets you specify retrieval 
criteria that are applicable to all circuit service types. The service retrieval 
criteria area lets you specify retrieval criteria that is specific to a service type. 
The service criteria area is hidden until you select a service type.

General retrieval criteria area
The general retrieval criteria area lets you retrieve circuit information from 
the Administration Database based on the following criteria: 

Table 112
Tools menu commands

Command Description

Help on Window Displays general information about the 
Component Information Viewer tool. 

What’s This? Displays information about a selected area of the 
Component Information Viewer window.
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The Circuit Viewer tool matches the TM Profile and Facility IDs against the 
values associated with circuit endpoints only, not intermediate components as 
in the case of a nailed up PVC.

ATM retrieval criteria area
The ATM service retrieval panel opens when you specify a service type of 
ATM.

Table 113
General retrieval criteria items

Command Description

Circuit ID Retrieves circuits matching the identifier from the 
database. An asterisk (*) in this field acts as a 
wildcard. This field supports a browse button [...] 
that provides a list of available circuit IDs.

Customer Name Retrieves circuits associated with customer 
names. An asterisk (*) in this field acts as a 
wildcard. This field supports a browse button [...] 
that provides a list of available customers.

Service Type Retrieves circuits based on the specified service 
type. When you select a specific service type, its 
associated panel opens below the general panel 
to provide additional search criteria.

TM Profile Retrieves circuits based on types of service 
offerings. 

Component Retrieves circuits based on the name of a 
component. An asterisk (*) in this field acts as a 
wildcard. This field supports a browse button [...] 
that provides a list of available components.

Facility ID Retrieves circuits based on the facility identifier 
at either end of the circuit. An asterisk (*) in this 
field acts as a wildcard. 
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Frame Relay retrieval criteria 
The Frame Relay service retrieval panel opens when you select a service type 
of Frame Relay.

IP VPN Access criteria
The IP VPN Access retrieval panel opens when you select a service type of 
IP VPN Access.

Table 114
ATM retrieval criteria items

Command Description

Circuit Type Identifies the type of ATM circuit to retrieve from 
the database. The following types are available: 
PVC, SPVC, PVP, SPVP, FR/ATM Access 
NPVC, FR/ATM Access SPVC. ATM MPE PVC 
and Trunk over ATM PVC.

Admin Control  Identifies the initial state of the connection 
following initial provisioning and after FP restarts 
and software reloads. The following values are 
available: permLocked and unlocked. If you 
select permLocked, the VPI and VCI numbers 
are reserved on the source node of the call but 
no bandwidth is used.

User Specified Path  Specifies either the primary or secondary 
manual designated transit line (MDTL) route. If 
you do not want the MDTL path to be considered 
in the search, leave this field blank.

Table 115
Frame Relay retrieval criteria items

Command Description

Data Network Address  identifies the data network address of the FrUni 
or FrNni at either the local or remote end. 
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Note: The Site and Access Point fields are enabled if the radio button to 
the left of the fields is selected. The Interface field is enabled if the radio 
button to the left of the field is selected.

For more information on setting up Sites and Access Points, refer to 
241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide and 241-6001-616 Preside MDM IP VPN Service Configuration User 
Guide.

Table 116
IP VPN Access retrieval criteria items

Command Description

Circuit Type  Identifies the specific type of IP VPN Access 
circuit. The following types are currently 
supported: FR IP VPN Access and ATM IP VPN 
Access.

Site Identifies the name of the site containing the IP 
Access Points on which the desired circuits 
terminate. An asterisk (*) in this field acts as a 
wildcard. This field supports a browser button [...] 
that provides a list of available sites based on the 
selected customer.

Access Point Identifies the name of the IP Access Point on 
which the desired circuits terminate. An asterisk 
(*) in this field acts as a wildcard. This field 
supports a browse button [...] that provides a list 
of available access points based on the selected 
site. If the selected site is set to "Unassigned", 
the list will only show the access points that have 
not been assigned to any site. If a user chooses 
"Unassigned" from the list of the available access 
points, only the circuits that have not been 
assigned to any access point will be retrieved.

Interface Identifies the name of the Logical Interface 
component on which the desired circuits 
terminate.
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Context support 
Context refers to variables that are shared among the Preside Multiservice 
Data Manager (MDM) tools using the MDM Context Server. The Circuit ID 
and Component fields in the retrieval panel support context. You can retrieve 
a circuit or component if it is in context by right-clicking on the field and 
selecting the Get Context command from the popup menu. For information 
about using context, see “Putting a component or circuit into context” 
(page 626) and “Getting a component or circuit from context” (page 627).

Command buttons
This panel contains the following command buttons:

Circuit(s) found panel
The Circuit(s) found panel displays a table containing all circuits in the 
database that meet the search criteria specified in the Circuit retrieval panel. 
The table includes the circuit identifier (ID), customer name, and the circuit 
type. 

Circuits retrieved from the database are consolidated first and then displayed 
in the Circuit(s) found panel. A Frame Relay circuit appears as a single circuit 
in the Circuit(s) found panel although it is actually several circuits. A Frame 
Relay circuit consists of a primary circuit and up to seven backup circuits, of 
which any can be active at a given time. As well, a FrameRelay IP VPN 
Access circuit (in a backhaul case) consists of a FrameRelay primary circuit 
and a FrameRelay access circuit, while an ATM IP VPN Access circuit is 
essentially an ATM MPE PVC circuit with an access-type AtmMpe Ac 
component (for example Rtr Vrf If AtmMpe Ac). Internally in the database, 

Table 117
Context panel buttons

Command Description

Retrieve Initiates a retrieval from the Administration 
Database.

Reset Resets the values in the Circuit retrieval criteria 
panel back to their default settings.
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for this type of ATM MPE PVC circuit, an artificial counterpart (an ATM 
access circuit) is maintained to facilitate circuit retrievals upon IP VPN 
Access service types.

Note: If you perform a query based on the "ATM" service and the "ATM 
MPE PVC" circuit type where the ATM MPE PVC circuit is associated 
with an ATM IP VPN Access circuit (the parent circuit), then only the 
ATM IP VPN Access circuit appears in the Circuit found table. Similarly, 
if you perform a query based on the "FR" service, when a FrameRelay 
primary circuit is associated with a FR IP VPN Access circuit (the parent 
circuit), then only the FR IP VPN Access circuit appears in the Circuit 
found table.

The name stored in the database for all IP VPN Access circuits is "IpCos". 
When an IP VPN Access circuit is displayed in the Circuit Viewer, it is further 
distinguished by its Site and Access Point, if they are known, and its IP CoS 
index. The name has the format Site/<site_name> AccessPoint/ 
<access_point_name> IPCoS/<IP CoS index>. For example:

Site/Ottawa Access Pt/Lab5 IpCos/1

If the Access Point or Site are not known, the string "none" appears as the 
name. For example:

Site/(none) Access Pt/(none) IpCos/0
Site/(none) Access Pt/Lab5 IpCos/1

Under certain conditions, icons display in the Circuit(s) found panel. For the 
circuit types SPVC and SPVP, a lock icon may display in the Circuit ID 
column. This icon indicates the connection is provisioned as locked. Absence 
of the lock icon can indicate that the circuit is unlocked or that the component 
is at a release prior to the introduction of the adminControl attribute (PCR 
3.0). 

You can reorder the display of columns in the Circuit(s) found list by dragging 
and dropping columns. See “Sorting a list in the Circuit(s) found panel” 
(page 611). You can also change the width of a column by dragging the 
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boundary line on the right side of the column heading until the column is the 
appropriate width. This panel also provides the total number of circuits based 
on the retrieval criteria.

When you select an entry from the circuit(s) found list, the circuit ID and 
serial number of that circuit are placed in context. Context lets you share 
information among other Preside Multiservice Data Manager (MDM) tools.

Right-clicking on a circuit in this panel opens a popup menu that lets you 
perform the following tasks: 

• Launch Service Provisioning, see “Starting a service provisioning tool 
with context” (page 629)

• “Starting state polling” (page 621) or “Stopping state polling” (page 622)

• “Viewing circuit component statistics” (page 623)

Circuit details panel
The Circuit details panel displays detailed circuit information including the 
following

• “Circuit state” (page 642)

• “Circuit information” (page 642)

• “Customer information” (page 644)

• “Circuit components” (page 645)

• “Connection states” (page 649)

Circuit state
If you turn on state polling, the circuit state displays at the top of the Circuit 
details panel. The overall circuit state is computed based on the states of the 
circuit components. The state of a circuit component is based on its state 
attributes retrieved from the switch. To view more information about states of 
circuit components, select the Circuit components and Connection state tabs. 

Circuit information
The Circuit information pane displays general and service-specific 
information about the circuit selected in the Circuit(s) found list. 
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General pane
You can view the following information about circuits in the general circuit 
information pane:

• circuit identifier

• circuit type

• source traffic management profile

• destination traffic management profile

• source facility identifier

• destination facility identifier

• description

You can edit the circuit Description field from the Circuit information pane. 
To edit the other fields, you need to use the MDM Database Administration 
tool. The Save button saves any changes that you make to the circuit 
description in the Administration Database.

The figure “Circuit Viewer window” (page 632) shows a sample Circuit 
Viewer window with the Circuit Information tab selected.

Service-specific pane
You can view the following ATM information in the service-specific details 
pane:

• admin control

• primary path

• secondary path

• automatic fallback

Depending on the Admin Control values, icons may display in the Circuit 
information pane. A lock icon in the Admin Control field denotes a circuit 
that has been provisioned as locked.

No service-specific information is available for Frame Relay circuits.
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For IP VPN Access circuits, you can view the component ID of the IP Logical 
Interface if it is known. 

Customer information
The Customer information pane displays information about the customer 
assigned to the circuit selected in the Circuit(s) found list. This pane displays 
the customer name and address and any additional comments associated with 
the customer. 

The figure “Sample Circuit Viewer window with Customer Information tab 
selected” (page 645) shows the Customer Information tab in the Circuit 
Viewer window.
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Figure 54
Sample Circuit Viewer window with Customer Information tab selected

Circuit components
The Circuit components pane displays a table containing the provisioned 
components for the circuit selected in the Circuit(s) found list. As well, the 
pane contains command buttons for performing operations on the circuit 
components.
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The circuit component information table includes the node, interface, 
connection, state, and traffic management (TM) profile data for all circuit 
types. If there are component attributes that are circuit dependent, then these 
attributes appear as additional columns in the table. For ATM circuits, the 
additional column displays the setting of the aisGeneration attribute for ATM 
SPVC and SPVP source connection components. For Frame Relay there is 
one column that indicates the Dlci type, either master or slave, and another 
column that displays the dataNetworkAddress attribute of the FrUni/FrNni 
Dna component. For FR IP VPN Access composite circuits, all components 
under the Frame Relay composite and the FrDte composite are displayed 
together in a single table. 

The state of a circuit component shown in the table is derived from its own 
operationalState and adminState and that of its interface as well as additional 
state attributes, depending on the type of component. These states are shown 
in the Connection states tabbed pane. 

When displaying SPVC and SPVP components, Circuit Viewer tries to find 
the destination AtmIf or FrATM interface from the called address. For AtmIf, 
if no address is provisioned, then a default address is computed by the loader 
and stored in the Administration Database when the component is loaded. It 
is this computed address that is used for the matching process. If Circuit 
Viewer finds an exact match to a single interface, then the interface and the 
connection type display in the component list. If no match is found, or if 
multiple matches are found, then the called address and the connection 
component without the connection type display in the component list. For the 
latter case, the connection type could be either a Fratm Dlci or an AtmIf Vcc. 
Circuit Viewer performs these matches for the following SPVCs and SPVPs:

• FrAtm to FrAtm

• AtmIf to AtmIf

• FrAtm to AtmIf

This type of address matching cannot be used for AtmIf to FrAtm since the 
provisioned FrAtm address is not in NSAP format.
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The Circuit components pane supports a popup menu that lets you start other 
Preside Multiservice Data Manager (MDM) tools or retrieve provisioned or 
operational attributes for a single component. If there is no connection to the 
command manager server, or if the component is a node, then the component 
popup menu is not available. 

For procedures on displaying component information, see “Displaying circuit 
component information” (page 612).

Circuit components command buttons
The following command buttons are available in the Circuit components 
pane:

The figures “Sample Circuit Viewer window with Circuit Components tab 
(List view) selected” (page 648) and “Sample Circuit Viewer window with 
Circuit Component tab (Path view) selected” (page 649) show the two views 
of the Circuit components tab in the Circuit Viewer window. 

Table 118
Alarm menu commands

Command Description

Trace  Is available for ATM SPVC and SPVP circuits 
only. This button performs a PNNI connection 
trace on the source component. This trace 
provides the details for the intermediate circuit 
components in the path.

Circuit Path Is available for ATM circuits only. This button 
displays the circuit components graphically. 
When the display changes from tabular to 
graphical format, the label on the button changes 
to List Components to revert to the tabular 
format.
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Figure 55
Sample Circuit Viewer window with Circuit Components tab (List view) 
selected
241-6001-011   15.1RSUP    



Chapter 14 Circuit Viewer   649
Figure 56
Sample Circuit Viewer window with Circuit Component tab (Path view) 
selected

Connection states
The Connection states tabbed pane is available only when state polling is 
turned on. This pane displays state attributes for each connection component 
that is polled. If a path trace has been done, the intermediate components will 
be displayed, otherwise just the endpoint state will be shown.
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The node, interface and connection columns identify the connection 
components that make up the circuit. The remaining columns display the state 
attributes for each component.

The figure “Sample Circuit Viewer window with Connection states tab 
selected” (page 650) shows the Connection states tab in the Circuit Viewer 
window.

Figure 57
Sample Circuit Viewer window with Connection states tab selected
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Sashes
There are a series of vertical sash bars in the window that let you change the 
amount of space a panel occupies. When you move a sash to increase the 
amount of space in one panel, the space for the other panels decrease 
correspondingly. To move a sash, drag the box in sash up and down. 

Online help
Help is available in most Preside Multiservice Data Manager (MDM) tools 
from either a Help menu or a Help button. 

The Help menu provides general descriptive information for the Circuit 
Viewer tool. You can view a brief overview of the tool using the On Window 
command. Help on key areas of the window is available from the What’s 
This? command. For details, see “Displaying Circuit Viewer online help” 
(page 603).

General descriptive help is available for dialogs that contain a Help button. 
You can view the help information for a dialog by clicking the Help button in 
the dialog. 
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Circuit Viewer fundamentals
The Circuit Viewer tool is one component of the Preside Multiservice Data 
Manager (MDM) circuit management suite. This tool works in conjunction 
with the MDM Database Administration tool, service provisioning tools, and 
the Administration Database to support the management of circuits in the 
network. For details about the MDM Database Administration tool and the 
Administration Database, see 241-6001-400 Preside MDM Administration 
Database User Guide. For details about the supported service provisioning 
tools, see 241-6001-600 Preside MDM Service Provisioning for ATM User 
Guide and 241-6001-603 Preside MDM Service Provisioning for Frame 
Relay User Guide.

Circuit Viewer retrieves circuit information from the Administration 
Database. You can specify criteria for searching the database. The Circuit 
Viewer tool displays a list of circuits that meet the specified criteria. Then, 
from this list of circuits, you can select a circuit for which you want detailed 
information. You can view data that includes the circuit information such as 
the circuit ID and type, customer information, circuit components, and 
connection states of those components. 

The Circuit Viewer tool service diagnostic information helps you manage 
faults in the network. These diagnostics include state information about the 
circuit, circuit components, and connection components. As well, you can 
view a selection of statistics for the connection, interface, and port 
components across a circuit. 

The Circuit Viewer supports the following circuits types:

• ATM

— PVC

— SPVC

— PVP

— SPVP

— FR/ATM Access NPVC

— FR/ATM Access SPVC

— ATM MPE PVC
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— Trunk over ATM PVC

• Frame Relay

— FRNNI

— FRUNI

• Frame Relay IP VPN Access

— Backhaul Access (2764)

— Direct Access (2764)

— IP Optimized Direct (2764 and 2547)

— IP Optimized Backhaul (2764 and 2547)

• ATM IP VPN Access (local PVC point to point connection)

Circuit Viewer server configuration
To use the Circuit Viewer application, you need to configure the Passport 
command access server. For details, see the section on the Passport command 
access server (PPAccessServer) in 241-6001-310 Preside MDM Server 
Reference Guide.

If the Passport command access server is on a different machine than Circuit 
Viewer, then you should specify the appropriate host via Options->Server 
Configuration in Circuit Viewer. Otherwise, Circuit Viewer will be unable to 
connect to the server. For more information, refer to “Setting the server 
configuration options” (page 604).

Circuit management log files
The Circuit Viewer tool stores log messages in the /opt/MagellanNMS/data/
log/CircuitManagement.log file. These log files have a maximum size of 10 
megabytes (MB). When this limit is reached, the content of 
CircuitManagement.log is moved and stored in CircuitManagement.log.1. 
New log messages accumulate in CircuitManagement.log once again. When 
CircuitManagement.log reaches is maximum size again, the following 
changes occur:

• the content of CircuitManagement.log.1 moves to 
CircuitManagement.log.2
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• the content of Circuit Management.log moves to 
CircuitManagement.log.1

• new log messages accumulate in CircuitManagement.log 

Current log messages are always stored in CircuitManagement.log. When 
this file reaches its size limit, the content is moved to another file in sequence. 
This roll-over process continues to create additional log files up to 
CircuitManagement.log.9. This method allows for a maximum of ten log 
files—one actively accumulating new log messages and nine others 
containing progressively older messages. When the maximum number of log 
files is reached, the roll-over process continues but the content of the oldest 
file, CircuitManagement.log.9, is lost.

Note: If a log file does not roll over as expected, another application may 
have a process that has the log file open. A rollover will occur when no 
process has the log file open and the log file nears its maximum size.

Since each log file can occupy up to 10 MB of disk space, and there are up to 
10 log files, storage for log files can reach 100 MB. Therefore, it is 
recommended that you have a file management strategy that includes 
archiving and deleting older log files. 

The MDM Database Administration tool also writes to the circuit 
management log file. As well, the ATM service provisioning tool writes to the 
circuit management log file if the provisioning causes errors in the 
Administration Database. Therefore, if you want to delete a current log file, 
first ensure that the log file is not being used by another application. 

The Frame Relay Service Provisioning tool can be launched from a Frame 
Relay IP VPN Access circuit as long as the circuit is complete (status Normal) 
and it has been assigned to an IP Access Point.
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HP OpenView NNM desktop

The Hewlett-Packard (HP) OpenView Network Node Manager (NNM) 
application can be used to access Preside Multiservice Data Manager 
(MDM). This section describes how to access a selection of MDM tools from 
this application. 

Navigation
• “HP OpenView procedures” (page 656)

• “HP OpenView NNM fundamentals” (page 667)

— “Root map” (page 667)

— “How HP OpenView NNM desktop displays device names” 
(page 668)
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HP OpenView procedures
This section contains procedures to start the HP OpenView Network Node 
Manager (NNM) application and to access a selection of MDM tools from 
that application. 

Navigation
Starting and stopping the HP OpenView NNM tool 

• “Starting HP OpenView NNM from the MDM toolset” (page 657)

• “Starting HP OpenView NNM from the UNIX command line” 
(page 658)

• “Quitting HP OpenView NNM” (page 659)

Displaying online information

• “Displaying online documentation” (page 660)

• “Displaying alarm help” (page 661)

Starting MDM tools from HP OpenView

• “Starting MDM Passport tools from the menu bar” (page 662)

• “Starting MDM Passport tools from the node pop-up menu” (page 664)

• “Starting MDM DPN tools from the menu bar” (page 665)

• “Starting MDM DPN tools from the node pop-up menu” (page 667)
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Starting HP OpenView NNM from the MDM toolset
Start HP OpenView NNM desktop to access the HP OpenView platform.

Procedure step
1 In the Preside MDM window, select Fault, HP OpenView NNM, and 

Network Node Manager.

The HP OpenView NNM desktop opens.
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Starting HP OpenView NNM from the UNIX command line
Start HP OpenView NNM desktop to access the HP OpenView platform.

Procedure steps
1 In a UNIX window start HP OpenView:

/opt/OV/bin/ovw &

The About HP OpenView window opens. To close the window, click Close 
or wait for the window to close on its own.

The Alarm Categories window opens. It may display a status message at 
the bottom, stating the percentage of the trapd.log file that has been 
loaded.

2 To view your network on the Root map, double-click the Nortel Networks 
symbol.

The Nortel Networks submap opens and displays the network devices.
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Quitting HP OpenView NNM
Use this procedure to quit the HP OpenView NNM application.

Procedure steps
1 From the Map menu, select Exit.

An OpenView Windows Warning dialog opens.

2 To exit, click OK.

The dialog closes along with the Event Categories window and any open 
submaps.
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Displaying online documentation
Display online documentation to access MDM and MDP documentation.

Procedure steps
1 From the Root map Help menu or any submap Help menu, select Online 

Documentation.

The Netscape browser opens with online documentation.

2 In the left pane of the browser, select the MDM or MDP document suite.

The left pane displays the documentation categories.

3 In the left pane, select a document name.

A table of contents appears. You can now select a topic from the 
document.

4 In the left pane, select the topic you want to view.

The topic details display in the right frame.
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Displaying alarm help
Alarm help allows you to view help on specific alarms. 

If you use this procedure to view help information for alarms from the HP 
OpenView NNM desktop, you need to first start the Alarm Help tool from the 
Preside MDM window. Starting Alarm Help in this manner opens the 
Netscape browser required for online help. As long as the Netscape Alarm 
Help window is open, you can request alarm help.

Procedure steps
1 In the Preside MDM window, select System -> Utilities -> Online 

Documentation.

The Alarm Help tool opens in a Netscape window.

2 On the OpenView submap, select the nodes for which you want alarm 
help.

3 From the Fault menu, select Alarm.

The All Alarms Browser window opens with a list of alarms for the selected 
nodes.

4 From the list of alarms, select one for which you want detail information.

5 From the Actions menu, select Additional Actions.

The Additional Actions on All Alarms dialog opens.

6 From the Action list, select Help for Passport Alarms.

7 Click the OK button.

The Netscape browser window displays the alarm help for the requested 
alarm
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Starting MDM Passport tools from the menu bar
You can start a selection of MDM PassportPassport tools from HP OpenView 
NNM menu bar. The table “MDM Passport tools that you can start from HP 
OpenView NNM” (page 662) provides a list of MDM tools that you can start 
from HP OpenView and the associated documentation for those tools.

Procedure steps
1 On the OpenView submap, click a Passport node to select it.

2 From the Performance, Configuration, Fault, or Miscellaneous menu, 
choose the MDM Passport tool that you want to start.

Table 119
MDM Passport tools that you can start from HP OpenView NNM

MDM tools For more information, see... 

Performance tools:

Passport Data Viewer 241-6001-031 Preside MDM 
Performance Management User Guide

Configuration tools:

Nodal Provisioning 241-6001-610 Preside MDM Nodal 
Provisioning User Guide

Software Distribution and 
Configuration

241-6001-023 Preside MDM 
Configuration Management for 
Passport User Guide

Service Integrity Simplification 241-6001-022 Preside MDM Network 
Reporting System User Guide

Network Activation 241-6001-023 Preside MDM 
Configuration Management for 
Passport User Guide

Passport/SNMP Devices 
Backup and Restore

241-6001-807 Preside MDM Network 
Backup and Restore

Fault tools:

Alarm Display 241-6001-011 Preside MDM Fault 
Management User Guide
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Component Information Viewer 241-6001-011 Preside MDM Fault 
Management User Guide

Component Status Display 241-6001-011 Preside MDM Fault 
Management User Guide

Network Status Bar 241-6001-011 Preside MDM Fault 
Management User Guide

Passport Shelf View 241-6001-011 Preside MDM Fault 
Management User Guide

Miscellaneous utilities:

Command Console 241-6001-804 Preside MDM 
Workstation Utilities User Guide

Customer Database 241-6001-804 Preside MDM 
Workstation Utilities User Guide

Table 119 (Continued)
MDM Passport tools that you can start from HP OpenView NNM

MDM tools For more information, see... 
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Starting MDM Passport tools from the node pop-up menu
You can start MDM Passport tools from a node’s pop-up menu.

Procedure steps
1 On the OpenView submap, right-click a Passport node to select it.

The node pop-up menu opens.

2 From the node pop-up menu, select one of the following MDM tools:

• a Passport Configuration tool 

• a Passport Fault tool 

• Data Viewer

• Command Console

• Customer Database
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Starting MDM DPN tools from the menu bar
You can start a selection of MDM DPN tools from HP OpenView NNM menu 
bar. The table “MDM DPN tools that you can start from HP OpenView 
NNM” (page 665) provides a list of MDM DPN tools that you can start from 
HP OpenView and the associated documentation for those tools.

Procedure steps
1 On the OpenView submap, click to select a node.

2 From the Performance, Configuration, Fault, or Miscellaneous menu, 
choose the MDM Passport tool that you want to start. 

Table 120
MDM DPN tools that you can start from HP OpenView NNM

MDM tools For more information, see... 

Performance tools:

DPN Performance Viewer 241-6001-031 Preside MDM 
Performance Management User Guide

Configuration tools:

Component Provisioning 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Service Data Backup 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Service Data Restore 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Global Data Manager 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Software Distribution 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide
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Software Substitution 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Envelope Editor 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Service Data Conversion 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Network Activation 241-6001-012 Preside MDM 
Configuration Management for DPN 
User Guide

Service Integrity Simplification 241-6001-022 Preside MDM Network 
Reporting System User Guide

DPN Fault tools:

Alarm Display 241-6001-011 Preside MDM Fault 
Management User Guide

Component Information Viewer 241-6001-011 Preside MDM Fault 
Management User Guide

Component Status Display 241-6001-011 Preside MDM Fault 
Management User Guide

Network Status Bar 241-6001-011 Preside MDM Fault 
Management User Guide

Miscellaneous utilities:

Command Console 241-6001-804 Preside MDM 
Workstation Utilities User Guide

Customer Database 241-6001-804 Preside MDM 
Workstation Utilities User Guide

Table 120 (Continued)
MDM DPN tools that you can start from HP OpenView NNM

MDM tools For more information, see... 
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Starting MDM DPN tools from the node pop-up menu
You can start MDM DPN tools from a node’s pop-up menu.

Procedure steps
1 On the OpenView submap, right-click a DPN node to select it.

The node pop-up menu opens.

2 From node pop-up menu, select one of the following MDM tools:

• a DPN Configuration tool 

• Command Console

• Customer Database

• a DPN Fault tool 

• DPN Performance Viewer

HP OpenView NNM fundamentals
HP OpenView Network Node Manager (NNM) is an optional feature of 
MDM that provides access to the HP OpenView platform. To run this desktop 
application, you need HP OpenView and the HP OpenView Desktop for 
MDM software installed on the MDM workstation. After the required 
software is installed, you can start the HP OpenView NNM desktop 
application from the MDM toolset. Then, from the HP OpenView NNM 
desktop, you can access the following from the MDM software:

• fault management tools

• configuration management tools

• Data Viewer performance management tool

• Customer Database utility for access to customer information databases 

• Command Console utility for direct access to a switching element 

Root map
When you start HP OpenView NNM from MDM, a Root map opens, 
displaying the Nortel Networks symbol and the IP Internet symbol. These 
symbols indicate the state of their respective networks through color. The 
standard HP OpenView color scheme is used. To view the standard color 
representation you can display the legend from the Help menu.
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How HP OpenView NNM desktop displays device names
HP OpenView NNM desktop displays Passport and DPN device names on the 
Nortel Networks submap. 

Passport devices
For Passport nodes, the icons distinguish between Passport nodes belonging 
to the 6000, 7000 and 15000 series. 

• Icons depicting Passport legacy and 6000 nodes contain P6 or 6.

• Icons depicting Passport 7400 nodes contain P7 or 7.

• Icons depicting Passport 15000 nodes contain P15 or 15.

• Icons depicting unknown Passport nodes contain P? or ?. Although the 
devices are in the database, it has not yet been configured to identify 
these devices. To change these icons to identify the Passport type, use the 
Make Configuration Data File (MCDF) utility. For details see 
241-6001-015 Preside MDM Network Model Administrator Guide.

Passport nodes also have a label beneath the icon. Passport switches display 
on the Nortel Networks submap as EM/<device_name>. For example: 
EM/EMDEV1

Passport 4400 access device names display on the Nortel Networks submap 
as MPA /<device_name>. For example: MPA/MPADEV1

DPN devices
DPN nodes are depicted by an icon that contains a D or O.

The label for DPN switches display on the Nortel Networks submap as 
follows, depending on the type of DPN device:

• DPN-100 device names display as
PM/<device_name>, for example: PM/PMDEV1

• Passport 4120 device names display as
PM/<device_name>, for example: PM/PM/DEV2

• Operating Agents on DPN-100, Passport 4120, or Passport 4400 with 
LDM cards display as
OA/<agent_name>, for example OA/AGENT3
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There is no subcomponent submap for DPN devices. To see a list of the 
subcomponents and their states, use the Component Information Viewer.
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Common surveillance tasks

Network operators perform common surveillance tasks, such as monitoring 
the network for faults (global network status through the Network Status Bar, 
state-based through the Network Viewer, or Component Status Display or 
alarm-based through the Alarm Display); diagnosing the cause of the faults 
and its impacts; and taking remedial actions.

You can use a combination of surveillance tools to perform common tasks. 
Specific procedures, based on the tool and task, are provided in the following 
sections:

• “Finding troubled components” (page 672)

• “Monitoring a selected set of components” (page 673)

• “Responding to troubled or out-of-service states” (page 674)

• “Determining a problem” (page 675)

• “Putting a component into maintenance state” (page 676)

• “Putting a component in acknowledged state” (page 677)

• “Clearing an alarm” (page 678)

• “Acknowledging/Unacknowledging an alarm” (page 679)

• “Fixing a problem” (page 679)

• “Changing the Network Viewer display” (page 679)
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Finding troubled components 
To quickly find troubled components, you can use the Network Status Bar, 
Network Viewer, Component Status Display, Alarm Display, and Component 
Information Viewer tools. If the Component Information Viewer is open with 
Auto Context Active turned on, component information from the Network 
Viewer, Component Status Display, and Alarm Display is passed to this tool 
for processing. See “Setting Preferences in MDM Toolset” (page 423) for 
more information.

For references to specific tools and tasks for finding troubled components, see 
the table “Finding troubled components” (page 672).

Table 121 
Finding troubled components

Tool and task Reference

Network Status Bar “Network Status Bar” (page 397)

• Monitor network status.

• Identify troubled 
components. 

“Network Status Bar fundamentals” 
(page 400)

“Troubled Components Dialog” (page 406)

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Navigate through the 
network.

“Using the Component Finder” (page 67)

“Using organization navigation” (page 71)

“Using background navigation” (page 77)

Component Status Display “Component Status Display” (page 519)

• Navigate through the 
network.

• Set component filtering.

“Starting the Component Status Display” 
(page 541)

“Changing the Component Filter Settings” 
(page 544)
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Monitoring a selected set of components
You can select a set of components that you want to monitor at a site, module, 
component, or subcomponent level of an organization. In the Alarm Display 
you can also perform filtering on specific components.

For references to specific tools and tasks for monitoring components, see the 
table.“Monitoring selected components” (page 673)

Alarm Display “Alarm Display” (page 303)

• Display active alarms 

• Display alarm logs

• Setting alarm filters.

• Setting special effects.

“Active mode” (page 363)

“Log mode” (page 363) 

“Filtering alarms” (page 365) 

“Setting alarm effects” (page 308)

Component Information 
Viewer

“Component Information Viewer” (page 415).

• Turn on Auto context 
active.

“Setting Preferences in MDM Toolset” 
(page 423)

• Set component filters. “Setting component filters in MDM Toolset” 
(page 421)

• Set information type. “Displaying additional component information 
in MDM Toolset” (page 434)

Table 122 
Monitoring selected components 

Tool and task Reference

Component Status Display “Component Status Display” (page 519)

• Choose the area of the 
network that you want to 
monitor.

“Starting the Component Status Display” 
(page 541)
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Table 121  (Continued)
Finding troubled components

Tool and task Reference
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Responding to troubled or out-of-service states
If you find a troubled component, or you receive an alarm indicating in-
service troubled (ISTB) or out-of-service (OOS) state, use the tools described 
in the table “Responding to troubled or out-of-service states” (page 675) to 
respond.

• Select the types of 
components with particular 
states or critical levels that 
you want to monitor.

“Changing the Component Filter 
Settings” (page 544)

• Sort the list of components by 
state, component name, or 
time, and set the update 
interval.

“Setting the sort key for the components 
list” (page 546)

“Setting the Auto-Refresh interval” 
(page 547)

Network Status Bar “Network Status Bar” (page 397)

• Identify troubled 
subcomponents.

“Troubled Components Dialog” 
(page 406)

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Navigate through the network. “Using the Component Finder” (page 67)

“Using organization navigation” 
(page 71)

“Using background navigation” (page 77)

Alarm Display “Alarm Display” (page 303)

• Filter alarms. “Filtering alarms” (page 365)

Table 122  (Continued)
Monitoring selected components 

Tool and task Reference
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Determining a problem
After you locate the component causing the problem in the network, you need 
to determine the underlying cause of the problem, its importance, and its 
impact.

For references to specific tools and tasks for determining a network problem, 
see the table “Determining the cause of network problems” (page 676).

Table 123
Responding to troubled or out-of-service states 

Tool and task Reference

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Use the Component Finder. “Finding a component using the 
Component Finder” (page 68)

• Use organization navigation. “Expanding in place to the next lower 
level” (page 71)

Component Status Display “Component Status Display” 
(page 519)

• Navigate through the network.

• Set the component filtering.

“Starting the Component Status 
Display” (page 541)

“Setting component filtering from the 
Component Filter Settings Dialog” 
(page 544)

Component Information Viewer “Component Information Viewer” 
(page 415)

• Select the problem 
subcomponent.

“Setting a target in the related 
components panel in MDM toolset” 
(page 427)
Preside MDM Fault Management User Guide   15.1RSUP



676   Chapter 16 Common surveillance tasks
Putting a component into maintenance state
After you find a problem, you may want to put the component in maintenance 
state while it is being fixed.

For references to specific tools and tasks for putting components in 
maintenance state, see the table “Putting a component in maintenance state” 
(page 676).

Table 124 
Determining the cause of network problems

Tool and task Reference

Component Information Viewer “Component Information Viewer” 
(page 415) 

• Navigate through the network. “Component Information Viewer data” 
(page 461)

• Set the information type. “Setting component filters in MDM 
Toolset” (page 421)

• Get more data from other 
tools.

For details on the Start Tool menu, see 
the section about the Start Tool in 
241-6001-122 Preside MDM Using MDM 
Toolset and Operator Client Interfaces 

Alarm Help See “Alarm Help” (page 371).

• Look up the fault code.

Table 125
Putting a component in maintenance state

Tool and task Reference

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Put the subcomponent into 
maintenance.

“Putting components into the 
Acknowledged state” (page 66)
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Putting a component in acknowledged state
After you find a problem, you may want to put the component in 
acknowledged state to mask its real state.

For references to specific tools and tasks for putting components in 
acknowledge state, see the table “Putting a component in acknowledged 
state” (page 677).

Component Status Display “Component Status Display” (page 519)

• Put the subcomponent into 
maintenance.

“Putting a component into Maintenance 
state” (page 543)

Component Information Viewer “Component Information Viewer” 
(page 415)

• Put the subcomponent into 
maintenance.

“Setting the maintenance state for a 
component” (page 430)

Table 126
Putting a component in acknowledged state

Tool and task Reference

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Put the subcomponent into 
acknowledged state.

“Putting components into the 
Acknowledged state” (page 66)

Component Status Display “Component Status Display” (page 519)

• Put the subcomponent into 
acknowledged state.

“Putting a component into Acknowledged 
state” (page 543)
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Table 125 (Continued)
Putting a component in maintenance state

Tool and task Reference
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Clearing an alarm 
Normally, operators do not clear alarms. They are cleared after the component 
is restored. If necessary, you can clear an active alarm; but once cleared, it 
cannot be retrieved. 

For references to specific tools and tasks for clearing an alarm, see the table 
“Clearing an alarm” (page 678).

Component Information Viewer “Component Information Viewer” 
(page 415)

• Put the subcomponent into 
acknowledged state.

“Setting the acknowledge state for a 
component” (page 428)

Table 127
Clearing an alarm

Tool and task Reference

Component Information Viewer “Component Information Viewer” 
(page 415)

• If necessary, clear the alarm. “Clearing alarms using Local Clear” 
(page 435) and
“Clearing alarms using Global Clear” 
(page 437)

Alarm Display “Alarm Display” (page 303)

• If necessary, clear the alarm. “Clearing alarms locally” (page 316) and 
“Clearing alarms globally” (page 317)

Table 126 (Continued)
Putting a component in acknowledged state

Tool and task Reference
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Acknowledging/Unacknowledging an alarm
After you investigate a the cause of an alarm, you may choose to acknowledge 
the alarm. This indicates to other network operators that the problem is under 
investigation. Conversely, you might choose to unacknowledge a previously 
acknowledged alarm.

For references to specific tools and tasks for acknowledging or 
unacknowledging an alarm, see the table.“Acknowledging and 
Unacknowledging an alarm” (page 679)

Fixing a problem
After a problem is diagnosed, you can fix or circumvent it by issuing 
commands from the Command Console. See the Command Console section 
in 241-6001-804 Preside MDM Workstation Utilities User Guide for 
information on this tool.

Changing the Network Viewer display
You can customize the Network Viewer display by saving different views of 
the network. 

For references to specific tasks for changing the Network Viewer display, see 
the table “Changing the Network Viewer display” (page 680).

Table 128
Acknowledging and Unacknowledging an alarm

Tool and task Reference

Component Information Viewer “Alarm acknowledgement and 
unacknowledgement” (page 381) 

Alarm Display “Alarm acknowledgement and 
unacknowledgement” (page 381)
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Table 129
Changing the Network Viewer display

Tool and task Reference

Network Viewer “Network Viewer in the MDM Toolset” 
(page 37)

• Displaying nodes and shelves “Displaying nodes” (page 49)

• Zoom to a larger view. “Zooming in on the display” (page 77)

• Save a view of the network 
that is to be used often.

“Using Views of the network” (page 85)
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LPDA-2 modem management

This appendix describes how you can manage LPDA-2 modems with Preside 
Multiservice Data Manager (MDM). It explains:

• what the LPDA-2 macros are

• how to use the LPDA-2 macros

• how to update the LPDA-2 macro configuration file

The macros described in this appendix can only be used with modems that 
support LPDA-2.

About LPDA-2 commands
LPDA-2 is a protocol that allows diagnostic commands to be sent to modems 
that support this protocol. You can send LPDA-2 commands using the macro 
facility of the Command Console. Each macro sends an LPDA-2 command to 
a modem at a specified port and displays the results of the command in the 
Command Console utility. For details about the Command Console utility, 
see 241-6001-804 Preside MDM Workstation Utilities User Guide.

The results displayed by the macros include comments on the values being 
displayed. When it is appropriate, a rating is displayed beside the value 
received from the modem. For example, the line quality received by the 
modem can be rated as good, fair, poor, or bad.

The values to which these ratings apply are set in the LPDA configuration file. 
You can edit this file to customize the display printed by the macros in the 
Command Console.
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Modem self-test macro - LPDASLF
The modem self-test macro sends a command to a modem to perform a series 
of self-tests. These tests are performed by both local and remote modems. The 
modem reports the results of these tests and displays them in the Command 
Console.

Modem and line status macro - LPDAMST
The modem and line status macro sends a command to the modem to report 
the results of the last self-test performed. The modem reports the results of 
these tests and displays them in the Command Console.

Modem transmit/receive test macro - LPDATRR
The modem transmit/receive test macro sends a command to the modem that 
causes the local and remote modems to exchange test sequences. The number 
of times the modems exchange these sequences is supplied by the operator.

Using LPDA-2 macros
You need to start all macros from the Command Console. Before you can 
send an LPDA-2 command to a modem, you need to disable the port to which 
it is attached. You can disable the port from the Command Console using the 
AM/RM DISABLE command. For details on the command, see 
241-1001-303 DPN-100 Operator Commands and Responses - Volume 4.

Example
RAAS-11 5 2 DISABLE 

disables port 2 on PE 5 of the RAAS-11 access module. 

The length of time the macros can run is limited. If no response is received 
before the time limit is reached, the macro times out and reports the problem.

You can start all macros that run from the Command Console by using $ in 
front of the macro name.

Running the LPDASLF macro
To run the LPDASLF macro, enter the command LPDASLF followed by the 
routing information that identifies the port being tested.
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Example
$LPDASLF RAAS-11 5 2

The test takes a maximum of one minute, the results are displayed in the 
Command Console window.

Running the LPDAMST macro
To run the LPDAMST macro enter the command LPDAMST followed by the 
routing information that identifies the port being tested.

Example
$LPDAMST RAAS-11 5 2

The test takes a maximum of one minute; the results are displayed in the 
Command Console window.

Running the LPDATRR macro
To run the LPDATRR macro, enter the command LPDATRR followed by the 
number of test sequences the modems are to exchange, and the routing 
information that identifies the port being tested.

Example
$LPDATRR  6 RAAS-11 5 2

Here the modems exchange six test sequences and then report the results.

The maximum number of times that the modems can exchange test sequences 
is ten and the minimum is one. You need to provide a value for the number of 
exchanges before the routing information.

The time taken to complete the test depends on the number of test sequence 
exchanges requested. The maximum time for the test is 60 minutes; the results 
are displayed in the Command Console.
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Updating the LPDA-2 configuration file
The file lpda.cfg contains information used by the macros to display the 
results received from the modem. A copy of this file is in the 
/opt/MagellanNMS/cfg/macros/nms directory. You can use this file to change 
the behavior of the LPDA-2 macros when you

• change the ranges of values that are used to judge the performance of the 
modem

• change the language in the report printed from the modem

• extend the modem models recognized by the macros

You need to put replacement versions of this file in the Preside Multiservice 
Data Manager (MDM)  user’s $HOME/MagellanNMS directory. The macros 
search this directory for the configuration file before going to the /opt/
MagellanNMS/cfg/macros/nms directory. 

If a problem occurs in the user’s copy of the configuration file, the error is 
reported, and the /opt/MagellanNMS/cfg/macros/nms version is used. If the 
macros fail to find a valid configuration file, they will print a warning and use 
a set of default values.

Detailed instructions for altering the configuration file are contained in the 
file.
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Common alarm format

The table “Common alarm format” (page 685) describes the Common alarm 
format parameters.

Table 130 
Common alarm format 

Parameter Semantics

componentID Indicates the full name of the component that generated the alarm.
For MPE 9500 alarms, the component ID is displayed using the 
following format: <type><IOC#><port#> 
[:<part#>[:[<part#>]][.<unit#>[.<unit#>...]]
where:

date Indicates the date at which the alarm was generated.

time Indicates the time at which the alarm was generated.

alarmType Indicates the type of event (for example, equipmentAlarm, Com-

municationsAlarm). This attribute is equivalent to the OSI alarm-

Type parameter.

common severity Indicates the severity of the alarm. This attribute is equivalent to the 
OSI perceivedSeverity parameter.

For MPE 9500, the possible values are CRITICAL, MAJOR, 

MINOR, WARNING, CLEAR, UNKNOWN.

probableCause Standardized cause for the event. This attribute is equivalent to the 
OSI probableCause parameter.
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notificationID Provides an identifier for the alarm. It may be used by the 
correlatedNotifications parameter of subsequent alarms.

customerID Indicates the device customer Id associated with the component.

This attribute is set to zero for MPE 9500.

rawState The DPN raw state.

commentData Provides a free form text description of the event.

operatorData A HEX string specifying operator data.

expertData A HEX string specifying expert data.

event An integer specifying the alarm type as being a message, a set, or 
a clear.

fault code A code used to obtain further information concerning the error 
causing the alarm.

For MPE 9500 originated alarms, the fault code format is 8 + 3 +4 
where 3 is a HEX string for the subsystem, and 4 represents the 
subsystem alarm code.

relatedComponentName The names of components related to the component originating the 
alarm.

correlatedNotifications Identifies alarms that are related to this alarm.

fileNameInformation Information allowing the determination of the location in source of 
the alarm generating code.

administrativeState This attribute is equivalent to the OSI administrativeState 
parameter.

operationalState This attribute is equivalent to the OSI operationalState parameter.

usageState This attribute is equivalent to the OSI usageState parameter.

proceduralStatus This attribute is equivalent to the OSI proceduralStatus 
parameter.

availabilityStatus This attribute is equivalent to the OSI availabilityStatus 
parameter.

unknownStatus This attribute is equivalent to the OSI unknownStatus parameter.

Table 130  (Continued)
Common alarm format 

Parameter Semantics
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fileNameInformation Identifies the file name of the source for the alarm generating code.

lineNumber Identifies the line number in fileNameInformation for the alarm 
generating code.

processId Identifies the process Id of the component generating the alarm.

version Identifies the name of the version of software running when the 
alarm was generated.

Supported for MPE 9500 only.

CCI Index If configured, identifies the unique integer, 
configuredComponentIndex (CCI), used across all configured 
components in the system.

Supported for MPE 9500 only.

DCI Index If configured, identifies the dynamicComponentIndexOrZero (DCI). 
The value of this attribute is unique within the scope of the 
configured parent component.

Supported for MPE 9500 only.

Table 130  (Continued)
Common alarm format 

Parameter Semantics
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Index
A
acknowledged state 522, 523

putting component into 66, 543, 677
taking component out of 67

adding alarm codes 375
alarm code, adding 375
alarm code, editing 375
alarm code, searching for 373
Alarm Display 361

command line arguments 351
Alarm Help, documents 371
Alarms

deleting 678
viewing AD alarm files 369

C
Cluster and pin 54
component filtering 527, 530, 532–534

changing settings of 544–545
component information viewer

refresh interval 503
component status 521
Component Status Display 519–550

choosing an organization 542
component filtering 527, 530, 532–534

changing settings of 544–545
component status 521
components panel 526–529
customizing 548–550
error & warning messages 538–540
Preside 
exiting 545
keyboard shortcuts 531
setting preferences 534–537, 546–548
starting 541
warning & error messages 538–540

components panel 526–529
context 42, 527
Customizing

Alarm Display Start Tool submenus 324
Component Information Viewer Related 

Components list tools menu 398
other resources 326

D
direct discovery 560, 592
DPN context 42

E
editing alarm codes 375

F
Filtering

alarms 365
changing filters 313
defining filters 309
saving filters 366
setting component filter parameters 79

filtering
components 527, 532–534

filtering components 530
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Filters
applying filters 365
changing filters in Alarm Display 313
using previously saved filters 82

filters
changing component filter settings 544–

545

H
hierarchical maintenance state 523
hierarchical out-of-service state 522
hot context

in component information viewer 503

I
in-service states 521, 522
in-service—troubled 521, 522
in-service—troubled state 521, 522
IP Discovery 553–592

adding an address 567
changing a password 558
changing network settings 569
creating network settings 568
deleting devices 562
deleting network settings 570
direct discovery 560, 592
displaying devices 579
failure of a discovery 592
location of logs 592
moving rows 571
process 591
route-based discovery 561, 591
setting a password 556, 559
sorting devices 579
starting in insecure mode 555
starting in secure mode 557
updating devices 564, 565, 566

K
keyboard shortcuts

Component Status Display 531
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commands 681
LPDAMST 683
LPDASLF 682
LPDATRR 683
updating configuration file 684

LPDA-2 macros 681
LPDAMST 682

running 683
LPDASLF 682

running 682
LPDATRR 682

running 683

M
Macros

LPDA-2 681
maintenance state

putting component into 543–544
maintenance states 523
Modem and line status macro - 

LPDAMST 682
Modem management 681
Modem self test macro - LPDASLF 682
Modem transmit - receive test macro - 

LPDATRR 682

N
network status

See also color scheme
Network Viewer 37

displaying component state 64
displaying links 55
displaying nodes 49
displaying shelf views 58
organization navigation 71

Node positioning 53

O
out-of-service state 521, 522
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P
Passwords

changing for IP Discovery 558
setting for IP Discovery 556, 559

Problems
fixing 679

propagated states 522

R
raw states 521
Reset button 380
route-based discovery 561, 591

S
Search Alarm button 380
Setting the Network Viewer preferences 79
starting Alarm Help 372
states 521, 522

acknowledged 522, 523
putting component into 543, 677

hierarchical maintenance 523
hierarchical out-of-service 522
in-service 521, 522
maintenance 523

putting component into 543–544
out-of-service 521, 522
propagated 522
raw 521
unknown 521, 522

Surveillance tasks
putting component into acknowledged 

state 66
surveillance tasks

acknowledging an alarm 679
changing NV display 679
clearing an alarm 678
determining a problem 675
fault correction 679
finding troubled components 672
monitoring selected components 673
putting component into acknowledged 
Preside 
state 677
putting component into maintenance 677
unacknowledging an alarm 679

T
text entry field 380
text string, searching for 374
Troubleshooting

in Network Viewer 99

U
unknown state 521, 522

V
viewing an alarm code from Alarm 

Display 374
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